Overview of Adding a Workstation 3-3
Adding a Workstation 3-3
Configuring Workstation Transaction Settings 3-5
Setting Offline Transaction Posting Time 3-6
Configuring Workstation Security 3-6
Configuring the Magnetic Stripe Reader on the Oracle MICROS Tablet 720 3-8
Configuring the Barcode Scanner on the Oracle MICROS Tablet 720 3-8
Integration with the Android Mobile Operating System 3-8
Android Devices and Versions 3-9
Android Functionality Support 3-10
Android Network Requirements 3-10
Android Payments 3-11
Configuring the Android Device 3-11
Configuring the Android Device as a Workstation 3-12
Setting the CAL Package for the Android Device 3-12
Installing the Client Application Loader (CAL) on the Android Device 3-13
Installing the Simphony Service Host 3-14
Viewing and Editing Simphony Android Files 3-14
Setting Languages 3-15

4 Employees and Privileges
Setting Employee Roles 4-1
Creating Employee Classes 4-3
Adding an Employee 4-4
Terminating an Employee 4-5
Changing Employee Information 4-5
Configuring Employee Shifts 4-7
Configuring Employee Breaks 4-9
Clock-In and Clock-Out Cycles 4-10
Setting Clock-In and Clock-Out Cycles 4-10
Job Codes 4-11
Configuring Job Codes 4-11
Understanding Tip Tracking 4-12
Configuring Tip Tracking and Reporting 4-13
Configuring Tip Track Front of House Buttons 4-14

5 Payments and Currency
Types of Payment 5-2
Configuring Base Currency and Alternate Currency 5-2
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Currency Conversions</td>
<td>5-3</td>
</tr>
<tr>
<td>Configuring the Cash Tender</td>
<td>5-4</td>
</tr>
<tr>
<td>Credit Card Tokenization</td>
<td>5-5</td>
</tr>
<tr>
<td>Loadable Payment Card Configuration Tasks</td>
<td>5-5</td>
</tr>
<tr>
<td>Loadable Payment Configuration Prerequisites</td>
<td>5-6</td>
</tr>
<tr>
<td>Universal Transaction Gateway for Shift4</td>
<td>5-7</td>
</tr>
<tr>
<td>Communication Methods for Fusebox Payment Card Driver</td>
<td>5-8</td>
</tr>
<tr>
<td>stunnel Installation Methods</td>
<td>5-8</td>
</tr>
<tr>
<td>Installing stunnel at a Single Host Location</td>
<td>5-9</td>
</tr>
<tr>
<td>Installing stunnel Through Simphony as a CAL Package</td>
<td>5-9</td>
</tr>
<tr>
<td>Configuring the CAPMS Payment Card Driver</td>
<td>5-10</td>
</tr>
<tr>
<td>Configuring the CAPMS Payment Module</td>
<td>5-11</td>
</tr>
<tr>
<td>Configuring the Dollars on the Net Payment Card Driver</td>
<td>5-13</td>
</tr>
<tr>
<td>Configuring the Dollars on the Net Payment Module</td>
<td>5-14</td>
</tr>
<tr>
<td>Configuring the Fusebox Payment Card Driver</td>
<td>5-16</td>
</tr>
<tr>
<td>Configuring the Fusebox Payment Module</td>
<td>5-18</td>
</tr>
<tr>
<td>Configuring the VisaD Payment Card Driver</td>
<td>5-20</td>
</tr>
<tr>
<td>Configuring the VisaD Payment Module</td>
<td>5-22</td>
</tr>
<tr>
<td>Configuring the Loadable Payment Card Device</td>
<td>5-23</td>
</tr>
<tr>
<td>Creating Front of House Loadable Payment Card Buttons</td>
<td>5-24</td>
</tr>
<tr>
<td>Distributing a Third-Party Credit Card Driver Package</td>
<td>5-24</td>
</tr>
<tr>
<td>Copying Third-Party Payment Driver Files</td>
<td>5-25</td>
</tr>
<tr>
<td>Creating a CAL Package for the Third-Party Payment Card Driver Distribution</td>
<td>5-25</td>
</tr>
<tr>
<td>Credit Card Batching</td>
<td>5-26</td>
</tr>
<tr>
<td>Creating a Credit Card Batch</td>
<td>5-26</td>
</tr>
<tr>
<td>Editing a Credit Card Batch</td>
<td>5-26</td>
</tr>
<tr>
<td>Settling a Credit Card Batch</td>
<td>5-27</td>
</tr>
<tr>
<td>Credit Card Preamble</td>
<td>5-27</td>
</tr>
<tr>
<td>Credit Card Preamble Rules</td>
<td>5-27</td>
</tr>
<tr>
<td>Updating Standard Credit Card Preambles</td>
<td>5-28</td>
</tr>
<tr>
<td>List of Standard Credit Card Preambles for the U.S.</td>
<td>5-28</td>
</tr>
<tr>
<td>Pay at the Table</td>
<td>5-29</td>
</tr>
<tr>
<td>Configuring a Credit Card Tender</td>
<td>5-30</td>
</tr>
<tr>
<td>Configuring the Room Tender</td>
<td>5-31</td>
</tr>
<tr>
<td>Configuring the OPERA PMS Payment Driver</td>
<td>5-31</td>
</tr>
<tr>
<td>Configuring the MICROS Standard Credit Card Payment Module</td>
<td>5-32</td>
</tr>
<tr>
<td>Configuring the Loadable PMS Payment Module</td>
<td>5-35</td>
</tr>
<tr>
<td>Configuring the Demo Payment</td>
<td>5-36</td>
</tr>
<tr>
<td>Setting the Front of House to Allow Pay at the Table</td>
<td>5-36</td>
</tr>
<tr>
<td>Configuring Email Receipts</td>
<td>5-38</td>
</tr>
<tr>
<td>Autosequence Events</td>
<td>5-39</td>
</tr>
</tbody>
</table>
## Taxes

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding Tax Rates and Tax Classes</td>
<td>6-2</td>
</tr>
<tr>
<td>Serving Periods</td>
<td>6-3</td>
</tr>
<tr>
<td>Configuring a Serving Period</td>
<td>6-3</td>
</tr>
<tr>
<td>Order Types</td>
<td>6-4</td>
</tr>
<tr>
<td>Configuring Order Types</td>
<td>6-5</td>
</tr>
<tr>
<td>Configuring Order Types as Subtotal Keys</td>
<td>6-6</td>
</tr>
<tr>
<td>Configuring Tax Rates and Classes</td>
<td>6-7</td>
</tr>
<tr>
<td>Understanding Tax Labels</td>
<td>6-8</td>
</tr>
<tr>
<td>Configuring Tax Labels</td>
<td>6-8</td>
</tr>
<tr>
<td>Printing Tax Rate Per Item</td>
<td>6-8</td>
</tr>
<tr>
<td>Configuring Tax Rates Per Item to Print on Guest Check, Customer Receipt and Journal</td>
<td>6-9</td>
</tr>
<tr>
<td>Configuring Workstation Number and Transaction Number to Print on Guest Check, Customer Receipt, and Journal</td>
<td>6-10</td>
</tr>
</tbody>
</table>

## Discounts

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic Discounts</td>
<td>7-2</td>
</tr>
<tr>
<td>Understanding Automatic Discount Rules</td>
<td>7-3</td>
</tr>
<tr>
<td>Understanding Awarding Algorithms</td>
<td>7-3</td>
</tr>
<tr>
<td>Discount Award Types</td>
<td>7-5</td>
</tr>
<tr>
<td>Discount Exclusivity</td>
<td>7-5</td>
</tr>
<tr>
<td>Simple Exclusivity</td>
<td>7-6</td>
</tr>
<tr>
<td>Group Exclusivity</td>
<td>7-7</td>
</tr>
<tr>
<td>Menu Item Groups</td>
<td>7-8</td>
</tr>
<tr>
<td>Configuring Discount Privileges</td>
<td>7-8</td>
</tr>
<tr>
<td>Configuring Discounts</td>
<td>7-9</td>
</tr>
<tr>
<td>Understanding Automatic Discounts with Decimal Quantity Menu Items</td>
<td>7-13</td>
</tr>
<tr>
<td>Amount Off Examples</td>
<td>7-13</td>
</tr>
<tr>
<td>Amount Substitution Examples</td>
<td>7-14</td>
</tr>
<tr>
<td>Configuring Decimal Quantity Menu Items</td>
<td>7-15</td>
</tr>
<tr>
<td>Configuring a Combination Pricing Discount</td>
<td>7-15</td>
</tr>
<tr>
<td>Applying Discounts Using Condiments</td>
<td>7-16</td>
</tr>
<tr>
<td>Configuring the Condiment as the Trigger</td>
<td>7-17</td>
</tr>
<tr>
<td>Configuring Parent Menu Item Class Discounts</td>
<td>7-17</td>
</tr>
<tr>
<td>Configuring the Discount for a Condiment</td>
<td>7-18</td>
</tr>
<tr>
<td>Creating the Discount Button</td>
<td>7-19</td>
</tr>
</tbody>
</table>
8  Service Charges

Configuring Service Charges 8-1

9  Setting Up Menu Items

Menu Item Programming Best Practices 9-2
Major Groups 9-3
Family Groups 9-3
Menu Item Master and Menu Item Definitions 9-3
Menu Item Classes 9-4
Menu Item Pricing 9-5
Screen Look Up (SLU) 9-6
Number Look Up (NLU) 9-6
Menu Levels 9-7
Sales Itemizers 9-9
Configuring Major Groups 9-10
Configuring Family Groups 9-10
Configuring Menu Item Classes 9-10
Configuring Menu Item Prices 9-12
Setting Main, Sub, and Custom Menu Levels 9-13
Setting the Default Main and Sub Levels for Serving Periods 9-14
Configuring Auto Menu Levels 9-14
Setting the Default Menu Levels for a Revenue Center 9-15
Configuring Active Menu Levels for Menu Item Definitions 9-15
Configuring Menu Item Functionality on the Workstation 9-16
Configuring Sales Itemizers 9-17
Configuring Master Records for Menu Items 9-17
Configuring Menu Item Definitions 9-18
Adding and Disabling Menu Items 9-19
Configuring Menu Item Availability from the EMC 9-20
Configuring Menu Item Availability for Multiple Definitions at the Workstation 9-20
Configuring a Weighed Menu Item 9-20
Understanding Tare Weight 9-21
Setting the Tare Weight for a Menu Item 9-21
Menu Item Fees 9-22
Configuring Menu Item Fees 9-22
Configuring Screen Look Ups for Menu Items 9-23
Configuring Screen Look Ups for Discounts 9-24
Configuring Screen Look Ups for Service Charges 9-24
Configuring Screen Look Ups for Tender/Media Records 9-25
Configuring Screen Look Ups for Family Groups 9-25
Configuring Screen Look Ups for Major Groups 9-26
Configuring Screen Look Ups for Custom Reports 9-26
Configuring Screen Look Ups for Open Checks 9-26
Configuring Number Look Ups for Discounts 9-27
Configuring Number Look Ups for Service Charges 9-28
Configuring Number Look Ups for Tender/Media Records 9-28
Configuring Number Look Ups for Main and Sub Levels 9-29
Menu Item Waste Checks 9-29
Allowing Employees to Begin Waste Checks and Run Waste Check Reports 9-30
Configuring Waste Reasons 9-31
Configuring Waste Receipt Headers and Trailers 9-31
Hiding Price Details on Waste Checks 9-32
Creating the Declare Waste Button 9-32
Menu Item Waste Reports 9-33

Condiments

Condiment Groups and Condiment Sets 10-2
Configuring Condiment Groups 10-2
Creating Menu Item Classes for Condiment Groups 10-3
Creating Menu Item Master Records for Condiments 10-3
Configuring Condiment Sets 10-4
Assigning Condiments to Parent Menu Item Classes 10-4
Assigning Default Condiments to Parent Menu Items 10-6
Condiment Prefixes 10-6
Creating Condiment Prefix Menu Items 10-7
Creating Menu Items Classes for Prefixes 10-7
Activating Condiment Prefixes 10-8
Deactivating Condiment Prefixes 10-8
Configuring Touchscreen Buttons for Condiment Prefixes 10-9
Setting Condiment Appearance 10-9
Understanding the Popup Condiment Orderer 10-10
Configuring a Popup Condiment Orderer Page 10-10
Configuring a Revenue Center to Use the Popup Condiment Orderer 10-11
Configuring a Menu Item Class to Use the Popup Condiment Orderer 10-12
11 Combo and Fixed Price Meals

Combo Meal Group Pricing 11-2
Placeholder Menu Items in Combo Meals 11-4
Creating Combo Meal Groups 11-5
Creating Combo Meals 11-8
Configuring Additional Combo Meal Settings 11-10
Creating Combo Meal Pages 11-11
Combo Meal Function Keys 11-12

12 Workstation Touchscreen Pages

Configuring Function Keys 12-1
Adding Menu Item Keys to the Transaction Page 12-2
Adding a Service Total Key to the Transaction Page 12-2
Adding Payment Keys to the Transaction Page 12-3
Adding Discount and Service Charge Keys to the Transaction Page 12-3
Configuring Macros 12-4

13 Guest Checks

Configuring Guest Check Numbers 13-2
Configuring Guest Check Headers and Trailers 13-2
Creating a Tender to End the Current Service Round of Checks 13-3
Understanding Fast Transactions 13-4
Configuring Fast Transactions 13-4
Understanding Full Seat Checks 13-5
Configuring the Workstation to Print Full Seat Checks 13-6
Creating a Full Seat Check Button 13-6
Splitting Off an Item 13-7
Configuring a Split Off Item Button 13-8
Conversational Ordering 13-8
Creating Menu Item Master Groups for Conversational Ordering 13-9
Configuring Menu Level Sets for Conversational Ordering 13-9
Configuring Menu Item Classes for Conversational Ordering 13-10
Configuring Menu Items for Conversational Ordering 13-11
Creating Front of House Buttons for Conversational Ordering 13-13
Configuring Employee Privileges for Automatic Check Firing 13-13
Configuring Automatic Check Firing 13-14
Understanding Suspend and Resume 13-15
Configuring Suspend and Resume 13-16
Creating a Suspend and Resume Button 13-16
Setting the Employee Auto Sign Out Period 13-16
Understanding Follow Me 13-17
Configuring Follow Me Checks 13-17
Order Handling on Open Checks 13-18
Holding and Sending Items to Order Devices 13-18
Setting the Service Total to Send Items to be Prepared While the Check Remains Open 13-19
Setting the Hold and Fire Option 13-19
Setting the Hold and Fire Tender Notification 13-20
Setting a Reminder for Items on Hold 13-20
Setting Checks with Items on Hold to End Current Service Round 13-20
Setting Check Handling with Held Items When Closing Checks 13-21
Printing Multiple Languages on Guest Checks and Customer Receipts 13-21
Configuring Right to Left Reading Languages 13-22
Creating a Print Language List Button 13-23
Creating Print Language Buttons 13-23

14  Reseting Daily Totals
14-1  Start of Day
14-2  Start of Day Business Rules
14-2  Start of Day with Offline Workstations or Server
14-3  Configuring Start of Day

15  Maintaining the Database
15-1  Understanding the Database Update Frequency
15-2  Setting the Database Update Frequency
15-2  Understanding the Clear Totals Operation
15-3  Running the Clear Totals Operation

16  Printers and Order Devices
16-2  Understanding Print Controller
16-2  Roll Printer
16-3  Slip Printer
16-3  Internet Protocol (IP) Printer
16-3  Bluetooth Printer
16-4  Oracle MICROS Mini Printer
16-4  Configuring a Printer
16-6  Logo Printing
16-7  Uploading a Logo to Simphony
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning a Logo to Guest Checks and Customer Receipts</td>
<td>16-7</td>
</tr>
<tr>
<td>Order Receipt Layouts</td>
<td>16-8</td>
</tr>
<tr>
<td>Configuring an Order Receipt Layout</td>
<td>16-8</td>
</tr>
<tr>
<td>KDS Controller</td>
<td>16-9</td>
</tr>
<tr>
<td>Configuring a KDS Controller</td>
<td>16-9</td>
</tr>
<tr>
<td>Configuring a KDS Display</td>
<td>16-13</td>
</tr>
<tr>
<td>Configuring the KDS Bump Bar</td>
<td>16-16</td>
</tr>
<tr>
<td>KDS Bump Bar Functions</td>
<td>16-17</td>
</tr>
<tr>
<td>Configuring KDS Course Overrides</td>
<td>16-18</td>
</tr>
<tr>
<td>Configuring a Backup KDS Controller</td>
<td>16-19</td>
</tr>
<tr>
<td>Upgrading an Order Device</td>
<td>16-20</td>
</tr>
<tr>
<td>Upgrading the RDC Operating System</td>
<td>16-21</td>
</tr>
<tr>
<td>Resetting the RDC Factory Settings</td>
<td>16-21</td>
</tr>
<tr>
<td>Installing the KDS Client</td>
<td>16-22</td>
</tr>
<tr>
<td>Configuring the Deployment Schedule to Install CAL on KDS</td>
<td>16-22</td>
</tr>
<tr>
<td><strong>Peripheral Devices</strong></td>
<td></td>
</tr>
<tr>
<td>Assigning and Unassigning a Cash Drawer</td>
<td>17-1</td>
</tr>
<tr>
<td>Configuring a Cash Drawer</td>
<td>17-2</td>
</tr>
<tr>
<td>Coin Dispenser</td>
<td>17-5</td>
</tr>
<tr>
<td>Configuring a Coin Dispenser</td>
<td>17-6</td>
</tr>
<tr>
<td>Magnetic Stripe Reader</td>
<td>17-6</td>
</tr>
<tr>
<td>Installing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices</td>
<td>17-7</td>
</tr>
<tr>
<td>Configuring a Magnetic Stripe Reader</td>
<td>17-7</td>
</tr>
<tr>
<td>Testing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices</td>
<td>17-8</td>
</tr>
<tr>
<td>Barcode Reader Setup Methods</td>
<td>17-9</td>
</tr>
<tr>
<td>Configuring a Barcode Reader Using the Barcodes Module Method</td>
<td>17-10</td>
</tr>
<tr>
<td>Configuring a Barcode Reader Using the Number Lookup (NLU) Method</td>
<td>17-11</td>
</tr>
<tr>
<td>Fingerprint Scanning</td>
<td>17-12</td>
</tr>
<tr>
<td>Configuring the Biometrics CAL Package Deployment</td>
<td>17-13</td>
</tr>
<tr>
<td>Configuring Employee Privileges for the Fingerprint Reader</td>
<td>17-13</td>
</tr>
<tr>
<td>Setting the Front of House to Assign Employee Personal Identification Number (PIN)</td>
<td>17-13</td>
</tr>
<tr>
<td>Configuring the Workstation Employee Fingerprint Sign In Options</td>
<td>17-14</td>
</tr>
<tr>
<td>Scanning a Fingerprint</td>
<td>17-14</td>
</tr>
<tr>
<td>Configuring a Scale</td>
<td>17-15</td>
</tr>
</tbody>
</table>
# Reporting

- Allowing Employees to Run Reports 18-1
- List of PMC Reports 18-1
- Configuring Employee Privileges for Oracle Hospitality Reporting and Analytics 18-3
- Configuring the Log Files for Oracle Hospitality Reporting and Analytics 18-4

# Auditing

- Understanding the Audit Trail 19-1
- Using the Audit Trail 19-1
- Understanding Audit This Record 19-3
- Using Audit This Record 19-4

# Dining Room Tables and Seating

- Standard and Enhanced Table Management 20-2
- Configuring the Standard Table Management Interface 20-3
- Creating Standard Dining Tables 20-4
- Table Management 20-5
- Reservation List 20-5
- Wait List 20-6
- Table Management, Reservation, and Wait List Configuration Prerequisites 20-6
- Configuring Table Management Privileges 20-7
- Configuring Reservation Privileges 20-9
- Configuring Wait List Privileges 20-9
- Configuring Servers for Table Management 20-10
- Configuring Properties for Table Management 20-11
- Configuring Custom Images for Table Management 20-11
- Configuring KDS or Dining Course Colors and Images for Table Management 20-11
- Configuring the Service Total Tender for Table Management 20-12
- Enhanced Dining Tables 20-12
- Setting Dining Table Classes 20-12
- Setting Enhanced Dining Table Attributes 20-13
- Configuring Enhanced Dining Tables 20-14
- Setting Table Decorator Images 20-15
- Configuring Server and Table Availability 20-17
- Setting Table Management Options 20-17
- Configuring Table Suggestion Factors 20-20
- Table Management Alerts 20-21
- Configuring Alerts 20-22
- Table Management Sections 20-22
Configuring Sections 20-22
Creating the Front of House Reservation List 20-23
Creating the Front of House Wait List 20-25
Front of House Table Management Tasks 20-28
Host Command Area 20-28
Configuring the Host Command Area 20-29
Dining Table Status 20-29
Configuring the Dining Table Status 20-30
Employee Lines 20-31
Configuring Employee Lines 20-31
Section Layout 20-32
Creating a Section Layout 20-33
Creating Enhanced Dining Tables 20-33
Setting Table Management Functions in Check Detail 20-34
Creating the Employee Section Assignment Report Button 20-34
Configuring Table Cancellation Reasons 20-35
Setting Reservation Timing Parameters 20-35
Setting Wait List Timing Parameters 20-36
Reservation Periods 20-37
Configuring Effectivity 20-38
Configuring Acceptance Limits 20-38
Configuring Occupancy Limits 20-39
Configuring Seating Limits 20-40
Configuring Target Turn Times 20-41
Table Management Configuration Levels 20-42
Reservation Configuration Levels 20-43
Wait List Configuration Levels 20-43

21 Enterprise Cash Management

Configuring Data Retention Limits 21-2
Specifying Ad Hoc Reports 21-3
Configuring ECM Privileges 21-3
Allowing Users to View Blind Totals 21-9
Allowing Assigned Receptacle Access 21-9
Configuring Accounting Methods for Users 21-9
Allowing Users to Override Employee Class Options 21-10
Tracking Tender Transaction Items 21-11
Tracking Service Charge Transactions 21-11
Tracking Discount Transactions 21-11
Creating, Editing, and Deleting Cash Management Reasons 21-12
| Cash Management Classes                      | 21-12 |
| Adding Transaction Items                     | 21-13 |
| Adding Counting Units                        | 21-13 |
| Cash Pull Threshold Set                      | 21-14 |
| Creating, Editing, and Deleting a Cash Pull Threshold Set | 21-15 |
| Cash Count Threshold Set                     | 21-15 |
| Creating, Editing, and Deleting a Cash Count Threshold Set | 21-16 |
| PAR Level Set                                | 21-16 |
| Creating, Editing, and Deleting a PAR Level Set | 21-16 |
| Count Sheet                                  | 21-17 |
| Creating, Editing, and Deleting a Count Sheet | 21-17 |
| Adding and Deleting a Page                   | 21-18 |
| Adding and Deleting a Group                  | 21-18 |
| Adding and Deleting a Unit                   | 21-19 |
| Sorting and Modifying the Order of Pages, Groups, and Units | 21-20 |
| Viewing the Totals Page                      | 21-20 |
| Creating, Editing, and Deleting an Account   | 21-20 |
| Creating, Editing, and Deleting a Vendor     | 21-20 |
| Creating and Editing a Template              | 21-21 |
| Creating, Editing, and Deactivating Receptacles | 21-23 |
| Setting Cash Management Parameters           | 21-24 |
| Creating Front of House Screens              | 21-27 |
| Configuring a Smart Key on a Workstation     | 21-30 |
| Configuring a Till Through Extensibility     | 21-32 |
| ECM Reporting                                | 21-32 |
| ECM Enterprise Reports                       | 21-32 |
| Assigning Enterprise Reports                 | 21-33 |
| Creating ECM Property Reports                | 21-33 |
| ECM Workstation Hardware                    | 21-34 |
| Enterprise Cash Management Configuration Levels | 21-35 |

22 Loyalty and Gift Card Interfaces and Drivers

| Loyalty and Stored Value Configuration Prerequisites | 22-2 |
| Loyalty Configuration Tasks                        | 22-2 |
| Configuring Loyalty and Stored Value Privileges     | 22-3 |
| Setting Loyalty Options                            | 22-7 |
| Configuring the Loyalty Driver                     | 22-7 |
| Configuring the Loyalty Module                     | 22-9 |
| Stored Value Configuration Tasks                   | 22-10 |
| Setting Stored Value Options                       | 22-10 |
Introduction to Simphony

Oracle Hospitality Simphony is an Enterprise-class point of sale (POS) software product. Simphony can be centrally hosted at Oracle’s datacenters, or customers can self-host Simphony at a single property. Simphony can handle a multi-property POS configuration consisting of thousands of workstations generating terabytes of sales data, as well as scale down to smaller single-property configurations.

Administrators can configure Simphony using the Back of House (BOH) Enterprise Management Console (EMC) application. This application allows you to set up the Enterprise, properties, revenue centers, and zones from a PC that has access to the central server.

Simphony interfaces with the following devices and solutions:

- Peripheral Devices
- Printers and Order Devices, such as a Kitchen Display System (KDS)
- Credit Card Drivers
- Loyalty and Gift Card Interfaces and Drivers
- Enterprise Cash Management (ECM)
- Table Management System (TMS)
- Oracle Hospitality Reporting and Analytics
- Oracle Hospitality OPERA 5 Hotel Property Systems
2

Enterprise

The term Enterprise refers to the entirety of a Simphony application. Simphony supports multiple properties, and administrators can configure each property somewhat independently. Each property can also coexist with other properties. The Simphony Enterprise offers a single application for configuration of multiple stores, and allows these stores to report centrally to a single Enterprise database.

A true Enterprise Simphony configuration includes more than one property, such as a franchise environment. In addition, its flexibility is ideal for multiple-property environments even if operations differ from one property to the next. In a true Enterprise, the importance of the Enterprise Management Console (EMC) programming hierarchy is apparent to the administrator. Some module components are programmed at the Enterprise and then used in various properties and revenue centers.

Although Simphony can be installed for large multi-property environments, it can also be installed at a single property. This type of installation, sometimes called a single-property Enterprise, is functionally the same as a true Enterprise. However, modules that are programmed on the Enterprise could technically be considered property level modules in this environment because the Enterprise consists of one property.

- Enterprise Organization
- Inheritance and Overrides
- Configuring Permissions for the Enterprise
- Understanding CAL Packages
- Overview of CAL Package Deployment
- Configuring CAL Package Permissions
- Configuring CAL Packages
- Resizing the Initial Workstation Database
- Changing a Custom CAL Package
- CAL Deployment Order
- Adding a Deployment Schedule for the Current CAL Package
- Adding a Deployment Schedule for a Group of CAL Packages
- Viewing CAL Package Deployment Schedules
- Changing a CAL Package Version
- Viewing, Reloading, and Saving CAL Package Contents
- Manually Deploying CAL Packages
- Updating CAL Client Workstations
- Distributing CAL from a Property Application Server
- Configuring the Distributed CAL (DCAL) Server
Enterprise Organization

The Enterprise Management Console (EMC) level refers to the location where an EMC module is programmed. In the EMC, you can program modules for the Enterprise, property, revenue center, and zone based on the information you are configuring. For example, employee roles are set at the Enterprise level, because typically a company keeps privileges the same throughout the Enterprise (for example, all bartenders have the same privileges). Tax rates are set at the property level because a property in Chicago uses different tax rates than a property in Dallas. Order devices are set at the revenue center level for a particular restaurant.

In the figure shown below, the Enterprise has two properties. One property has two revenue centers (they might be a restaurant and bar), while the other property has one revenue center.

Figure 2-1   Enterprise Hierarchy Organization Levels

Inheritance and Overrides

When you program a module in the Enterprise Management Console (EMC) at the Enterprise level, the property and revenue center levels inherit the module settings. That is, the property and revenue center have the same setting as the Enterprise level. For example, a discount set at the Enterprise level is used by all properties within the Enterprise. If you want the property or revenue center to have a different configuration than the Enterprise level, you can override the inheritance by setting the module at the property and revenue center levels. For example, you can configure menu items at the Enterprise level, and override the menu items for a property by changing the settings at the property level.
The list of records for each EMC module shows the Zone/Location and Inheritance Type columns. The Zone/Location column shows the zone or the location (Enterprise, property, or revenue center) of each record. The Inheritance Type column indicates the type of inheritance for each record:

- **Defined Here, No Override** – This status indicates the record is defined in the location of the module that is open. The record does not override another record. It is possible that another record overrides this record. (EMC is not aware of records below the current location.)
- **Inherited** – This status indicates the record is defined in another location, and it is inherited in the current module and location.
- **Defined Here, Overriding** – This status indicates the record is defined in the location of the module that is open. The record overrides another record from a higher location.

You cannot edit an inherited record from a child hierarchy. When overrides exist for a record, the lowest record location applies.

## Configuring Permissions for the Enterprise

You can set user permissions for the Enterprise Management Console (EMC) modules. The privilege options define the actions the user can perform at the Enterprise level.

1. In the EMC, select the Enterprise level, click **Configuration** and **Roles**.
2. Double-click the role type record (for example, administrator, manager or server).
3. Click the EMC Modules tab.
4. Select the appropriate module permission options for the user role. You can grant user permissions for the following module actions:
   - **View** – Open and view a module. If you allow a user to Edit, Add, or Delete, you must also grant View access (otherwise the user cannot open the module).
   - **Edit** – Update fields or records within a module.
   - **Add** – Add records to a module.
   - **Delete** – Delete records from a module.

   If you want to grant access for all module actions, select **All Modules** in the Global Access section for each action. The **All Modules** option allows you to easily configure the user to View, Edit, Add, or Delete every module without individually selecting each option. Selecting **All Modules** also allows the user to access new modules that become available in future Simphony versions. Oracle Hospitality recommends granting **All Modules** permission for an administrator type of role.

5. Click the Actions tab.
6. Select the appropriate action permissions for the role.

   If you want to grant access to perform all actions, select **All Actions** in the Global Access section. Selecting **All Actions** also allows the user to perform new actions that become available in future Simphony versions. Oracle Hospitality recommends granting **All Actions** permission for an administrator type of role.

7. Click **Save**.
Understanding CAL Packages

The Client Application Loader (CAL) is a process that allows seamless distribution, installation, and maintenance of Simphony software from a CAL server to all Simphony client workstations and service hosts. CAL is the only method for installing Simphony workstation software and service software (such as Kitchen Display System (KDS) Controller software and System Interface Module (SIM) file access software). The CAL stores software packages in the transaction database, providing a central storage location. The CAL allows the clients to:

- Automatically discover the Simphony CAL servers
- Obtain a list of configured workstations from the CAL servers
- Establish unique workstation IDs and network configuration (either Dynamic Host Configuration Protocol (DHCP) or static Internet Protocol (IP)) based on the information received from the CAL server

Packages

Packages are a sophisticated method of distributing software to the clients. Files that need to be copied or run on the client are bundled together, given a name, and placed in a separate directory on the server. A CAL Package is a group of files and folders that are copied to workstations and other CAL-enabled devices. You can configure the packages to be distributed to:

- All devices in the Enterprise
- Devices in selected properties
- Specific devices

CAL Directory and Package Contents

The CAL Package files and folders are located on the Simphony application server in the EGatewayService directory. This is the most important directory. Handlers in this directory process messages that are sent to the Simphony application server. The EGatewayService directory includes the encrypted database information, as well as the web.config file that includes important Simphony settings. The following table lists the sub-directories that reside in the EGatewayService\CAL folder and the CAL package contents for various types of client devices.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Type of Device</th>
<th>CAL Packages</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANDROID</td>
<td>Devices Running the Android Mobile Operating System</td>
<td>ServiceHost2.0</td>
</tr>
<tr>
<td>DC</td>
<td>Kitchen Display System (KDS) Controllers</td>
<td>DCKDS, DCKDS2.0, DCKDSPrintServer2.0, McrsCAL, McrsCAL2.0</td>
</tr>
<tr>
<td>Directory</td>
<td>Type of Device</td>
<td>CAL Packages</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
</tbody>
</table>
| MC40      | Motorola MC40  | - FuseboxSTunnel2.0  
|           |                | - McrsCAL  
|           |                | - McrsCAL2.0  
|           |                | - ServiceHost2.0  
| MTABLET   | Oracle MICROS Tablet E-Series | - McrsCAL  
|           |                | - McrsCAL2.0  
|           |                | - ServiceHost2.0  
|           |                | - WSKDS2.0  
| PPC       | Mobile MICROS Devices | - McrsCAL  
|           |                | - SimphonyClient  
| PPC70     | Mobile MICROS MC70 | - McrsCAL  
|           |                | - SimphonyClient  
| ServiceHosts | Not Applicable | Sub-directory named for the Service Host ID that contains automatically generated setup information for each Service Host  
| Win32     | Any 32-bit Windows machine, such as the Oracle MICROS PC Workstation 2015 or Oracle MICROS Workstation 6 | - CALVersionFixer2.0  
|           |                | - CashManagement2.0  
|           |                | - CMLite2.0  
|           |                | - DigitalPersona2.0  
|           |                | - EGateway  
|           |                | - EGatewayPrereqs  
|           |                | - FuseboxSTunnel2.0  
|           |                | - McrsCAL  
|           |                | - McrsCAL2.0  
|           |                | - MediaViewer2.0  
|           |                | - PosToKdsHandler  
|           |                | - PosToKdsHandler2.0  
|           |                | - ServiceHost2.0  
|           |                | - ServiceHostPrereq2.0  
|           |                | - ServiceHostPrereq2015SQL 2.0  
|           |                | - SimphonyClient  
|           |                | - WSKDS2.0  
| WS5       | Oracle MICROS Workstation 5 | - FuseboxSTunnel2.0  
|           |                | - McrsCAL  
|           |                | - McrsCAL2.0  
|           |                | - PosToKdsHandler2.0  
|           |                | - ServiceHost2.0  
|           |                | - ServiceHostPrereq2.0  
|           |                | - SimphonyClient  
|           |                | - WebServer  
|           |                | - WSKDS  
|           |                | - WSKDS2.0  

Chapter 2
Understanding CAL Packages

2-5
### Table 2-1 (Cont.) CAL Package Contents

<table>
<thead>
<tr>
<th>Directory</th>
<th>Type of Device</th>
<th>CAL Packages</th>
</tr>
</thead>
<tbody>
<tr>
<td>WS5A</td>
<td>Oracle MICROS Workstation 5a</td>
<td>• FuseboxSTunnel2.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• McrsCAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• McrsCAL2.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PosToKdsHandler2.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ServiceHost2.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ServiceHostPrereq2.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SimphonyClient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• WebServer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• WSKDS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• WSKDS2.0</td>
</tr>
</tbody>
</table>

### Installation and Upgrade

The configuration in the CAL Packages module of the Enterprise Management Console (EMC) determines when a client receives a new CAL package. The Setup.dat file is a text file that contains installation instructions. New packages include the following information in the Setup.dat file:

- **Name** – Identifies the CAL Package
- **Version** – Identifies the release version number using a four-number dotted notation format (for example, 2.800.4.25)
- **Commands** – Indicates what, how, and where files are placed

The Simphony installer derives an internal name and version for Simphony packages from the Setup.dat file. The internal name and version typically differs from the package name and version. For example, ServiceHost 2.7 and ServiceHost 2.8 are two separate packages, but they share the same internal name, ServiceHost. The installer identifies the matching internal names and prevents installing and running two versions of ServiceHost.exe on the same client.

The CAL client uses the internal name and version from the Setup.dat file to determine whether to download the CAL package. EMC does not allow you to configure duplicate schedules for packages with the same internal name. For example, if you have a deployment schedule for ServiceHost.2.8 to deploy to the Enterprise, adding an Enterprise deployment for ServiceHost.2.8 and ServiceHost.2.7 results in the following error message: Cannot save duplicate deployments.

When you upgrade Simphony to a new version, the installer does not add new deployments (with one exception) and does not change existing packages or schedules. As a result, you do not need to change deployment schedules from Install to Skip. The installer preserves CAL packages and adds new versions.

### Related Topics

- Configuring CAL Package Permissions
- Configuring CAL Packages
- Resizing the Initial Workstation Database
- Changing a Custom CAL Package
- Adding a Deployment Schedule for the Current CAL Package

---

Chapter 2
Understanding CAL Packages

2-6
Overview of CAL Package Deployment

Deploying a Client Application Loader (CAL) package consists of completing the following tasks:

- Setting CAL Package Permissions
- Configuring CAL Packages
- Changing a Custom Package
- Understanding the Deployment Order of CAL Packages
- Adding a Deployment Schedule for the Current CAL Package
- Adding a Deployment Schedule for a Group of CAL Packages
- Viewing CAL Package Deployments
- Switching a CAL Package Version
- Viewing CAL Package Contents
- Deploying CAL Packages
- Updating CAL Clients

Related Topics

- Configuring CAL Package Permissions
- Configuring CAL Packages
- Resizing the Initial Workstation Database
- Changing a Custom CAL Package
- Adding a Deployment Schedule for the Current CAL Package
- Adding a Deployment Schedule for a Group of CAL Packages
- Viewing CAL Package Deployment Schedules
- Changing a CAL Package Version
- Viewing, Reloading, and Saving CAL Package Contents
- Manually Deploying CAL Packages
- Updating CAL Client Workstations
- CAL Deployment Order
Configuring CAL Package Permissions

1. In the EMC, select the Enterprise level, click **Configuration** and **Roles**.
2. Double-click the role type record (for example, administrator, manager or server).
3. Click the EMC Modules tab.
4. Scroll to the CAL Packages file and select the **View**, **Edit**, **Add**, and **Delete** permissions for the employee role.
5. Click **Save**.

**Related Topics**
- Understanding CAL Packages
- Overview of CAL Package Deployment
- CAL Deployment Order

Configuring CAL Packages

Client Application Loader (CAL) packages belong to the following two subgroups:
- The Simphony subgroup contains the standard packages installed by Simphony.
- The Custom subgroup contains the packages added by an administrator.

1. In the EMC, select the Enterprise level, click **Setup** and **CAL Packages**.
2. Highlight a CAL package.
3. You can click the following commands in the CAL packages tree:

<table>
<thead>
<tr>
<th>Table 2-2</th>
<th>CAL Packages Tree Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Switch View</strong></td>
<td>Change the grouping of CAL packages from name to version and vice versa. For example, you can view packages belonging only to Simphony version 2.8.</td>
</tr>
<tr>
<td><strong>Add Custom CAL Package</strong></td>
<td>Upload a CAL package from a local file system to the Enterprise Management Console (EMC) and database. Uploaded packages appear in the Custom subgroup.</td>
</tr>
<tr>
<td><strong>Refresh</strong></td>
<td>Refresh the entire page.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Delete the highlighted CAL package.</td>
</tr>
</tbody>
</table>

**Related Topics**
- Understanding CAL Packages
- Overview of CAL Package Deployment
- CAL Deployment Order
Resizing the Initial Workstation Database

You can change the initial database size of a workstation using a CAL package Generate XML tool from the EMC. You configure the starting database size and growth pattern (Pre-sized or AutoGrow) for the Simphony client databases and the tool creates the CAL package to be added to the application. The tool only sets the initial size of the database. You cannot use it to shrink a database that has already grown too large.

1. Select the Enterprise level, click Setup, and then click CAL Packages.
2. Click the Generate XML tab.
3. From the Sizing Mode drop-down list, select the method for sizing the database:
   • Select AutoGrow for high volume locations where the size of the database on disc grows through a nightly job. AutoGrow mode allows the application to size the database during a nightly job at a specified time. This avoids the lengthy delays of sizing until the application is not in use. Do not select this option for workstations equipped with the 8GB Universal Disk On Chip (UDOC).
   • Select PreSized for workstations with limited disc space where the Simphony default database sizes are not proportionate to the available space. You can set a maximum size for each database and log file, and reserve a percentage of the available disc space for non-database files. In Pre-sized mode, the database is potentially sized every time the workstation Service Host starts, and the database does not grow.
4. In the Non DB Percentage field, enter a percentage (between 0 and 100) of the free space of the disc to reserve for non-database content.
5. In the Resize Time field, enter the amount of time in hours and minutes for the nightly resize job.

The value in this field determines the time on a 24-hour clock to run the database resize job, which attempts to resize the database outside of business hours. Although this field is required, PreSized mode ignores the value entered as there is no nightly resize job.
6. Select the database to configure from the Alias drop-down list. You can resize the following database configurations:
   • LocalDB (local datastore database)
   • CPSERVICE DB (CAPS database)
   • KDSSERVICE DB (KDS database)
   • CMLocal (cash management database)
7. In the Data File and the Log File sections, enter the appropriate values as described in the following table. To set the default database configuration, select Use Default Values.
### Table 2-3  Data File and Log File Database Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Size</td>
<td>Enter the initial size of the database file. Define the size with a number followed by M, G, or T suffixes to indicate megabytes, gigabytes, or terabytes.</td>
</tr>
<tr>
<td>Maximum Size (AutoGrow mode only)</td>
<td>Enter the maximum size to which the database can grow. If there is not enough unreserved space to fit the maximum size, the configuration does not validate. The NonDB Percentage value you entered determines how much of the free space is not available for the databases.</td>
</tr>
<tr>
<td>Auto Grow Floor (AutoGrow mode only)</td>
<td>Enter the size of the free space within the database that triggers a nightly grow event. If you set this value to 10M and the free space inside the data file goes below 10M, the nightly resize job attempts to resize the database.</td>
</tr>
<tr>
<td>Auto Grow Increment (AutoGrow mode only)</td>
<td>Enter the auto growth increment for the database. This value is used by the nightly resize job when the database must grow.</td>
</tr>
</tbody>
</table>

8. Click the **Add** button.

9. Click the ellipsis point (...) button, select the destination folder, and then click **OK**.

10. Click the **Generate** button.

### Related Topics
- Understanding CAL Packages
- Overview of CAL Package Deployment
- CAL Deployment Order

### Changing a Custom CAL Package

You can change the name of a custom package, its deployment order, and its platform type.

1. In the EMC, select the Enterprise level, click **Setup** and **CAL Packages**.
2. Expand the Custom subgroup and highlight the appropriate custom CAL package.
3. Change the following information:
   - **Name**
   - **Deployment Order** – Enter the order in which to deploy the CAL package. CAL packages with a value of 0 (zero) are loaded before packages with a value of 1. See **CAL Deployment Order** for more information.
   - **Platform Type** – Select the type of platform to receive the CAL Package.
4. In the Limit To Services section, select specific Service Host types to deploy to workstations.
• If you do not select a service, the package deploys to every Service Host based on the deployment schedule.

• If you select one or more services, the package deploys only to Service Hosts that run selected services. That is, when you configure a new service for the existing Service Host, there is no additional deployment for the Service Host. If a CAL package exists that is specific to the service, the Service Host downloads it immediately.

For example, if you select Cash Management, you must also select the Check And Posting service (CAPS) because the Enterprise Cash Management module only runs on CAPS Service Hosts. This causes all Service Hosts that run CAPS to automatically download the Cash Management CAL package if a deployment schedule exists for the Enterprise or property.

Related Topics
• Understanding CAL Packages
• Overview of CAL Package Deployment
• CAL Deployment Order

CAL Deployment Order

By default, all Client Application Loader (CAL) packages have a deployment order of 0 (zero). This can result in packages going to workstation clients in an undesirable order. Assigning an order allows Simphony to create and place certain files or folders for one package, which are used later by another package in order to succeed.

Oracle Hospitality recommends deploying CAL packages in the order listed in the following table:

<table>
<thead>
<tr>
<th>Deployment Order</th>
<th>CAL Package Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>CAL Client</td>
</tr>
<tr>
<td>1</td>
<td>Platform Updates</td>
</tr>
<tr>
<td>2</td>
<td>SimphonyClient</td>
</tr>
<tr>
<td>3</td>
<td>EGatewayPrereqs and WebServer</td>
</tr>
<tr>
<td>4</td>
<td>EGateway</td>
</tr>
<tr>
<td>5</td>
<td>PosToKdsHandler</td>
</tr>
<tr>
<td>6</td>
<td>Interface files (for example, OPERA)</td>
</tr>
<tr>
<td>7+</td>
<td>Custom files (for example, WSKDS and SIM scripts)</td>
</tr>
</tbody>
</table>

Related Topics
• Understanding CAL Packages
• Overview of CAL Package Deployment
• Configuring CAL Package Permissions
• Configuring CAL Packages
• Resizing the Initial Workstation Database
Adding a Deployment Schedule for the Current CAL Package

You can schedule Client Application Loader (CAL) packages to automatically deploy at preset times.

1. In the CAL Packages module, expand the **Simphony** or **Custom** subgroups, and highlight the CAL package you want to deploy.
2. Click the Deployment Schedules tab.
3. Click **Add Deployment** to create a new row in the deployments grid.
4. In the **CAL Package** field, select the version number.
5. In the **Deployment Type** drop-down list, select the type of deployment:
   - **1 - Property/Enterprise** – Click the ellipsis button and select one or more properties where the package will download.
   - **2 - Specific Service Host** – Click the ellipsis button and select one or more service hosts or workstations where the package will download.
6. In the **Action To Take** field, select one of the following options:
   - If you want the deployment to proceed, select **Install**.
   - If you want to prevent a package from being downloaded select **Skip**.

You can configure multiple deployment schedules for the same CAL package. Symphony uses the most granular deployment when given multiple deployment schedules. For example, if you configure a deployment schedule for a workstation and for the property, Symphony uses the workstation deployment. If you configure a CAL package deployment for a property with **Install** and a deployment for a workstation with **Skip**, the CAL package is not installed on the workstation.

7. (Optional) In the **Effective From** field, select the start date when the package becomes active. You can use this field to schedule Symphony upgrades.
8. (Optional) In the **Effective To** field, select the end date when the package becomes inactive.

**Related Topics**

- Understanding CAL Packages
- Overview of CAL Package Deployment
- CAL Deployment Order
Adding a Deployment Schedule for a Group of CAL Packages

Certain nodes in the tree do not have corresponding CAL packages. You can use these nodes to group CAL packages. For example, you can configure packages that affect All Simphony or the Service Host.

1. In the CAL Packages module, expand the Symphony or Custom subgroups, and highlight a node without a corresponding CAL package.

2. Click the Deployment Schedules tab.

3. Click Add Deployment.

4. From the Choose CAL Package For Deployment drop-down list, select the package you want to deploy.

   The list of available CAL packages in the dialog changes depending on the node highlighted in the tree. For example, if you highlight the Simphony node, the list of packages contains all Simphony CAL packages. If you select the Service Host node, the list contains only the Service Host packages.

5. From the Deployment Type drop-down list, select the type of deployment:
   - 1 - Property/Enterprise
   - 2 - Specific Service Host

6. Click the ellipsis button.

7. In the Select Properties or Select Service Host dialog (depending on your selection in Step 5), select one or more properties or Service Hosts where the package will download, and click OK.
   - Filter lengthy lists by property number or name, or by workstation number or name.
   - Select the Show already configured properties option to prevent yourself from configuring duplicate deployment schedule records.
   - Press and hold the Ctrl key while performing a left mouse click to select multiple properties. You can click the Select All or Clear All links to affect all properties in the list.
   - You can select multiple service hosts or specific workstations.

8. In the Action To Take field, select one of the following options:
   - If you want the deployment to proceed, select Install.
   - If you want to prevent a package from being downloaded select Skip.

   You can configure multiple deployment schedules for the same CAL package. Simphony uses the most granular deployment when given multiple deployment schedules. For example, if you configure a deployment schedule for a workstation and for the property, Simphony uses the workstation deployment. If you configure a CAL package deployment for a property with Install and a deployment for a workstation with Skip, the CAL package is not installed on the workstation.

9. (Optional) In the Effective From field, select the start date when the package becomes active. You can use this field to schedule Simphony upgrades.
10. (Optional) In the Effective To field, select the end date when the package becomes inactive.

Related Topics
- Understanding CAL Packages
- Overview of CAL Package Deployment
- CAL Deployment Order

Viewing CAL Package Deployment Schedules

A deployment schedule indicates the time at which a specific client or clients will download a Client Application Loader (CAL) package for deployment. You must configure deployment schedules in order to deploy CAL packages.

1. In the EMC, select the Enterprise level, click Setup and CAL Packages.
2. Expand the Symphony or Custom subgroups, and highlight the appropriate CAL package.
   If you want to view all deployment schedules for all CAL packages, highlight the All node.
3. Click the Deployment Schedules tab. Previously scheduled CAL packages appear in the list.

Related Topics
- Understanding CAL Packages
- Overview of CAL Package Deployment
- CAL Deployment Order

Changing a CAL Package Version

You can switch a Client Application Loader (CAL) package that has one version or multiple versions.

1. To change a CAL package with one version:
   a. In the CAL Packages module, delete the existing deployment.
   b. Add a new deployment for the new version.
2. To change a CAL package with multiple versions:
   a. In the CAL Packages module, highlight the package deployment.
   b. Click Change Package Version.
   c. In the Choose CAL Package For Deployment drop-down list, select the appropriate package version for deployment, and click OK.

Related Topics
- Understanding CAL Packages
- Overview of CAL Package Deployment
- CAL Deployment Order
Viewing, Reloading, and Saving CAL Package Contents

1. In the EMC, select the Enterprise level, click Setup and CAL Packages.
2. Highlight the Client Application Loader (CAL) package and click the Package Contents tab. The Platforms section lists all available platform types, the Setup.dat version, and CAL package name.
3. From the Files list, select a platform to see all files included in the package.
   - If you want to open the file in Notepad, click View Selected File.
   - If you want to reload the entire CAL package for all platforms and files from the specified file location, click Reload Package From Disk. You must be logged in with the same hierarchy level as the CAL package to see this command.
     After you modify an existing default or custom package, reload the package.
     Ensure that the Setup.dat version matches the file before it loads to avoid reloading the package on all clients.
     After installation, replace the local machine with the load balanced address in SimphonyInstall.xml, and then reload the entire package.
   - If you want to save the entire CAL package for all platforms and files to the specified file location, click Save Package To Disk, select an empty output folder, and click OK.

Related Topics
- Understanding CAL Packages
- Overview of CAL Package Deployment
- CAL Deployment Order

Manually Deploying CAL Packages

You can manually deploy Client Application Loader (CAL) packages immediately if you do not want to schedule the deployment to run automatically.

1. In the EMC, select the Enterprise level, click Setup and CAL Packages.
2. Click the Deployment Schedules tab.
3. Click Add Deployment, select the following values, and click OK:
   - CAL Package For Deployment
   - Deployment Type
4. Select the Property or Service Host (depending on the Deployment Type)
5. In the Action to Take field, select 0 - Install.
6. (Optional) In the Effective From and Effective To fields, select the dates when the package becomes active and inactive.
7. Click Save. The CAL package downloads to the appropriate client workstations within a few minutes.

Related Topics
- Understanding CAL Packages
• Overview of CAL Package Deployment
• CAL Deployment Order

### Updating CAL Client Workstations

1. Power on the workstation. The workstation connects to the Enterprise server and checks for application updates.

2. The Client Application Loader (CAL) installs the packages according to the deployment order specified in the Enterprise Management Console (EMC). The workstation might restart several times.

### Related Topics
• Understanding CAL Packages
• Overview of CAL Package Deployment
• CAL Deployment Order

### Distributing CAL from a Property Application Server

When new client applications or support files are available, the CAL sends the new set of files from the Enterprise application server to the clients. A standard Simphony version 2.x Service Host CAL package is usually about 50 megabytes (MB) in size. Based on that, a property with 100 workstation clients needs to download 5000 MB of data through the Wide Area Network (WAN). When the network bandwidth of a property cannot support simultaneous requests made by numerous clients, properties might experience bandwidth bottlenecks.

To alleviate bandwidth problems, the Distributed CAL (DCAL) feature lets you configure one or more Service Hosts above or within a property as a DCAL server. To distribute CAL packages, the DCAL server uses the Local Area Network (LAN), which has a higher bandwidth and a higher data transfer rate than a WAN. Updated files and new packages are downloaded to the DCAL server, and then workstations retrieve the updated files from the DCAL server over the LAN.

You can also use DCAL to distribute packages to workstations when a property loses connectivity to the Enterprise application server. After deploying CAL packages to the DCAL server, clients can use the DCAL server to get the new CAL packages without relying on connectivity to the Enterprise application server.

---

**Figure 2-2  Without DCAL**
Configuring the Distributed CAL (DCAL) Server

You need to configure both the Workstations module and the DCAL Download Schedules module to set up the DCAL server.

Configuring the Workstations Module

Designate a Service Host to act as a DCAL server within or above a property, depending on the number of workstations and the geographical distribution of properties.

1. In the EMC, select the property, click **Setup** and **Property Parameters**.
2. Click the **Workstations** tab.
3. Click the ellipsis point (...) button for the Distributed CAL Service Host.
4. In the Select Service Host dialog, select the service host to act as the DCAL server and click **OK**.

Due to limited storage, when configuring on a Microsoft Windows CE device, the DCAL server only stores CAL Packages for Microsoft Windows CE clients. If a property has a combination of Microsoft Windows 32 and Microsoft Windows CE Service Hosts, you should set up a Microsoft Windows 32 Service Host as a DCAL server.

5. Click **Save**.

Related Topics

- Distributing CAL from a Property Application Server
- Changing the CAL Server Location
- Pairing a New Workstation With a DCAL Server
- Configuring a DCAL Download Schedule
Changing the CAL Server Location

After you configure a property to retrieve CAL packages from the DCAL server, workstations in the property that were pointed to the Enterprise application server automatically change the CAL URL to point to the DCAL server. You must restart the Service Host for the changes in the CAL server to take effect.

Related Topics
- Configuring the Distributed CAL (DCAL) Server
- Moving the DCAL Server to Another Service Host
- Configuring a DCAL Download Schedule
- Reviewing the DCAL File Download Status

Moving the DCAL Server to Another Service Host

If a DCAL server was moved from one Service Host to another, all Service Hosts within the property update the CAL URL to point to the newly defined DCAL server. You must restart the Service Host for the changes in the DCAL server to take effect.

You can see the changes made to the CAL server URL from the workstation.

1. Sign on to a workstation.
2. Click the PMC button, click PMC Home Page, and then click the General tab.
3. Review the CAL Url field and verify the changes.

Related Topics
- Distributing CAL from a Property Application Server
- Changing the CAL Server Location
- Pairing a New Workstation With a DCAL Server

Configuring a DCAL Download Schedule

DCAL Download Schedules prevent unexpected network utilization by controlling when the software packages are delivered to the DCAL server from the Enterprise application server.

1. In the EMC, select the Enterprise level, click Setup and CAL Packages.
2. Click the DCAL Download Schedules tab.
3. Click the Add Download link.
4. In the Add Download Schedules for Distributed CAL Services dialog, select the CAL Package from the Select CAL Package drop-down list.
5. Select the properties to receive the scheduled CAL Packages, and then click OK.
6. Click the ellipsis (...) button in the Download From field, and set a time to download the CAL Package. Leave the Download From field empty to download CAL Packages immediately.
You need to configure Deployment Schedules to deploy CAL Packages to the Service Hosts. Without Deployment Schedules, CAL Packages are stored on the DCAL server and are not deployed to the Service Hosts. Adding a Deployment Schedule for the Current CAL Package contains more information about scheduling CAL Packages to deploy at preset times.

Related Topics

- Distributing CAL from a Property Application Server
- Changing the CAL Server Location
- Pairing a New Workstation With a DCAL Server

Reviewing the DCAL File Download Status

After you configure and implement CAL Package download schedules, you can review the availability and file download status of CAL Packages for a selected workstation.

1. In the EMC, select the Enterprise level, click Setup and CAL Packages.
2. Click the ServiceHost Status/Control tab, and then click the Add Download link.
3. Click the Install Status tab, select the search variables, and then click the Search button.

Related Topics

- Distributing CAL from a Property Application Server
- Changing the CAL Server Location
- Pairing a New Workstation With a DCAL Server

Pairing a New Workstation With a DCAL Server

When setting up new workstations, select the application server from the workstation’s CAL client list. If you configured a DCAL server, select the DCAL server from the list. Because the DCAL server is configured to serve a property, the CAL client does not provide a list of properties after you have selected the DCAL server as the CAL server.

Related Topics

- Configuring the Distributed CAL (DCAL) Server
- Moving the DCAL Server to Another Service Host
- Configuring a DCAL Download Schedule
- Reviewing the DCAL File Download Status
Properties

A property is a place of business. A property can have one or more revenue centers within a confined geographic location. For example, a hotel property can have three revenue centers (restaurant, bar, and gift shop), and a shopping mall can have several restaurant revenue centers. Both properties can belong to the same Simphony Enterprise, but each property has separate sales figures, tax information, and other configuration specific to the location.

- Adding a Property
- Adding a Revenue Center
- Overview of Adding a Workstation
- Adding a Workstation
- Configuring Workstation Transaction Settings
- Setting Offline Transaction Posting Time
- Configuring Workstation Security
- Configuring the Magnetic Stripe Reader on the Oracle MICROS Tablet 720
- Configuring the Barcode Scanner on the Oracle MICROS Tablet 720
- Integration with the Android Mobile Operating System
- Android Devices and Versions
- Android Functionality Support
- Android Network Requirements
- Android Payments
- Configuring the Android Device
- Configuring the Android Device as a Workstation
- Setting the CAL Package for the Android Device
- Installing the Client Application Loader (CAL) on the Android Device
- Installing the Simphony Service Host
- Viewing and Editing Simphony Android Files
- Setting Languages

Adding a Property

1. In the EMC, select the Enterprise level, click **Setup** and **Properties**.
2. Insert a record.
3. On the Add Property dialog, enter the **Property Number** and **Property Name**.
4. Select the **Simphony Platform** from the drop-down list.
5. Select the **Time Zone** of the property.

6. Select the reporting location from the **Report Location** drop-down list. The Oracle Hospitality Reporting and Analytics database determines the locations that appear in the list.
   
a. If you want to add a new location, click the **New** button and enter the appropriate information. An administrator must then add the information to the Oracle Hospitality Reporting and Analytics property list in order to run reports.
   
b. If you want to change an existing location, click the **Edit** button and enter the appropriate information.

7. (Optional) If you want to copy information from a property template, in the Source Property section select **Copy from source property**. The hierarchy panel and **Modules To Copy** fields become active.
   
a. In the hierarchy panel, select the property to use as the source property.
   
b. In the Modules to Copy section, select the modules you want to copy from the source property. To automatically select all modules, click the **Select All Modules** link.
   
c. (Optional) Select **Create Clone** to copy the Internet Protocol (IP) addresses of workstations and kitchen display system (KDS) displays and to distribute all revenue centers and create new revenue centers. Selecting this option essentially selects the next two options (described in Steps 7d and 7e).
   
d. (Optional) Select **Create RVCs** to create new revenue centers for the property based on the existing revenue centers in the template property.
   
e. (Optional) Select **Copy IP Addresses** to copy the IP addresses of workstations and KDS displays from the source property to the destination property. (You should use this option when properties are segmented on their own networks and IP address conflicts do not occur.)
   
f. (Optional) Select **Distribute inherited records** to distribute all records (defined and inherited) from the source property to the destination property. Deselect this option to distribute only records defined at the source property to the destination property.
   
g. (Optional) Select **If destination record is inherited, create override** to create an override record in the destination property when an inherited definition exists.
   
h. (Optional) Select **Distribute Data Extensions if they exist** to distribute data extension values if they exist.

8. Click **OK** to copy the records from the source template property to the new property.

---

### Adding a Revenue Center

1. In the EMC, select the property, click **Setup** and **RVC Configuration**.

2. Insert a record.

3. On the Add Revenue Center dialog, enter the **RVC Number** and **RVC Name**.

4. (Optional) If you want to copy information from a revenue center template, in the Source Revenue Center section select **Copy from source Revenue Center**. The hierarchy panel and **Modules To Copy** fields become active.
a. In the hierarchy panel, select the revenue center to use as the source revenue center.

b. In the Modules to Copy section, select the modules you want to copy from the source revenue center. To automatically select all modules, click the Select All Modules link.

c. (Optional) Select Distribute inherited records to distribute all records (defined and inherited) from the source revenue center to the new revenue center. Deselect this option to distribute only records defined at the source revenue center to the new revenue center.

d. (Optional) Select If destination record is inherited, create override to create an override record in the new revenue center when an inherited definition exists.

e. (Optional) Select Distribute Data Extensions if they exist to distribute data extension values if they exist.

5. Click OK to copy the records from the source template revenue center to the new revenue center.

6. In the table view of the RVC Configuration module, select the following options as applicable for the new revenue center:
   • LDS Active – Select this option if the revenue center uses a Liquor Dispensing System (LDS), which is a third party system used for pouring and tracking liquor and beverages, as well as mixed drinks.
   • KDS Controller – Select the KDS Controller to control the kitchen display system (KDS) order devices in the revenue center.

7. Click Save.

Overview of Adding a Workstation

Adding a workstation consists of completing the following tasks:
   • Adding a workstation
   • Configuring workstation transaction settings
   • Setting offline transaction posting time
   • Configuring workstation security
   • Configuring order device upgrades
   • (Optional) Configuring integration with Android mobile operating system

Related Topics
   • Adding a Workstation
   • Configuring Workstation Transaction Settings
   • Setting Offline Transaction Posting Time
   • Configuring Workstation Security

Adding a Workstation

1. In the EMC, select the property, click Setup and Workstations.
2. Insert a record for the workstation, enter the name, and click OK.

3. Double-click the new workstation record.

4. On the General tab, enter information in the following fields:

Table 3-1  General Workstation Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select the type of workstation from the drop-down list:</td>
</tr>
<tr>
<td></td>
<td>• Mobile MICROS – Mobile devices</td>
</tr>
<tr>
<td></td>
<td>• Workstation Client – Workstations, virtual machines, and Android tablets.</td>
</tr>
<tr>
<td></td>
<td>• POSAPI Client – Simphony Transaction Services</td>
</tr>
<tr>
<td></td>
<td>• MICROS Tablet Client – Oracle MICROS Tablet E-Series</td>
</tr>
<tr>
<td>Language</td>
<td>Select the default language of the workstation. This is the language that</td>
</tr>
<tr>
<td></td>
<td>appears on the workstation’s Sign In screen. If an employee has a different</td>
</tr>
<tr>
<td></td>
<td>language set, the employee sees another language after signing in to the</td>
</tr>
<tr>
<td></td>
<td>workstation.</td>
</tr>
<tr>
<td>Resolution Cols</td>
<td>Enter the number of Resolution Columns for the workstation’s display. This</td>
</tr>
<tr>
<td></td>
<td>number should correspond to one of the resolutions set in the workstation’s</td>
</tr>
<tr>
<td></td>
<td>.INI file, or leave it at 0 (zero) as a default.</td>
</tr>
<tr>
<td>Resolution Rows</td>
<td>Enter the number of Resolution Rows for the workstation’s display. This</td>
</tr>
<tr>
<td></td>
<td>number should correspond to one of the resolutions set in the workstation’s</td>
</tr>
<tr>
<td></td>
<td>.INI file, or leave it at 0 (zero) as a default.</td>
</tr>
<tr>
<td>Log Verbosity</td>
<td>Select the logging verbosity for the workstation. For example, select 0 (zero)</td>
</tr>
<tr>
<td></td>
<td>for minimal logging. Higher numbers cause the workstation’s disk or flash</td>
</tr>
<tr>
<td></td>
<td>drive to fill more quickly.</td>
</tr>
<tr>
<td>(Optional) Workstation Class</td>
<td>Select a Workstation Class to allow similar workstations to be grouped together and share certain page configuration settings.</td>
</tr>
<tr>
<td>Database Update Frequency</td>
<td>Enter the number of seconds the workstation waits to retrieve the latest</td>
</tr>
<tr>
<td></td>
<td>updates from the database. The default value is 60 seconds.</td>
</tr>
<tr>
<td></td>
<td>The value in this field overrides the Property Parameter’s Database Update</td>
</tr>
<tr>
<td></td>
<td>Frequency setting.</td>
</tr>
<tr>
<td>Check Inactivity Timeout</td>
<td>Enter the number of seconds that the workstation waits before showing a</td>
</tr>
<tr>
<td></td>
<td>message (Do you need more time?), prompting the workstation operator to</td>
</tr>
<tr>
<td></td>
<td>cancel the transaction. When you enter 0 (zero), the message does not</td>
</tr>
<tr>
<td></td>
<td>appear.</td>
</tr>
<tr>
<td></td>
<td>When you select <strong>Enable Follow Me</strong> in the RVC Parameters module, the check is automatically suspended rather than cancelled.</td>
</tr>
<tr>
<td>Check Inactivity Dialog Timeout</td>
<td>Enter the number of seconds that the workstation shows the Inactivity dialog</td>
</tr>
<tr>
<td></td>
<td>before automatically cancelling the transaction. This field is dimmed when</td>
</tr>
<tr>
<td></td>
<td>you set the <strong>Check Inactivity Timeout</strong> value to 0 (zero).</td>
</tr>
<tr>
<td>Report Timeout</td>
<td>Enter the number of seconds the workstation waits to retrieve reporting</td>
</tr>
<tr>
<td></td>
<td>information before failing.</td>
</tr>
</tbody>
</table>
### Table 3-1  (Cont.) General Workstation Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address / Host Name</td>
<td>Enter the IP address or host name of the Service Host where the workstation application runs.</td>
</tr>
</tbody>
</table>

5. Click the Revenue Centers tab.
6. Select the revenue centers for the workstation. You must select at least one revenue center.
7. Click **Save**.

**Related Topics**
- Overview of Adding a Workstation

### Configuring Workstation Transaction Settings

1. In the EMC, select the property, click **Setup** and **Workstations**.
2. Double-click the workstation record to open it.
3. Click the Transactions tab and enter information in the following fields:

### Table 3-2  Workstation Transaction Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Check Number</td>
<td>Enter the minimum guest check number to use:</td>
</tr>
<tr>
<td></td>
<td>• When the workstation is in offline mode</td>
</tr>
<tr>
<td></td>
<td>• When the workstation is used in revenue centers without the RVC Parameters option <strong>Use Revenue Center Check Numbers</strong>. In these revenue centers, each workstation determines its own check number range.</td>
</tr>
<tr>
<td>Maximum Check Number</td>
<td>Enter the maximum guest check number to use:</td>
</tr>
<tr>
<td></td>
<td>• When the workstation is in offline mode</td>
</tr>
<tr>
<td></td>
<td>• When the workstation is used in revenue centers without the RVC Parameters option <strong>Use Revenue Center Check Numbers</strong>. In these revenue centers, each workstation determines its own check number range.</td>
</tr>
<tr>
<td>(Optional) Default Order Type</td>
<td>Select the default active order type for the workstation (for example, Dine In, Take Out, or Drive Thru).</td>
</tr>
<tr>
<td>Barcode Format Set</td>
<td>Select the barcode format for the workstation to read barcodes of various lengths.</td>
</tr>
<tr>
<td>Cashier Link</td>
<td>Select the cashier record to link to the workstation. Linking cashier records provides sales information, such as menu item sales and tenders.</td>
</tr>
<tr>
<td></td>
<td>This field is available only when you select <strong>8 - On = Link Cashier Totals to WS; OFF = Link to Operator</strong> in the Workstations Options Offline/Misc sub-tab.</td>
</tr>
<tr>
<td>Merchant Group</td>
<td>Select the merchant group, or select <strong>0 - Use RVC Setting</strong> to use the settings from the revenue center in which the transaction occurs.</td>
</tr>
</tbody>
</table>
Table 3-2 (Cont.) Workstation Transaction Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thai Tax Rd Number</td>
<td>If applicable, enter the number to print on Thai Tax trailers.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**Related Topics**

- Overview of Adding a Workstation

**Setting Offline Transaction Posting Time**

You can configure the posting of transactions that occur when a property or its workstations are unable to communicate with the database for an extended period of time.

1. In the EMC, select the property, click **Setup** and **Property Parameters**.
2. Click the Options tab.
3. If you want offline checks to post to the database (when communications with the Check and Posting server are re-established) with the actual time of the transaction, select **6 - Post Offline Transactions with Actual Transaction Time**. Deselect this option if you want offline checks to post with the time that the check is uploaded into the database.
   
   Reports run offline might not match reports run online (after all the transactions have been played back).
4. Click **Save**.

**Related Topics**

- Overview of Adding a Workstation

**Configuring Workstation Security**

1. In the EMC, select the property, click **Setup** and **Workstations**.
2. Double-click the workstation record to open it.
3. Click the Options tab and the Display/Security sub-tab.
4. Enter information in the following fields:
### Table 3-3 Workstation Security Options

<table>
<thead>
<tr>
<th>Security Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mag Card Entry Required for Employee ID</td>
<td>Select this option to require all employee identification (ID) entries at the workstation to use a magnetic employee identification card (for example, to sign in and authorize privileged operations). When you select this option, the workstation does not accept an employee ID number entered through the keyboard or touchscreen. Deselect this option to allow the employee ID to be entered by either a magnetic card or by the keyboard or touchscreen.</td>
</tr>
<tr>
<td>Disable Employee Auto Sign Out</td>
<td>Select this option to if you do not want to use the Automatic Operator Popup Interval set in the RVC Parameters module. Deselect this option to sign out workstation operators after the Automatic Operator Popup Interval expires.</td>
</tr>
<tr>
<td>Use Alternate ID for Sign-in</td>
<td>Select this option to allow workstation operators to sign in using a four-digit alternate ID number rather than a ten-digit employee ID number.</td>
</tr>
<tr>
<td>Fingerprint Scan Required for Employee ID</td>
<td>Select this option to require all employee ID entries at the workstation to scan a fingerprint. When you select this option, the workstation does not accept an employee ID number entered through the keyboard or touchscreen.</td>
</tr>
<tr>
<td>Employee ID or Fingerprint Scan Required for Employee ID</td>
<td>Select this option to require all employee ID entries at the workstation to scan a fingerprint or enter an employee ID through the keyboard or touchscreen. When you select this option, the workstation only accepts an employee ID number entered through the keyboard or touchscreen, or fingerprint scan.</td>
</tr>
<tr>
<td>Employee ID and Fingerprint Scan Required for Employee ID</td>
<td>Select this option to require all employee ID entries at the workstation to scan a fingerprint and enter an employee ID through the keyboard or touchscreen. When you select this option, the workstation only accepts an employee ID number entered through the keyboard or touchscreen and fingerprint scan.</td>
</tr>
<tr>
<td>Mag Card or Fingerprint Scan Required for Employee ID</td>
<td>Select this option to require all employee ID entries at the workstation to scan a fingerprint or swipe a magnetic card. When you select this option, the workstation only accepts either a magnetic card swipe or fingerprint scan.</td>
</tr>
<tr>
<td>Mag Card and Fingerprint Scan Required for Employee ID</td>
<td>Select this option to require all employee ID entries at the workstation to scan a fingerprint and swipe a magnetic card. When you select this option, the workstation accepts only a magnetic card swipe and fingerprint scan.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Related Topics**

- Overview of Adding a Workstation
Configuring the Magnetic Stripe Reader on the Oracle MICROS Tablet 720

The Oracle MICROS Tablet 720 comes with a built-in OPOS Mag Stripe Reader (MSR).

1. In EMC, select **Property, Setup, Hardware/Interfaces, Workstations**, and then **Devices**.
2. In the **Peripheral Device Configuration** section, click **Add**.
3. For **Select Peripheral Device Type**, select **OPOS Mag Stripe Reader**.
4. For **Configuration**, enter **IDTECH_SECUREMAG_USBHID**.
5. Click **OK**, and then **Save**.

The *Oracle MICROS Tablet 720 Setup Guide* contains more information on setting up and using the Tablet 720.

Configuring the Barcode Scanner on the Oracle MICROS Tablet 720

The Oracle MICROS Tablet 720 comes with a built-in OPOS Barcode Scanner.

1. In EMC, select **Property, Setup, Hardware/Interfaces, Workstations**, and then **Devices**.
2. In the **Peripheral Device Configuration** section, click **Add**.
3. For **Select Peripheral Device Type**, select **OPOS Barcode Reader**.
4. For **Configuration**, enter **Honeywell**.
5. Click **OK**, and then **Save**.

The *Oracle MICROS Tablet 720 Setup Guide* contains more information on setting up and using the Tablet 720.

Integration with the Android Mobile Operating System

You can run Simphony version 2.7 and later on devices with the Android mobile operating system. The Simphony Point of Service (POS) client operates in a similar way on an Android mobile device and a Microsoft Windows device.

You can configure the POS client using the Enterprise Management Console (EMC), regardless of the platform. EMC manages the POS attributes, such as employees, menu items, discounts, taxes, and service charges for all Simphony client devices. System administrators use EMC to configure the pages (touchscreens) for all clients, and to deploy different user interfaces to Android devices than to traditional fixed place workstations.

The user interface workflow is the same on all devices and workstations. Rules are consistent across all devices governing the sale of items, applicable discounts, and employee functions. Android devices have special requirements that you should consider if you are familiar with the traditional Microsoft platforms. These differences...
include deployment methodology, configuration requirements, and the procurement process. Understanding these nuances and setting reasonable customer expectations ensures successful Simphony deployment with Android devices.

Related Topics
• Configuring the Android Device
• Configuring the Android Device as a Workstation
• Setting the CAL Package for the Android Device
• Installing the Client Application Loader (CAL) on the Android Device
• Installing the Simphony Service Host
• Viewing and Editing Simphony Android Files

Android Devices and Versions

Simphony is certified and supported with the following Android devices:
• Google Nexus 7 inch Tablet (one revenue center per device)
• Samsung Galaxy Note 10 inch (one revenue center per device)
• Samsung S 10 inch
• Samsung S 8 inch

Oracle recommends using one revenue center per Android device, and a maximum of 10,000 menu item definitions.

The following table shows the Android versions available and supported with Simphony.

<table>
<thead>
<tr>
<th>Version Number</th>
<th>Version Name</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1.x</td>
<td>Jellybean</td>
<td>No</td>
</tr>
<tr>
<td>4.2.x</td>
<td>Jellybean</td>
<td>No</td>
</tr>
<tr>
<td>4.3.x</td>
<td>Jellybean</td>
<td>No</td>
</tr>
<tr>
<td>4.4.x</td>
<td>KitKat</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Related Topics
• Configuring the Android Device
• Configuring the Android Device as a Workstation
• Setting the CAL Package for the Android Device
• Installing the Client Application Loader (CAL) on the Android Device
• Installing the Simphony Service Host
• Viewing and Editing Simphony Android Files
Android Functionality Support

Note the following functionality limitations when using Simphony on an Android device:

- Simphony does not support remote access to the Android desktop for certified support applications (for example, Bomgar, Remote Desktop Protocol (RDP), and so on).
- Android devices only operate the Simphony POS client application and cannot host shared services that other devices might access.
- Android devices do not support the Check and Posting Service (CAPS). Therefore, the property must use at least one device with a Microsoft operating system in addition to the Android device. Oracle Hospitality recommends that this device be an Oracle MICROS Workstation 5a (POSReady) or Oracle MICROS PC Workstation 2015.

Related Topics
- Configuring the Android Device
- Configuring the Android Device as a Workstation
- Setting the CAL Package for the Android Device
- Installing the Client Application Loader (CAL) on the Android Device
- Installing the Simphony Service Host
- Viewing and Editing Simphony Android Files

Android Network Requirements

Android devices are connected wirelessly to Simphony using an 802.11x network. Therefore, it is vital that the property have a high quality wireless network. Spotty Wi-Fi coverage causes application performance issues with check sharing and posting, as well as bouncing between online and offline states with the services on property (for example, check and posting, printing and kitchen display) and the Enterprise, which impacts the ability to receive database updates.

You must configure the Android device to use a wireless local area network (WLAN) with connectivity to the LAN used by the Check and Posting Service and other Simphony clients with which they might share checks. Simphony does not support the use of a 3G or 4G connection through a telecommunications provider back to these local devices.

Oracle Hospitality recommends that you configure Android devices to use a static Internet Protocol (IP) address. Simphony does not support the use of Dynamic Host Configuration Protocol (DHCP) assigned addresses unless you define a DHCP reservation.

Related Topics
- Configuring the Android Device
- Configuring the Android Device as a Workstation
- Setting the CAL Package for the Android Device
- Installing the Client Application Loader (CAL) on the Android Device
Android Payments

The Android clients support processing credit cards and other forms of electronic payments.

Simphony installs several credit card payment drivers with the application. The following drivers are supported with the Android mobile operating system:

- CAPMS
- Elavon Fusebox
- mCreditDebit
- MerchantLink TV2G
- Shift4 Dollars On The Net
- VisaD

The loadable Stored Value and Loyalty modules support Android clients, and are used with Oracle Hospitality Gift and Loyalty and FreedomPay. The Xprocessor Extension Application, which is used for third party gift cards such as Givex, does not support Android devices.

Related Topics

- Configuring the Android Device
- Configuring the Android Device as a Workstation
- Setting the CAL Package for the Android Device
- Installing the Client Application Loader (CAL) on the Android Device
- Installing the Simphony Service Host
- Viewing and Editing Simphony Android Files

Configuring the Android Device

Perform the following steps before installing Simphony software.

1. Configure the Android device to be a member of the point of sale (POS) network using a static Internet Protocol (IP) address.
2. Install antivirus software.
3. Turn off Trusted Sources on the device. See the manufacturer instructions for details.
4. If you are using a Bluetooth printer, pair it with the device. See the manufacturer instructions for details.
Configuring the Android Device as a Workstation

1. (Optional) If you are using a Bluetooth printer with the Android device, set the printer in the Printers module. Configuring a Printer contains more information about setting up the printer.

2. In the EMC, select the property, click Setup and Workstations.

3. Insert a new workstation record.

4. Double-click the record to open it in form view.

5. Enter information into the workstation configuration fields, and set the Type as Workstation Client.

6. Enter the Internet Protocol (IP) address or host name of the Service Host where the workstation application runs in the Address/Host Name field.

7. Click the Options tab and the Display/Security sub tab.

8. Select 39 - Floating Tablet.

9. (Optional) If you are using a Bluetooth printer, click the Printers tab and select the printer.

10. Click Save.

Related Topics
- Integration with the Android Mobile Operating System
- Android Devices and Versions
- Android Functionality Support
- Android Network Requirements
- Android Payments

Setting the CAL Package for the Android Device

1. In the EMC, select the Enterprise level, click Setup and CAL Packages.

2. Highlight the Service Host version.

3. Click the CAL Package Configuration tab.

4. Set the Platform Type for Service Host.[version] to 0 - All Clients.

5. Click the Deployment Schedules tab.

6. Set the deployment for the Service Host package for your Enterprise, property, or individual Service Host. Adding a Deployment Schedule for the Current CAL Package contains more information about setting the deployment.

7. Click Save.

Related Topics
- Integration with the Android Mobile Operating System
- Android Devices and Versions
Installing the Client Application Loader (CAL) on the Android Device

1. Open an Internet browser window on the Android device.

2. Browse to the application server: http://[servername or IP]:8080/EGateway/Download/CAL/Android/McrsCALClient_[CALversion].apk.
   McrsCALClient_[CALversion].apk downloads to the device. (The CAL version is likely 129 or later.)

3. Open the Downloads menu on the Android device.

4. Touch the McrsCALClient_[CALversion].apk file to start the installation.

5. If prompted, select the device Package Installer or local application for Android file installation and touch Always.

6. If you receive a prompt for clearing instructions, touch OK.

7. Touch Install. CAL installs and notifies you upon completion.

8. Touch Done.

9. Press the Home button on the Android device to prompt for CAL Launcher.

10. Touch the Micros CAL option and then touch Always.

11. If you receive a prompt with instructions about defaults, touch OK. The CAL Launcher home page appears. Installation of CAL is complete.

12. Touch the CAL shortcut to launch CAL Admin.

13. Enter the correct code based on the six-digit number shown at the top, and touch Next.

   CAL restricts access to CAL Admin and other areas on the Android device. You must enter a security code to access the CAL Admin configuration and settings on the device.

14. CAL searches for available servers. If found, the available servers appear. Touch the desired server to populate the server information. If no servers are available, manually configure the information for the workstation.

15. Touch Next to continue.

16. Select the correct property for the device and touch Next to continue. CAL returns a list of defined workstations for the selected property.

17. Touch the correct workstation for the device to populate the workstation information. If no workstations are available, manually configure the information for the workstation.

18. Touch Save.

Related Topics

• Integration with the Android Mobile Operating System
Installing the Simphony Service Host

The download and installation of Simphony ServiceHost automatically occurs. The Client Application Loader (CAL) shows the download file progress. The estimated file size is 558,000 kilobytes.

1. Touch **Install**.
2. Touch **Open**. ServiceHost starts and requests that you save the property and workstation settings.
3. Touch **OK**. ServiceHost loads and downloads data from the Enterprise level.
4. Enter the **Installer User Name** for the property and touch **OK**.
5. Enter the **Installer Password** for the property and touch **OK**. The installation is complete when the login page appears.

Related Topics
- Integration with the Android Mobile Operating System
- Android Devices and Versions
- Android Functionality Support
- Android Network Requirements
- Android Payments

Viewing and Editing Simphony Android Files

After you install Simphony on an Android device, use the Configuration Management Tool to view and edit certain files.

1. Launch the Simphony application on the Android device.
2. After the application loads, perform the following task on the Android device: On event (left swipe + right swipe + left swipe + tap + tap).
3. Enter the correct code based on the six-digit number shown at the top, and tap **Sign In**. The Management Tool Home screen appears.
4. The following table lists the options and actions you can perform.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View web.config.txt</td>
<td>Tap to view and edit the web.config.txt file</td>
</tr>
<tr>
<td>View config32.web</td>
<td>Tap to view and edit the config32.web file</td>
</tr>
<tr>
<td>View Log</td>
<td>Tap to view the EGateway Log</td>
</tr>
</tbody>
</table>
Table 3-5  (Cont.) Simphony Android Files

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View LogZone</td>
<td>Tap to view the LogZone_LoadHandlers.txt file, which is not editable</td>
</tr>
<tr>
<td>Ping Server</td>
<td>Tap to view the Server Name or IP Address</td>
</tr>
<tr>
<td>Delete DataStore</td>
<td>Tap to delete the DataStore database file and restart the application on the device</td>
</tr>
<tr>
<td>Copy DataStore</td>
<td>Tap to copy the DataStore database file within the device</td>
</tr>
</tbody>
</table>

Related Topics
- Integration with the Android Mobile Operating System
- Android Devices and Versions
- Android Functionality Support
- Android Network Requirements
- Android Payments

Setting Languages

1. In the EMC, select the Enterprise, click Setup and Languages.
2. Insert a record and name it for the language you want (for example, Chinese).
3. Double-click the record to open it.
4. On the General tab, select the language in the Keyboard Type drop-down list.
5. Click the Text Files tab.
6. Click the Add link and select 1 - OPS Text in the File Type drop-down list.
7. Click the Edit link and the Import from a file link.
8. Browse to C:\MICROS\Simphony2\EgatewayService\handlers, select OPS.txt, and click Open.
9. Click the Add link and select 2 - POS Core Text in the File Type drop-down list.
10. Click the Miscellaneous tab.
11. Select the language in the Locale field.
12. Select the LocalID from the drop-down list.
13. Click Save.
14. Select the property, click Setup and Workstations.
15. On the General tab, select the Language you want to appear on the workstation tablet device.
16. Click Save.
17. Select the property, click Setup and Property Parameters.
18. On the General tab, select primary and secondary languages from the Language 1 and Language 2 lists.
19. Select the language from the **Select Secondary Print Language** list. Selecting **0 - None** causes only the default language to print. When printing multiple languages, the application prints item names in the order configured for the property.

20. Click **Save**.

21. Select the Enterprise, property, revenue center, or zone, click **Setup** and **Format Parameters**.

22. Click the Options tab.

23. Select option **52 - Print Secondary Language on Guest Checks/Customer Receipt**.

24. Click **Save**.
Employees and Privileges

In Simphony, privileges determine the activities an employee can perform, the Enterprise Management Console (EMC) modules available to the employee, and the types of transactions the employee can process. You can set some privileges by the job title (for example, host, server, bartender, cashier, manager) and others by the task (for example, adding menu items, adding employees, adding reservations, and performing voids).

You can assign employees to roles based on the tasks they perform. Most workstation operators are associated with a single role (such as bartender or server).

- Setting Employee Roles
- Creating Employee Classes
- Adding an Employee
- Terminating an Employee
- Changing Employee Information
- Configuring Employee Shifts
- Configuring Employee Breaks
- Clock-In and Clock-Out Cycles
- Setting Clock-In and Clock-Out Cycles
- Job Codes
- Configuring Job Codes
- Understanding Tip Tracking
- Configuring Tip Tracking and Reporting
- Configuring Tip Track Front of House Buttons

Setting Employee Roles

1. In the EMC, select the Enterprise level, click **Configuration** and **Roles**.
2. Insert a record for the type of role (for example, host, bartender, server, manager, or administrator) and click **OK**.
3. Double-click the role type.
4. On the General tab, select the role security from the **Level** drop-down list. Level 0 (zero) has greater privileges than level 9. The value in this field prevents Enterprise Management Console (EMC) users from creating employee records with greater privileges than the user is granted. The following table describes typical levels for various types of roles. Gaps appear to allow flexibility for other types of roles that are not listed.
Table 4-1 Role Security Levels

<table>
<thead>
<tr>
<th>Level</th>
<th>Type of Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>System Administrator</td>
</tr>
<tr>
<td>1</td>
<td>Enterprise Level Programmer</td>
</tr>
<tr>
<td>2</td>
<td>Property Level Programmer</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Property Floor Manager</td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Bartender, Cashier, Server</td>
</tr>
</tbody>
</table>

5. Click the EMC Modules tab.

6. For each EMC module listed in the File column, select one or more of the following privileges:
   - **View** – You must grant access to view a module in order for the employees in the role to open the module.
   - **Edit** – Selecting this option allows employees in the role to update fields or records within a module.
   - **Add** – Selecting this option allows employees in the role to add records to a module.
   - **Delete** – Selecting this option allows employees in the role to delete records from a module.
   - **Add Override** – Selecting this option allows employees in the role to override records in a module.
   - **Allow Duplicate Obj#** – Selecting this option allows employees in the role to add records where existing records with the same number exist elsewhere in the Enterprise.
   - **Allow Duplicate Name** – Selecting this option allows employees in the role to add records where existing records with the same name exist elsewhere in the Enterprise.
   - If you want to easily configure a role to View, Edit, Add, Delete, or Add Override for every module without having to individually select each option, right-click a column heading and select **Set All**.

7. Click the Actions tab.

8. Select **Enable** for the appropriate EMC tasks listed in the Action column.
   If you want to easily activate a role for every module without having to individually select each option, right-click the Enable heading and select **Set All**.

9. Click **Save**.
Creating Employee Classes

You can set collective options for a group of similar employee roles using an Employee Class. Each employee must belong to an Employee Class to perform workstation operations.

1. In the EMC, select the property, click Configuration and Employee Classes.
2. Insert a record for a group of employees (for example, server, bartender, or host) and double-click the record to open it.
3. On the General tab, enter or select information for the fields as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#Hours/Day Before OT</td>
<td>Enter the number of regular hours that employees in the Employee Class can work in a single day before being paid at the overtime rate.</td>
</tr>
<tr>
<td>#Hours/Period Before OT</td>
<td>Enter the number of regular hours that employees in the Employee Class can work in a single pay period before being paid at the overtime rate.</td>
</tr>
<tr>
<td>ISL Options</td>
<td>Select the ISL Employee Options to allow employees in the Employee Class to execute Interface Script Language (ISL) scripts. ISL is the Oracle Hospitality proprietary interpreted language used to create small programs called scripts. The ISL options act like a transaction privilege level in an ISL script. ISL scripts can be written to include variables that check for the presence of these privileges for the employee who is running the script. If the employee is not a member of an Employee Class that has the necessary ISL employee option set, the script does not execute, and a privilege prompt appears.</td>
</tr>
<tr>
<td>Default Trans TS</td>
<td>Select the default touchscreen that appears when members of the Employee Class sign in to a workstation.</td>
</tr>
<tr>
<td>MMH Default Trans TS</td>
<td>Select the default touchscreen that appears when members of the Employee Class sign in to a Mobile MICROS device.</td>
</tr>
<tr>
<td>Pickup/Add/Xfer SLU Style</td>
<td>Select a touchscreen style that workstation operators can use when adding and transferring checks with the Add/Transfer Check Screen Lookup (SLU) function key.</td>
</tr>
<tr>
<td>View Screen/Style Names for RVC</td>
<td>View the touchscreen names and styles set in the revenue centers.</td>
</tr>
</tbody>
</table>

4. Click the Operator Options tab.
5. For each revenue center listed, in the Operator Type drop-down list, select the
guest check printing method for workstation operators assigned to the Employee
Class.
   • By Round – Select this option to print a guest check at the end of each
     service round, showing only the changes posted to the service round.
   • On Demand – Select this option to print a buffered guest check after
     performing a Service Total or tender set to print an on demand check.
   • Temp On Demand – Select this option to print a guest check on demand (in a
     by round manner).
   • Special By Round – Select this option to print a guest check on demand for
     all rounds except the first round of a check. The first round always prints.
     Subsequent service rounds print if the Service Total is set to print an on
     demand check.

6. For each revenue center listed, select the appropriate Options for workstation
operators assigned to the Employee Class and click OK.

Using a Server Employee Class as an example, you can require all servers in a
revenue center to enter the number of guests when beginning new checks and to
enter table numbers.

7. Click Save.

Adding an Employee

You must have the Enterprise level permission Add Employees to add an employee
record from a template.

1. In the EMC, select the Enterprise, property, or revenue center, click
   Configuration and Employee Maintenance.

2. Click the Insert Record icon on the toolbar. The Add Employees dialog appears.

3. In the Select a task to perform drop-down list, select Add Employee Record
   from Template.

   Using a template simplifies the process of adding employees.

4. Click Select next to the Employee To Copy field.

5. In the Select Employee dialog, select a template employee record and click OK.

6. Enter employee information in the following fields and click OK.
   • First and Last Name
   • (Optional) Check Name – The employee name appearance on guest checks
     (for example, Sally S)
   • (Optional) ID – The employee identification number
   • Record Number – The next available record number appears by default
   • Property # and Name – The property where the employee works
   • RVC # and Name – The revenue center (RVC) where the employee works

7. Click Yes on the Add Employee? confirmation prompt.

8. If you want to add another employee, click Yes on the prompt, and repeat Steps 6
   through 7. If you do not want to add more employees, click No.
Terminating an Employee

You must have the Enterprise level permission called Delete Employees to remove an employee record.

1. In the EMC, select the Enterprise, property, or revenue center, click Configuration and Employee Maintenance.
2. Search for the employee record.
3. In the table view, right-click the employee record and select Delete.
4. On the Delete Employee Records dialog, click Yes to confirm.
5. To see a list of all deleted employees in the search area, select View Deleted Employees and click Search.
6. To reactivate a deleted employee, right-click the employee record, select Reactivate, and click Yes to confirm.
7. If you are an administrator and want to permanently delete an employee, right-click the employee record, select Permanently Delete, and click Yes on the prompts to confirm.

You cannot permanently delete an employee who is not marked Is Deleted and who has associated sales or timecard records in the Oracle Hospitality Reporting and Analytics database. Employees are mapped between the Simphony and Reporting and Analytics databases using the object number from the Enterprise Management Console (EMC). Consider the following example:

- Employee 12345, Ted Davis, has $500 in sales
- Employee 12345 is deleted from the database
- If the EMC allowed this employee to be permanently deleted, a new employee, Mary Smith, could be added at employee record 12345 and the new employee would essentially start with $500 in sales

Thus, the two-step employee deletion process preserves the object number between the two databases. Because of this potential scenario, object numbers are not reusable. If employee 12345 is marked as Is Deleted in the database, you cannot create a new employee record using number 12345.

8. Click Save.

Changing Employee Information

You must have the Enterprise level permission Edit Employees to change an employee record.

1. In the EMC, select the Enterprise, property, or revenue center, click Configuration and Employee Maintenance.
2. Search for the employee record using the Search Criteria fields to limit the results, and click Search. Depending on the hierarchy level at which you opened the Employee Maintenance module (Enterprise, property, or revenue center), the resulting list of employee records appears in one of the following tabs located near the lower area of the screen:
• Employee Records – Enterprise level
• Property Employee Records – Property level
• Operator Records – Revenue Center level

3. You can make changes in either table view or form view. To make changes in form view, double-click the object number of the employee record.

4. Change any of the information in the active fields. The following tables list the types of information you can change for each hierarchy level.

Table 4-3  Employee Records Information

<table>
<thead>
<tr>
<th>Sub Tab</th>
<th>Type of Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Allows you to change basic information about the employee, including name, language,</td>
</tr>
<tr>
<td></td>
<td>identification numbers, level, group, and Enterprise Management Console (EMC) login</td>
</tr>
<tr>
<td></td>
<td>credentials.</td>
</tr>
<tr>
<td>Roles</td>
<td>Allows you to change the employee’s role (permissions).</td>
</tr>
<tr>
<td>Reporting</td>
<td>Allows you to change the employee’s log in credentials for Oracle Hospitality Reporting</td>
</tr>
<tr>
<td></td>
<td>and Analytics.</td>
</tr>
<tr>
<td>References</td>
<td>Shows the locations where the employee is being referenced (excluding workstations).</td>
</tr>
</tbody>
</table>

Table 4-4  Property Employee Records Information

<table>
<thead>
<tr>
<th>Sub Tab</th>
<th>Type of Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Allows you to change basic information about the employee, including name, employee</td>
</tr>
<tr>
<td></td>
<td>class, revenue center, and clock-in options.</td>
</tr>
<tr>
<td>Job Codes</td>
<td>Shows the job code assigned to the employee in the property. You can change the</td>
</tr>
<tr>
<td></td>
<td>Regular and Overtime Pay Rates for each job code.</td>
</tr>
<tr>
<td>Operators</td>
<td>Shows each revenue center in the property where the employee has an operator record.</td>
</tr>
<tr>
<td></td>
<td>You can change the Cash Drawer, Table Count, TMS Color, and Server Efficiency.</td>
</tr>
<tr>
<td></td>
<td>You can also select whether to use the Employee Class options or set options at the</td>
</tr>
<tr>
<td></td>
<td>operator level.</td>
</tr>
</tbody>
</table>

Table 4-5  Operator Records Information

<table>
<thead>
<tr>
<th>Sub Tab</th>
<th>Type of Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Allows you to change basic information about the employee, including name, employee</td>
</tr>
<tr>
<td></td>
<td>class, revenue center, and clock-in options.</td>
</tr>
</tbody>
</table>
Table 4-5  (Cont.) Operator Records Information

<table>
<thead>
<tr>
<th>Sub Tab</th>
<th>Type of Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Codes</td>
<td>Shows the job code assigned to the employee in the property. You can change the</td>
</tr>
<tr>
<td></td>
<td><strong>Regular and Overtime Pay Rates</strong> for each job code.</td>
</tr>
<tr>
<td>Operators</td>
<td>Shows each revenue center in the property where the employee has an operator record.</td>
</tr>
<tr>
<td></td>
<td>You can change the <strong>Cash Drawer</strong>, <strong>Table Count</strong>, <strong>TMS Color</strong>, and **Server</td>
</tr>
<tr>
<td></td>
<td>Efficiency**. You can also select whether to use the <strong>Employee Class</strong> options or</td>
</tr>
<tr>
<td></td>
<td>set options at the operator level.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

Configuring Employee Shifts

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Setup** and **Control Parameters**.

2. Click the Options tab and select the appropriate shift options.

Table 4-6  Shift Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>49 – Enable Shift Tracking</td>
<td>Select this option to activate shift reporting, segregating employee,</td>
</tr>
<tr>
<td></td>
<td>employee tip, and cashier financial totals by shift. Deselect this option to</td>
</tr>
<tr>
<td></td>
<td>have employee, employee tip and cashier totals accumulate in a single total</td>
</tr>
<tr>
<td></td>
<td>set. When you deselect this option, the subsequent shift-related options are</td>
</tr>
<tr>
<td></td>
<td>dimmed.</td>
</tr>
<tr>
<td>50 – Increment Cashier Shift when Clocking Out</td>
<td>Select this option to increment the shift for the cashier associated with the</td>
</tr>
<tr>
<td></td>
<td>employee clocking out (except when clocking out on break). Deselect this</td>
</tr>
<tr>
<td></td>
<td>option to have the shift for the cashier associated with the employee remain</td>
</tr>
<tr>
<td></td>
<td>the same.</td>
</tr>
<tr>
<td>51 – Increment Cashier Shift when Clocking In</td>
<td>Select this option to increment the shift for the cashier associated with the</td>
</tr>
<tr>
<td></td>
<td>employee clocking in (except when returning from break). Deselect this option</td>
</tr>
<tr>
<td></td>
<td>to have the shift for the cashier associated with the employee remain the</td>
</tr>
<tr>
<td></td>
<td>same.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>52 – Increment Cashier Shift when Changing Job</td>
<td>Select this option to increment the shift for the cashier associated with the employee when they clock in with a different job. This clock in occurs automatically when the employee signs in to a workstation with a different revenue center than the job in which they are currently clocked in. Deselect this option to have the shift for the cashier associated with the employee remain the same during this clock in cycle.</td>
</tr>
<tr>
<td>53 – Increment Cashier Shift when Changing Revenue Center</td>
<td>Select this option to increment the shift for the cashier associated with the employee when they sign in to a different revenue center. Deselect this option to have the shift for the cashier associated with the employee remain the same when signing in to a different revenue center.</td>
</tr>
<tr>
<td>54 – Prompt before incrementing Cashier Shift</td>
<td>Select this option to prompt the employee to increment the shift for the cashier associated with the employee when the shift is set to increment upon clocking in or out, changing jobs, or changing revenue centers. Deselect this option so that no prompting occurs when the cashier shift is set to increment through one of those methods.</td>
</tr>
<tr>
<td>55 – Prompt to Increment Cashier Shift after Shift Report</td>
<td>Select this option to prompt the workstation operator to increment the cashier shift when a Cashier Shift Report is generated with a shift scope. Deselect this option so that no prompting occurs and the cashier shift does not increment.</td>
</tr>
<tr>
<td>56 – Increment Employee Shift when Clocking Out</td>
<td>Select this option to increment the shift for the employee upon clocking out (except on break). Deselect this option to have the shift for the employee remain the same.</td>
</tr>
<tr>
<td>57 – Increment Employee Shift when Clocking In</td>
<td>Select this option to increment the shift for the employee upon clocking in (except when returning from break). Deselect this option to have the shift for the employee remain the same.</td>
</tr>
<tr>
<td>58 – Increment Employee Shift when Changing Job</td>
<td>Select this option to increment the shift for the employee when they clock in with a different job. This clock in occurs automatically when the employee signs in to a workstation with a different revenue center than the job in which they are currently clocked in. Deselect this option to have the shift for the employee remain the same during this clock in cycle.</td>
</tr>
</tbody>
</table>
### Table 4-6  (Cont.) Shift Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>59 – Increment Employee Shift when Changing Revenue Center</td>
<td>Select this option to increment the employee shift when they sign in to a different revenue center. Deselect this option to have the employee shift remain the same when signing in to a different revenue center.</td>
</tr>
<tr>
<td>60 – Prompt to Increment Employee Shift after Shift Report</td>
<td>Select this option to prompt the workstation operator to increment the employee shift when an Employee Shift Report is generated with a shift scope. Deselect this option to have no prompting and leave the employee shift the same.</td>
</tr>
<tr>
<td>61 – Prompt before incrementing Employee Shift</td>
<td>Select this option to prompt the employee to increment the employee shift when the shift is set to increment upon clocking in or out, changing jobs, or changing revenue centers. Deselect this option to have no prompting when the employee shift is set to increment through one of those methods.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

4. Select the revenue center, click **Setup** and **RVC Parameters**.

5. Click the Calendar tab.

6. In the Shift Incrementing Options section, select the following options if you do not want Employee or Cashier Financial Shifts to reset with the start of business day:
   - **Do not reset Employee Financial Shifts with the start of each business day**
   - **Do not reset Cashier Financial Shifts with the start of each business day**

7. Click **Save**.

### Configuring Employee Breaks

A break is a rest period for hourly workers, such as a lunch break. Breaks can be either paid or unpaid and you can set time limits for breaks. Some jurisdictions legislate break length requirements for minor employees.

1. In the EMC, select the property, click **Setup** and **Property Parameters**.

2. Click the Timekeeping tab and enter values in the following fields:
   - **Minor Unpaid Break Minimum Length** – If applicable, enter the minimum number of minutes allowed for unpaid breaks taken by a minor employee.
   - **Minor Unpaid Break Maximum Length** – If applicable, enter the maximum number of minutes allowed for unpaid breaks taken by a minor employee.
   - **Minor Paid Break Minimum Length** – If applicable, enter the minimum number of minutes allowed for paid breaks taken by a minor employee.
   - **Minor Paid Break Maximum Length** – If applicable, enter the maximum number of minutes allowed for paid breaks taken by a minor employee.
• **Regular Unpaid Break Minimum Length** – Enter the minimum number of minutes allowed for an unpaid break taken by a regular employee.

• **Regular Unpaid Break Maximum Length** – Enter the maximum number of minutes allowed for an unpaid break taken by a regular employee.

• **Regular Paid Break Minimum Length** – Enter the minimum number of minutes allowed for a paid break taken by a regular employee.

• **Regular Paid Break Maximum Length** – Enter the maximum number of minutes allowed for a paid break taken by a regular employee.

3. Click **Save**.

### Clock-In and Clock-Out Cycles

A clock-in cycle for a workstation operator includes one clock in and the subsequent clock out. Clock-in cycles are sequentially numbered from the start of the current payroll period to the current date on employee time cards and labor detail reports. If breaks are not in use, a cycle is the equivalent of a work shift.

A clock-in cycle includes the day, date, and time of the entry and the Job Code under which the employee clocks in.

**Related Topics**

• [Setting Clock-In and Clock-Out Cycles](#)

### Setting Clock-In and Clock-Out Cycles

1. In the EMC, select the Enterprise, property, or revenue center, click **Configuration** and **Employee Maintenance**.

2. Search for the property employee record.

3. Select the Employee Records tab near the lower part of the screen, and then double-click the object number of the appropriate record.

4. If the **ID** field is blank, enter the employee identification number.

5. Click the **Search/Table View** tab.

6. Select the Property Employee Records tab near the lower part of the screen, and then double-click the object number of the appropriate record.

7. Click the **Job Codes** tab and add a job code for the role if it does not exist.

   Employees who clock in require a job code. Employees without a job code assigned typically do not need to clock in (such as tax exempt employees). If an employee has more than one job code assigned (for example, bartender and server), the workstation prompts the employee to select a job code when clocking in.

8. Click **Save** to apply the changes.

9. Select the Enterprise level, click **Configuration** and **Roles**.

10. Select the role type, click the **Operations** tab and the **Timekeeping** sub tab.

11. In the **Job Rate Options** section, select the appropriate **Clock in at Rate** options for employees associated with the role. Each rate number refers to a pay rate that is assigned for the employee record.
12. Select the appropriate general timekeeping options as described in the following table:

### Table 4-7 Employee Timekeeping Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Allow the Employee to Perform or Authorize...</th>
</tr>
</thead>
<tbody>
<tr>
<td>13 - Authorize/Perform Reprint of Time Card</td>
<td>Reprinting a time card using the Reprint Time Card key, and to authorize non-privileged employees to do so</td>
</tr>
<tr>
<td>20009 - Authorize Clock In / Authorize Clock In/Out for the Wrong Location</td>
<td>Other employees to clock in Setting this option also allows users to clock in or out for the wrong location</td>
</tr>
<tr>
<td>20010 - Authorize/Perform Clock In/Out Outside Schedule or Scheduled Breaks</td>
<td>Clocking in or out at times that conflict with the assignment in the Time Clock Schedule module</td>
</tr>
<tr>
<td>20011 - ON = Minor Employees; OFF = Regular Employees</td>
<td>Designate employees associated with the role as minors</td>
</tr>
<tr>
<td>20012 - Authorize/Perform Clock Out with Open Checks</td>
<td>Clocking out at the end of a shift with open guest checks, and to authorize other employees to do so</td>
</tr>
<tr>
<td>20013 - Authorize Changing Revenue Center at Clock In</td>
<td>Changing the revenue center assignment of other employees who are clocking in</td>
</tr>
<tr>
<td>20014 - Change Revenue Center at Clock In</td>
<td>Changing the revenue center assignment when clocking in</td>
</tr>
<tr>
<td>20015 - Authorize/Perform Clock Out in the Future</td>
<td>Clock themselves out at a time ahead of the application time</td>
</tr>
</tbody>
</table>

13. Click **Save**.

**Related Topics**
- Clock-In and Clock-Out Cycles

**Job Codes**

A Job Code identifies a category of labor group (for example, Server, Bartender, Cashier, Manager) for timekeeping. Job codes:
- Link hourly employees to specific pay rates upon clock in
- Group labor hours and costs into job categories on reports

**Related Topics**
- Configuring Job Codes

**Configuring Job Codes**

1. In the EMC, select the property, click **Configuration** and **Job Codes**.
2. Insert a new job code record with the appropriate name (for example, Server, Bartender, or Manager) and double-click it to open.
3. Select the **Employee Role** from the drop-down list to associate with the job code.
If you select **0 - None**, the employee receives privileges based on the roles set in the Employee Maintenance module.

This setting is ideal for an employee who has two job codes (for example, Server and Bartender). The privileges associated with this employee role are active for the duration of the clock-in cycle.

4. Select the **Employee Class** from the drop-down list.

If you select **0 - None**, the employee uses the Employee Class set in the Employee Maintenance module.

The employee is assigned to this employee class for the duration of the clock-in cycle.

5. Select the **Revenue Center** in which the job code is available.

If you want to make the job code available in all revenue centers, select **0 - None**.

6. Enter the **Report Group** for the job code.

The labor reports sort and calculate subtotals by the Report Group. If you set the Report Group to 0 (zero), the job code does not appear on job code reports.

7. Select the appropriate options as described in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 – Prompt for Direct Tips before Clocking Out</td>
<td>Select this option to prompt employees who are clocked in under the job code to declare the amount of direct tips received (tips given directly from the customer to the employee) when clocking out.</td>
</tr>
<tr>
<td>2 – Prompt for Indirect Tips before Clocking Out</td>
<td>Select this option to prompt employees who are clocked in under the job code to declare the amount of indirect tips received (tips given from one employee to another) when clocking out.</td>
</tr>
<tr>
<td>3 – Cannot Clock Out with Open Checks</td>
<td>Select this option to prevent employees clocked in under the job code from clocking out while they have open guest checks. You can override this setting for employees that have the Clock Out with Open Checks privilege.</td>
</tr>
<tr>
<td>4 – Use Scheduled Time if Employee Clocks in Early</td>
<td>Select this option to use the employee’s scheduled clock-in time for labor calculations if the employee clocks in earlier than scheduled.</td>
</tr>
<tr>
<td>5 – Prompt for Clock In Revenue Center</td>
<td>Select this option to allow employees to select the revenue center when clocking in.</td>
</tr>
</tbody>
</table>

8. Click **Save**.

**Related Topics**
- **Job Codes**

**Understanding Tip Tracking**

Servers can use Tip Track to:
• Share tips with other employees
• Edit tip-outs
• Claim tips from other employees

Managers can use Tip Track to:
• Grant tip-out privileges
• Generate tip-out transaction reports

You cannot use Tip Track with Oracle Hospitality Labor Management.

Related Topics
• Configuring Tip Tracking and Reporting
• Configuring Tip Track Front of House Buttons

Configuring Tip Tracking and Reporting

1. In the EMC, select the Enterprise level, click Configuration and Roles.
2. Select the type of role (for example, server or bartender).
3. Click the Operations tab and the Miscellaneous sub-tab.
4. If you want to allow employees to give cash tips to others, select 187 - Authorize/Perform the Pay Tip Out To Others Keys.
5. If you want to allow employees to receive a tip from another employee, select 188 - Claim Tips From Other Employee.
6. If you want to allow employees to edit cash tips given to other employees, select 189 - Authorize/Perform Edit Of Any Tip Outs.
7. Select the manager type of role in the left pane.
8. Click the Ad Hoc Reports sub-tab.
9. If you want to allow managers to run the Employee Tip Track Report, select 31045 - Run Employee Tip Track Report.
10. Click Save.
11. Select the revenue center, click Setup and RVC Parameters.
12. Click the Options tab.
13. If you want to print a validation receipt when a tip-out or tip edit operation occurs, select 7 - Validate Employee Direct/Indirect Tips Declared Transactions.
14. Assign a validation printer at the property level:
   a. Select the property, click Setup and Workstations.
   b. Click the Printers tab.
   c. Select a Validation Printer and click OK.
   d. Click Save.

Related Topics
• Understanding Tip Tracking
Configuring Tip Track Front of House Buttons

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Page Design.
2. Open the Front of House page on which to place tip track buttons.
3. On the Edit tab, select the page area in which to define the tip track functions.
4. Click Button.
5. On the General sub-tab, enter the button name Tip Track Tip Out in the Legend field.
6. Select Function from the Type drop-down.
7. Click the black arrow directly beneath the Type drop-down, select Tips in the Type section, select Tip Track Tip Out in the Results section, and click OK.
8. Repeat Steps 3 through 7 to create the following buttons:
   • Tip Track Edit My Tips
   • Tip Track Edit
9. Click Save.

Related Topics
• Understanding Tip Tracking
Customers pay guest checks with various types of payments or tenders, ranging from paper to plastic to digital.

- Types of Payment
- Configuring Base Currency and Alternate Currency
- Configuring Currency Conversions
- Configuring the Cash Tender
- Credit Card Tokenization
- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites
- Universal Transaction Gateway for Shift4
- Communication Methods for Fusebox Payment Card Driver
- stunnel Installation Methods
- Installing stunnel at a Single Host Location
- Installing stunnel Through Simphony as a CAL Package
- Configuring the CAPMS Payment Card Driver
- Configuring the CAPMS Payment Module
- Configuring the Dollars on the Net Payment Card Driver
- Configuring the Dollars on the Net Payment Module
- Configuring the Fusebox Payment Card Driver
- Configuring the Fusebox Payment Module
- Configuring the VisaD Payment Card Driver
- Configuring the VisaD Payment Module
- Configuring the Loadable Payment Card Device
- Creating Front of House Loadable Payment Card Buttons
- Distributing a Third-Party Credit Card Driver Package
- Copying Third-Party Payment Driver Files
- Creating a CAL Package for the Third-Party Payment Card Driver Distribution
- Credit Card Batching
- Creating a Credit Card Batch
- Editing a Credit Card Batch
- Settling a Credit Card Batch
- Credit Card Preamble
Types of Payment

Payments reduce the balance of the guest check, and can include the types listed in the following table:

<table>
<thead>
<tr>
<th>Payment Type</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash</td>
<td>Configuring the Cash Tender</td>
</tr>
<tr>
<td>Credit Cards</td>
<td>Loadable Payment Card Configuration Tasks</td>
</tr>
<tr>
<td>Gift Cards</td>
<td>Stored Value Configuration Tasks</td>
</tr>
<tr>
<td>Pay at the Table</td>
<td>Pay at the Table</td>
</tr>
<tr>
<td>Hotel Room Charge</td>
<td>Configuring the Room Tender</td>
</tr>
</tbody>
</table>

Configuring Base Currency and Alternate Currency

1. In the EMC, select the Enterprise, property or zone, click **Setup and Currency Parameters**.

2. Select the **Base Currency** from the drop-down list. This is the primary currency for the location.

   Oracle recommends setting the base currency once during initial configuration of a property, prior to opening guest checks. When you change the base currency after opening checks, the Enterprise Management Console (EMC) prompts you for verification twice.

3. (Optional) Select the **Alternate Currency** from the drop-down list. This is the other currency used at the location. For example, a property located near Niagara Falls
might set US Dollars as the base currency and accept Canadian Dollars as the alternate currency.

4. If you want to use rounding, select 4 - Round Currency. When you select this option the subsequent options are available. Select the appropriate options to round the amount due:

   • 5 - ON = Round to Nearest 0; OFF = Round to Nearest 5 – Select this option if you want to round currency amounts to the nearest 0 (for example, 163.336 rounds to 163.340). Deselect this option to round currency amounts to the nearest 5 (for example, 163.336 rounds to 163.335).

   • 6 - ON = Round to Second-Least Significant Digit; OFF = Round to Least Significant Digit – Select this option if you want to round currency amounts based on the second least significant digit (for example, in 100.45, the second least significant digit is 4). Deselect this option to round currency amounts based on the least significant digit (for example, in 100.45, the least significant digit is 5).

5. Click Save.

6. Select the Enterprise, property or zone, click Setup and Currency Availability.

7. If you selected the Enterprise level, for each record, select the non-base currency (foreign or alternate currency) in the Currency field.

8. Select the appropriate alternate currency options:

   • 2 - Issue Change In Other Currency – Select this option if you want to issue change from a currency conversion in the currency. Deselect this option to issue change in the base currency.

   • 3 - Prompt For Issuing Change – Select this option to have the workstation prompt the workstation operator to issue change in the other currency. Deselect this option to issue change in the base currency.

   • Select options 4, 5, and 6 as appropriate for the alternate currency. These options are described in Step 4.

9. Click Save.

**Configuring Currency Conversions**

You can configure how one currency rate converts to another currency rate. Typically, currency conversion rates are set at the Enterprise level and each property receives the same conversion. If one location has a slightly different conversion rate for the same two currencies, you can set the currency conversion at the zone (for example, a Euro-to-US Dollar conversion might be standard for the Enterprise level, but an airport property has a different rate).

1. In the EMC, select the Enterprise, property or zone, click Setup and Currency Conversions.

2. Insert a record and double-click it. Each record contains two currencies: a Currency and a Conversion Currency.

3. Select the Currency and click OK.

   This field, divided by the Rate, determines the number of Conversion Currency records.
4. Select the **Conversion Currency** and click **OK**. You must select a different currency than the selection in the Currency field. That is, the Currency and Conversion Currency fields cannot contain the same values.

   This field, multiplied by the Rate, determines the number of Currency records.

5. Enter the conversion **Rate**.

   The Rate determines how the application calculates the Currency and Conversion Currency. The Conversion and Conversion Reverse fields calculate automatically to show additional information about the record.

6. Click **Save**.

**Configuring the Cash Tender**

You must configure a cash tender for guests to pay the check with cash.

1. In the EMC, select the Enterprise, property, or revenue center, click **Setup** and **Payments**.

2. Insert a record and enter **Cash** as the name.

3. Double-click the record to open it.

4. On the General tab, click the **Import from a file** link.

5. Browse to C:\MICROS\Simphony2\EgatewayService\handlers, select `Micros.Payment.Cash.dll`, and click **Open**.

6. Click the Configuration tab.

7. In the Module Configuration sub-tab, enter information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Module ID           | Enter `MicrosCashPaymentModule`.
| Description         | Enter a description for the payment driver (for example, Micros Cash Payment Module).                                                        |
| Do Not Batch        | Select **False**.                                                                                                                             |
| Run As Service      | Select either **True** or **False** to indicate whether you want to run the Micros Cash Payment Module module as a Service Host service. If you select **False**, the cash module runs directly on Ops. |
| Show Change Due Dialog | If you want to show a change due dialog in Ops, select **True**.                                                                          |

8. Click **Save**.

9. Select the Enterprise or property, click **Configuration**, and **Tender/Media**.

10. Insert a record and name it **Cash**.

11. Double-click the Cash record to open it.

12. On the General tab, in the **Key Type** field, select option **1 - Payment**.

13. Click the Options tab, and the Printing Options sub-tab.

14. Select options **8 - Print Customer Receipt** and **21 - Print Summary Totals**.
Credit Card Tokenization

Credit card tokenization helps to protect merchants from credit card theft. Tokenization technology replaces the customer’s credit card number with a different identifier to uniquely distinguish the customer’s credit card during settlement of a transaction. This technology eliminates the need to store credit card numbers on persistent media on the merchant’s site. All sensitive information that is stored for credit card processing is kept off site.

Encryption technology is used to store customer credit card data. While the encryption technology is secure, it requires ongoing maintenance tasks to maintain the security. Managing this technology can be cumbersome for merchants. Many smaller merchants do not typically employ Management Information System (MIS) staff to monitor networks and security infrastructure. Larger Enterprise clients can incur large auditing charges to verify that each property is compliant with Payment Card Industry Data Security Standards (PCI DSS).

In a typical restaurant payment scenario, a server picks up a guest check with the credit card to be used for payment. The server swipes the credit card on the Point of Sale (POS) application and the credit authorization with the credit card number is sent to the credit card payment processor. The payment processor returns a valid authorization code and, along with the payment, a token is also returned to identify the credit card during the transaction’s settlement. Any record of the original card number, expiration date, and track data is erased from memory. When the voucher prints, all that remains is the last four digits of the original credit card number and a token that identifies the card to the payment processor for future operations.

Consider the same transaction, but with the network connection to the credit card processor offline. In this case, the server must manually authorize the credit card and the credit card payment processor cannot provide a token. The credit card data must be stored until a token can be acquired by the POS system (usually at transaction settlement time). At that point the sensitive credit card information is purged from the application.

<table>
<thead>
<tr>
<th>Loadable Credit Card Driver</th>
<th>Requires Tokenization?</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAPMS</td>
<td>Optional</td>
</tr>
<tr>
<td>Dollars on the Net by Shift4</td>
<td>Yes</td>
</tr>
<tr>
<td>Fusebox by Elavon</td>
<td>Optional (Elavon sets tokenization)</td>
</tr>
<tr>
<td>VisaD</td>
<td>No</td>
</tr>
</tbody>
</table>

**Table 5-3  Loadable Credit Card Tokenization**

**Loadable Payment Card Configuration Tasks**

Setting up a loadable payment driver consists of completing the tasks listed in the following table:

15. Click **Save**.

Related Topics

- Adding Payment Keys to the Transaction Page
Table 5-4  Loadable Payment Card Configuration Tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reading configuration prerequisites</td>
<td>Configuration Prerequisites</td>
</tr>
</tbody>
</table>
| (If applicable) Vendor installing third-party gateway application or communication method | • Universal Transaction Gateway (required for Dollars on the Net by Shift4)  
• Communication Methods for Fusebox Payment Card Driver |
| Configuring the loadable payment driver                            | Configuring the Payment Card Driver:                   |
| Configuring the loadable payment card module                       | • CAPMS                                                |
|Configuring the payment device                                      | • Dollars on the Net                                   |
| Configuring the loadable payment card module                       | • Fusebox                                              |
| Creating Front of House loadable payment card buttons                | Creating Front of House Loadable Payment Card Buttons  |
| (Optional) Setting Automatic Event Tasks                            | Autosequence Events                                    |
| (If applicable) Distributing a third-party payment card driver package | Distributing a Third-Party Credit Card Driver Package |

Related Topics

- Configuring the Dollars on the Net Payment Card Driver
- Configuring the Dollars on the Net Payment Module

Loadable Payment Configuration Prerequisites

Before configuring the loadable payment card driver and module, perform the following actions:
• Install Simphony version 2.6 or later at the property.

• Obtain access to the Enterprise Management Console (EMC) within Simphony.

• Ensure that you have the Value Added Reseller (VAR) sheet from a CAPMS payment processing vendor representative. The VAR sheet contains the property information, such as the Bank Identification Number, Merchant Number, Store Number, and Terminal Number.

• (If Applicable) Implement custom payment or device drivers. The Distributing Third-Party Credit Card Driver CAL Packages section contains instructions.

Related Topics
• Configuring the Dollars on the Net Payment Card Driver
• Configuring the Dollars on the Net Payment Module

Related Topics
• Installing stunnel at a Single Host Location
• Installing stunnel Through Simphony as a CAL Package
• Configuring the Fusebox Payment Card Driver
• Configuring the Fusebox Payment Module

Related Topics
• Configuring the CAPMS Payment Card Driver
• Configuring the CAPMS Payment Module

Related Topics
• Configuring the VisaD Payment Card Driver
• Configuring the VisaD Payment Module

Universal Transaction Gateway for Shift4

The Universal Transaction Gateway (UTG) is necessary for communication between Simphony and Dollars on the Net by Shift4. Obtain the Internet Protocol (IP) address of each computer that processes credit card transactions, and provide this list to the Shift4 representative. A Shift4 representative must install the UTG:

• On only one machine at a property. (Do not install UTG on each workstation.)

• Before you can configure the Shift4 loadable payment card driver in Simphony.

A Shift4 representative must also install and configure one instance of the UTG at the Oracle Hospitality Hosting Center to support all batching activity. Depending on the transaction volume, you can implement additional UTGs in the Hosting Center to handle the required daily transactions.

UTG does not run on the Windows CE operating system.

Related Topics
• Configuring the Dollars on the Net Payment Card Driver
• Configuring the Dollars on the Net Payment Module
Communication Methods for Fusebox Payment Card Driver

You can implement one of the following communication methods to process credit cards with the Fusebox payment card driver:

- Fusebox solution through stunnel
- ProtoBase Hosted Solution through Virtual Private Network (VPN)

For premise-based implementations, a single VPN can accommodate both authorization and settlement traffic.

Fusebox stunnel

The Fusebox application (Next Generation Hosted Solutions from Elavon) uses the stunnel application as a secure TCP connection between the property and the Elavon Hosting Center. This secure connection allows credit card authorizations and communication between the Oracle Hospitality Hosting Center and the Elavon Hosting Center for settlements. Stunnel is a small application that uses a certificate to establish an SSL connection. You can implement stunnel through a Simphony CAL package. stunnel Installation Methods contains instructions about implementing stunnel.

ProtoBase Hosted Solution

If you use the legacy ProtoBase application, you need to use the ProtoBase Hosted Solution VPN communication method. When you use the ProtoBase Hosted Solution to communicate, establish at least two VPNs.

- Set the first VPN between the property and the ProtoBase Hosting Center. Install and configure a VPN appliance to establish the connection. This connection is used to process credit card authorizations. Contact an Elavon representative for details about this implementation.
- The second VPN appliance resides at the Oracle Hospitality Hosting Center and is used to process all settlements (batching) for the property. If multiple properties exist within an Enterprise organization, you can use a single VPN connection. Contact an Elavon representative for details about this implementation.

Related Topics

- Installing stunnel at a Single Host Location
- Installing stunnel Through Simphony as a CAL Package
- Configuring the Fusebox Payment Card Driver
- Configuring the Fusebox Payment Module

stunnel Installation Methods

Simphony uses the stunnel application to communicate with the Elavon Hosting Center. You can install stunnel on one computer (single host location) at the Enterprise level, or on individual workstations at the property to allow individual connectivity to Fusebox by Elavon. You must install stunnel at the Oracle Hospitality Hosting Center to perform all batching activities.
Single Host Location

Use this method for Oracle Hospitality Hosting Center installations or for properties that want to perform all payment card activity from a single computer. Installing stunnel at a Single Host Location contains instructions for this method.

CAL Package to Each Workstation

Use this method for properties that want to have stunnel installed on each workstation and perform payment card activity from multiple workstations. Installing stunnel Through Simphony as a CAL Package contains instructions for this method.

Related Topics

- Installing stunnel at a Single Host Location
- Installing stunnel Through Simphony as a CAL Package
- Configuring the Fusebox Payment Card Driver
- Configuring the Fusebox Payment Module

Installing stunnel at a Single Host Location

Obtain the Simphony version 2.6 or later installation media to perform the instructions in this section.

1. From the root of the Simphony version 2.6 installation media, browse to \Install\Simphony2\Tools\FuseboxSTunnel.
2. Double-click stunnel.exe. stunnel automatically installs the files under Program Files, Fusebox, stunnel. stunnel installs as a service and is set to automatically start.

Related Topics

- Communication Methods for Fusebox Payment Card Driver
- stunnel Installation Methods
- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites

Installing stunnel Through Simphony as a CAL Package

1. In the EMC, select the Enterprise level, click Setup and CAL Packages.
2. Select Fusebox STunnel in the navigation tree.
3. Click the Deployment Schedules tab.
4. Click Add Deployment.
5. Select 1 - Property/Enterprise in the Deployment Type drop-down list.
6. Select the property in the Property field.
7. Select 0 - Install in the Action to Take drop-down list.
8. Click Save.
Configuring the CAPMS Payment Card Driver

1. In the EMC, select the Enterprise, property, or revenue center, click **Setup** and **Payment Drivers**.
2. Insert a record and enter **CAPMS** as the name.
3. Double-click the record to open it.
4. On the General tab, click the **import from a file** link.
5. Browse to `C:\MICROS\Simphony2\EgatewayService\handlers`, select **CAPMSPayment.dll**, and click **Open**.
6. Click the Configuration tab.
7. In the Assembly/Class section, enter information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the payment driver (for example, CAPMS Payment Driver).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the name of the third-party driver development company. This value appears in the Driver drop-down list.</td>
</tr>
<tr>
<td>Driver ID</td>
<td>Enter <strong>CAPMS</strong>.</td>
</tr>
</tbody>
</table>

8. In the Common Driver Properties section, enter **1** in the following fields:
   - Bank Identification Number
   - Batch Number
   - Merchant Number
   - Store Number
   - Terminal Number

The values in these fields cannot be 0 (zero) or blank.

9. In the Transport Service Properties section, enter information in the following fields:
Table 5-6  Transport Service Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batching Host</td>
<td>Enter the IP address of the machine where the vendor gateway application is installed at the Hosting or Enterprise level. Refer to the third party driver development company for the appropriate value.</td>
</tr>
<tr>
<td>Batching Host Port</td>
<td>Refer to the third party driver development company for the appropriate value.</td>
</tr>
<tr>
<td>Host Timeout</td>
<td>Enter the timeout value in seconds. Setting the value to 0 (zero) equals no timeout. Do not leave this field blank.</td>
</tr>
</tbody>
</table>

10. In the CAPMS Driver Properties section, enter information in the following fields:

Table 5-7  CAPMS Driver Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable RFID</td>
<td>Select False.</td>
</tr>
<tr>
<td>Enable Shift4 Messaging</td>
<td>Select True.</td>
</tr>
<tr>
<td>Enable Tokenization</td>
<td>This setting is based on the vendor configuration. Select True to use tokenized messaging. Select False to use standard non-tokenized messages.</td>
</tr>
<tr>
<td>Interface Name</td>
<td>Refer to the third party driver development company for the appropriate value.</td>
</tr>
<tr>
<td>Message Version</td>
<td>Refer to the third party driver development company for the appropriate value.</td>
</tr>
</tbody>
</table>
| Non-Tokenized Authorization Reversal Method | If you set Enable Tokenization to False, select one of the following standard messaging options:  
• Expire – Do nothing with the authorization reversal request.  
• Send – Send the authorization reversal request.  
• ZeroSale – Send $0.00 sale as the authorization reversal request. |
| Send Issue Number          | Select False.                                                                |
| Send Start Date            | Select False.                                                                |

11. Click Save.

Related Topics

- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites

Configuring the CAPMS Payment Module

1. In the EMC, select the Enterprise level, click Setup and Payments.
2. Insert a record and enter Credit Card as the name. If a Credit Card payment record exists, skip this step.
3. Double-click the record to open it.

4. On the General tab, click the **Import from a file** link.

5. Browse to C:\MICROS\Simphony2\EgatewayService\handlers, select `Micros.Payment.LoadableCreditCardModule.dll`, and click **Open**.

6. Select **CAPMS** from the **Driver** drop-down list.

7. Select the appropriate device from the **Device** drop-down list.
   - Select **Internal** for Oracle Hospitality devices.
   - Select the third-party device if the property is using a custom device driver.

8. Click the Configuration tab.

9. In the Common Properties section, enter information in the following fields:

   **Table 5-8 Common Properties Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Manual Authorization Credit Card</td>
<td>This field indicates whether manual authorization of credit cards is allowed. Select True for processors using the CAPMS driver.</td>
</tr>
<tr>
<td>Allow Partial Settlement On Batch</td>
<td>Select False for processors using the CAPMS driver.</td>
</tr>
<tr>
<td>Do Not Batch</td>
<td>This field indicates whether batch creation and settlement occurs within Simphony. Select False for processors using the CAPMS driver.</td>
</tr>
<tr>
<td>Encrypt Data</td>
<td>Select True for processors using the CAPMS driver.</td>
</tr>
<tr>
<td>Manual Card Data Entry Retries</td>
<td>This field indicates the number of times a workstation operator can attempt to manually enter a card number. Oracle Hospitality recommends entering 5. The minimum value is 1.</td>
</tr>
<tr>
<td>Offline Authorizations</td>
<td>This field indicates the number of offline card authorizations allowed before the application attempts to re-establish online communication.</td>
</tr>
<tr>
<td>Prompt for Manual Card Data Entry</td>
<td>This field indicates whether workstation operators can manually enter a card number. Select True for processors using the CAPMS driver.</td>
</tr>
<tr>
<td>Retry Authorization Reversals On Batch</td>
<td>Select False for processors using the CAPMS driver.</td>
</tr>
<tr>
<td>Run As Service</td>
<td>Select False for processors using the CAPMS driver.</td>
</tr>
</tbody>
</table>

10. Click **Save**.

11. (Optional) If you need to configure CAPMS payment driver settings that are unique to the property or revenue center, continue with the following steps.

12. Select the property or revenue center, click **Setup** and **Payment Drivers**.
13. Double-click the CAPMS record to open it.

14. On the General tab, click the **Override this record** link, and then click **Yes**.

15. Click the Configuration tab.

16. If the property or revenue center values differ from those set at the Enterprise level in the Common Driver Properties section, enter property information in the fields.

   Ensure that you have the Value Added Reseller (VAR) sheet from a CAPMS payment processing vendor representative. The VAR sheet contains the property information, such as the Bank Identification Number, Merchant Number, Store Number, and Terminal Number.

17. If the property or revenue center values differ from those set at the Enterprise level in the Transport Service Properties section, enter property information in the fields.

18. Click **Save**.

**Related Topics**

- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites

---

## Configuring the Dollars on the Net Payment Card Driver

1. In the EMC, select the Enterprise, property, or revenue center, click **Setup** and **Payment Drivers**.

2. Insert a record and enter **DOTN** as the name.

3. Double-click the record to open it.

4. On the General tab, click the **Import from a file** link.

5. Browse to C:\MICROS\Simphony2\EgatewayService\handlers, select **DOTNPayment.dll**, and click **Open**.

6. Click the Configuration tab.

7. In the Assembly/Class section, enter information in the following fields:

   **Table 5-9   Assembly/Class Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the payment driver (for example, Dollars on the Net Payment Driver).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the name of the third-party driver development company (for example, Shift4). This value appears in the Driver drop-down list.</td>
</tr>
<tr>
<td>Driver ID</td>
<td>Enter <strong>DOTN</strong>.</td>
</tr>
</tbody>
</table>

8. In the Common Driver Properties section, enter **1** in the following fields:
   - Bank Identification Number
   - Batch Number
   - Merchant Number
   - Store Number
• Terminal Number
  The values in these fields cannot be 0 (zero) or blank.

9. In the Transport Service Properties section, enter information in the following fields:

   Table 5-10  Transport Service Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batching Host</td>
<td>Enter the IP address of the machine where the Universal Transaction Gateway (UTG) application is installed at the Hosting or Enterprise level. Refer to the third party driver development company for the appropriate value.</td>
</tr>
<tr>
<td>Batching Host Port</td>
<td>Enter <strong>17476</strong>. Refer to the Shift4 company if you want to use a different port.</td>
</tr>
<tr>
<td>Host Timeout</td>
<td>Enter the timeout value in seconds. Setting the value to 0 (zero) equals no timeout. Do not leave this field blank.</td>
</tr>
<tr>
<td>Primary Host</td>
<td>Enter the IP address of the machine at the property that runs the UTG application. If you enter <strong>0.0.0.0.</strong>, the actual IP address of the workstation at the property is required when you set the override.</td>
</tr>
<tr>
<td>Primary Host Port</td>
<td>Enter <strong>17476</strong>. Refer to the Shift4 company if you want to use a different port.</td>
</tr>
</tbody>
</table>

10. In the Shift4 Driver Properties section, enter **MICROS_SIMP2** in the **VendorID** field.
    This is the Interface Identifier that Shift4 uses to recognize the interface sending the message.

11. Click **Save**.

   Related Topics
   • Universal Transaction Gateway for Shift4
   • Loadable Payment Card Configuration Tasks
   • Loadable Payment Configuration Prerequisites

### Configuring the Dollars on the Net Payment Module

1. In the EMC, select the Enterprise level, click **Setup** and **Payments**.
2. Insert a record and enter **Credit Card** as the name. If a Credit Card payment record exists, skip this step.
3. Double-click the record to open it.
4. On the General tab, click the **Import from a file** link.
5. Browse to C:\MICROS\Simphony2\EgatewayService\handlers, select **Micros.Payment.LoadableCreditCardModule.dll**, and click **Open**.
6. Select **DOTN** from the **Driver** drop-down list.
7. Select the appropriate device from the **Device** drop-down list.
- Select **Internal** for Oracle Hospitality devices.
- Select the third-party device if the property is using a custom device driver.

8. Click the Configuration tab.

9. In the Common Properties section, enter information in the following fields:

### Table 5-11  Common Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Manual Authorization Credit Card</td>
<td>This field indicates whether manual authorization of credit cards is allowed. Select <strong>True</strong> for processors using the Shift4 driver.</td>
</tr>
<tr>
<td>Allow Partial Settlement On Batch</td>
<td>Select <strong>True</strong> for processors using Dollars on the Net by Shift4.</td>
</tr>
<tr>
<td>Do Not Batch</td>
<td>This field indicates whether batch creation and settlement occurs within Simphony. Select <strong>False</strong> for processors using the Shift4 driver.</td>
</tr>
<tr>
<td>Encrypt Data</td>
<td>Select <strong>True</strong> for processors using the Shift4 driver.</td>
</tr>
<tr>
<td>Manual Card Data Entry Retries</td>
<td>This field indicates the number of times a workstation operator can attempt to manually enter a card number. Oracle Hospitality recommends entering 5. The minimum value is 1.</td>
</tr>
<tr>
<td>Offline Authorizations</td>
<td>This field indicates the number of offline card authorizations allowed before the application attempts to re-establish online communication.</td>
</tr>
<tr>
<td>Prompt for Manual Card Data Entry</td>
<td>This field indicates whether workstation operators can manually enter a card number. Select <strong>True</strong> for processors using the Shift4 driver.</td>
</tr>
<tr>
<td>Retry Authorization Reversals On Batch</td>
<td>Select <strong>False</strong> for processors using the Shift4 driver.</td>
</tr>
<tr>
<td>Run As Service</td>
<td>Select <strong>False</strong> for processors using the Shift4 driver.</td>
</tr>
</tbody>
</table>

10. Click **Save**.

11. Select the property, click **Setup** and **Payment Drivers**.

12. Double-click the **DOTN** record to open it.

13. On the General tab, click the **Override this record** link, and then click **Yes**.

14. Click the Configuration tab.

15. If the property or revenue center values differ from those set at the Enterprise level in the Common Driver Properties section, enter property information in the fields. For example, Shift4 assigns a Merchant ID Number for the property, and you can enter it here.
16. In the Transport Service Properties section **Batching Host** field, enter the IP address of the computer where the UTG application is installed at the Hosting Center.

17. In the **Primary Host** field, enter the IP address of the computer with the UTG application installed at the property.

18. In the Shift4 Driver Properties section, enter information in the following fields:

### Table 5-12 Shift4 Driver Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APIPassword</td>
<td>Shift4 assigns the password which is unique to the property and pairs it with the APISerialNumber.</td>
</tr>
<tr>
<td>APISerialNumber</td>
<td>Shift4 assigns the password which is unique to the property and pairs it with the APIPassword.</td>
</tr>
<tr>
<td>ZipCode</td>
<td>Enter the zip code of the property assigned by Shift4.</td>
</tr>
</tbody>
</table>

19. Click **Save**.

**Related Topics**

- Universal Transaction Gateway for Shift4
- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites

### Configuring the Fusebox Payment Card Driver

1. In the EMC, select the Enterprise, property, or revenue center, click **Setup** and **Payment Drivers**.

2. Insert a record and enter **Fusebox** as the name.

3. Double-click the record to open it.

4. On the General tab, click the **Import from a file** link.

5. Browse to C:\MICROS\Simphony2\EgatewayService\handlers, select **FuseboxPayment.dll**, and click **Open**.

6. Click the Configuration tab.

7. In the Assembly/Class section, enter information in the following fields:

### Table 5-13 Assembly/Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the payment driver (for example, Fusebox Payment Driver).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the name of the third-party driver development company (for example, Elavon). This value appears in the Driver drop-down list.</td>
</tr>
<tr>
<td>Driver ID</td>
<td>Enter <strong>FB</strong>.</td>
</tr>
</tbody>
</table>
8. In the Common Driver Properties section, enter 1 in the following fields:
   • Bank Identification Number
   • Batch Number
   • Merchant Number
   • Store Number
   • Terminal Number

   The values in these fields cannot be 0 (zero) or blank.

9. In the Transport Service Properties section, enter information in the following fields:

   **Table 5-14  Transport Service Properties Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batching Host</td>
<td>• If you are using the Fusebox solution, enter the IP address of the machine where the stunnel application is installed.</td>
</tr>
<tr>
<td></td>
<td>• If you are using ProtoBase, enter the IP address of the ProtoBase Hosted Solution provided by the Elavon representative for settlement transactions.</td>
</tr>
<tr>
<td>Batching Host Port</td>
<td>• Enter 10001 for Fusebox.</td>
</tr>
<tr>
<td></td>
<td>• Contact the Elavon representative for the ProtoBase Hosted Solution port number for settlement transactions.</td>
</tr>
<tr>
<td>Host Timeout</td>
<td>Enter the timeout value in seconds. Setting the value to 0 (zero) equals no timeout. Do not leave this field blank.</td>
</tr>
<tr>
<td>Primary Host</td>
<td>Enter the IP address of the machine that runs the stunnel application.</td>
</tr>
<tr>
<td></td>
<td>• If stunnel is installed per workstation, enter 127.0.0.1.</td>
</tr>
<tr>
<td></td>
<td>• If stunnel is installed on a single workstation at the property, leave this field blank.</td>
</tr>
<tr>
<td></td>
<td>• If the property is using ProtoBase, enter the IP address of the ProtoBase Hosted Solution provided by the Elavon representative for authorizations.</td>
</tr>
<tr>
<td>Primary Host Port</td>
<td>• Enter 10001 for Fusebox.</td>
</tr>
<tr>
<td></td>
<td>• Contact the Elavon representative for the ProtoBase Hosted Solution port number for authorizations.</td>
</tr>
</tbody>
</table>

10. In the Elavon Driver Properties section, enter information in the following fields:
Table 5-15  Elavon Driver Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chain Code</td>
<td>Elavon assigns the six-character alphanumeric code, which is used for key management in gateway environments. The Chain Code is used with Fusebox, but not with ProtoBase.</td>
</tr>
<tr>
<td>LocationName</td>
<td>If Elavon supplied a Location Name or Source IP Address to pass from the Point-of-Sale (POS), enter it here. This value passes on every transaction and can be the location name or Fusebox workstation. You can leave this field blank. The LocationName is used with Fusebox, but not with ProtoBase.</td>
</tr>
<tr>
<td>TerminationID</td>
<td>Enter the terminal code assigned by Elavon for the property to use with credit cards.</td>
</tr>
<tr>
<td>TransactionInquiryRetryDelayTimeoutMS</td>
<td>After a communication failure with Fusebox, Simphony sends an inquiry to Fusebox to discover the cause of failure. This value is the amount of time Simphony waits before sending the request when a failure occurs. Oracle Hospitality recommends entering 5000.</td>
</tr>
</tbody>
</table>

11. Click **Save**.

**Related Topics**

- Communication Methods for Fusebox Payment Card Driver
- stunnel Installation Methods
- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites

**Configuring the Fusebox Payment Module**

1. In the EMC, select the Enterprise level, click **Setup** and **Payments**.
2. Insert a record and enter **Credit Card** as the name. If a Credit Card payment record exists, skip this step.
3. Double-click the record to open it.
4. On the General tab, click the **Import from a file** link.
5. Browse to C:\MICROS\Symphony2\EgatewayService\handlers, select Micros.Payment.LoadableCreditCardModule.dll, and click **Open**.
6. Select **Fusebox** from the **Driver** drop-down list.
7. Select the appropriate device from the **Device** drop-down list.
   - Select **Internal** for Oracle Hospitality devices.
   - Select the third-party device if the property is using a custom device driver.
8. Click the Configuration tab.
9. In the Common Properties section, enter information in the following fields:
Table 5-16  Common Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Manual Authorization Credit Card</td>
<td>This field indicates whether manual authorization of credit cards is allowed. Select <strong>True</strong> for processors using the Fusebox driver.</td>
</tr>
<tr>
<td>Allow Partial Settlement On Batch</td>
<td>Select <strong>False</strong> for processors using the Fusebox driver.</td>
</tr>
<tr>
<td>Do Not Batch</td>
<td>This field indicates whether batch creation and settlement occurs within Simphony. Select <strong>False</strong> for processors using the Fusebox driver.</td>
</tr>
<tr>
<td>Encrypt Data</td>
<td>Select <strong>True</strong> for processors using the Fusebox driver.</td>
</tr>
<tr>
<td>Manual Card Data Entry Retries</td>
<td>This field indicates the number of times a workstation operator can attempt to manually enter a card number. Oracle Hospitality recommends entering <strong>5</strong>. The minimum value is <strong>1</strong>.</td>
</tr>
<tr>
<td>Offline Authorizations</td>
<td>This field indicates the number of offline card authorizations allowed before the application attempts to re-establish online communication.</td>
</tr>
<tr>
<td>Prompt for Manual Card Data Entry</td>
<td>This field indicates whether workstation operators can manually enter a card number. Select <strong>True</strong> for a card number. Select <strong>True</strong> for the Fusebox driver.</td>
</tr>
<tr>
<td>Retry Authorization Reversals On Batch</td>
<td>Select <strong>False</strong> for processors using the Fusebox driver.</td>
</tr>
<tr>
<td>Run As Service</td>
<td>Select <strong>False</strong> for processors using the Fusebox driver.</td>
</tr>
</tbody>
</table>

10. Click **Save**.

11. (Optional) If you need to configure Fusebox payment driver settings that are unique to the property or revenue center, continue with the following steps.

12. In the EMC, select the property or revenue center, click **Setup** and **Payment Drivers**.

13. Double-click the **Fusebox** record to open it.

14. On the General tab, click the **Override this record** link, and then click **Yes**.

15. Click the Configuration tab.

16. If stunnel is installed on a single workstation at the property, enter the **Primary Host** in the Transport Service Properties section. This is the IP address of the machine that houses stunnel for Fusebox, or the IP address for authorizations to the ProtoBase Hosted Solution.

17. In the Elavon Driver Properties section, enter information in the following fields:
Table 5-17  Elavon Driver Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chain Code</td>
<td>Elavon assigns the six-character alphanumeric code, which is used for key management in gateway environments. The Chain Code is used with Fusebox, but not with ProtoBase.</td>
</tr>
<tr>
<td>LocationName</td>
<td>If Elavon supplied a Location Name or Source IP Address to pass from the Point-of-Sale (POS), enter it here. This value passes on every transaction and can be the location name or Fusebox workstation. You can leave this field blank. The LocationName is used with Fusebox, but not with ProtoBase.</td>
</tr>
<tr>
<td>TerminationID</td>
<td>Enter the terminal code assigned by Elavon for the property to use with credit cards.</td>
</tr>
<tr>
<td>TransactionInquiryRetryDelayTimeoutMS</td>
<td>After a communication failure with Fusebox, Simphony sends an inquiry to Fusebox to discover the cause of failure. This value is the amount of time Simphony waits before sending the request when a failure occurs. Oracle Hospitality recommends entering 5000.</td>
</tr>
</tbody>
</table>

18. Click **Save**.

Related Topics

- Communication Methods for Fusebox Payment Card Driver
- stunnel Installation Methods
- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites

Configuring the VisaD Payment Card Driver

1. In the EMC, select the Enterprise, property, or revenue center, click **Setup and Payment Drivers**.
2. Insert a record and enter **VisaD** as the name.
3. Double-click the record to open it.
4. On the General tab, click the **Import from a file** link.
5. Browse to C:\MICROS\Symphony2\EgatewayService\Handlers, select **VisaDPayment.dll**, and click **Open**.
6. Click the Configuration tab.
7. In the Assembly/Class section, enter information in the following fields:
Table 5-18   Assembly/Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the payment driver (for example, VisaD Payment Driver).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the name of the third-party driver development company (for example, MerchantLink). This value appears in the Driver drop-down list.</td>
</tr>
<tr>
<td>Driver ID</td>
<td>Enter VISAD.</td>
</tr>
</tbody>
</table>

8. In the Common Driver Properties section, enter 1 in the following fields:
   - Bank Identification Number
   - Batch Number
   - Merchant Number
   - Store Number
   - Terminal Number
   The values in these fields cannot be 0 (zero) or blank.

9. In the Transport Service Properties section, enter information in the following fields:

Table 5-19   Transport Service Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Timeout</td>
<td>Enter the timeout value in seconds. Setting the value to 0 (zero) equals a 30-second timeout. Do not leave this field blank. Oracle recommends entering 60. This field applies only to Win32 machines. You cannot change the timeout from the default setting of 100 seconds on WinCE machines.</td>
</tr>
<tr>
<td>Primary Host</td>
<td>Enter the uniform resource locator (URL) of the payment provider application. For MerchantLink, enter g1.merchantlink.com.</td>
</tr>
<tr>
<td>Primary Host Port</td>
<td>Enter the port number used for the Primary Host. For MerchantLink, enter 443.</td>
</tr>
<tr>
<td>Request URI</td>
<td>If applicable, enter the Uniform Resource Identifier (URI) for the payment provider. For MerchantLink, enter /Micros/process_transaction.cgi.</td>
</tr>
<tr>
<td>Secondary Host</td>
<td>Enter the URL of the payment provider application. For MerchantLink, enter g2.merchantlink.com.</td>
</tr>
<tr>
<td>Secondary Host Port</td>
<td>Enter the port number used for the Secondary Host. For MerchantLink, enter 443.</td>
</tr>
</tbody>
</table>

10. In the VisaD Driver Properties section, enter 9999 in the Max Batch Records field.

11. Click Save.

Related Topics
- Loadable Payment Card Configuration Tasks
Loadable Payment Configuration Prerequisites

Configuring the VisaD Payment Module

1. In the EMC, select the Enterprise level, click Setup and Payments.
2. Insert a record and enter Credit Card as the name. If a Credit Card payment record exists, skip this step.
3. Double-click the record to open it.
4. On the General tab, click the Import from a file link.
5. Browse to C:\MICROS\Symphony2\EgatewayService\handlers, select Micros.Payment.LoadableCreditCardModule.dll, and click Open.
6. Select VisaD from the Driver drop-down list.
7. Select the appropriate device from the Device drop-down list.
   - Select Internal for Oracle Hospitality devices.
   - Select the third-party device if the property is using a custom device driver.
8. Click the Configuration tab.
9. In the Common Properties section, enter information in the following fields:

Table 5-20 Common Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Manual Authorization Credit Card</td>
<td>This field indicates whether manual authorization of credit cards is allowed. Select True for processors using the VisaD driver.</td>
</tr>
<tr>
<td>Allow Partial Settlement On Batch</td>
<td>Select False for processors using the VisaD driver.</td>
</tr>
<tr>
<td>Do Not Batch</td>
<td>This field indicates whether batch creation and settlement occurs within Simphony. Select False for processors using the VisaD driver.</td>
</tr>
<tr>
<td>Encrypt Data</td>
<td>Select True for processors using the VisaD driver.</td>
</tr>
<tr>
<td>Manual Card Data Entry Retries</td>
<td>This field indicates the number of times a workstation operator can attempt to manually enter a card number. Oracle Hospitality recommends entering 5. The minimum value is 1.</td>
</tr>
<tr>
<td>Offline Authorizations</td>
<td>This field indicates the number of offline card authorizations allowed before the application attempts to re-establish online communication.</td>
</tr>
<tr>
<td>Prompt for Manual Card Data Entry</td>
<td>This field indicates whether workstation operators can manually enter a card number. Select True for processors using the VisaD driver.</td>
</tr>
<tr>
<td>Retry Authorization Reversals On Batch</td>
<td>Select False for processors using the VisaD driver.</td>
</tr>
</tbody>
</table>
Table 5-20  (Cont.) Common Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run As Service</td>
<td>Select <strong>False</strong> for processors using the VisaD driver.</td>
</tr>
</tbody>
</table>

10. Click **Save**.

11. (Optional) If you need to configure VisaD payment driver settings that are unique to the property or revenue center, continue with the following steps.

12. Select the property or revenue center, click **Setup** and **Payment Drivers**.

13. Double-click the **VisaD** record to open it.

14. On the General tab, click the **Override this record** link, and then click **Yes**.

15. Click the Configuration tab.

16. If the property or revenue center values differ from those set at the Enterprise level in the Transport Service Properties section, enter property information in the fields.

   Ensure that you have the Value Added Reseller (VAR) sheet from a VisaD payment processing vendor representative. The VAR sheet contains the property information, such as the Agent Bank Number, Industry Type, Merchant Category, and Time Zone.

17. In the VisaD Driver Properties section, enter values in all fields based on the VAR sheet information.

18. Click **Save**.

**Related Topics**

- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites

**Configuring the Loadable Payment Card Device**

The payment module generally uses payment devices containing internal drivers (for example, magnetic stripe reader (MSR) or radio-frequency identification (RFID)) that are compatible with Simphony and accept payment card information. If this is the case, skip the instructions in this section.

If the payment module uses a physical input device containing a custom driver that is not supported with Simphony, you must configure the third-party device driver to allow communications between the device and Simphony.

1. In the EMC, select the Enterprise level, click **Setup** and **Payment Device**.

2. Insert a record and enter the device name.

3. Double-click the record to open it.

4. On the General tab, click the **Import from a file** link.

5. Browse to C:\MICROS\Simphony2\GatewayService\handlers, select [ThirdPartyProvider].dll, and click **Open**.

6. Click the Configuration tab.

7. In the Assembly/Class section, enter information in the following fields:
Creating Front of House Loadable Payment Card Buttons

Oracle Hospitality recommends that you create payment card buttons on a page for the loadable payment card functions.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Page Design.
2. Open the Front of House page on which to place loadable payment card buttons.
3. On the Edit tab, select the page area in which to define the loadable payment card functions (typically the payment area).
4. Click Payments.
5. On the General sub-tab, select Payment Tenders from the Type drop-down list.
6. Click the black arrow beneath the Type drop-down.
7. On the Select Tender/Media Payment dialog, select the payment tender you want and click OK.
   Select None if you want to use all types of credit cards.
8. On the Payment Configuration dialog, select CreditDebit:Loadable from the Payment Type drop-down list.
9. Select the function you want from the Functions drop-down list (for example, CreditAuthAndPay).
10. Position and size the button on the page. Use the Style arrow to change the color.
11. In the Legend field, enter the button name.
12. Repeat Steps 7 through 11 for each type of payment tender.
13. Click Save.

Distributing a Third-Party Credit Card Driver Package

Custom third-party credit card payment device drivers do not automatically install along with the Simphony Enterprise Management Console (EMC) installation. Consequently, the configuration for the third-party drivers is not available in the EMC. Complete the following tasks in EMC to configure third-party payment device drivers:

- Manually copy the third-party payment .DLL files to the correct installation directories on the Application Server where Server EMC or Remote EMC is
Copying Third-Party Payment Driver Files

1. After you receive the CreditDriverPackage.zip from the third-party vendor, unzip it to a location.

2. Copy the CreditCardDrivers2.0 folder from the \CreditDriverPackage\CE directory and place it in the following folders on the Application Server:
   - \MICROS\Simphony2\EgatewayService\CAL\WS5A\Packages
   - \MICROS\Simphony2\EgatewayService\CAL\WS55\Packages

3. Copy the CreditCardDrivers2.0 folder from the \CreditDriverPackage\WIN32 directory and place it in the following folder on the Application Server:
   - \MICROS\Simphony2\EgatewayService\CAL\Win32\Packages

4. Open the CreditCardDrivers2.0 folder in the \MICROS\Simphony2\EgatewayService\CAL\Win32\Packages directory and copy all of the files to the following directories on the Application Server, with the exception of the Setup.dat file. Do not copy the Setup.dat file to these directories.
   - \MICROS\Simphony2\EgatewayService\handlers
   - \MICROS\Simphony\EgatewayService\Download\EMCClient

5. Copy the correct third-party payment .DLL files to the appropriate installation directory on the Application Server where Server EMC or Remote EMC is installed.
   - Server EMC
     - Copy custom .DLL files to \MICROS\Simphony2\EgatewayService\handlers
   - Remote EMC
     - Copy custom .DLL files to \MICROS\EMC\EMCClient

Related Topics

- Distributing a Third-Party Credit Card Driver Package
- Creating a CAL Package for the Third-Party Payment Card Driver Distribution

Creating a CAL Package for the Third-Party Payment Card Driver Distribution

Create a Client Application Loader (CAL) package in the Enterprise Management Console (EMC). See Understanding CAL Packages for instructions to create and upload the CAL package.
Credit Card Batching

Credit card batches are typically created and settled automatically using a PC Autosequence during the Start of Day (SOD) process. You can manually create, edit, and settle credit card batches from the Enterprise Management Console (EMC) in special situations, such as:

- When the property wants to batch multiple times per day, at various times
- During troubleshooting

Related Topics

- Creating a Credit Card Batch
- Editing a Credit Card Batch
- Settling a Credit Card Batch

Creating a Credit Card Batch

1. In the EMC, select a property, click Tasks and Create Batch.
2. (Optional) Enter information about the batch you are creating in the Comment field.
3. If you want to create a batch for yesterday’s totals and all dates prior to yesterday, select Yesterday.
4. If you want to create a batch only for today’s totals up to the current time, select Current Totals.
5. If you want to create a batch for the entire property, select All in the Revenue Centers section.
6. If you want to create a batch only for the totals of a particular revenue center, select Selected, and select a revenue center from the list.
7. If you want to revert the changes that you made and use the default selections, click Default.
8. Click Create.

 Related Topics

- Credit Card Batching

Editing a Credit Card Batch

1. In the EMC, select a property, click Tasks and Edit Batch.
2. Click Select adjacent to the Batch field, select a batch, and click Select.
3. If you want to refine the search results, use the Employee, Revenue Center, Card Holder, and Check Number filters.
The card holder name is often encrypted on the card and is not stored in the Transaction database. Therefore, it is not always possible to use this as a search parameter.

4. Click **Search**.
5. Click **Edit** near the relevant credit card record.
6. Make the changes, and click **Save**.

**Related Topics**
- Credit Card Batching

## Settling a Credit Card Batch

1. In the EMC, select a property, click **Tasks** and **Transfer Batch**.
2. Click **Select**, select one or more batches to transfer, and then click **Transfer**.

**Related Topics**
- Credit Card Batching

## Credit Card Preamble

A credit card preamble—sometimes called a credit card prefix, issuer identification number (IIN), or bank identification number (BIN)—is a digit or series of digits at the beginning of a credit card number that identifies the type of card or company that issued the card.

**Related Topics**
- Credit Card Preamble Rules

## Credit Card Preamble Rules

Adhere to the following rules that govern a valid credit card preamble:

- The **Start** and **End** preambles must end with an asterisk (*) (for example, 304*).
- The number of digits in the **Start** and **End** fields must be the same.
- The number of digits in the **Start** and **End** fields cannot exceed the **Length** defined.
- The value of the **End** field must be greater than the value of the **Start** field.

**Related Topics**
- Updating Standard Credit Card Preambles
- List of Standard Credit Card Preambles for the U.S.
Updating Standard Credit Card Preambles

1. Click the Enterprise or property, click **Configuration**, and then click **Tender/Media**.

2. Double-click a credit card tender to open it, click the **Options** tab, and then click the **Credit Card Options** subtab.

3. In the Preamble section, click **Add**, and then enter the **Start**, **End**, and **Length** for the preamble.

   If the preamble record defines a range such as 3050 to 3090, the Start field represents the begin range, which is 3050*, and the End field represents the end range, which is 3090*.

   See **List of Standard Credit Card Preambles for the U.S.** for a list of standard credit card preamble ranges for commonly used card types.

4. To add another preamble for the card, Repeat Step 3.

5. Click **Save**.

6. Repeat Steps 2 through 5 for other credit card payment types.

**Related Topics**
- Credit Card Preamble
- Credit Card Preamble Rules
- List of Standard Credit Card Preambles for the U.S.

**List of Standard Credit Card Preambles for the U.S.**

The values listed in the following table apply to all US sites. Additional types are accepted in other countries. Contact the local processor for the specific list. Preambles also change as card providers are bought out (for instance, Discover purchased Diner's Club) and should be updated regularly.

**Table 5-22  List of Standard U.S. Credit Card Preambles**

<table>
<thead>
<tr>
<th>Card Type</th>
<th>Start</th>
<th>End</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visa</td>
<td>40000000*</td>
<td>49999999*</td>
<td>16</td>
</tr>
<tr>
<td>MasterCard</td>
<td>51000000*</td>
<td>55999999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>222100*</td>
<td>272099*</td>
<td>16</td>
</tr>
<tr>
<td>American Express</td>
<td>34000000*</td>
<td>34999999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>37000000*</td>
<td>37999999*</td>
<td>15</td>
</tr>
<tr>
<td>Diners Club</td>
<td>36000000*</td>
<td>36999999*</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>38000000*</td>
<td>39999999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>30000000*</td>
<td>30599999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>30950000*</td>
<td>30959999*</td>
<td>16</td>
</tr>
<tr>
<td>JCB</td>
<td>35280000*</td>
<td>35899999*</td>
<td>16</td>
</tr>
</tbody>
</table>
Pay at the Table

This section describes the brief process in which a guest can pay a check using a tablet device, and an overview for setting up Simphony's Pay at the Table (PATT) features.

Guests can use PATT on the following handheld devices:

- Oracle MICROS Table E-Series
- Zebra MC40 (formerly the Motorola MC40) mobile device running on the Android mobile operating system and configured with either an integrated or external magnetic card reader.

After a dining room guest or hotel guest places an order, a server or room service staff member presents a tablet device containing the check to the guest, who can:

- View the check
- Add a tip or change the tip value
- Select a different language
- Share payment among several guests
- Charge menu items to a credit card or room account
- Swipe a credit card, or enter a room number and guest last name
- Sign the check with electronic signature after card authorization
- Enter a valid email address and receive a receipt electronically through email

When a guest charges payment to a room account, Simphony posts the total payment to the OPERA property management system (PMS). The front desk manager can view the payment and signature from Pay at the Table in:

### Table 5-22 (Cont.) List of Standard U.S. Credit Card Preambles

<table>
<thead>
<tr>
<th>Card Type</th>
<th>Start</th>
<th>End</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discover</td>
<td>60110000*</td>
<td>60110999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>60112000*</td>
<td>60114999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>60117400*</td>
<td>60117999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>60117700*</td>
<td>60119999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>64400000*</td>
<td>65999999*</td>
<td>16</td>
</tr>
<tr>
<td>Discover (CUP)</td>
<td>62212600*</td>
<td>62292599*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>62400000*</td>
<td>62699999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>62820000*</td>
<td>62889999*</td>
<td>16</td>
</tr>
</tbody>
</table>

Related Topics

- Credit Card Preamble
- Credit Card Preamble Rules
- Updating Standard Credit Card Preambles
• Oracle Hospitality Reporting and Analytics using the Check Query and Audit and Analysis portlets
• Oracle Hospitality Simphony Reports

Sales executives can demonstrate Pay at the Table features to clients without using a magnetic card or card reader.

Check images, including captured electronic signatures, are available through the Oracle Hospitality Reporting and Analytics Check Query and Audit and Analysis portlets.

Complete the following tasks to set up the Pay at the Table feature.
• Configure the Tenders
• Configure the Payment Drivers
• Configure the Payment Modules
• Create Pay at the Table Buttons for Ops
• Configure Email Receipts
• Configure Languages

Related Topics
• Configuring a Credit Card Tender
• Configuring the Room Tender
• Configuring the OPERA PMS Payment Driver
• Configuring the MICROS Standard Credit Card Payment Module
• Configuring the Loadable PMS Payment Module
• Configuring the Demo Payment
• Setting the Front of House to Allow Pay at the Table
• Configuring Email Receipts

## Configuring a Credit Card Tender

1. In the EMC, select the Enterprise or property, click **Configuration**, and **Tender/Media**.
2. Insert a record and name it based on the credit card company (for example, Visa or MasterCard).
3. Double-click the credit card record to open it.
4. On the General tab, in the **Key Type** field, select option **1 - Payment**.
5. Click the Options tab, and the Printing Options sub-tab.
6. Select options **8 - Print Customer Receipt** and **21 - Print Summary Totals**.
7. Click the Ops Behavior sub-tab.
8. Select option **3 - Assume Paid in Full**.
9. Click **Save**.
Configuring the Room Tender

Configure a room charge tender for guests to charge meals to a hotel room using Oracle Hospitality OPERA.

1. In the EMC, select the Enterprise or property, click Configuration, and Tender/Media.
2. Insert a record and name it PATT Room Charge.
3. Double-click the PATT Room Charge record to open it.
4. On the General tab, in the Key Type field, select option 1 - Payment.
5. Click the Options tab, and the Interface Options sub-tab.
7. Click Save.

Related Topics

• Pay at the Table

Configuring the OPERA PMS Payment Driver

To configure the Oracle Hospitality OPERA 5 Hotel Property Systems payment driver:

1. In the EMC, select the Enterprise, property, or revenue center, click Setup and Payment Drivers.
2. Insert a record and enter OPERA PMS Driver as the name.
3. Double-click the record to open it.
4. On the General tab, click the Import from a file link.
5. Browse to C:\MICROS\Simphony2\GatewayService\handlers, select OperaWSPayment.dll, and click Open.
6. Click the Configuration tab.
7. In the Assembly/Class section, enter information in the following fields:

<table>
<thead>
<tr>
<th>Table 5-23 Assembly/Class Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Display Name</td>
</tr>
<tr>
<td>Driver ID</td>
</tr>
</tbody>
</table>

8. In the Opera Interface Properties section, enter information in the following fields:
### Table 5-24  Opera Interface Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection String</td>
<td>Enter <code>jdbc / operaoperads</code>.</td>
</tr>
<tr>
<td>Interface ID</td>
<td>Enter the OPERA interface ID.</td>
</tr>
<tr>
<td>Opera Tender Number</td>
<td>Enter the Tender/Media object number mapped for the Room Charge.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Resort</td>
<td>Enter the name of the property using OPERA.</td>
</tr>
<tr>
<td>UserName</td>
<td>Enter the user name.</td>
</tr>
<tr>
<td>Web Service</td>
<td>Enter the uniform resource locator (URL) of the OPERA Web Service.</td>
</tr>
</tbody>
</table>

9. Click **Save**.

#### Related Topics
- Pay at the Table

### Configuring the MICROS Standard Credit Card Payment Module

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Setup** and **Payments**.

2. Insert a record and name it based on the payment driver you are using (for example, MCreditDebit).

3. Double-click the record to open it.

4. Select **3 - DLL** in the **Content Type** drop-down list.

5. Select the **Import from a file** link.

6. Browse to `C:\MICROS\Simphony2\EgatewayService\handlers\Micros.Payment.MCreditDebit.dll`, and click **Open**.

7. Click the Configuration sub-tab.

8. In the Assembly/Class section, enter information in the following fields:

#### Table 5-25  Assembly/Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Enter a description for the payment driver (for example, MicrosCreditDebitPaymentModuleStandard).</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the payment driver (for example, Micros Standard Credit/Debit Payment Driver).</td>
</tr>
</tbody>
</table>

9. In the Common Properties section, enter information in the following fields:
Table 5-26 Common Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Manual Authorization Credit Card</td>
<td>This field indicates whether manual authorization of credit cards is allowed. Select <strong>True</strong> for processors using the MICROS standard credit and debit payment driver.</td>
</tr>
<tr>
<td>Allow Partial Settlement On Batch</td>
<td>Select <strong>False</strong> for processors using the MICROS standard credit and debit payment driver.</td>
</tr>
<tr>
<td>Bank Identification Number</td>
<td>Enter the 6-digit bank identification number provided by the bank or processor.</td>
</tr>
<tr>
<td>Batch Number</td>
<td>Enter a value between 1 and 9999 to indicate the next sequence number. The number increments by one each time a new batch is created, and resets to 1 after reaching 999. The bank or processor assigns the value for this field and uses it to detect duplicate batches.</td>
</tr>
<tr>
<td>Do Not Batch</td>
<td>This field indicates whether batch creation and settlement occurs within Simphony. Select <strong>False</strong> for processors using the MICROS standard credit and debit payment driver.</td>
</tr>
<tr>
<td>Encrypt Data</td>
<td>Select <strong>True</strong> for processors using the MICROS standard credit and debit payment module.</td>
</tr>
<tr>
<td>Host Timeout</td>
<td>Enter the timeout value in seconds. Setting the value to 0 (zero) equals a 30-second timeout. Do not leave this field blank. Oracle Hospitality recommends entering <strong>60</strong>.</td>
</tr>
<tr>
<td></td>
<td>This field applies only to Win32 machines. You cannot change the timeout from the default setting of 100 seconds on WinCE machines.</td>
</tr>
<tr>
<td>Merchant Number</td>
<td>Enter the merchant number provided by the bank or processor.</td>
</tr>
<tr>
<td>Offline Authorizations</td>
<td>Enter the number of offline card authorizations allowed before the application attempts to re-establish online communication.</td>
</tr>
<tr>
<td>Primary Host</td>
<td>Enter the uniform resource locator (URL) of the payment provider application. As an example, this field should include something.receiving-url.com. For MerchantLink, enter <strong>g1.merchantlink.com</strong>.</td>
</tr>
<tr>
<td>Primary Host Port</td>
<td>Enter the port number used for the Primary Host. For MerchantLink, enter <strong>443</strong>.</td>
</tr>
<tr>
<td>Prompt for Manual Card Data Entry</td>
<td>This field indicates whether workstation operators can manually enter a card number. Select <strong>True</strong> for processors using the VisaD driver.</td>
</tr>
<tr>
<td>Retry Authorization Reversals On Batch</td>
<td>Select <strong>False</strong> for processors using the MICROS standard credit and debit payment module.</td>
</tr>
<tr>
<td>Run As Service</td>
<td>Select <strong>False</strong> for processors using the MICROS standard credit and debit payment module.</td>
</tr>
<tr>
<td>Store Number</td>
<td>Enter the 4-digit store identification number used to identify the merchant store. The bank or processor assigns the value for this field.</td>
</tr>
<tr>
<td>Terminal Number</td>
<td>Enter the workstation number at the merchant store.</td>
</tr>
</tbody>
</table>
### Table 5-26  (Cont.) Common Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Card Data Entry Retries</td>
<td>This field indicates the number of times a workstation operator can attempt to manually enter a card number. Oracle Hospitality recommends entering 5. The minimum value is 1.</td>
</tr>
<tr>
<td>VisaQ Compatibility</td>
<td>Select False for processors using the MICROS standard credit and debit payment driver.</td>
</tr>
</tbody>
</table>

10. If you are using the VisaD driver, enter information in the VisaD Driver Specific section fields:

### Table 5-27  VisaD Driver Specific Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Bank Number</td>
<td>Enter a six-digit number that identifies the Agent Bank Number. This value identifies the agent of the acquirer which signed the merchant. The acquirer provides this value to the merchant.</td>
</tr>
<tr>
<td>Agent Chain Number</td>
<td>Enter a six-digit number that identifies the Agent Chain Number. This value identifies a specific chain of an agent organization. The merchant's bank or processor provides this number.</td>
</tr>
<tr>
<td>City Code</td>
<td>The city code identifies the merchant's location. Within the United States, enter the five- or nine-digit zip code of the merchant's address. In other countries, the bank or processor assigns the code.</td>
</tr>
<tr>
<td>Country Code</td>
<td>Select the country that identifies where the merchant is located. The bank or processor assigns the value for this field. The United States country code is 840.</td>
</tr>
<tr>
<td>Currency Code</td>
<td>Select the currency that the merchant uses. The bank or processor assigns the value for this field. The United States currency code is 840.</td>
</tr>
<tr>
<td>Enable Card Level Results</td>
<td>Select True to have the the VisaD driver retrieve card-level results during authorization and return the data at settlement.</td>
</tr>
<tr>
<td>Enable POS Data Code</td>
<td>Select True to have the VisaD driver report the POS Data Code at authorization and settlement.</td>
</tr>
<tr>
<td>Include Exp Date And Extra Mag Card Data</td>
<td>Select True to include the expiration date and modified magnetic stripe reader data during settlement.</td>
</tr>
<tr>
<td>Industry Type</td>
<td>Select a value to identify the industry type to the merchant. The bank or processor assigns the value for this field.</td>
</tr>
<tr>
<td>Language Indicator</td>
<td>This field is used to designate the language in which Authorization Response messages should be returned to the workstation for display and printing. The bank or processor assigns the value for this field.</td>
</tr>
</tbody>
</table>
### Table 5-27  (Cont.) VisaD Driver Specific Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Batch Records</td>
<td>Enter the maximum number of records that can be transferred in one batch (for example, 9999). Some banks and driver types can support only a specific number of records during credit card settlement. When you enter 0 (zero), all records are processed in the same batch.</td>
</tr>
<tr>
<td>Merchant Category</td>
<td>Enter the four-digit number assigned by the bank or processor to identify the merchant type.</td>
</tr>
<tr>
<td>Merchant Location</td>
<td>Enter the merchant location or city name provided by the bank or processor. For auditing purposes, the Merchant Location should correspond to the location or city that prints on a credit card voucher.</td>
</tr>
<tr>
<td>Merchant Name</td>
<td>Enter the merchant’s name. For auditing purposes, the Merchant Name should correspond to the name that prints on a credit card voucher.</td>
</tr>
<tr>
<td>Merchant State</td>
<td>Enter the merchant’s state or province code provided by the bank or processor. For auditing purposes, the Merchant State should correspond to the state or province code that prints on a credit card voucher.</td>
</tr>
<tr>
<td>Request URI</td>
<td>If applicable, enter the uniform resource identifier (URI) to use when sending VisaD messages to the processor. For MerchantLink, enter <code>/Micros/process_transaction.cgi</code>.</td>
</tr>
<tr>
<td>Secondary Host</td>
<td>Enter the uniform resource locator (URL) of the secondary host. As an example, this field should include something.receiving-url.com. For MerchantLink, enter <code>g2.merchantlink.com</code>.</td>
</tr>
<tr>
<td>Secondary Host Port</td>
<td>Enter the port number used for the Secondary Host. For MerchantLink, enter 443.</td>
</tr>
<tr>
<td>Send RFID Data</td>
<td>Select True to add RFID-related fields to the message. Some processors require this information to authorize and settle RFID transactions.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Select the code used to calculate the local time within the VisaNet Authorization System. The bank or processor assigns the value for this field.</td>
</tr>
</tbody>
</table>

11. **Click Save.**

**Related Topics**
- Pay at the Table

### Configuring the Loadable PMS Payment Module

Configure a property management system (PMS) payment module for guests to charge meals to a hotel room using Oracle Hospitality OPERA version 5.0.04.01 and later.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Setup**, and **Payments**.
2. Insert a record and name it **LoadablePMS**.
3. Double-click the LoadablePMS record to open it.
4. Click the **Import from a file** link.
5. Browse to MICRO$\text{I}mphony2\text{I}gatewayService\text{I}handlers \text{I}Micros.Payment.LoadablePmsModule.dll, and click **Open**.
6. Click the Configuration sub-tab.
7. Select the **Module Functions** section.
8. Enter the **Configuration Number** for the Room Charge tender record.
9. Select **Payment** as the **Configuration Type**.
10. Click **Save**.

**Related Topics**
- Pay at the Table

---

### Configuring the Demo Payment

Sales executives can use demo mode to demonstrate Pay at the Table features to clients without needing a magnetic card or reader.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Setup** and **Payments**.
2. Insert a record for demo payments (for example, Demo).
3. Double-click the record to open it.
4. Select **3 - DLL** in the **Content Type** drop-down list.
5. Click the **Import from a file** link.
6. Browse to C:\MICROS\Simphony2\gatewayService\handlers \Micros.Payment.CreditDebit.dll, and click **Open**.
7. Click **Save**.

**Related Topics**
- Pay at the Table

---

### Setting the Front of House to Allow Pay at the Table

Depending on the property's Pay at the Table (PATT) payment methods, you need to create the following PATT buttons for the Front of House page:

- **PATT Credit Card** – Create this button if the property allows credit card payments with PATT
- **PATT Room Charge** – Create this button if the property allows room charges with PATT

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.
2. Open the Front of House page on which to place Pay at the Table buttons.
3. On the Edit tab, select the page area in which to define the Pay at the Table functions (typically the payment area).

4. Click Button.

5. On the General sub-tab, enter the button name in the Legend field.

6. Select Function from the Type drop-down.

7. Click the black arrow directly beneath the Type drop-down and select Pay at the Table.

8. Highlight the PATT button.

9. Click the Pay at the Table Config button.

10. (Optional) Select Enable Tip Screen, and enter the Default Tip Percent value. The tip percentage appears to the guest. If you do not want the tip screen to appear to guests, deselect Enable Tip Screen.

11. (Optional) Select Enable Share Payment and enter the Default Share Payment group sizes (for example, 2, 3, 4). This is the default number of people that can share the payment. (If a different number of people want to share payment, the guest can enter the number.) Deselect Enable Share Payment if you do not want guests to share check payment.

12. (Optional) If you want to use Pay at the Table in demonstration mode, select Demo Payment. This allows sales executives to demonstrate Pay at the Table features to clients without needing a magnetic card or reader. Deselect Demo Payment to use Pay at the Table live at a property.

13. In the Select Payment Type area, select the payment type (for example, Credit Card or OPERA) from the Payment Type drop-down.

14. Click the Edit Command link in the Command column.

15. In the Payment Configuration dialog, select the appropriate payment method from the Type drop-down. Click Edit... and then enter the appropriate Command. The following table lists the Types and associated Commands.

### Table 5-28 PATT Payment Methods

<table>
<thead>
<tr>
<th>Type</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credit Card</td>
<td>CreditDebit:MCreditDebit — MICROS standard credit and debit drivers for credit card charges</td>
</tr>
<tr>
<td>Credit Card Other</td>
<td>CreditDebit:Loadable — Loadable credit and debit drivers for credit card charges</td>
</tr>
<tr>
<td>Opera</td>
<td>Other1:LoadablePms — Loadable property management system driver for room charges</td>
</tr>
</tbody>
</table>

16. If the payment type is a credit card, select CreditAuthAndPay from the Functions drop-down list, and click OK.

17. Position and size the button on the page. Use the Style arrow to change the color.

18. Click Save.

19. Repeat Steps 1 through 18 for each PATT button.
Related Topics

- Pay at the Table

Configuring Email Receipts

1. In the EMC, select the property, click **Setup** and **Property Parameters**.
2. On the General tab, click the Primary SMTP Server sub-tab.
3. Enter information in the fields as described in the following table:

   **Table 5-29   Email Receipt Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Enter the email server or service to use. Click <strong>Select</strong> to choose from the SMTP Server list of commonly used mail servers (for example, Outlook, Gmail, or Yahoo).</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the port number for the SMTP email server. A default port of 587 works for most SMTP servers.</td>
</tr>
<tr>
<td>SSL</td>
<td>Select this option to require secure Internet communication.</td>
</tr>
<tr>
<td>User Name</td>
<td>Enter the user name of the email address that will send receipts.</td>
</tr>
<tr>
<td>Password, Confirm Password</td>
<td>Enter the password associated with the email user name.</td>
</tr>
<tr>
<td>Source Email</td>
<td>Enter the full email address to appear as the sender in the emailed receipt. Depending on the SMTP server, this may not create a copy of emails sent.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter the business name or name to appear along with the email in the sender field. Depending on the SMTP server, this value may or may not appear in the sent email (for example, <strong>Username = jsmith Name = John</strong> could appear as: John<a href="mailto:jsmith@oracle.com">jsmith@oracle.com</a>).</td>
</tr>
<tr>
<td>BCC List</td>
<td>Enter the email address(es) to receive a blind carbon copy of the email receipt that is sent to the guest. Oracle Hospitality recommends that you list the source email in the BCC field so you can resend copies of email receipts later if necessary.</td>
</tr>
<tr>
<td>Send Test Email</td>
<td>After saving the information entered in the fields, send a test email receipt message to the source email address. A confirmation appears after the email is successfully sent.</td>
</tr>
</tbody>
</table>

4. Select **Backup SMTP Server**.
5. Configure the Backup SMTP Server with the same settings as the Primary SMTP Server or an alternate server from which to send emails in the event the primary server becomes unavailable.
6. Select **Text Formatting**, and enter information in the following fields:
   - **Email Subject** – Enter text in rich text format to appear as the subject line of email receipts.
   - **Email Body** – Enter text in rich text format to appear as the body of email receipts. You must include `@@Check` in the body in order to send a copy of the receipt.

7. Select **HTML Formatting**, and enter information in the following fields:
   - **Email Subject** – Enter text in HTML format as the subject line of email receipts.
   - **Email Body** – Enter text in HTML format as the body of email receipts. You must include `@@Check` in the body in order to send a copy of the receipt.

8. Select the **Send Html Email** option to dim the Text Formatting tab, and send only HTML format. Deselect this option to dim the HTML Formatting tab and send only the text formatted email.

9. Click **Save**.

**Related Topics**
- Pay at the Table

### Autosequence Events

You can set up automatic event tasks, such as nightly credit card batching, using the PC Autosequence feature in Simphony. After you create an automatic event, you can schedule it to run repeatedly at specific frequencies or time intervals.

To set up an automatic event, you must configure the Autosequence Event and the Autosequence Event Schedule.

**Related Topics**
- Configuring Autosequence Events
- Configuring the Autosequence Event Schedule

### Configuring Autosequence Events

1. In the EMC, select the Enterprise level, click **Configuration** and **PC Autosequences**.

2. Insert a record for the autosequence event (for example, Nightly Batch). If the autosequence event record exists, skip this step.

3. Double-click the record to open it.

4. On the General tab, select each **Property** to include in the autosequence event run.

5. (Optional) Select the employee group to have privileges to run the autosequence event from the **Privilege Group** drop-down list.

6. (Optional) To restrict execution of the autosequence event, click the **Add** link in the Parameters section and add optional parameters.

7. Click the Steps tab.
8. Beneath the Steps section, click the **Add** link to add the first step of the autosequence event.

9. In the Step Parameters section, select the **Step Type** from the drop-down list.

10. Repeat Steps 9 and 10 to add each step required to run the autosequence event.

11. Select the outcome for each step:
   - **Step on Success** – Select the step number to occur next if a step succeeds. For example, after Step 1 runs successfully, proceed to Step 2.
   - **Step on Failure** – Select the step number to occur next if a step fails. For example, if Step 1 fails, do no proceed with any steps.

12. Click **Save**.

**Related Topics**
- **Autosequence Events**

### Configuring the Autosequence Event Schedule

1. In the EMC, select the Enterprise level, click **Configuration** and **PC Autosequence Schedules**.

2. Insert a record for the autosequence schedule (for example, Nightly Batch). If the autosequence schedule record exists, skip this step.

3. Double-click the record to open it.

4. On the General tab, enter information in the following fields:

   **Table 5-30  General Settings Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autosequence</td>
<td>Select the autosequence event from the drop-down list.</td>
</tr>
<tr>
<td>Server Name</td>
<td>Enter the name of the server located at the Enterprise level or Hosting Center.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Select the time zone of the Enterprise level or Hosting Center.</td>
</tr>
<tr>
<td>Schedule Type</td>
<td>Select the frequency for the autosequence event.</td>
</tr>
<tr>
<td>Duration</td>
<td>Select <strong>Enabled</strong> for the autosequence event to run.</td>
</tr>
<tr>
<td></td>
<td>Select the <strong>Start</strong> and <strong>End dates</strong> for the autosequence event.</td>
</tr>
</tbody>
</table>

5. Click the Recurrence tab.

6. In the **Daily** section, enter the number of days for the autosequence event to reoccur. For example, to run the event daily, set this value to Every 1 day(s).

7. In the **Daily Frequency** section, set the time or times for the autosequence event to run.

8. Click **Save**.
Related Topics

- Autosequence Events
Taxes

A tax is a sum of money demanded by a government for its support or for specific facilities or services, levied upon income, property, sales, and so on. The following table explains methods of taxation:

### Table 6-1  Tax Methods

<table>
<thead>
<tr>
<th>Tax Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>European Value Added Tax (VAT)</td>
<td>A VAT is a form of sales tax used in some countries. VAT is an inclusive tax, which means the tax is included in the menu item price. The global tax type can be set as European or United States. A VAT tax is calculated differently, depending on the global setting. In Europe, only inclusive type tax is calculated. In the United States, inclusive type tax and add-on type tax can be used at the same time.</td>
</tr>
<tr>
<td>U.S. Inclusive Tax</td>
<td>U.S. inclusive tax uses the item price and a percent value to calculate the tax amount. The tax is then included in the price of each menu item not added to the bill. For example, if the tax rate is 5% and the item price is $5.00, the inclusive tax method calculates by the formula: $5.00 / (1+5%) = $4.76. The total price to the customer remains $5.00, but the net sales price is $4.76 and the tax is $0.24. If U.S. inclusive tax is used, only one inclusive tax rate may be applied to a menu item.</td>
</tr>
<tr>
<td>Add-on Tax</td>
<td>This method uses the item price to calculate tax, which is then added to the bill. For example, if the tax rate is 5% and the item is $5.00, the application calculates 5% of $5.00, posting $0.25 tax to the check and making the total due of $5.25.</td>
</tr>
<tr>
<td>Breakpoint or Threshold Tax</td>
<td>Breakpoints establish the points at which an increase of one cent in sales will increase tax by one cent. For example, a breakpoint tax might be one percent for sales from zero to twenty cents and then two percent from twenty-one to forty cents. Twenty cents would be the breakpoint for this tax.</td>
</tr>
</tbody>
</table>

- Understanding Tax Rates and Tax Classes
- Serving Periods
- Configuring a Serving Period
- Order Types
- Configuring Order Types
- Configuring Order Types as Subtotal Keys
- Configuring Tax Rates and Classes
- Understanding Tax Labels
- Configuring Tax Labels
• Printing Tax Rate Per Item
• Configuring Tax Rates Per Item to Print on Guest Check, Customer Receipt and Journal
• Configuring Workstation Number and Transaction Number to Print on Guest Check, Customer Receipt, and Journal

Understanding Tax Rates and Tax Classes

Simphony uses two tax handling files to assign taxes to menu items, discounts, and service charges:
• Tax Rates
• Tax Classes

A tax class is a collection of tax rates. Tax classes determine the tax rates that apply to menu items and service charges, and which tax rates can be reduced by discounts. A tax class can have up to 64 active tax rates, but typically a single tax class has one to three tax rates. By grouping multiple tax rates into a single tax class, you can easily see a record named Food Tax in other Enterprise Management Console (EMC) modules without wondering which tax rates are active.

You can associate a tax class with the following types of records:
• Menu Item Class: All menu item definitions in the menu item class are taxed using the tax class
• Discount: Specific tax rates can receive a discount when a menu item is discounted
• Service Charge: Specific types of services charges are taxed, such as banquet and room service transactions

In some jurisdictions, multiple tax rates apply to food items. Usually these tax rates must be calculated separately for accounting purposes (allowing each jurisdictional government to collect the appropriate tax amount). Generally a restaurant must pay taxes to both the state and the city:
• State – 5% tax
• City – 2% tax

In this example, both the state and city tax rates are active for the Food tax class. The total tax for a food item would be 7%.

For customer convenience, bars often use inclusive taxes. In some properties with multiple revenue centers, it is common that a bar revenue center uses inclusive taxes while a restaurant revenue center uses add-on taxes, even though both revenue centers serve the same items. In this scenario, the configuration of a Liquor tax class might be:
• Inclusive tax rate – 5%
• Add-on tax rate – 5%

Using this scenario, you can set either order types or serving periods to have the appropriate tax rates in the revenue centers. The following table shows an example configuration using Order Types:
### Table 6-2  Example of Inclusive Tax with Multiple Revenue Centers

<table>
<thead>
<tr>
<th>Revenue Center</th>
<th>Order Type Tax Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar</td>
<td>• Inclusive tax rate enabled</td>
</tr>
<tr>
<td></td>
<td>• Add-on tax rate disabled</td>
</tr>
<tr>
<td>Restaurant</td>
<td>• Inclusive tax rate disabled</td>
</tr>
<tr>
<td></td>
<td>• Add-on tax rate enabled</td>
</tr>
</tbody>
</table>

**Related Topics**
- Configuring Tax Rates and Classes

---

### Serving Periods

A serving period is a time period during the business day in one revenue center. The following examples illustrate serving periods:

- Breakfast (5:00 a.m. to 11:00 a.m.)
- Lunch (11:00 a.m. to 5:00 p.m.)
- Dinner (5:00 p.m. to 10:00 p.m.)

You can run sales reports for serving periods, include the active serving period in interface posting messages, and use serving periods on the default transaction screen.

**Related Topics**
- Configuring a Serving Period

---

### Configuring a Serving Period

1. In the EMC, select the revenue center, click **Configuration** and **Serving Periods**.
2. Insert a record and name it for the serving period.
3. Select the serving period's **Start Time** and **End Time**. If the serving period lasts all day, use the same start and end times.
4. In the **Table Count** field, enter the number of tables available during the serving period.
5. Select the days of the week when the serving period is active.
6. Select the **Default Transaction Touchscreen** to use when the serving period is active.
7. If you are using Mobile MICROS workstation, select the **MMH Default Transaction Touchscreen** to use when the serving period is active.
8. Select the **Default Main Level** to use when the serving period is active.
9. Select the **Default Sub Level** to use when the serving period is active.
10. Click the Taxes tab.
11. Select the tax rates to use when the serving period is active.
12. Click **Save**.
An order type is a menu item sales category, such as Dine In or Take Out. You can set up to eight order types for each location. Order types control active tax rates for a transaction and prevent theft in fast transaction environments. The following table describes the three order type classes in Simphony:

**Table 6-3  Order Types**

<table>
<thead>
<tr>
<th>Order Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Order Type</td>
<td>This is the order type of the current round. If the workstation operator changes the transaction order type, the order type of all menu items in the current round changes to the selected order type while the order type of the check remains unaffected. A reference entry with the name of the changed order type appears at the top of the menu items.</td>
</tr>
<tr>
<td>Check Order Type</td>
<td>The check order type appears in the check detail header. If you select <strong>16 - Post to Check Order Type</strong> in the RVC Parameters module under Posting options, menu item sales post to the check order type. Otherwise, menu item sales post to the overridden order type.</td>
</tr>
<tr>
<td>Menu Item Order Type</td>
<td>This is the order type of the menu item and also affects the condiments of the menu item. The workstation operator can change the order type of an entire combo meal or selected items in a combo meal. A reference entry appears with the name of the order type beneath the menu item to which the change was made. If the workstation operator consolidates menu items, changing the menu item order type affects all consolidated items. When the workstation operator changes a condiment order type, it applies to the parent menu item.</td>
</tr>
</tbody>
</table>

**Order Type Subtotal Security Option**

In a fast transaction environment, you can increase security and prevent theft by restricting the workstation operators' ability to perform voids and cancel transactions, while still allowing operators to perform legitimate error corrections. Simphony allows you to suppress the check total on the workstation until the workstation operator presses a subtotal key. The following table describes the type of theft that can be prevented using the subtotal security.
Table 6-4  Subtotal Restriction Scenarios

<table>
<thead>
<tr>
<th>No Order Type Subtotal Keys</th>
<th>Using Order Type Subtotal Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Workstation operator begins transaction.</td>
<td>• Workstation operator begins transaction.</td>
</tr>
<tr>
<td>• Customer orders hamburger and soda.</td>
<td>• Customer orders hamburger and soda.</td>
</tr>
<tr>
<td>• Workstation operator sees the total as $4.78 and requests the payment amount from the customer.</td>
<td>• Workstation operator does not see the total amount due, and must press one of the Order Type function keys to view the subtotal.</td>
</tr>
<tr>
<td>• The customer gives $4.78 in cash.</td>
<td>• The customer gives $4.78 in cash.</td>
</tr>
<tr>
<td>• Workstation operator pockets the cash and voids the items or cancels the transaction.</td>
<td>• Workstation operator cannot void items or cancel the transaction after pressing the Order Type key. After pressing the Order Type key, the items ordered are considered previous-round items for voiding purposes. Typically, only managers can perform previous-round voids.</td>
</tr>
</tbody>
</table>

If the workstation operator adds another menu item after pressing the Order Type key, the check summary is blank. The workstation operator can perform error corrections on items that were ordered since the Order Type key was pressed, but cannot perform error corrections on items before the Order Type declaration.

Related Topics

- Configuring Order Types
- Configuring Order Types as Subtotal Keys

Configuring Order Types

1. In the EMC, select the Enterprise, property, or zone, click Descriptors and Order Types.
2. In the Text field, enter an order type for each record (for example, Dine In, Take Out, Drive Thru).
3. Click Save.
4. Select the Enterprise, property, revenue center, or zone, click Setup and Order Type Parameters.
5. For each order type record, select the appropriate options as described in the following table:

Table 6-5  Order Type Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Print on Customer Receipt and Guest Check</td>
<td>Select this option to print the order type name on customer receipts and guest checks.</td>
</tr>
</tbody>
</table>
Table 6-5  (Cont.) Order Type Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 - Print on Order Printer</td>
<td>Select this option to print the order type name on order printers.</td>
</tr>
<tr>
<td>4 - Do Not Post Transactions to Tip Report Totals</td>
<td>Select this option if you do not want sales for the order type to appear on Tip Report Totals.</td>
</tr>
<tr>
<td>5 - Perform Auto Combo Recognition</td>
<td>Select this option to have workstations automatically perform auto combo recognition when the workstation operator changes the workstation to the order type.</td>
</tr>
<tr>
<td>6 - Transaction Cancel Default</td>
<td>Select this option when starting orders without an order type.</td>
</tr>
<tr>
<td>8 - Enable Routing Order by Order Type</td>
<td>Select this option to control order routing by the order type. The workstation order devices must be set for all possibilities and use this as an override to disable order devices.</td>
</tr>
</tbody>
</table>

6. In the **Tax Mask** field, select the appropriate tax rates for the order type record.

7. Select **Active** for each order type that you want to activate.

8. Click **Save**.

9. Select the revenue center, click **Setup** and **RVC Parameters**.

10. Select the **Default Order Type** from the drop-down list. This is the order type that is active when a workstation operator begins a check.

11. Click **Save**.

12. If you want to override the default order type setting for a workstation:
   a. Select the property, click **Setup** and **Workstations**.
   b. Click the Transactions tab.
   c. Select the **Default Order Type** from the drop-down list.
   d. Click **Save**.

**Related Topics**
- **Order Types**

**Configuring Order Types as Subtotal Keys**

You can allow the Order Type keys in the revenue center to act as Subtotal keys.

1. In the EMC, select the Enterprise, property, or revenue center, click **Setup** and **Control Parameters**.

2. Click the Options tab.
3. If you do not want summary subtotals to appear on the workstation until the
workstation operator presses an Order Type key, select **8 - Display Summary Totals Only After Order Type Declared**.

4. Click **Save**.

**Related Topics**

- **Order Types**

**Configuring Tax Rates and Classes**

1. In the EMC, select the Enterprise, property, or zone, click **Setup** and **Tax Rates**.

2. Locate the appropriate tax rate. There are up to 64 active tax rates.

3. In the **Type** field, select the tax rate type from the drop-down list. The following table describes the tax types:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - Disabled Tax Rate</td>
<td>Select this option if you do not want to use the tax calculation for the tax rate.</td>
</tr>
<tr>
<td>1 - Add On, Breakpoint</td>
<td>Select this option to calculate the add-on tax using the Breakpoint method, and add the tax to the check total. The government imposing the tax provides a breakpoint chart to facilitate programming the breakpoint entry.</td>
</tr>
<tr>
<td>2 - Add On, Percentage</td>
<td>Select this option to calculate the add-on tax using the Flat Percentage Rate, and add the tax to the check total.</td>
</tr>
<tr>
<td>3 - Included, Percentage</td>
<td>Select this option to calculate the inclusive tax using the Flat Percentage Rate to determine what portion of the sales price is the tax. The inclusive tax applies differently depending on the global tax type (European or United States). Because the tax is included in the price, the tax is backed out of gross sales on reports. You cannot back out inclusive tax from a check total using an Exempt Tax function key.</td>
</tr>
<tr>
<td>4 - Florida Surcharge</td>
<td>Select this option to calculate surcharges for menu items in Florida.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

5. Select the Enterprise, property, or zone, click **Setup** and **Tax Classes**.

6. Insert a tax class record with the appropriate name (for example, Food Tax or Liquor Tax).

7. In the **Taxes Enabled** field, select the applicable tax rates and click **OK**. The tax rates you select are active for the tax class.

8. Click **Save**.
Related Topics

• Understanding Tax Rates and Tax Classes

Understanding Tax Labels

Setting tax labels allows you to perform the following actions:

• Define up to two tax labels and associate each of them with a specific tax rate
• Associate multiple tax rates with the same tax labels
• Associate a blank tax label with tax exempt items (considered non-value-added tax (VAT))

Related Topics

• Configuring Tax Labels

Configuring Tax Labels

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Setup and Tax Parameters.
2. Click the International Options tab.
3. Select 17 - Enable Tax Labels.
4. Click the Options tab.
5. If you want to print items with a 0% tax rate on guest checks, select 8 - Post Taxable Sales when Tax Rate is Zero.
6. Click Save.
7. Select the Enterprise, property, revenue center, or zone, click Setup and Format Parameters.
8. Click the Options tab.
9. Select the appropriate printing options:
   • 57 - Do Not Print Change/Payment Due in Double Wide – Select this option if you do not want double-wide formatting when a guest check has change due.
   • 58 - Do Not Consolidate Current Round Items in Printed Guest Check – Select this option if you do not want to combine the current round items when printing a receipt.
10. Click Save.

Related Topics

• Understanding Tax Labels

Printing Tax Rate Per Item

You can have a menu item's tax rate print on the header of guest checks and customer receipts, and in the journal. The following diagram illustrates a sample customer receipt printed with the tax rates for each menu item, workstation number and transaction number.
Configuring Tax Rates Per Item to Print on Guest Check, Customer Receipt and Journal

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Setup** and **Tax Parameters**.

2. Click the International Options tab.

3. Select **16 - Print Tax Rate per item** to print tax rates associated with the menu item class on the header of guest checks and customer receipts. Deselect this option if you do not want the tax rates to print on the guest check, customer receipt or Journal.

   For example, the line item for a BLT on the printed check appears as follows:

   1 BLT 5.99 T2 T4

   The guest check and customer receipt indicate the tax rate applied to each item. The T2 and T4 shown after the item’s price indicate that tax rates 2 and 4 were applied to a BLT.

4. Click **Save**.

Related Topics
• Printing Tax Rate Per Item
Configuring Workstation Number and Transaction Number to Print on Guest Check, Customer Receipt, and Journal

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Setup** and **Format Parameters**.

2. Click the Options tab.

3. Select the appropriate workstation and transaction options. These options work independently of each other; you can set one, both, or none.
   - **54 - Print Workstation Number** – Select this option to have the workstation number print on the header of guest checks and customer receipts, and in the journal.
   - **55 - Print Transaction Number** – Select this option to have the transaction number print on the header of guest checks and customer receipts, and in the journal. The journal header does not contain the legacy transaction number (labeled TRN).

4. Click **Save**.

**Related Topics**
- [Printing Tax Rate Per Item](#)
Discounts

You can activate a discount using the methods described in the following table:

<table>
<thead>
<tr>
<th>Discount Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual</td>
<td>A workstation operator manually applies a discount to a check. This is a traditional discount method.</td>
</tr>
<tr>
<td>Automatic</td>
<td>A workstation applies an automatic discount when the transaction meets certain criteria. As a workstation operator adds menu items to the guest check, the workstation looks for items that trigger a discount, and then applies the award amount to the check.</td>
</tr>
<tr>
<td>Coupon</td>
<td>An automatic coupon discount is an automatic discount with one difference: the workstation operator must first apply the discount to the guest check, letting the discount engine know that the discount is available for the check.</td>
</tr>
<tr>
<td>Combination Pricing</td>
<td>A combination pricing discount is a type of automatic discount or automatic coupon discount that allows a property to charge a single price for multiple items when they appear on a check at the same time. Restaurants use this type of discount in combo meal scenarios such as Burger, Fries, and Soda are $3.25. Configuring a Combination Pricing Discount contains instructions to set up combination pricing discounts.</td>
</tr>
</tbody>
</table>

The discount engine within Ops automatically performs the following actions:

- Detects the presence of discountable menu items on a transaction.
- Applies the discounts to the transaction.
- Automatic Discounts
- Understanding Automatic Discount Rules
- Understanding Awarding Algorithms
- Discount Award Types
- Discount Exclusivity
- Simple Exclusivity
- Group Exclusivity
- Menu Item Groups
- Configuring Discount Privileges
- Configuring Discounts
- Understanding Automatic Discounts with Decimal Quantity Menu Items
Automatic Discounts

The workstation automatically applies discounts to a guest check based on conditions within the transaction and without workstation operator interaction. For example, a property may run a promotional sale: buy one DVD and receive one CD for free. In this situation, whenever both a CD and a DVD appear on a single transaction, a 100% discount applies to the CD. There are several automatic discount types. This scenario is just one example of an automatic discount configuration.

Automatic discounts and automatic coupon discounts use the following Menu Item Groups to determine which items receive a discount:

- **Trigger Menu Item Group**
  A trigger menu item group contains at least one item that makes an item become discountable. For example, in a Buy a DVD, get a CD example, the DVD is in the trigger menu item group.

- **Award Menu Item Group**
  An award menu item group contains at least one item to receive a discount. For example, in the Buy a DVD, get a CD example, the CD is in the award menu item group.

A menu item can be in both the trigger and award groups.

Simphony uses several other factors to determine the automatic discount amount:

- **Automatic Discount Rules**
- **Awarding Algorithms**
- **Discount Award Types**
- **Discount Exclusivity**
Understanding Automatic Discount Rules

Various algorithms (known as Automatic Discount Rules) determine how Simphony calculates a discount. The following table explains the Automatic Discount Rules:

**Table 7-2  Automatic Discount Rules**

<table>
<thead>
<tr>
<th>Automatic Discount Rule</th>
<th>Description</th>
</tr>
</thead>
</table>
| Item Price Substitution | This discount rule is used in scenarios such as:  
  - All Beverages are half-price on Tuesday  
  - If you order three or more hamburgers, they are 20% off  
  The Item Price Substitution discount rule is similar to the Sales Price rule. |
| Quantity Threshold      | This discount rule is used for Buy-One-Get-One scenarios, such as Buy one DVD and get one CD for 50% off, or Buy two entrees and a dessert is free. |
| Total Price Threshold   | This discount rule is used for scenarios such as 15% off all purchases of $200 or more. |
| Combination Pricing     | This discount type needs to have part of each item included in the combination to apply the discount. You must order at least two of an item before a discount can be applied. This discount rule is used for combination meals, such as when a hamburger, fries, and soda are applied on one check, charge $4.00. |
| Sales Price             | This discount rule is similar to Item Price Substitution, but it is simpler to program. Use this discount rule for All hamburgers are $2.00 on Wednesdays, without configuring Minimum Quantity of trigger items or Max Count per check. |

Understanding Awarding Algorithms

When dealing with automatic discounts, the better deal always wins. For example, if you set both Buy One DVD Get One CD For Free and Buy One DVD Get One Car For Free, the application discounts the price of the car to $0.00 because this is a better deal than receiving a CD for $0.00.

When you use automatic discounts, the discount engine performs algorithms to determine which discounts are applied and which items receive a discount. The following two types of algorithms determine the discount:
Table 7-3  Awarding Algorithms

<table>
<thead>
<tr>
<th>Awarding Algorithm</th>
<th>Description</th>
</tr>
</thead>
</table>
| Best Deal for Customer  | Each automatic discount type provides the best deal for the customer, which means that the workstation scans all menu items and determines the largest discount to apply. In this example, a common best deal scenario is described as follows:  
• A combo discount is configured so any Pants-and-Shirt purchase is $30.  
• If a customer orders a $25 pair of pants and a $20 shirt, the discount is $15:  
  – $25 for a pair of pants, $20 for a shirt = $45  
  – The combination price is $30, so the discount is $15.  
• If the customer then orders a $25 shirt, the discount recalculates:  
  – $25 for a pair of pants, $25 for a shirt = $50  
  – The combination price is $30, so the discount is $20.  
In this example, the higher-priced shirt is discounted, so the customer receives a total discount of $20 instead of just $15. This is the calculation for all automatic discounts and you cannot configure it (except for Quantity Threshold Discounts). By default, Ops considers all menu items on the check and all discounts that can apply, and creates the largest discount possible for the customer. |
| Best Deal for Merchant  | You can configure Quantity Threshold Discounts to provide the best deal for the merchant, which means that the customer receives the lowest possible discount. Some jurisdictions require this configuration. |

Figure 7-1  Examples of Best Deals for Merchant and Customer

**-- Ex 1: Best for Customer --**

<table>
<thead>
<tr>
<th>Item</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filet</td>
<td>20.00</td>
</tr>
<tr>
<td>Chicken Dinner</td>
<td>15.00</td>
</tr>
<tr>
<td>Spaghetti</td>
<td>10.00</td>
</tr>
<tr>
<td>Discount</td>
<td>-7.50</td>
</tr>
</tbody>
</table>

**-- Ex 2: Best for Merchant --**

<table>
<thead>
<tr>
<th>Item</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filet</td>
<td>20.00</td>
</tr>
<tr>
<td>Chicken Dinner</td>
<td>15.00</td>
</tr>
<tr>
<td>Spaghetti</td>
<td>10.00</td>
</tr>
<tr>
<td>Discount</td>
<td>-5.00</td>
</tr>
</tbody>
</table>
Consider this discount: Buy one entree and get a second (of equal or lesser value) for 50% off. The examples show the different calculations of the discount based on the best deal configuration.

- In Example 1, the Filet is the most expensive item, so it is the trigger. The Chicken Dinner is more expensive than the Spaghetti, so it is discounted by 50%. The total discount is $7.50.
- In Example 2, the Filet is the most expensive item, so it is the trigger. The Spaghetti is the least expensive entree, so it is discounted by 50%. The total discount is $5.00.

Discount Award Types

The following table describes the discount award types.

<table>
<thead>
<tr>
<th>Award Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent Off</td>
<td>Symphony calculates this type of award as a percent of the sales total.</td>
</tr>
<tr>
<td>Amount Off</td>
<td>Symphony calculates this type of award as a fraction of the sales total. The discount awarded cannot be greater than the Amount Off value.</td>
</tr>
<tr>
<td>Amount Substitution</td>
<td>Symphony calculates this type of award as a fraction of the sales total. Calculations do not change with whole numbers. For decimal values, Symphony calculates what percent of the parent item the original substitution price was, and applies that percent discount to the new decimal quantity.</td>
</tr>
</tbody>
</table>

Discount Exclusivity

Discount exclusivity controls how multiple discounts interact with each other. You can configure discounts to be exclusive to the following:

- Per transaction
- Per menu item
- Based on workstation operator-defined groups

In short, discount exclusivity stops discounts from applying multiple times to the same items.

Discount exclusivity applies in these situations:

- A senior citizen discount coupon cannot be used at the same time as a 25% off all items discount.
- A Buy One Get One Free discount cannot be applied to a transaction that also has a Buy $100, Get 25% Off Discount.
• The customer's 10% coupon cannot be applied to items that get the Happy Hour discount.

You can configure two types of discount exclusivity: simple exclusivity and group exclusivity. Simple exclusivity is easier to use and configure. Group exclusivity yields greater flexibility, but at the price of complexity. Simple Exclusivity and Group Exclusivity contain more information about these types of discount exclusivity.

Automatic discounts always recalculate after the workstation operator adds or removes an item from a guest check. Because of this, automatic discounts are always applied after manual discounts. Consider the following example:
• The revenue center is configured with automatic discounts enabled in the RVC Parameters module.
• One automatic discount is active: all food is 10% off.
• A manual discount is configured, and it allows the 10% off all food discount to be on the check at the same time as the manual discount.
• The operator orders $20 of food.
• The automatic discount applies on the check for $2.

If the workstation operator then adds a manual discount for $5.00 off, the discount changes:
• All automatic discounts are removed (this occurs internally on the workstation but is listed here to explain the logic)
• The check’s total is $15.00 ($20.00 minus the $5.00 manual discount)
• The 10% automatic discount is applied for $1.50, taking the check’s total to $13.50

Because of the scenario described here, it is not possible to get a better deal when combining automatic and manual discounts. Either the discounts can both be on the check (as in this example) or the manual discount is not allowed (if the automatic discount is exclusive to the manual discount). Thus, if you want to use manual discounts and automatic discounts in the same environment, you should configure the discounts that would normally be manual as automatic coupon discounts, which follow the best deal rules of the Discount Engine. See Understanding Awarding Algorithms for more information.

Configuring Discounts contains more information about setting the Simple Item Exclusivity and Simple Transaction Exclusivity options.

Simple Exclusivity

The following three discount options apply to simple exclusivity in the Discounts module:
### Table 7-5  Simple Exclusivity Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9 - Simple Item Exclusivity</td>
<td>When you select this option, only this discount can be applied to a menu item. This prevents individual items from being discounted more than once. Deselecting this option causes the Exclusivity Group settings to determine how this discount interacts with other discounts. If other discounts that are better deals can apply to the item or transaction, the better deal discounts apply.</td>
</tr>
<tr>
<td>23 - Simple Transaction Exclusivity</td>
<td>When you select this option, only this discount can be applied to a single check. This prevents the check from being discounted more than once. Deselecting this option causes the Exclusivity Group settings to determine how this discount interacts with other discounts. If other discounts that are better deals can apply to the item or transaction, the better deal discounts apply.</td>
</tr>
<tr>
<td>24 - Discount is Final</td>
<td>When you select this option, no additional discounts can be applied to the transaction after this discount posts. (This option works in automatic discount transactions only.)</td>
</tr>
</tbody>
</table>

### Group Exclusivity

Group exclusivity is sometimes a difficult concept to grasp, but it is important as it lets you configure the manner in which possibly hundreds of discounts interact. An understanding of group exclusivity is crucial for long-term discount configuration.

When two discounts are exclusive to each other, it means that only one discount applies. This exclusiveness can apply either per transaction or per menu item:

- If two discounts are transaction exclusive to each other, only one can be applied to the same transaction. The discount that provides the best deal is applied to the check.
- If two discounts are item exclusive to each other, only one can be applied to a specific menu item. Two discounts that are item exclusive can both be present on a transaction, but only applied to different menu items. Again, the discount that provides the best deal is applied to the item.

### Table 7-6  Transaction Exclusivity

<table>
<thead>
<tr>
<th>Discount</th>
<th>In Exclusivity Group 1</th>
<th>In Exclusivity Group 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>B</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>C</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>D</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

Given the configuration shown in the Transaction Exclusivity table, the following occurs:

- Discounts A and B cannot appear on the same transaction because they both belong to the first group.
• Discounts A and C cannot appear on the same transaction because they both belong to the second group.
• Discounts B and C can appear on the same transaction because they do not belong to the same groups.
• Discount D can appear on any transaction with A, B, and C because it does not belong to any group.

The Transaction Exclusivity example shows a configuration with only two groups. The combinations become more complex (yet more flexible) when using all 32 groups in the property.

Table 7-7  Item Exclusivity

<table>
<thead>
<tr>
<th>Discount</th>
<th>In Exclusivity Group 1</th>
<th>Menu Items Affected by Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Yes</td>
<td>x, y</td>
</tr>
<tr>
<td>B</td>
<td>Yes</td>
<td>x</td>
</tr>
<tr>
<td>C</td>
<td>No</td>
<td>y</td>
</tr>
</tbody>
</table>

Given the configuration shown in the Item Exclusivity table, the following occurs:
• Menu Item x is discounted by A or B, but not both. Discounts A and B are exclusive to each other.
• Menu Item y is discounted by A and C. These discounts are not exclusive to each other, so they may both discount the same items.

Menu Item Groups

A menu item group is a workstation operator-defined group of menu items that Simphony uses to calculate discounts. Within the Menu Item Group module, you can assign menu items based on Major Groups, Family Groups, or by menu item object number or range.

Related Topics
• Configuring Menu Item Groups

Configuring Discount Privileges

1. In the EMC, select the Enterprise level, click **Configuration** and **Roles**.
2. Select the role type, click the Operations tab and the Voids/Returns sub tab.
3. Select the appropriate options to allow employees to void discounts in a previous round and on closed checks:
   • **27 - Authorize/Perform Void of Discounts from a Previous Round**
   • **70 - Authorize/Perform Void of Discounts on Closed Checks**
4. Click the Transactions sub tab.
5. Select the appropriate options that apply to discounts:
   • **20 - Post Discounts to Checks Belonging to Another Operator**
• 98 - Authorize/Perform Employee Meal Discount Override for Non-Scheduled Employees

6. Click **Save**.

### Configuring Discounts

1. In the EMC, select the Enterprise, property, or zone, click **Configuration** and **Discounts**.

2. Insert a record for a discount or double-click a record to select it.

3. On the General tab, select the type of discount from the **Activation Type** drop-down list:
   - 0 - Manual (Manually entered and applied) from the **Activation Type**
   - 1 - Automatic (Automatically applied, operator cannot enter)
   - 2 - Coupon (Automatically applied, operator must enter)

4. If you are configuring a manual discount, enter the following information. Otherwise, skip this step.
   a. If you want to use a percent discount, enter the percentage in the **Percent** field.
   b. If you want to use an amount discount, enter the maximum amount allowed for the discount in the **Max Amount** field.

5. Select **Enabled** to make the discount available to the workstation operator. (If you configure a temporary discount, you can quickly turn it off.)

6. Select the **Tax Class** to be discounted.

7. Select a **Privilege Group** to restrict the discount to only employees who are linked to the same privilege group. Set the **Privilege Group** to 0 to allow all employees to use the discount.

8. Select the method to determine how condiment menu items are discounted in the **Condiment Discountability** drop-down list.

9. Select the **Report Group** to associate with the discount.

10. Select the appropriate options for the discount. The following table describes the options and indicates the Activation Types (Manual, Automatic, Coupon) that are available for each option.

### Table 7-8   Discount Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Manual</th>
<th>Automatic</th>
<th>Coupon</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - ON = Open; OFF = Preset</td>
<td>Select this option if you want to make the discount open. The workstation prompts the workstation operator to enter the amount or percentage.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>2 - ON = Amount; OFF = Percentage</td>
<td>Select this option if you want to make the discount an amount. Deselect this option if you want the discount to be a percentage.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Manual</td>
<td>Automatic</td>
<td>Coupon</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------</td>
<td>-----------</td>
<td>--------</td>
</tr>
<tr>
<td>3 - This is an Item Discount</td>
<td>Select this option if you want the application to calculate the discount based on the price of the last menu item entered. Deselect this option to calculate the discount based on the discountable transaction subtotal.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>4 - Employee Meal</td>
<td>Select this option to set the discount as an Employee Discount. The workstation prompts the workstation operator to enter the employee number of the employee receiving the discount.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>5 - Reference Entry Required</td>
<td>Select this option to have the workstation operator enter a name or number when using the discount.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>6 - Validation Required</td>
<td>Select this option to cause a validation chit to print when the discount is applied.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>7 - Limit Discount to Value in Amount Field</td>
<td>Select this option to limit the amount of a discount. Enter an amount in the <strong>Amount</strong> field, which represents the highest discount possible when setting this option.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
| 8 - If No Amount is Entered, Use the Full Discountable Amount | Select this option to control the open amount discount calculation if the workstation operator does not enter an amount before pressing the discount button. In essence, this option allows you to set a discount as:  
  • A 100% discount (if the workstation operator does not enter an amount before selecting the Discount key)  
  • An open amount discount (if the workstation operator enters an amount before selecting the Discount key)  
You must select option **2 - ON = Amount; OFF = Percentage** to activate this option.               | Yes    | No        | No      |
| 9 - Simple Item Exclusivity                 | Select this option to have the discount apply to a menu item. This setting prevents individual items from receiving a discount more than once.                                                                   | Yes    | Yes       | Yes    |
| 17 - Item is Shareable                      | Select this option to allowing sharing of the discount between two or more seats or checks through TouchEdit or TouchSplit.                                                                                | Yes    | No        | No      |
### Table 7-8  (Cont.) Discount Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Manual</th>
<th>Automatic</th>
<th>Coupon</th>
</tr>
</thead>
<tbody>
<tr>
<td>18 - Employee Meal Discount Applies to Scheduled Employees Only</td>
<td>Select this option for properties using timekeeping and only when setting discount option 4 - <strong>Employee Meal</strong>. The discount can be used as an employee meal discount only for employees who are scheduled to work.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>22 - Employee Meal Discount Applies to Employees On Break Only</td>
<td>Select this option for properties using timekeeping and only when setting discount option 4 - <strong>Employee Meal</strong>. The discount can be used as an employee meal discount only for employees who are on break.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>23 - Simple Transaction Exclusivity</td>
<td>Select this option to have the discount apply to a single check. This setting prevents the check from receiving a discount more than once.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>24 - Discount is Final</td>
<td>Select this option if you do not want workstation operators to apply additional discounts to the transaction after the discount is posted.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>25 - Discount Combo Meal Group Items</td>
<td>Select this option to discount combo group menu items when the <strong>Allow Discounts</strong> option is set for the combo group.</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>28 - Apply to Returned or Direct-Voided Menu Items</td>
<td>Select this option to allow the discount to be applied to returned and voided items.</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>29 - Menu item to use check open time</td>
<td>Select this option if you want a menu item to use the check’s open time (instead of using the current time) to determine effectivity of the discount.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>30 - Selected menu item to include parent menu item in discount</td>
<td>Select this option to include a parent menu item in the discount when the workstation operator selects a child menu item for the discount.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table 7-8  (Cont.) Discount Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Manual</th>
<th>Automatic</th>
<th>Coupon</th>
</tr>
</thead>
<tbody>
<tr>
<td>31 - Net Automatic Service Charge Itemizer</td>
<td>Select this option if you want the net value of the menu item to post to the Automatic Service Charge Itemizer, reducing the Automatic Service Charge after the discount is applied. This option is available when you set option 3 - This is an Item Discount (above) and option 12 - Add to Automatic Service Charge Itemizer in the Menu Item Classes module.</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>32 - Limit Discount value to value of Discountable Item</td>
<td>Select this option to limit the discountable amount to the item or award when the Amount Off exceeds the item or award. For example, if the Amount Off is $5.00 and the item or award is $4.00, the discount is limited to $4.00.</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>33 - Cash Management Transaction Item</td>
<td>Select this option to include the discount in Enterprise Cash Management (ECM) tracking and reports.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

11. Click the RVC Type tab.
12. Select the revenue centers that can have the discount available.
13. Click the Effectivity tab.
14. Select the dates, days and times you want the discount to be in effect.
15. Click the Effectivity Groups tab.
   The effectivity group configuration allows you to configure and package promotions so that the menu items and their discounts are only available for a fixed period of time.
16. Click Add Effectivity Record.
17. Assign discounts, menu item prices, and other configuration elements to the effectivity group.
18. Click Save.
19. If you want to set an automatic discount to apply to a revenue center:
   a. Select the revenue center, click Setup and RVC Parameters.
   b. Click the Options tab and select 48 - Enable Automatic Discounts by Default. If you do not select this option, workstation operators must activate automatic discounts per transaction using one of the following function keys:
      • 655 - Auto Discount Toggle – Toggle the automatic discounts for the transaction
      • 656 - Auto Discount Apply – Apply all discounts possible
      • 657 - Auto Discount Remove – Remove all discounts from the transaction
c. Click Save.

Related Topics
- Discounts

Understanding Automatic Discounts with Decimal Quantity Menu Items

Simphony ignores partial (or decimal) quantities with automatic discounts and applies the discount for the closest whole number. For example, if you have an order for 2.3 cups yogurt, the automatic discount algorithms consider only 2.0 cups yogurt when determining whether to apply a discount.

- If you add a menu item to the check with an original quantity less than 1, Simphony does not apply the automatic discount.
- If you add a menu item to the check with a discount and then split the check, the discount no longer applies to either check.

The following automatic discount rules ignore partial quantities when ordering:
- Quantity Threshold
- Combination Pricing

The discount engine ignores menu items added with an original quantity of less than 1 (for example .5 cup of yogurt). Understanding Automatic Discount Rules contains more information about Quantity Threshold and Combination Pricing.

Amount Off Examples contains examples of the Amount Off award type.

Amount Substitution contains examples of the Amount Substitution award type.

Related Topics
- Configuring Decimal Quantity Menu Items
- Configuring a Combination Pricing Discount

Amount Off Examples

This section provides examples of the Amount Off discount award type.

Example 1: Whole Number Item
- 1 Salad: $10.00
- Amount Off: $2.00
- Award Percent = Amount Off ($2.00) / Item Base Price ($10.00) = .20
- Discount = Current Sales Total ($10.00) x Award Percent (.20) = $2.00

Because the Current Sales Total is greater than or equal to the base price, the customer receives the Amount Off.

Example 2: Decimal Number Item
- .5 Salad: $5.00
Amount Substitution Examples

This section provides examples of the Amount Substitution discount award type.

Example 4: Whole Number Item

- 1 Salad: $10.00
- Amount Substitution: $9.00 (discounted $1.00)
- Award Percent = Amount Substitution ($9.00) / Item Base Price ($10.00) = .90
- Discount = ($10.00) - Amount Substitution ($9.00) = $1.00

When dealing with whole number menu items, the customer always pays the Amount Substitution. If the customer orders items totaling $100, they pay only $90.00.

Example 5: Decimal Number Item

- .5 Salad: $5.00
- Amount Substitution: $9.00 (discounted $1.00 from parent item base price)
- Award Percent = Amount Substitution ($9.00) / Item Base Price ($10.00) = .90
- Discount = (Current Sales Total – (Current Sales x Award Percent)) = $5.00 – ($5.00 x .90) = $5.00 – $4.50 = $.50

Example 6: Decimal Number Item, More Condiments Than Parent Items

- The Award Percent for Amount Substitution is based on the parent item base price, not the total price of each item plus condiments.
- The Discount Calculation only comes into effect when the menu item plus condiments are less than the base price amount of the parent item.
## Configuring Decimal Quantity Menu Items

1. In the EMC, select the Enterprise, property, or revenue center, click **Configuration** and **Menu Item Classes**.

2. Double-click the menu item class record to open it.

3. On the General tab, select **2 - Decimal/fraction allowed, round sales count up** in the **Count Entry** drop-down list.

4. Click **Save**.

### Related Topics
- **Understanding Automatic Discounts with Decimal Quantity Menu Items**
- **Amount Off Examples**
- **Amount Substitution Examples**

## Configuring a Combination Pricing Discount

1. In the EMC, select the Enterprise, property, or zone, click **Configuration** and **Discounts**.

2. Double-click the discount record to open it.
3. On the Auto tab, select **Combination Pricing** from the **Automatic** (*Automatically applied, operator cannot enter*) drop-down list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>This field determines the order in which the workstation calculates the discounts. This field is blank (0) for all discounts by default, meaning that the workstation calculates discounts at the same time. When using this field, the workstation calculates all discounts in priority 1, then in priority 2, and so on. The Priority field allows the discount engine to determine which discount to apply quicker, thus reducing central processing unit (CPU) time on the workstation.</td>
</tr>
<tr>
<td>Trigger MI Groups</td>
<td>Select the menu item groups that belong to this combination discount. This discount is used in scenarios such as a Burger, Fries, and Soda are $3.25. You can configure a maximum of four trigger Menu Item Groups for combination pricing discounts. You can use a Trigger MI Group more than once (for example, if the combo meal includes two sides). (This is not a typical configuration.)</td>
</tr>
<tr>
<td>Amount Substitution</td>
<td>Enter the price to be charged for this combo meal.</td>
</tr>
<tr>
<td>Max Count</td>
<td>Enter the maximum number of combo meals that can be ordered per check. In general, this field is set to 0 to allow an unlimited amount of combo meals on a single check.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**Related Topics**
- Understanding Automatic Discounts with Decimal Quantity Menu Items
- Amount Off Examples
- Amount Substitution Examples

**Applying Discounts Using Condiments**

You can apply manual, automatic, and coupon discounts to a check when a condiment item is present on the check. A workstation operator can manually apply a discount by selecting the condiment item. For example, configure a bagel to be a parent menu item and configure the condiment, such as cream cheese, to trigger a 5% discount. As a result, when the workstation operator enters the customer order for a bagel with cream cheese, the system applies the discount after the workstation operator selects cream cheese.

Place condiments in trigger menu item groups to have Simphony apply automatic and coupon discounts.

Complete the following tasks to apply discounts using condiments:
- Specify the condiment to be the trigger
• Set the discount to apply to the parent menu item, condiment, or both
• Set up the discount for a condiment
• Create a discount button to appear on the workstation page

Related Topics
• Configuring the Condiment as the Trigger
• Configuring Parent Menu Item Class Discounts
• Configuring the Discount for a Condiment
• Creating the Discount Button

Configuring the Condiment as the Trigger

1. In the EMC, select the Enterprise, property, or zone, click Configuration and Menu Item Groups.
2. Create a menu item group record and then double-click it to open.
3. Click Add near the Include area.
4. Select information for the fields described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select 4 - By Menu Item.</td>
</tr>
<tr>
<td>Start #</td>
<td>Click in this field, but do not enter a value.</td>
</tr>
<tr>
<td>End #</td>
<td>Click in this field, but do not enter a value.</td>
</tr>
<tr>
<td>See Items and Select</td>
<td>Click the link and then select the condiment to be the trigger. This condiment appears in the End # field.</td>
</tr>
</tbody>
</table>

5. Click Save.

Related Topics
• Applying Discounts Using Condiments

Configuring Parent Menu Item Class Discounts

1. In the EMC, select the Enterprise, property, or zone, click Configuration and Menu Item Groups.
2. Double-click the menu item and select the Options tab.
3. Select 55 - Discounts Apply to Priced Condiments (parent items only) to allow both parent and condiment items to receive the discount. Deselect option 55 if you want only the parent item to receive the discount.
4. Click Save.

Related Topics
• Applying Discounts Using Condiments
Configuring the Discount for a Condiment

1. In the EMC, select the Enterprise, property, or zone, click Configuration and Discounts.
2. Create the discount record and then double-click it.
3. On the General tab, enter the fields as described in the following table:

| Table 7-11  Discount Fields |
|-------------|-----------------------------|
| Field       | Description                 |
| Activation Type | Select the type of discount: |
|              | • 0 - Manual (Manually entered and applied) |
|              | • 1 - Automatic (Automatically applied, operator cannot enter) |
|              | • 2 - Coupon (Automatically applied, operator must enter) |
| Percent      | Enter the discount percentage if you want to use a percent discount. |
| Max Amount   | Enter the maximum amount allowed for the discount if you want to use an amount discount. |
| Enabled      | Select this option to make the discount available to the workstation operator. (If you configure a temporary discount, you can quickly turn it off.) |
| Condiment Discountability | Select the discount method for condiment menu items: |
|              | • 0 - Use MI Class Option – You must also select Menu Item Class option 55 - Discounts Apply to Priced Condiments (parent items only). |
|              | • 1 - Parent Items Only – Selecting this option makes the discount apply only to the parent menu item. |
|              | • 2 - Condiment Items Only – Selecting this option makes the discount apply to the trigger condiment and to all condiments associated with the check. |
|              | • 3 - Parent and Highlighted Condiment Items – This option is available only for manual discounts. |
|              | • 4 - Parent and All Condiment Items – Selecting this option makes the discount apply to the parent menu item and to all condiments associated with the check. |
| Trigger MI Group | Select the menu item group. This group is the trigger for the discount. When you select 0 - Use Discount Itemizers, the only options available for the Trigger Condiment Group are 0 - None and all available condiment groups previously created. |
| Trigger Condiment Group | Select the trigger condiment group. This field is dimmed when Trigger MI Group is set to 0 - Use Discount Itemizers. |
| Options      | Select 25 - Discount Combo Meal Group Items if you want combo group menu items to be discounted. You must also select option 1 - Allow Discounts in the Combo Meal Groups module. |

4. On the Effectivity tab, select the days on which the application applies the discount.
5. On the RVC Type tab, select the revenue centers that can use this discount.

6. On the Menu Levels tab and in the Menu Level Configuration group, select all options for Active On Main Levels and Active On Sub Levels.

7. On the Output tab, select the following options:
   - Print on Customer Receipt
   - Print on Journal
   - Print on Guest Check

8. Click **Save**.

**Related Topics**
- Applying Discounts Using Condiments

---

**Creating the Discount Button**

1. In the EMC, select the Enterprise, property, or zone, click **Configuration** and **Page Design**.

2. In the **Type** field, select **Discount**.

3. Click the black arrow beneath the Type field, select the discount, and click **OK**.

4. Click **Save**.

**Related Topics**
- Applying Discounts Using Condiments

---

**Configuring Menu Item Groups**

1. In the EMC, select the Enterprise, property, or zone, click **Configuration**, and **Menu Item Groups**.

2. Insert a menu item group record and then double-click it to open.

3. Click **Add** near one of the following areas:
   - Include – You can add the menu item groups to include in the discount here
   - Exclude – You can add the menu item groups to exclude from the discount here

4. Select information for the fields described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
   | **Type** | Select the grouping you want to include or exclude:  
   |         | • 0 - None  
   |         | • 1 - All  
   |         | • 2 - By Major Group  
   |         | • 3 - By Family Group  
   |         | • 4 - By Menu Item  
   | **Start #** | Click in this field, but do not enter a value. |
Table 7-12  (Cont.) Include and Exclude Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>End #</td>
<td>Click in this field, but do not enter a value.</td>
</tr>
<tr>
<td>See Items and Select</td>
<td>Click the link and then select the menu item(s) to be the trigger. This item appears in the End # field.</td>
</tr>
<tr>
<td>Range</td>
<td>The item(s) you selected in the See Items and Select dialog appear in this field.</td>
</tr>
</tbody>
</table>
| Override Price Amount/Percentage (Include only)     | If you want a discount to apply to menu items differently, use this field. For example, you can set discounts for Sweet Potato Fries to 15% and Pub Fries to 20%.  
To use this field with automatic discounts, you must select the Use Price in MI Group Detail option in the Discounts (Auto) module. You can set amount off, percent off, or amount substitution, based on the discount configuration. For example, enter 10.00 to indicate 10% off (not 0.10). |

5. Click **Save**.

**Related Topics**

- Menu Item Groups
Service Charges

A service charge is the amount added to a sales transaction for a service rendered and is posted to one of the following parties:

- The person or people providing the service (for example, a server or bartender, or a team of servers)
- The House or the establishment providing the service

You can configure the following types of service charges:

- Service changes that report as Tips on employee tip reports
- Service changes that report as Service Charges on employee tip reports
- Service changes that are paid to the House
- Non-revenue service charges
- Gift certificates sold
- Configuring Service Charges

Related Topics

- Configuring Service Charges

Configuring Service Charges

1. In the EMC, select the Enterprise, property, or zone, click Configuration and Service Charges.
2. Insert the service charge record and then double-click it.
3. On the General Settings tab, enter the fields as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent</td>
<td>Enter the service charge percentage.</td>
</tr>
<tr>
<td>Amount</td>
<td>Enter the service charge amount.</td>
</tr>
<tr>
<td>Tips Paid Tender/Media</td>
<td>If you want to link a tender to the service charge, select the Tender/Media from the drop-down list.</td>
</tr>
<tr>
<td>HALO</td>
<td>Enter the High Amount Lock Out (HALO) value for the service charge. This field prevents workstation operators from entering abnormally high values for the service charge. To exceed this limit, the workstation operator must have the Authorize/Perform Over HALO Amounts on Service Charge Keys option set for the employee role. When you set this value to 0, there is no HALO for the service charge. This field does not apply to automatic service charges.</td>
</tr>
</tbody>
</table>
Table 8-1  (Cont.) General Settings Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Class</td>
<td>If you want to apply a tax class to the service charge, select a <strong>Tax Class</strong> from the drop-down list.</td>
</tr>
<tr>
<td>Privilege Group</td>
<td>Select a Privilege Group to restrict use of this service charge to employees who are linked to the same privilege group. You can set the field to 0 to allow all employees to use the service charge.</td>
</tr>
<tr>
<td>Percent to Tips Paid</td>
<td>Select the trigger condiment group. This field is dimmed when you set the <strong>Trigger MI Group</strong> to 0 - <strong>Use Discount Itemizers</strong>.</td>
</tr>
<tr>
<td>Report Group</td>
<td>Select the report group to which this service charge record belongs. Report groups are sub-categories that allow reports to show similar service charges grouped and subtotaled together. You can set report groups in the Report Groups module, in the Reporting section of the Property tab.</td>
</tr>
</tbody>
</table>

4. Select the Service Charge options as described in the following table:

Table 8-2  Service Charge Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - ON = Open; OFF = Preset</td>
<td>Select this option to make the service charge an open service charge, prompting the workstation operator for the amount or percentage. Deselect this option to use a preset amount or preset percentage for the service charge.</td>
</tr>
<tr>
<td>2 - ON = Amount; OFF = Percentage</td>
<td>Select this option to make the service charge an amount service charge. Deselect this option to make the service charge a percentage service charge.</td>
</tr>
<tr>
<td>3 - Post to Charged Tips Total on Tip Reports</td>
<td>Select this option to post the service charge to the Direct Charged Tips total and to add it to the Total Tips on employee tip reports. This setting records charged tips that employees receive directly from customers. If you select this option, workstation operators who use it must also enter a charged tip payment using a tendering key with Tender/Media option <strong>Post to Charged Receipts on Tip Reports</strong> set. Select either 3 - <strong>Post to Charged Tips Total</strong> on Tip Reports or 11 - <strong>Do Not Post to Gross Receipts</strong>, but not both. Select either 3 - <strong>Post to Charged Tips Total</strong> on Tip Reports or 4 - <strong>Post to Service Charges Total on Tip Reports</strong>, but not both.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>4 - Post to Service Charges Total on Tip Reports</td>
<td>Select this option to post the service charge to the Service Charges total, but not the Total Tips or the Gross F&amp;B Receipts total. Use this option for service charges that are paid to the House. This setting records tips that employees receive as wages through payroll. Deselect this option to post the service charge to the Gross F&amp;B Receipts, but not the Service Charges total. The Service Charges total on tip reports meets the reporting requirements of United States IRS Form 8027, which states that this total should equal all tips that are paid to the employee as wages, and are less than 10% of the transaction total. Select either 3 - Post to Charged Tips Total on Tip Reports or 4 - Post to Service Charges Total on Tip Reports, but not both.</td>
</tr>
<tr>
<td>5 - Reference Entry Required</td>
<td>Selecting this option requires the workstation operator to enter a name or number when using the service charge.</td>
</tr>
<tr>
<td>6 - Validation Required</td>
<td>Select this option to print a validation chit when the workstation operator uses the service charge.</td>
</tr>
<tr>
<td>7 - Non-Revenue Service Charge (No Post to Sales)</td>
<td>Select this option to create a service charge that can be paid by credit card without posting to the Simphony sales totals. (A tracking group total can track this amount if necessary.) This option is often used to create a service charge for gift certificate sales as the customer can pay for the gift certificate with a credit card. When you select this option, you must configure the service charge as an amount service charge. A non-revenue service charge cannot post to a check that contains menu items. If the tender requires a cashier link, posting a non-revenue service charge also requires a cashier link. When using this option, deselect options 3 and 4.</td>
</tr>
<tr>
<td>8 - Taiwanese Paid Out</td>
<td>Select this option to create a service charge records repayment of cash from a Taiwanese paid out.</td>
</tr>
<tr>
<td>9 - Reset Itemizer(s)</td>
<td>Select this option to reset service charge itemizers. This option prevents all service charges from being applied twice to menu items that post to the same service charge itemizers. Deselecting this option allows multiple service charges to apply to the same service charge itemizers.</td>
</tr>
<tr>
<td>10 - Service Charge Adds to Guest Count</td>
<td>Select this option to increment the transaction’s guest count by one every time the service charge applies to the transaction. This option is often used for non-revenue service charges that apply as cover charges. Selecting the RVC Parameter option 8 - Use Number of Seats for Guest Count overrides the setting of this option. When the workstation operator presses the Number of Guests key during a transaction, the guest count no longer increments when the service charge applies to the transaction. The workstation operator must maintain the guest count manually from that point.</td>
</tr>
</tbody>
</table>
Table 8-2  (Cont.) Service Charge Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 - Do Not Post to Gross Receipts</td>
<td>Select this option to prevent this service charge from posting to gross F&amp;B receipts on tip reports. This is intended for service charges that meet the United States Internal Revenue Service’s definition of non-allocable receipts (as defined in the IRS Instructions for Form 8027). Deselecting this option allows the service charge to post to gross F&amp;B receipts on the tip reports. Select either <strong>3 - Post to Charged Tips Total on Tip Reports</strong> or <strong>11 - Do Not Post to Gross Receipts</strong>, but not both.</td>
</tr>
<tr>
<td>12 - Item is Shareable</td>
<td>Select this option to share the item between two or more seats or two or more checks when using TouchEdit or TouchSplit.</td>
</tr>
<tr>
<td>13 - Cash Tips</td>
<td>Select this option to add the Direct Cash Tips total on the tip reports. Selecting option <strong>3 - Post to Charged Tips Total on Tip Reports</strong> or <strong>4 - Post to Service Charges Total on Tip Reports</strong> overrides this option. This option is used in a cashier environment where the customer leaves the table and pays their check directly with a cashier. After paying the bill, the cashier can post a value to a Cash Tip Service Charge. This Cash Tip Service Charge posts to the employee’s Direct Cash Tips total on the Employee Tip Report.</td>
</tr>
<tr>
<td>14 - Service Charge Used For Stored Value Transactions</td>
<td>Select this option if the service charge is used for stored value transactions.</td>
</tr>
<tr>
<td>15 - Mask Account Number</td>
<td>Use this option for service charges with reference entries. Select this option to mask the account number (often a gift card number or other reference entry) on guest checks and customer receipts. Deselect this option to keep the text un-masked.</td>
</tr>
<tr>
<td>16 - Encrypt Service Charge Reference Entry</td>
<td>Use this option for service charges with reference entries. Select this option to encrypt the reference entry (in the Oracle Hospitality relational database) that is associated with the service charge. Deselect this option to post the unencrypted reference entry information to the relational database.</td>
</tr>
<tr>
<td>17 - Use Floor Amount (Automatic Service Charges Only)</td>
<td>This option only applies to the service charge in revenue centers where it is used as an automatic service charge. Select this option to require a minimum value for the automatic service charge. Then enter the minimum floor amount in the Amount field, which is only active for percentage service charges when you select option <strong>17</strong>.</td>
</tr>
</tbody>
</table>
Table 8-2  (Cont.) Service Charge Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>18 - Gift Certificate Sold</td>
<td>Select this option to create a service charge that can be paid without posting to the application’s sales totals. (A tracking group total can track the amount if necessary.) This option is similar to 7 - Non-Revenue Service Charge, except that menu items can be present on the check in addition to the service charge. When you select this option, you must configure the service charge as an amount. If a tender requires a cashier link, posting a non-revenue service charge also requires a cashier link. Selecting this option dims option 7.</td>
</tr>
<tr>
<td>21 - Post To Till Totals</td>
<td>Select this option if you are using Cash Management and the server must be assigned to a Cash Management till when applying the service charge. Deselect this option if the Cash Management accounting method is set to Server Banking.</td>
</tr>
<tr>
<td>22 - Add to Checks Begun/Paid Count if Non-Revenue</td>
<td>This option applies to the service charge if it is configured as non-revenue (option 7 is set). Selecting this option increases the checks begun or paid count on reports when the non-revenue service charge applies to a transaction. Deselecting this option results in no change to the checks begun or paid count.</td>
</tr>
<tr>
<td>23 - Rental Deposit</td>
<td>Select this option to use the service charge as a rental deposit. Rental deposits work with the deposit handling feature and are necessary to apply a deposit to a check. Service charges with this option set may be non-revenue service charges. However, unlike traditional non-revenue service charges, a check may contain more than one rental deposit service charge.</td>
</tr>
<tr>
<td>26 - Configure as Banquet Tip</td>
<td>Select this option to include the amount of the service charge transaction in the Tip line item of the banquet check.</td>
</tr>
<tr>
<td>27 - Configure as Banquet Fee</td>
<td>Select this option to include the amount of the service charge transaction in the Fees line item based upon the selected service charge on the banquet check.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Related Topics**

- Service Charges
Setting Up Menu Items

A menu item is the foundation of transactions. Anything ordered is a menu item. In restaurants, food and drinks are menu items. In retail stores, shirts and hats are also considered menu items. Therefore, any item being sold is a menu item.

- Menu Item Programming Best Practices
- Major Groups
- Family Groups
- Menu Item Master and Menu Item Definitions
- Menu Item Classes
- Menu Item Pricing
- Screen Look Up (SLU)
- Number Look Up (NLU)
- Menu Levels
- Sales Itemizers
- Configuring Major Groups
- Configuring Family Groups
- Configuring Menu Item Classes
- Configuring Menu Item Prices
- Setting Main, Sub, and Custom Menu Levels
- Setting the Default Main and Sub Levels for Serving Periods
- Configuring Auto Menu Levels
- Setting the Default Menu Levels for a Revenue Center
- Configuring Active Menu Levels for Menu Item Definitions
- Configuring Menu Item Functionality on the Workstation
- Configuring Sales Itemizers
- Configuring Master Records for Menu Items
- Configuring Menu Item Definitions
- Adding and Disabling Menu Items
- Configuring Menu Item Availability from the EMC
- Configuring Menu Item Availability for Multiple Definitions at the Workstation
- Configuring a Weighed Menu Item
- Understanding Tare Weight
- Setting the Tare Weight for a Menu Item
• Menu Item Fees
• Configuring Menu Item Fees
• Configuring Screen Look Ups for Menu Items
• Configuring Screen Look Ups for Discounts
• Configuring Screen Look Ups for Service Charges
• Configuring Screen Look Ups for Tender/Media Records
• Configuring Screen Look Ups for Family Groups
• Configuring Screen Look Ups for Major Groups
• Configuring Screen Look Ups for Custom Reports
• Configuring Screen Look Ups for Open Checks
• Configuring Number Look Ups for Discounts
• Configuring Number Look Ups for Service Charges
• Configuring Number Look Ups for Tender/Media Records
• Configuring Number Look Ups for Main and Sub Levels
• Menu Item Waste Checks
• Allowing Employees to Begin Waste Checks and Run Waste Check Reports
• Configuring Waste Reasons
• Configuring Waste Receipt Headers and Trailers
• Hiding Price Details on Waste Checks
• Creating the Declare Waste Button
• Menu Item Waste Reports

Menu Item Programming Best Practices

Oracle Hospitality recommends configuring menu items in the following order:

Figure 9-1 Sequence for Programming Menu Items
Major Groups

A major group is a basic category of a menu item, such as Food or Liquor. Every menu item belongs to a major group. Examples of major groups include:

- Food
- Liquor
- Beer
- Wine

You can configure major groups based on your database and reporting needs. For example, you can configure major groups to represent leased outlets so that an accountant can immediately see sales figures for a tenant.

Related Topics
- Configuring Major Groups

Family Groups

A family group is a category of menu items. Every menu item belongs to a family group. A family group is a sub-category of a major group. For example, if the major group is food, its family groups are appetizer, salad, dessert, and entrée.

Related Topics
- Configuring Family Groups

Menu Item Master and Menu Item Definitions

A menu item master record is a property-level menu item record. This record resides at the top of the menu item hierarchy, and its primary purpose is to appear in reports. A menu item master:

- Does not appear on workstation touchscreens
- Does not have a price

A menu item can have only one menu item master per property (for example, one Shrimp Cocktail master record exists).

A menu item definition record is a revenue center-level menu item record. Menu item definitions determine how menu item master records act, how and when they appear to a workstation operator, including:

- Screen look up (SLU) on which the menu item appears
- Menu item class to which it belongs
- Menu levels where the item is active
- Name of the item that appears on touchscreens

Menu item definitions are the records that customers can order. Menu item definitions appear on touchscreens and print on order chits, guest checks, and customer receipts. A menu item can have up to 64 menu item definitions in a revenue center for a single
menu item master. The following figure shows the relationship between the menu item master and menu item definitions.

When customers order menu items (configured as menu item definitions), the sale count of the menu item master increases. This is the purpose of the menu item master record. Only one instance of the item needs to exist in a property, but multiple menu item definitions allow this master record to behave differently.

Related Topics
- Configuring Master Records for Menu Items
- Configuring Menu Item Definitions
- Adding and Disabling Menu Items
- Configuring Menu Item Availability from the EMC
- Configuring Menu Item Availability for Multiple Definitions at the Workstation

Menu Item Classes

A menu item class consists of a set of options that apply to similar menu items in a revenue center. A menu item class specifies important information, including:
- The tax class associated with the menu items
- Whether or not the item is a condiment
- The functionality of menu levels after ordering an item
- The order devices to which the items print

Configuring similar menu items into a class is easier than individually setting each menu item's order device output or condiment settings. For example, the menu items Coke, Diet Coke, Sprite, and Root Beer all share the following characteristics:
- Receive the same tax rates
- Do not require condiments
- Print to the same order device

Therefore, you can create one menu item class called Soda and make all soda menu items a part of this class.

Related Topics
- Configuring Menu Item Classes
Menu Item Pricing

A menu item price is the amount charged for the sale of a menu item. In Simphony, menu item prices are configured per menu item definition. Typically a menu item definition is set with one price. You can set a definition with multiple prices (for example, separate prices for a small, medium, and large soda), or no price (common for condiments).

When multiple prices are active for a menu item definition, the workstation searches the prices assigned to the definition starting with price sequence number 1, then price sequence number 2, and so on. The workstation adds the first price that meets the active level to the check. For example, based on the configuration described in the following table, the item price is $8.00 when ordered on menu level 7, and $4.00 when ordered at any other level. The workstation's logic is:

- The current level of the transaction is level 5.
- Price number 1 for the item is active on level 7. Continue to the next price.
- Price number 2 for the item is active on level 0. This represents any level. The item is $4.00.

Table 9-1  Correct Menu Prices and Levels

<table>
<thead>
<tr>
<th>Price Sequence Number</th>
<th>Price</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>8.00</td>
<td>7 - Double</td>
</tr>
<tr>
<td>2</td>
<td>4.00</td>
<td>0 - All Levels</td>
</tr>
</tbody>
</table>

When configuring multiple prices, you must always configure the 0 - All Levels price level as the last price sequence number for the definition. For example, in the following table, the configurations in the previous table are reversed.

Table 9-2  Incorrect Menu Prices and Levels

<table>
<thead>
<tr>
<th>Price Sequence Number</th>
<th>Price</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4.00</td>
<td>0 - All Levels</td>
</tr>
<tr>
<td>2</td>
<td>8.00</td>
<td>7 - Double</td>
</tr>
</tbody>
</table>

The workstation's logic is:

- The current level of the transaction is level 7.
- Price number 1 for the item is active on level 0; this includes all levels. The item is $4.00.

The item price $8.00 never becomes active because the 0 - All Levels price level is set as the first price sequence for the definition.

Related Topics
- Configuring Menu Item Prices
Screen Look Up (SLU)

Similar to a number look up (NLU), a screen look up (SLU) is a touchscreen button that gives workstation operators access to a list of items, except the workstation shows each item in the list as a separate touchscreen button. For example, the Open Check SLU shows separate touchscreen buttons for each open check within the revenue center. When a workstation operator presses a SLU (for example, appetizers), the workstation shows all menu items belonging to that SLU group. Typically menu item buttons are not added directly to a touchscreen, but instead menu items are usually linked to SLU groups.

You can configure screen look ups for the following items:

- Menu Items
- Discounts
- Service Charges
- Tender/Media Records
- Family Groups
- Major Groups
- Custom Reports
- Open Checks

Related Topics
- Configuring Screen Look Ups for Menu Items
- Configuring Screen Look Ups for Discounts
- Configuring Screen Look Ups for Service Charges
- Configuring Screen Look Ups for Tender/Media Records
- Configuring Screen Look Ups for Family Groups
- Configuring Screen Look Ups for Major Groups
- Configuring Screen Look Ups for Custom Reports
- Configuring Screen Look Ups for Open Checks

Number Look Up (NLU)

A number look up (NLU) is a touchscreen button that allows workstation operators to access a numbered list of items. The workstation operator can select one of the following items in the list or enter the relevant NLU number to apply the item to the transaction:

- Discounts
- Main Levels
- Service Charges
- Sub Levels
- Tender/Media
If you want items to appear in NLU, you must configure a valid NLU number greater than zero (0) for each record. In an improperly configured database, it is possible for two records to have the same NLU number. If this occurs, the workstation applies the lowest numbered record (by object number) to the check. When showing discounts, service charges, and tender/media records, the workstation takes the active menu level of the transaction into consideration.

Related Topics
- Configuring Number Look Ups for Discounts
- Configuring Number Look Ups for Service Charges
- Configuring Number Look Ups for Tender/Media Records
- Configuring Number Look Ups for Main and Sub Levels

Menu Levels

Menu levels determine where and when a workstation operator exists during a transaction. Simphony uses menu levels to:

- Determine what workstation operators can and cannot access during a transaction. For example, shared revenue centers are often configured so that two revenue centers are active on different transaction levels, making some items visible to one revenue center, while the other revenue center shows different items.
- Allow different prices for one menu item.

A main menu level and a sub menu level are always active. You can determine which levels are active by default (using the menu level hierarchy) and allow workstation operators to change the levels during a transaction using a function key or menu level pop-ups. You can also configure the status bar in the lower area of the workstation to show main and sub level names that are active.

Auto Menu Level

You can set the main menu level, sub menu level, or both to change automatically at a specific time of day. This configuration is called auto menu level, and controls pricing at different times of a day or week. For example, a revenue center can offer an Early Bird Special (entrées are 20% off) every weekday from 3:00 p.m. to 6:00 p.m. For the Early Bird Special to automatically occur, you can set an auto menu level from 3:00 p.m. to 6:00 p.m. Monday through Friday. Set menu item definitions with multiple prices accordingly (one price for the Early Bird level and another general price).

You can set auto menu levels to overlap (although this is uncommon). In this case, menu levels become active based on the order in which you set the auto menu levels. After the workstation determines that one level is active, it does not look at the other auto menu levels. Therefore, you must pay special attention when configuring multiple auto menu levels that occur on the same days at the same times.

As an example, based on the configuration described in the following table, at 3:00 p.m., the main level becomes 2 - Early Bird. The main level does not change to 3 - Free Drinks at 4:00 p.m. When a transaction begins, the workstation considers the auto menu level table in the order of the configured auto levels. The workstation checks the status of auto menu level and because it is active, the workstation continues to use the Early Bird menu level. In this example, the Free Drinks menu level never becomes active.
Table 9-3  Example of Incorrect Auto Menu Levels

<table>
<thead>
<tr>
<th>Number</th>
<th>Main Level</th>
<th>Start</th>
<th>End</th>
<th>Days Active</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2 - Early Bird</td>
<td>15:00</td>
<td>18:00</td>
<td>Monday–Friday</td>
</tr>
<tr>
<td>2</td>
<td>3 - Free Drinks</td>
<td>16:00</td>
<td>17:00</td>
<td>Monday–Friday</td>
</tr>
</tbody>
</table>

According to the configuration in the following table, at 3:00 p.m. the main level become 2 - Early Bird, and at 4:00 p.m. the main level becomes 3 - Free Drinks. This occurs because the Free Drinks level is set at auto level 1, and starts after Early Bird, which is set at auto level 2.

Table 9-4  Example of Correct Auto Menu Levels

<table>
<thead>
<tr>
<th>Number</th>
<th>Main Level</th>
<th>Start Time</th>
<th>End Time</th>
<th>Days Active</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3 - Free Drinks</td>
<td>16:00</td>
<td>17:00</td>
<td>Monday–Friday</td>
</tr>
<tr>
<td>2</td>
<td>2 - Early Bird</td>
<td>15:00</td>
<td>18:00</td>
<td>Monday–Friday</td>
</tr>
</tbody>
</table>

The workstation’s logic for these two menu levels is explained in the following table.

Table 9-5  Workstation Logic

<table>
<thead>
<tr>
<th>Time</th>
<th>Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>15:00</td>
<td>Is auto level 1 active? No</td>
</tr>
<tr>
<td></td>
<td>Is auto level 2 active? Yes. Active main level is 2 - Early Bird</td>
</tr>
<tr>
<td>16:00</td>
<td>Is auto level 1 active? Yes. Active level is 3 - Free Drinks</td>
</tr>
<tr>
<td>17:00</td>
<td>Is auto level 1 active? No</td>
</tr>
<tr>
<td></td>
<td>Is auto level 2 active? Yes. Active main level is 2 - Early Bird</td>
</tr>
<tr>
<td>18:00</td>
<td>Is auto level 1 active? No</td>
</tr>
<tr>
<td></td>
<td>Is auto level 2 active? No</td>
</tr>
<tr>
<td></td>
<td>The main level is 1 - Regular, which is the default menu level</td>
</tr>
<tr>
<td></td>
<td>for the revenue center</td>
</tr>
</tbody>
</table>

Menu Level Hierarchy

The following menu level hierarchy determines which setting controls the default transaction menu levels:

Table 9-6  Menu Level Hierarchy

<table>
<thead>
<tr>
<th>Number</th>
<th>Enterprise Management Console (EMC) Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Serving Periods</td>
<td>If the active serving period has a main or sub level</td>
</tr>
<tr>
<td></td>
<td></td>
<td>that is not 0, that is the active main or sub level.</td>
</tr>
</tbody>
</table>
### Menu Level Configuration Tasks

Setting up menu levels consists of completing the following tasks:

- Set up main, sub, and custom menu levels
- Configure the default main and sub levels for serving periods
- Configure auto menu levels
- Configure the default menu levels for a revenue center
- Configure the active menu levels for menu item definitions
- Configure the functionality of menu items at the workstation

#### Related Topics

- Setting Main, Sub, and Custom Menu Levels
- Setting the Default Main and Sub Levels for Serving Periods
- Configuring Auto Menu Levels
- Setting the Default Menu Levels for a Revenue Center
- Configuring Active Menu Levels for Menu Item Definitions
- Configuring Menu Item Functionality on the Workstation

### Sales Itemizers

When the workstation operator adds items to a check, Simphony maintains various subtotals, known as itemizers, in the background. An itemizer is a bucket where totals accumulate. Simphony uses sales itemizers to separate menu item sales into categories such as food, beverage, and merchandise. You can configure up to 16 sales itemizers.

#### Related Topics

- Configuring Sales Itemizers
Configuring Major Groups

1. In the EMC, select the Enterprise, property, or zone, click **Configuration** and **Major Groups**.
2. Insert a new record and enter a name for the major group (for example, Food).
3. Enter a number other than 0 (zero) in the **Report Group** field.
   For example, you can enter 1 for the Food major group and enter 2 for the Liquor major group. When you enter 0 (zero), the menu item does not appear on the Menu Item Report.
4. Click **Save**.

**Related Topics**
- Major Groups

Configuring Family Groups

1. In the EMC, select the Enterprise, property, or zone, click **Configuration** and **Family Groups**.
2. Insert a new record and enter a name for the family group (for example, Appetizers).
3. Enter a number other than 0 (zero) in the **Report Group** field.
   For example, you can enter 1 for all family groups associated with Food and enter 2 for all family groups associated with Liquor. When you enter 0 (zero), the menu item does not appear on the Menu Item Report.
4. Select the **Parent Major Group** to which the new family group belongs.
5. Click **Save**.

**Related Topics**
- Family Groups

Configuring Menu Item Classes

For instructions on configuring menu item classes for condiments and fixed price meals, see **Creating Menu Item Classes for Condiment Groups**.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Classes**.
2. Insert a new record and enter a name for the new menu item class.
3. Double-click the new menu item class.
4. On the General tab, configure the appropriate settings:
## Table 9-7  General Menu Item Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Class</td>
<td>Select the tax class to apply to the menu item class. If you do not want to apply a tax class, select 0 - None.</td>
</tr>
<tr>
<td>Main Level Popup</td>
<td>Select the Main Level of the transaction that becomes active after ordering a menu item from the menu item class.</td>
</tr>
<tr>
<td>Sub Level Popup</td>
<td>Select the Sub Level of the transaction that becomes active after ordering a menu item from the menu item class.</td>
</tr>
</tbody>
</table>
| Privilege Group   | Select a Privilege Group number to restrict the use of menu items in the menu item class to employees who are linked to the same Privilege Group. 
If you want all employees to order items in the menu item class, select 0 (zero). |
| Sales Itemizer    | Select the sales itemizer to sort the menu item class.                                                                                     |
| Discount Itemizer | Select the discount itemizer to determine which discounts can apply to specific menu items.                                                 |
| Srv Chrg Itemizer | Select the service charge itemizer to determine which service charges can apply to specific menu items.                                     |
| HALO              | Enter the High Amount Lock Out value for menu items in the class. This value is the total dollar amount of the items that are being ordered. |
| Pricing Calculation | Select the calculation method to use for pricing menu items in the class.  
- If you want the price to be based on the amount entered, select 0 - Based on entered count  
- If you want the price to be based on the rounded up count, select 1 - Based on sales count when sales rounded up. |
| Count Display     | Select the manner in which the amount appears for a decimal item on the workstation and printers.  
- If you want the amount entered to appear, select 0 - Show entered amount  
- If you want the sales count to appear, select 1 - Show sales count amount with entered count as reference |
| Count Entry       | Select the way that workstation operators can enter the sales count of an item in the class.                                                  |

5. Click the Options tab and select the appropriate options.
Table 9-8  Menu Item Class Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - ON = Open-Priced Menu Items; OFF = Preset Menu Items</td>
<td>Select this option to require workstation operators to enter a price when adding a menu item in the class. Deselect this option if you are using preset prices.</td>
</tr>
<tr>
<td>3 - Negative Priced Menu Items</td>
<td>Select this option if you want menu items in this class to post a negative price.</td>
</tr>
<tr>
<td>4 - Increment Seat Number With Sale of these Menu Items</td>
<td>Select this option if you want to increase the seat number each time a workstation operator adds a menu item in the class.</td>
</tr>
<tr>
<td>5 - Reference Entry Required</td>
<td>Select this option to require workstation operators to enter a reference entry when adding menu items in the class.</td>
</tr>
<tr>
<td>6 - Validation Required</td>
<td>Select this option if you want a validation chit to print at the validation printer designated in the Workstation module.</td>
</tr>
<tr>
<td>7 - Item Discounts May Be Applied to these Menu Items</td>
<td>Select this option to allow menu items in the class to be discounted with an item discount (manual discount only).</td>
</tr>
<tr>
<td>8 - Allow Menu Items in this Class to be Non-Priced</td>
<td>Select this option to allow menu items in the class to be non-priced.</td>
</tr>
<tr>
<td>10 - ON = Use Sub Level Pricing; OFF = Use Main Level Pricing</td>
<td>Select this option to use Sub Level pricing for the menu item class.</td>
</tr>
<tr>
<td>11 - Add to Guest Count</td>
<td>Select this option to increase the guest count each time a workstation operator adds menu items in the class.</td>
</tr>
<tr>
<td>13 - Print Price on Order Chit</td>
<td>Select this option if you want to print the menu item price on order printers. This option is typically used with open-priced menu items.</td>
</tr>
<tr>
<td>14 - Do Not Put in Transaction Detail</td>
<td>Select this option to prevent zero-priced or non-priced menu items in the class from printing, appearing, or posting.</td>
</tr>
<tr>
<td>38 - Item is Shareable</td>
<td>Select this option to allow menu items in the class to be shared between two or more seats, or two or more checks.</td>
</tr>
<tr>
<td>45 - Use KDS/Dining Course Number</td>
<td>Select this option to use KDS/Dining Coursing with the menu item class.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

**Related Topics**

- Menu Item Classes

**Configuring Menu Item Prices**

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Maintenance**.

2. Click **Search** to show all menu items, and double-click a menu item master record.
3. Click **Prices**, and click the **Insert** button on the toolbar.

4. Select **Price Sequence #1**, enter the **Default Price** for the menu item, and click **OK**.

5. Configure the price record. The following table explains the price record fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Optional) Prep Cost</td>
<td>Enter the menu item prep cost.</td>
</tr>
<tr>
<td>Tax Class Override</td>
<td>If you want the menu item price to use a different tax class than the tax class configured for the menu item definition, select a new tax class from the list.</td>
</tr>
<tr>
<td></td>
<td>If you select 0-None, the price uses the tax class configured for the menu item class associated with the menu item definition.</td>
</tr>
<tr>
<td>Service Charge Group</td>
<td>If the price includes a service charge, select a service charge group from the list.</td>
</tr>
<tr>
<td>Active on Level</td>
<td>Select the main or sub menu level in which this price becomes active.</td>
</tr>
<tr>
<td></td>
<td>If you select 0-All Levels, the price is active for all menu levels.</td>
</tr>
<tr>
<td>Options</td>
<td>If the price applies for the item when ordered as a course for a fixed price meal, select 1 - <strong>Price for Fixed Price Meal Course</strong>.</td>
</tr>
<tr>
<td></td>
<td>If the price applies when the item is ordered as a course for a fixed price meal as well as when ordered as a normal menu item entry, select 2 - <strong>Price for Fixed Price Meal Course and Regular Menu Item</strong>.</td>
</tr>
<tr>
<td>Effectivity Group</td>
<td>If you want the price to become active at a specific date and time, select the corresponding effectivity group from the list.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

7. Repeat Steps 3 through 6 to add more price definitions for the menu item.

**Related Topics**

- **Menu Item Pricing**

**Setting Main, Sub, and Custom Menu Levels**

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Level Sets**.

2. If you want to create a custom menu level, insert a new record and enter a custom level set name.

3. If you want to define main menu levels, double-click **Main**.

4. If you want to define sub menu levels, double-click **Sub**.
5. If you want to define menu levels for a custom level set, double-click the new custom level that you created in Step 2.

6. Select the appropriate options:
   a. If you want the menu level to change to the default level when a workstation operator presses a touchscreen button corresponding to any menu level in this menu level set again, select 1 - Pressing level key again reverts to default level.
   b. If the menu level set is bound to a Default Master Group and you want the workstation to switch the active parent menu item when the active menu level changes, select 2 - Bound to parent.

7. (Optional) Select the Default Master Group for the menu level set.

8. In the Menu Level Entries section, define the menu levels. For example, Breakfast, Lunch, Dinner.

9. (Optional) Define the Prefix or Suffix for each menu level to show on the check detail area and print on guest checks and customer receipts.

10. To define a menu level as the default level for the menu level set:
    a. In the Options column, click the ellipsis point (...) symbol adjacent to the default menu level.
    b. Select 1 - Default and click OK.

11. To define a menu level as an anonymous level for the menu level set:
    a. In the Options column, click the ellipsis point (...) symbol adjacent to the anonymous menu level.
    b. Select 2 - Anonymous and click OK.

   The Default and Anonymous menu levels are generic, and are typically used with $0.00 priced menu item definitions that have names such as {SIZE} Hot Drink or {TEMP} Drink.

12. Click Save.

Related Topics
• Menu Levels

Setting the Default Main and Sub Levels for Serving Periods

1. In the EMC, select the revenue center, click Configuration and Serving Periods.
2. Double-click a serving period record.
3. In the General tab, select the Default Main Level and the Default Sub Level.
4. Click Save.

Related Topics
• Menu Levels

Configuring Auto Menu Levels

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Auto Menu Levels.
2. In the **Start** column, enter the time at which the menu level becomes active.

3. In the **End** column, enter the time at which the menu level becomes inactive.

4. Select the **Main Level** and the **Sub Level**.

5. In the **Options** column, click the ellipsis point (…) symbol.

6. Select **1 - This Entry is Active**, and select one or more of the following options that correspond with the days that the menu level should become active:
   - 2 - Active On Sunday
   - 3 - Active On Monday
   - 4 - Active On Tuesday
   - 5 - Active On Wednesday
   - 6 - Active On Thursday
   - 7 - Active On Friday
   - 8 - Active On Saturday

7. Click **Save**.

**Related Topics**
- **Menu Levels**

### Setting the Default Menu Levels for a Revenue Center

1. In the EMC, select the revenue center, click **Setup** and **RVC Parameters**.

2. In the General tab, select the **Default Main Level** and the **Default Sub Level**.

3. Click the Options tab and set the main and sub menu levels as follows:
   - If you want the workstation to remain at the current main menu level after completing a transaction, select **23 - Retain Current Main Level after a Transaction**.
   - If you want the workstation to remain at the current sub menu level after completing a transaction, select **24 - Retain Current Sub Level after a Transaction**.

4. Click **Save**.

**Related Topics**
- **Menu Levels**

### Configuring Active Menu Levels for Menu Item Definitions

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Maintenance**.

2. Search for and then double-click a menu item master record.

3. If the menu item has multiple definitions, select a definition and click the General tab.

4. In the Menu Level Availability section, select the active main and sub levels for the item.
5. If you want the menu item definition to be active on all menu levels, click **All**.

6. If you want the definition to be active on a custom menu level:
   a. Click **Menu Levels Tab**, select a **Menu Level Set**, and select the menu levels.
   b. If you want the definition to be active on all custom levels, select **Active on All Levels**.

7. If the menu item has multiple price records click **Prices** and select the **Active Menu Level** for each price definition.

If the menu item belongs to a class that uses sub level pricing (menu item class option **10 - ON = Use Sub Level Pricing; OFF = Use Main Level Pricing** is set), the application only lists sub levels. Otherwise, the application only lists the main levels.

8. Click **Save**.

**Related Topics**

- **Menu Levels**

---

**Configuring Menu Item Functionality on the Workstation**

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Classes**.

2. Double-click a menu item class.

3. If you want the main level of the transaction to change to another level when a workstation operator orders a menu item from this class, select a new **Main Level Popup**.

4. If you want the sub level of the transaction to change to another level when a workstation operator orders a menu item from this class, select a new **Sub Level Popup**.

5. If you want the transaction to return to the default main level after a workstation operator orders a menu item from this class, select **Main Level Default**.

6. If you want the transaction to return to the default sub level after a workstation operator orders a menu item from this class, select **Sub Level Default**.

7. Click the Options tab and select the appropriate options:

**Table 9-10  Menu Item Functionality Options at the Workstation**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 - ON = Use Sub Level Pricing; OFF = Use Main Level Pricing</td>
<td>Select this option if an item has multiple price definitions and you want the workstation to use sub level pricing for the menu item class.</td>
</tr>
<tr>
<td>26 - Keep Main Level With Repeat Rounds</td>
<td>Select this option if you want the items in the class to use the same main menu level that was in effect during the most recent service round when ordered using the <strong>Repeat Round</strong> touchscreen button.</td>
</tr>
</tbody>
</table>
Table 9-10  (Cont.) Menu Item Functionality Options at the Workstation

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>27 - Keep Sub Level With Repeat Rounds</td>
<td>Select this option if you want the items in the class to use the same sub menu level that was in effect during the most recent service round when ordered using the Repeat Round touchscreen button.</td>
</tr>
<tr>
<td>28 - Print Main Level Prefix and Suffix</td>
<td>Select this option if you want the workstation to show the main menu level prefixes or suffixes on the check detail area and print on guest checks and customer receipts.</td>
</tr>
<tr>
<td>29 - Print Sub Level Prefix and Suffix</td>
<td>Select this option if you want the workstation to show the sub menu level prefixes or suffixes on the check detail area and print on guest checks and customer receipts.</td>
</tr>
<tr>
<td>69 - Prompt to lookup menu item definition based on current menu levels (Repeat Rounds)</td>
<td>Select this option if you want the workstation to prompt workstation operators to run a fresh menu item definition lookup based on the current active menu levels when a repeatable menu item is unavailable. You must also select options 26 - Keep Main Level With Repeat Rounds and 27 - Keep Sub Level With Repeat Rounds.</td>
</tr>
</tbody>
</table>

8. Click Save.

Related Topics

• Menu Levels

Configuring Sales Itemizers

1. In the EMC, select the Enterprise level, click Descriptors and Sales Itemizers.
2. In the Text column, enter the names for each descriptor.
3. Click Save.

Related Topics

• Sales Itemizers

Configuring Master Records for Menu Items

You can add master records for menu items, along with menu item definitions and prices, using a template record. If there are no template records to use when creating a property, you can add only a menu item master record, without adding definitions and prices.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Menu Item Maintenance.
2. Click Insert on the toolbar.
3. In the Select a task to perform drop-down list, select Add Master Record Without a Template, and enter the Name of the new menu item.
4. Select a **Major Group** and a **Family Group** for the menu item.

5. Enter a **Report Group** number between 1 and 99 for the menu item. Menu Item Reports sort and list subtotals by Report Group. If the Report Group number is 0 (zero), the menu item does not show on Menu Item Reports.

6. Select the appropriate value for the object number:
   - If you want to insert the menu item in the next available position, select **Next Available Position**.
   - If you want to define the record number or range for the new menu item record or records, select **Record Number Or Range**, and enter the record numbers or ranges.

7. Click **OK**.

**Related Topics**
- Menu Item Master and Menu Item Definitions

---

**Configuring Menu Item Definitions**

You can add menu item definitions to existing menu item master records from both table and form view. This procedure explains how to add new definition records from table view.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Maintenance**.

2. Click **Insert**.

3. In the **Select a task to perform** drop-down list, select **Add Definition to Masters**.

4. If you want to add definitions to a single menu item master record, select a menu item master record from the master record list.

5. If you want to add definitions to multiple menu item master records:
   a. If the menu item master records to receive the definitions are not in sequential order, in the **Range Type** drop-down list, select **Record Number or Range** and enter individual record numbers or ranges (for example, 3, 5, 6-12).
   b. If the menu item master records to receive the definitions are in sequential order, in the **Range Type** drop-down list, select **Select Range** and select the begin and end items.

6. If you want to use an existing definition record as a template for creating the new definitions, select **Use Template**, and select the menu item definition record to use as a template.

7. If you are not using an existing definition record as a template for creating the new definitions, select the **Menu Item Class** for the new definitions.

8. Select the **Definitions to Add**.

9. If you are using a template menu item definition and you want the new definitions to inherit price records from the template, in the **Insert Price Records** drop-down list, select **Inherit Price from Template**.

10. If you want to insert new price records for the new menu item definitions, in the **Insert Price Records** drop-down list, select **Specify Prices**, select the number of prices to create for the definitions, and enter the **Price** for the definitions.
Typically, you use this option when the new definitions have only one price record each.

11. Select Yes to confirm the insertion.
12. Click Save.

Related Topics
- Menu Item Master and Menu Item Definitions

Adding and Disabling Menu Items

Adding a menu item is a different process than adding records in other Enterprise Management Console (EMC) modules. You can add master records, definition records, and price records at the same time for the Enterprise in the Menu Item Maintenance module. These instructions explain how to add menu item master records with definition and price records. For information about adding masters, definitions, and prices individually, see the appropriate section:
- Configuring Master Records for Menu Items
- Configuring Menu Item Definitions
- Configuring Menu Item Prices

1. To add menu items in the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Menu Item Maintenance.
2. Insert a record.
3. If you opened Menu Item Maintenance from the revenue center, in the Select a task to perform drop-down list, select Add Master Record from Template.
4. Click Select adjacent to the Master to Copy field and select a template record.
5. Enter the Name of the new menu item.
6. Enter the Record Number of the item. By default, this field shows the next available record number after the selected record to copy.
7. If you selected Add Master Record from Template, select Copy Menu Item Names to copy all existing primary and foreign names, including Long Descriptors, from the original menu item to the new menu item.
8. If the menu item is priced the same for the entire Enterprise or property, select Use the same price for all records, and enter the price in the text box next to the option.
9. If the menu item has more than one definition and price, select Configure Prices Individually, enter the price for the first definition in the Price column, and click OK to add the menu item.
10. If you want to add another menu item, click Yes when prompted and repeat Steps 4 through 9.
11. If you do not want to add another item, click No.
12. Click Save.
13. If you want to disable a menu item, select the Enterprise, property, revenue center, or zone, click Configuration and Menu Item Maintenance.
14. Double-click the menu item that you want to disable.
15. Click the General tab and deselect all main and sub levels in the Menu Level Availability section.

16. Click Save.

Related Topics
• Menu Item Master and Menu Item Definitions

Configuring Menu Item Availability from the EMC

When a menu item has multiple definitions, changing the menu item availability from the Enterprise Management Console (EMC) affects all definitions.

1. In the EMC, select the property or revenue center, click Configuration and Menu Item Availability.

2. Change the Menu Item Status of the relevant item to 2 - Use Availability Settings.

3. If you want to change the available count for a menu item, enter the count in the Count field.

4. If you want to make an item unavailable, select Out of Item.

5. Click Save.

Related Topics
• Menu Item Master and Menu Item Definitions

Configuring Menu Item Availability for Multiple Definitions at the Workstation

By default, the Menu Item Availability function key only allows workstation operators to adjust the availability of the first menu item definition. To allow workstation operators to edit all definitions of an item from the workstation:

1. In the EMC, select the revenue center, click Setup and RVC Parameters.

2. On the Options tab, select 66 - Manage Menu Item Availability/Out of Item for each Menu Item Definition.

3. Click Save.

Related Topics
• Menu Item Master and Menu Item Definitions

Configuring a Weighed Menu Item

A weighed menu item is measured in ounces, pounds, or kilograms and is priced per unit of measurement (for example, lobster is sold by the pound). You can measure the weight manually or automatically. The workstation calculates the price regardless of the weight entry method.

• Manual – The workstation operator can use the Item Weight function key and enter the weight of the item.
• Automatic – A scale attached to a workstation can automatically calculate the weight of the item.

There are two ways to configure a weighed menu item:

1. Assign the menu item to a menu item class that has option **15 - Weighed Items** set.
2. Set a Tare Weight for menu item definition. See **Understanding Tare Weight** and **Setting the Tare Weight for a Menu Item** for more information.

**Related Topics**

• **Understanding Tare Weight**

**Understanding Tare Weight**

Tare weight is the weight of a container or wrapper that is deducted from the gross weight to obtain the net weight. Tare weight is used to accurately measure the weight of a weighed menu item. For example, in a restaurant with a salad bar where salad is sold by weight, the customer should not be charged for the weight of the container. To prevent this, a tare weight is configured for the salad menu item, and the weight of the salad's container is automatically subtracted from the weight of the salad.

When a weighed menu item posts to a guest check or customer receipt, the weight and tare weight (if set) appear and factor into the calculations with the same level of precision. The level of precision is determined by the Unit of Measure (UOM) as follows:

• Kilograms: 0.000
• Pounds: 0.00
• Ounces: 0.0

This precision formatting meets the United States Department of Agriculture Weights and Measures requirements for scale certification.

The UOM must match in the Enterprise Management Console (EMC) configuration and on the scale setting. For example, the scale must measure in ounces and EMC must be set to use ounces. You cannot set the scale to measure in ounces and set EMC to measure in pounds. When a mismatch occurs between the scale and EMC, Ops rejects the posting and informs the workstation operator that there is a UOM mismatch due to configuration in EMC.

**Related Topics**

• **Setting the Tare Weight for a Menu Item**
• **Configuring a Weighed Menu Item**
• **Configuring a Scale**

**Setting the Tare Weight for a Menu Item**

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Maintenance**.
2. Click **Search** to show all menu items, and double-click a menu item master record.
3. Click the Definition Records tab in the lower area of the screen.

4. In the Tare Weight field, enter the weight of the empty package for an item that is sold by weight.

5. Click **Save** to apply the changes.

6. Select the Enterprise, property, revenue center, or zone, click **Setup** and **Control Parameters**.

7. Click the Options tab and select **13 - Convert Weight to System Unit of Measure**. Setting this option allows Ops to convert the item weight to the property's UOM if the UOM received from a scale does not correspond to the UOM established by the Property Parameters module in the EMC.

   You must set this option in the United States to comply with the Department of Agriculture Weights and Measure requirements.

8. Click **Save**.

   **Related Topics**
   - Understanding Tare Weight

## Menu Item Fees

You can apply one or more menu item service charge fees (for example, a bottle deposit and a recycling fee) combined as a service charge group to a menu item. When the workstation operator adds a menu item (for example, Diet Coke) associated with a service charge group, the application adds the menu item fees under the service charge group to the check. Auditors can track the revenue from specific menu item fees, such as a recycling fee.

   **Related Topics**
   - Configuring Menu Item Fees

## Configuring Menu Item Fees

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Service Charge Groups**.

2. Insert a new service charge group or double-click the service charge group record.

3. Add or remove service charges to be included with this service charge group using the **Add** and **Delete** links.

4. Click **Save**.

5. Select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Classes**.

6. Double-click the menu item class record.

7. On the General tab, select the **Service Charge Group** from the drop-down list to apply to the menu item class record.

8. Click **Save**.

9. Select the Enterprise level, click **Configuration** and **Roles**.

10. Select the role type, click the Operations tab and the Voids/Returns sub tab.
11. Select **Authorize/Perform Void of Fees**.

12. Click **Save**.

13. Select the Enterprise, property, or revenue center, click **Configuration** and **Page Design**.

14. Add the **Display/Hide Menu Item Fees** function key.

15. Click **Save**.

16. To show or hide menu item fees on the workstation, toggle the **Display/Hide Menu Item Fees** function key.

**Related Topics**

- **Menu Item Fees**

---

**Configuring Screen Look Up for Menu Items**

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Descriptors** and **Menu Item**.

2. Enter names for menu item screen look up groups (for example, breakfast, lunch, and dinner) in the Text column, and click **Save**.

3. Select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Maintenance**.

4. Double-click a menu item and click **General**.

5. Select the relevant **SLU** group in the Touchscreen Properties section.

6. (Optional) Enter a **SLU Sort Priority** for the menu item.

7. Repeat Steps 4 and 5 for all menu items that you want to appear on screen lookups.

8. Select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.

9. Double-click the transaction page on which you want the screen look up to appear on the workstation.

10. Click **Other** in the Page Design toolbar and click **Sales SLU**.

11. Select **Menu Item** as the Type, **SLU** as the Property, and the menu item screen lookup group as the Value.

12. Select the **Menu Item Display Name** and click **Save**.

13. If the revenue center uses hand held point-of-sale (POS) devices:
   a. Select **Dynamic SLU** as the **Property**, and select a menu item screen look up group as the **SLU Value**.
   b. Enter a non-zero value for the **Visual State(s)**.
      The application uses the Visual State value to link menu item screen look ups with their corresponding Visual State buttons, which workstation operators use to change the menu items that appear in the Dynamic SLU.
   c. If you want to add more screen look ups to the Dynamic SLU, click **Add**.
   d. Select the **Menu Item Display Name** and click **Save**.
e. Insert buttons for each screen look up that you added to the Dynamic SLU. For example, if you added five screen look up groups to the Dynamic SLU, insert five buttons.

f. Select **Function** as the Type, and select **Visual State** from the function list.

g. Enter a Visual State value that you assigned to a screen look up group in Step 13-b in the Arguments field.

h. Click **Save**.

**Related Topics**
- Screen Look Up (SLU)

### Configuring Screen Look Ups for Discounts

1. In the EMC, select the Enterprise, property, or zone, click **Descriptors** and **Discount**.
2. Enter names for discount screen look up groups in the Text column, and click **Save**.
3. Select the Enterprise property, or zone, click **Configuration** and **Discounts**.
4. Double-click a record and click **NLU/SLU**.
5. Select the relevant **SLU** group for the discount and click **Save**.
6. Repeat Steps 3 through 5 for all discounts that you want to appear in screen lookups.
7. Select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.
8. Double-click the transaction page on which you want the screen look up to appear on the workstation.
9. Click **Other** in the Page Design toolbar and click **Sales SLU**.
10. Select **Discount** as the **Type** and the discount screen lookup group as the **Value**.
11. Click **Save**.

**Related Topics**
- Screen Look Up (SLU)

### Configuring Screen Look Ups for Service Charges

1. In the EMC, select the Enterprise property, or zone, click **Descriptors** and **Service Charge**.
2. Enter names for service charge screen look up groups in the Text column, and click **Save**.
3. Select the Enterprise property, or zone, click **Configuration** and **Service Charges**.
4. Double-click a record and click **NLU/SLU**.
5. Select the relevant **SLU** group for the service charge and click **Save**.
6. Repeat Steps 3 through 5 for all service charges that you want to appear in screen lookups.

7. Select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.

8. Double-click the transaction page on which you want the screen look up to appear on the workstation.

9. Click **Other** in the Page Design toolbar and click **Sales SLU**.

10. Select **Service Charge** as the **Type** and the service charge screen lookup group as the **Value**.

11. Click **Save**.

**Related Topics**
- Screen Look Up (SLU)

### Configuring Screen Look Ups for Tender/Media Records

1. In the EMC, select the Enterprise property, or zone, click **Descriptors** and **Tender/Media**.

2. Enter names for tender/media screen look up groups in the Text column, and click **Save**.

3. Select the Enterprise or property, click **Configuration** and **Tender/Media**.

4. Double-click a record and click **NLU/SLU**.

5. Select the relevant **SLU** group for the tender/media and click **Save**.

6. Repeat Steps 3 through 5 for all tender/media records that you want to appear in screen lookups.

7. Select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.

8. Double-click the transaction page on which you want the screen look up to appear on the workstation.

9. Click **Other** in the Page Design toolbar and click **Sales SLU**.

10. Select **Tender/Media** as the **Type** and the tender/media screen lookup group as the **Value**.

11. Click **Save**.

**Related Topics**
- Screen Look Up (SLU)

### Configuring Screen Look Ups for Family Groups

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.

2. Double-click the transaction page on which you want the screen look up to appear on the workstation.

3. Click **Other** in the Page Design toolbar and click **Sales SLU**.
4. Select **Menu Item** as the Type, **Family Group** as the Property, and the family group to show in the screen look up as the Value.

5. Select the **Menu Item Display Name** and click **Save**.

**Related Topics**
- Screen Look Up (SLU)

### Configuring Screen Look Ups for Major Groups

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.

2. Double-click the transaction page on which you want the screen look up to appear on the workstation.

3. Click **Other** in the Page Design toolbar and click **Sales SLU**.

4. Select **Menu Item** as the Type, **Major Group** as the Property, and the major group to show in the screen look up as the Value.

5. Select the **Menu Item Display Name** and click **Save**.

**Related Topics**
- Screen Look Up (SLU)

### Configuring Screen Look Ups for Custom Reports

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.

2. Double-click the transaction page on which you want the screen look up to appear on the workstation.

3. Click **Other** in the Page Design toolbar and click **Sales SLU**.

4. Select **Custom Report** as the Type and click **Save**.

**Related Topics**
- Screen Look Up (SLU)

### Configuring Screen Look Ups for Open Checks

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.

2. Double-click the transaction page on which you want the screen look up to appear on the workstation.

3. Click **Other** in the Page Design toolbar and click **Check SLU**.

4. If you want the screen look up (SLU) to show open checks belonging to all employees, select **All Employees**.

5. If you want the SLU to show open checks belonging to only the signed in employee, select **Currently Signed In Employee**.

6. Select the type of open checks you want to appear on the SLU:
Table 9-11  Open Check Options

<table>
<thead>
<tr>
<th>Open Check SLU Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Checks</td>
<td>Select this option if you want to show all open checks.</td>
</tr>
<tr>
<td>Autofire Checks Only</td>
<td>Select this option if you want to show only open checks that are programmed to send to order devices at a preset time.</td>
</tr>
<tr>
<td>All Except Autofire Checks</td>
<td>Select this option if you do not want to show open checks that are programmed to send to order devices at a preset time.</td>
</tr>
<tr>
<td>Checks Held Items Only</td>
<td>Select this option if you want to show only open checks with items on hold.</td>
</tr>
<tr>
<td>All Except Checks with Held Items</td>
<td>Select this option if you do not want to show checks with items on hold.</td>
</tr>
<tr>
<td>All Except Autofire and Checks with Held Items</td>
<td>Select this option if you do not want to show open checks with items on hold and checks that are programmed to send to order devices at a preset time.</td>
</tr>
<tr>
<td>Autofire Checks with Held Items Only</td>
<td>Select this option if you want to show only open checks that are programmed to send to order devices at a predefined time and have items on hold.</td>
</tr>
</tbody>
</table>

7. If you want to show only open checks that belong to particular order types (for example, Dine-in or Take Out), select one or more Order Types, click Add, and click Save.

Related Topics

•  Screen Look Up (SLU)

Configuring Number Look Ups for Discounts

1. In the EMC, select the Enterprise or property, click Configuration and Discounts.
2. Double-click a record and click NLU/SLU.
3. Enter a unique NLU number for the discount, and click Save.
   You can enter a value between 1 and 255.
4. Repeat Steps 2 and 3 for all discounts that you want to appear in the number look up.
5. Select the Enterprise, property, revenue center, or zone, click Configuration and Page Design.
6. Double-click the transaction page on which you want the number look up to appear on the workstation.
7. Insert a new button, select Function as the Type, select Discount NLU from the function list, and click OK.
8. Click Save.

Related Topics

•  Number Look Up (NLU)
Configuring Number Look Ups for Service Charges

1. In the EMC, select the Enterprise or property, click Configuration and Service Charges.

2. Double-click a record and click NLU/SLU.

3. Enter a unique NLU number for the service charge, and click Save.
   You can enter a value between 1 and 255.

4. Repeat Steps 2 and 3 for all service charges that you want to appear in the number look up.

5. Select the Enterprise, property, revenue center, or zone, click Configuration and Page Design.

6. Double-click the transaction page on which you want the number look up to appear on the workstation.

7. Insert a new button, select Function as the Type, select Service Charge NLU from the function list, and click OK.

8. Click Save.

Related Topics

• Number Look Up (NLU)

Configuring Number Look Ups for Tender/Media Records

1. In the EMC, select the Enterprise or property, click Configuration and Tender/Media.

2. Double-click a record.

3. Enter a unique NLU number for the tender/media record, and click Save.
   You can enter a value between 1 and 255.

4. Repeat Steps 2 and 3 for all tender/media records that you want to appear in the number look up.

5. Select the Enterprise, property, revenue center, or zone, click Configuration and Page Design.

6. Double-click the transaction page on which you want the number look up to appear on the workstation.

7. Insert a new button, select Function as the Type, select Tender/Media NLU from the function list, and click OK.

8. Click Save.

Related Topics

• Number Look Up (NLU)
Configuring Number Look Ups for Main and Sub Levels

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.
2. Double-click the transaction page on which you want the number look up to appear on the workstation.
3. Insert a new button, select **Function** as the Type, select either **Main Level NLU** or **Sub Level NLU** from the function list, and click **OK**.
4. Click **Save**.

Related Topics
- Number Look Up (NLU)

Menu Item Waste Checks

Menu Item Waste describes menu items that are not sold to customers due to reasons such as spillage, spoilage and quality standards. There are three main characteristics of a menu item waste check:
- A menu item waste check does not post to sales.
- Inventory is depleted when the application posts waste.
- A menu item waste check closes after posting. Service Total and Print functions close a waste check.

When menu item waste occurs, authorized workstation operators can begin a menu item waste check and then enter wasted menu items. Wasted menu items appear in the waste reports. Managers can generate Waste reports by revenue center, menu item, employee, and waste reason. Depending on the reasons for waste, managers can take action to reduce inventory loss. You can differentiate waste checks from other checks in the Employee Journal Report and the Check Journal Report by the Waste Check banner on the check header.

The following table lists the functional differences between menu item waste checks and guest checks.

**Table 9-12 Differences Between Waste Checks and Guest Checks**

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu Item Waste Checks</th>
<th>Guest Checks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kitchen Display Systems (KDS) or screen lookups display the check</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Reopen a closed check</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Apply discounts</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Apply taxes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Apply service charges</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Apply guest count</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Return item</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Edit seat</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table 9-12  (Cont.) Differences Between Waste Checks and Guest Checks

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu Item Waste Checks</th>
<th>Guest Checks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split check</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Gift card or credit card operations</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Send and Stay</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Hold and Fire</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Transaction void</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Transaction return</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Menu item availability</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Complete the following tasks to set up the Menu Item Waste feature:

- Configure employee privileges to begin waste checks and run waste check reports
- Define reasons for menu items declared as waste
- Configure waste receipt headers and trailers
- (Optional) Hide price details on waste checks
- Add a Declare Waste button to the touchscreen page

Related Topics

- Allowing Employees to Begin Waste Checks and Run Waste Check Reports
- Configuring Waste Reasons
- Configuring Waste Receipt Headers and Trailers
- Hiding Price Details on Waste Checks
- Creating the Declare Waste Button
- Menu Item Waste Reports

Allowing Employees to Begin Waste Checks and Run Waste Check Reports

1. In the EMC, select the Enterprise level, click Configuration, and Roles.
2. Select the role type and click the Operations tab.
3. Select 263 – Authorize/Begin Menu Item Waste Check to allow employees associated with this role to begin waste checks and to authorize other employees to begin waste checks.
4. Select the appropriate report privileges as described in the following table:
Table 9-13  Menu Item Waste Report Privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Allows the Employee to ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>31065 – Run Waste Detail Report</td>
<td>Run the Waste Detail Report from the workstation.</td>
</tr>
</tbody>
</table>

5. Click Save.

Related Topics

- Menu Item Waste Checks
- Menu Item Waste Reports

Configuring Waste Reasons

1. In the EMC, select the Enterprise level, click Descriptors and Void/Return/Waste Reasons.
2. To add a new waste reason, enter a waste reason in an empty row under the Text column and then select 2 - Use for Waste from the Options column.
3. To use an existing void or return reason also as a waste reason, select 2 - Use for Waste from the Options column adjacent to relevant the void or return reason. The options work independently of each other; you can set one, both, or none.
4. Click Save.

Related Topics

- Menu Item Waste Checks
- Menu Item Waste Reports

Configuring Waste Receipt Headers and Trailers

When you post a waste check, the guest check printer assigned to the workstation prints a waste receipt.

1. In the EMC, select the Enterprise level and click Descriptors.
2. Select one of the following options, depending on whether you want to configure receipt headers or trailers:
   - Waste Receipt Headers
   - Waste Receipt Trailers
3. Perform one of the following actions:
   - Enter text for the header or trailer in the rows under the Text column.
   - Select a check box under the Use Logo column and then select a logo using the ellipsis icon in the Logo column.
4. Click **Save**.

**Related Topics**
- Menu Item Waste Checks
- Menu Item Waste Reports

### Hiding Price Details on Waste Checks

A waste check measures the cost of wasted inventory as opposed to a guest check that posts the prices of menu items to the sales totals.

Complete these steps if you do not want to display prices of waste menu items in the check detail area of the workstation screen or print prices on waste receipts.

1. In the EMC, select the Enterprise level, click **Setup**, and **Format Parameters**.
2. Select the Options tab and select **54 - Do not display/print price for Waste**.
3. Click **Save**.

**Related Topics**
- Menu Item Waste Checks
- Menu Item Waste Reports

### Creating the Declare Waste Button

To declare waste, you need to add the Declare Waste function key to a page.

1. In the EMC, select the Enterprise, property, or revenue center, click **Configuration** and **Page Design**.
2. Open the Front of House page on which to place the Declare Waste button.
3. On the Edit tab, select the page area in which to define the Declare Waste button.
4. Click **Button** to add a button.
5. On the General sub-tab, enter the button name in the **Legend** field.
6. Select **Function** from the **Type** drop-down.
7. Click the black arrow directly beneath the **Type** drop-down and select **Declare Waste**.
8. Highlight the **Declare Waste** button.
9. Position and size the button on the page. Use the Style arrow to change the color.
10. Click **Save**.

**Related Topics**
- Menu Item Waste Checks
- Menu Item Waste Reports
Menu Item Waste Reports

Menu Item Waste Reports provide an overview of discarded menu items resulting from spillage, spoilage, or compromised quality standards so that you can take action to reduce inventory loss in your revenue center. You can generate waste reports by revenue center, menu item, employee, and waste reason. The following Menu Item Waste Reports are available:

- Waste Detail Report
- Waste Summary Report
- Employee Waste Report
- Menu Item Waste Report

The Waste Detail Report shows in-depth information about wasted menu items grouped by the waste reason, as described in the following table. You can filter the report data by waste reason.

<table>
<thead>
<tr>
<th>Column</th>
<th>Shows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check #</td>
<td>• The reason for discarding the menu items or ingredients.</td>
</tr>
<tr>
<td></td>
<td>• The waste check number.</td>
</tr>
<tr>
<td></td>
<td>• The total number of menu items or ingredients discarded for the same waste reason.</td>
</tr>
<tr>
<td>Employee</td>
<td>The name of the employee that created the waste check.</td>
</tr>
<tr>
<td>QTY Menu Item</td>
<td>The quantity wasted followed by the name of the wasted menu item or ingredient.</td>
</tr>
<tr>
<td>Amount</td>
<td>The price of the wasted menu items or ingredients.</td>
</tr>
</tbody>
</table>

The Waste Summary Report shows an overview of the menu items wasted and the corresponding waste quantity grouped by the waste reason, as described in the following table. You can filter the report data by waste reason.

<table>
<thead>
<tr>
<th>Column</th>
<th>Shows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waste Reason</td>
<td>• The reason for discarding the menu items or ingredients.</td>
</tr>
<tr>
<td></td>
<td>• The employee that recorded the waste (created the waste check).</td>
</tr>
<tr>
<td></td>
<td>• The name of the wasted menu items or ingredients.</td>
</tr>
<tr>
<td>Quantity</td>
<td>• The quantity of menu items or ingredients wasted.</td>
</tr>
<tr>
<td></td>
<td>• The total number of menu items or ingredients discarded for the same waste reason.</td>
</tr>
</tbody>
</table>

The Employee Waste Report shows a summary of the waste checks created by each employee, as described in the following table. When you filter the Employee Waste
Report for an employee, the report shows a summary of the waste checks created by the selected employee.

**Table 9-16  Employee Waste Report**

<table>
<thead>
<tr>
<th>Column</th>
<th>Shows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>• The name of the employee that created the waste check.</td>
</tr>
<tr>
<td></td>
<td>• List of waste reasons added to the waste checks that were created by the employee.</td>
</tr>
<tr>
<td>Quantity</td>
<td>• The quantity of menu items or ingredients that were wasted for each waste reason.</td>
</tr>
<tr>
<td></td>
<td>• The total number of menu items or ingredients discarded.</td>
</tr>
</tbody>
</table>

The Menu Item Waste Report shows the waste reason and the quantity of menu items wasted grouped by menu item, as described in the following table. At the end of the report, a summary of menu items wasted for each family group is shown. You can filter the report by the family group.

**Table 9-17  Menu Item Waste Report**

<table>
<thead>
<tr>
<th>Column</th>
<th>Shows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Name</td>
<td>• The name of the wasted menu item or ingredient.</td>
</tr>
<tr>
<td></td>
<td>• The reason for discarding the menu item or ingredient.</td>
</tr>
<tr>
<td>Quantity</td>
<td>• The quantity corresponding to each menu item or ingredient wasted.</td>
</tr>
<tr>
<td></td>
<td>• The total number of menu items or ingredients discarded.</td>
</tr>
<tr>
<td>Family Group</td>
<td>The family groups of each menu item wasted appear as a summary at the end of the report.</td>
</tr>
<tr>
<td>Quantity</td>
<td>• The number of menu items or ingredients wasted for each family group.</td>
</tr>
<tr>
<td></td>
<td>• The total number of menu items or ingredients discarded.</td>
</tr>
</tbody>
</table>

**Related Topics**
- Menu Item Waste Checks
- Allowing Employees to Begin Waste Checks and Run Waste Check Reports
- Configuring Waste Reasons
- Configuring Waste Receipt Headers and Trailers
- Hiding Price Details on Waste Checks
- Creating the Declare Waste Button
Condiments

A condiment is an item that is external to a regular menu item. For example, ketchup, salt, and chocolate sprinkles are all condiments. Condiments can also give further details to the cook preparing the menu item, such as a well-done steak or salad with ranch dressing. In Simphony, condiments are often instructions or modifiers, such as the words extra, add, substitute, and without.

Setting up condiments consists of completing the tasks listed in the following table:

### Table 10-1 Condiment Configuration Tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create condiment groups</td>
<td>Configuring Condiment Groups</td>
</tr>
<tr>
<td>Create menu item classes for the condiment groups</td>
<td>Creating Menu Item Classes for Condiment Groups</td>
</tr>
<tr>
<td>Create menu item master records for condiments and assign to condiment classes</td>
<td>Creating Menu Item Master Records for Condiments</td>
</tr>
<tr>
<td>Create condiment sets and assign condiments</td>
<td>Configuring Condiment Sets</td>
</tr>
<tr>
<td>Assign condiments to parent menu item classes</td>
<td>Assigning Condiments to Parent Menu Item Classes</td>
</tr>
<tr>
<td>Assign default condiments to parent menu items</td>
<td>Assigning Default Condiments to Parent Menu Items</td>
</tr>
<tr>
<td>Create condiment prefixes</td>
<td>Configuring Condiment Prefixes</td>
</tr>
<tr>
<td>Configure additional settings for condiment appearance on workstations, guest checks, and customer receipts</td>
<td>Setting Condiment Appearance</td>
</tr>
</tbody>
</table>

- Condiment Groups and Condiment Sets
- Configuring Condiment Groups
- Creating Menu Item Classes for Condiment Groups
- Creating Menu Item Master Records for Condiments
- Configuring Condiment Sets
- Assigning Condiments to Parent Menu Item Classes
- Assigning Default Condiments to Parent Menu Items
- Condiment Prefixes
- Creating Condiment Prefix Menu Items
- Creating Menu Items Classes for Prefixes
- Activating Condiment Prefixes
- Deactivating Condiment Prefixes
Condiment Groups and Condiment Sets

A condiment set defines the condiments that accompany the parent menu item. For example, a condiment set for a bacon cheeseburger includes the following condiments:

- Bacon
- Cheddar Cheese
- Mayonnaise
- Lettuce
- Ketchup

A condiment group defines the category to which a condiment set belongs and dictates its behavior.

Related Topics

- Configuring Condiment Groups
- Creating Menu Item Classes for Condiment Groups
- Creating Menu Item Master Records for Condiments
- Configuring Condiment Sets
- Assigning Condiments to Parent Menu Item Classes
- Assigning Default Condiments to Parent Menu Items
- Setting Condiment Appearance

Configuring Condiment Groups

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Descriptors** and **Condiment Group Names**.
2. Enter condiment group names (for example, Meat Group or Cheese Group) in the **Text** field.
3. Click **Save**.

Related Topics

- Condiment Groups and Condiment Sets
Creating Menu Item Classes for Condiment Groups

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Classes**.
2. Insert a new record, enter the class name, and double-click the new record.
3. On the General tab, select the **Condiment Order Type** from the drop-down list.
4. Click the Options tab and select **2 - ON = Condiment Menu Items; OFF = Regular Menu Items**.
5. If you do not want to charge customers for the condiments in this class, select **8 - Allow Menu Items in this Class to be Non-Priced**.
6. If you want each condiment in this class to print to a specific order device, select **22 - ON = Use Own Output Link; OFF = Use Parent's (Condiments Only)**.
7. Click the Condiment Groups tab and select the **Member Condiment Groups** for the class. For example, if the condiment class is Deli Meat Class, select Meat Group from the Member Condiment Groups list.
8. Click **Save**.
9. Repeat Steps 2 through 8 to create menu item classes for all condiment groups.

Related Topics
- Condiment Groups and Condiment Sets

Creating Menu Item Master Records for Condiments

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Maintenance**.
2. Insert a new record and enter the condiment name (for example, Ham).
3. Search for and then double-click the new record.
4. Insert a definition record and click the General sub-tab.
5. In the Name and Class section, select the **Menu Item Class** for the condiment. For example, if the condiment is Ham, select Deli Meat Class.
6. If this is a priced condiment:
   a. Click the Prices sub-tab, insert a price definition, and enter the **Price** for the condiment.
   b. If you want the price to become active at a specific menu level, select **Active On Level** and select the level.
7. Click **Save**.
8. Repeat Steps 2 through 6 to create menu item master records for all condiments.

Related Topics
- Condiment Groups and Condiment Sets
Configuring Condiment Sets

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Condiment Sets.

2. Insert a new record, enter a name for the condiment group, and then double-click the new record.

3. Click Add in the Condiments section.

4. In the Menu Item column, click the ellipsis point (...) symbol, select a condiment from the list, and click OK.

5. Enter the number of condiments that accompany the condiment group in the Default Count field.
   
   For example, if the condiment is a slice of cheddar cheese and you enter number 2 as the default count, 2 slices of cheddar cheese accompany the condiment group.

6. In the Sort Order field, enter the order in which the workstation should show the condiment on screen.

7. If you want the condiment to remain in the order when the workstation operator changes a menu item to plain (for example, when a workstation operator changes the order to a plain bacon cheeseburger, the bacon and the cheese are not removed), click the ellipsis point (...) symbol in the Options column, select 1 - Persist On Plain, and click OK.

8. Enter the Menu Item Definition Sequence number that coincides with this condiment. The Menu Item Definition Sequence number helps workstation operators switch between condiments.

   For example, the cheeseburger has two menu item definitions. If the customer orders definition 1, the cheeseburger should have cheddar cheese and if the customer orders definition 2, the cheeseburger should have mozzarella cheese. When configuring the condiment group for the cheeseburger, you must enter 1 as the Menu Item Definition Sequence for the condiment cheddar cheese and 2 as the Menu Item Definition Sequence for the condiment mozzarella cheese.

9. Repeat Steps 3 through 8 to add more condiments to the condiment group.

10. Click Save.

Related Topics

- Condiment Groups and Condiment Sets

Assigning Condiments to Parent Menu Item Classes

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Menu Item Classes.

2. Double-click a parent menu item class.

3. Click the Condiment Groups tab and select the appropriate Required Condiment Groups and Allowed Condiment Groups for the class. For example, if the parent menu item class is Ham Sandwich Class, the required and allowed condiment groups are listed in the following table:
Table 10-2  Examples of Required and Allowed Condiment Groups

<table>
<thead>
<tr>
<th>Condiment Group</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required Condiment</td>
<td>Meat Group, Bread Group</td>
</tr>
<tr>
<td></td>
<td>Required condiments are sometimes referred to as forced condiments. Each</td>
</tr>
<tr>
<td></td>
<td>Required Condiment Group that you select appears on the Forced</td>
</tr>
<tr>
<td></td>
<td>Condiments tab. From there you can enter the Minimum and Maximum</td>
</tr>
<tr>
<td></td>
<td>amounts for each item.</td>
</tr>
<tr>
<td>Allowed Condiment</td>
<td>Meat Group, Bread Group, Cheese Group, Sauce Group, and Veggie Group</td>
</tr>
</tbody>
</table>

4. (Optional) Click the Forced Condiments tab.

5. For each required condiment group, enter the minimum and maximum condiment count required to complete the order. For example, if you set the minimum condiment count for Meat Group as 2, the workstation operator must add two meat types to complete the order.

6. If you want to limit the number of selections that workstation operators can add from a condiment group at a certain menu level, enter the Threshold 1 and 2 for each required condiment group. Typically, the menu level controls how much the application charges for a condiment. The threshold values allow you to determine when the price of a condiment changes, based on the number of items selected.

7. Click the Options tab and select the appropriate options as described in the following table:

Table 10-3  Condiment Menu Item Class Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9 - Condiment Changes Print Group of Parent</td>
<td>Select this option if you want the menu items in this class to use the print group of the condiment.</td>
</tr>
<tr>
<td>Menu Item</td>
<td></td>
</tr>
<tr>
<td>21 - Require Number of Condiments to</td>
<td>Select this option if you want the number of the required condiments belonging to the menu item class to match the number of parent menu items</td>
</tr>
<tr>
<td>Match Number of Parent Items</td>
<td>ordered.</td>
</tr>
<tr>
<td>23 - Add Condiment Price to the Parent Item's</td>
<td>Select this option if you want guest checks and receipts to show only a single price for the parent menu item and its condiments</td>
</tr>
<tr>
<td>Price on Check Only</td>
<td>(the price breakdown for each condiment does not appear).</td>
</tr>
<tr>
<td>30 - Sort Condiments by Print Group</td>
<td>Select this option if you want condiments to sort according to their print group.</td>
</tr>
<tr>
<td>41 - Consolidate Menu Items with Condiments</td>
<td>Select this option if you want order devices to consolidate items with condiments and print each condiment with the seat number to which</td>
</tr>
<tr>
<td>on Order Output</td>
<td>the condiment applies. You must also select 6 - Print Seat Numbers with Individual Items in the Order Devices module at the revenue center</td>
</tr>
<tr>
<td></td>
<td>level.</td>
</tr>
</tbody>
</table>
Table 10-3  (Cont.) Condiment Menu Item Class Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>42 - Consolidate Parents with Matching Condiments on Order Output</td>
<td>Select this option if you want order devices to consolidate parent menu items with identical condiments.</td>
</tr>
</tbody>
</table>

8. Click **Save**.

9. Repeat Steps 2 through 7 for all parent menu item classes.

Related Topics

• Condiment Groups and Condiment Sets

Assigning Default Condiments to Parent Menu Items

Default condiments are not supported with Transaction Services. If you are using Transaction Services, workstation operators need to add default condiments separately.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Maintenance**.

2. Search for and double-click a parent menu item record.

3. Click the Default Condiments sub-tab and then click **Add**.

4. Click the ellipsis point (…) symbol in the **Condiment Set** column, select the condiment set, and click **OK**.

5. (Optional) Enter the sort group number for the condiment set in the **Sort Group** column.

   All condiment sets appear in the workstation according to the Sort Group. Condiment sets in Sort Group 0 appear first, followed by 1, 2, and so on. Items that have the same Sort Group number appear as they are listed in the EMC.

6. Click the ellipsis point (…) symbol in the **Options** column and select **1 - Display when in default state**.

7. If you want to always charge customers for the condiment count, select **2 - Charge for entire sales count** and press **OK**.

   For example, if a burger comes with 2 slices of cheese by default, the customer is charged when there are 1 or 2 slices of cheese on the burger. If you do not select this option, customers are only charged when the condiment count exceeds the default count.

8. Click **Save**.

Related Topics

• Condiment Groups and Condiment Sets

Condiment Prefixes

Many restaurants allow customers to modify menu items, such as adding, removing, increasing and decreasing the number of condiments on the item. You can insert prefixes (for example, No, Add, Extra) before the condiment on the guest check, order
devices, and customer receipts. This allows the workstation operator, server, kitchen staff, and customer to see changes made to a default condiment. It also provides helpful preparation instructions to the kitchen staff and helps to eliminate order confusion.

Complete the following tasks to set up condiment prefixes:

- Create condiment prefix menu items
- Create menu item classes for the prefixes
- Activate and deactivate condiment prefixes
- Configure separate touchscreen buttons for condiment prefixes

**Related Topics**
- Creating Condiment Prefix Menu Items
- Creating Menu Items Classes for Prefixes
- Activating Condiment Prefixes
- Deactivating Condiment Prefixes
- Configuring Touchscreen Buttons for Condiment Prefixes

### Creating Condiment Prefix Menu Items

1. In the EMC, select the Enterprise, click **Configuration** and **Menu Item Maintenance**.
2. Insert a new record and name it Prefixes. This is a header menu item record and is used to distinguish the prefixes from other menu items.
3. Select the Prefixes header record and insert a new record. Enter the prefix (for example, ADD) as the name for the new menu item record.
4. Double-click the record you created in Step 3, and click **Menu Levels Tab**.
5. Select **Active on All Levels**.
6. Click **Prices** and insert a $0 priced record.
7. Click **Save**.
8. Repeat Steps 3 through 7 to create records for the remaining four prefixes.

**Related Topics**
- Condiment Prefixes

### Creating Menu Items Classes for Prefixes

1. In the EMC, select the Enterprise, click **Descriptors** and **Condiment Group Names**.
2. Enter a group name to show in the workstation for the condiment prefixes, and click **Save**.
3. Select the Enterprise, click **Configuration** and **Menu Item Classes**.
4. Insert a new record and name it after a prefix (for example, ADD).
5. Double-click the new record.
6. On the General tab, select the **Condiment Prefix Type** that corresponds to the prefix menu item class that you created in Step 4:
   - 2 - No Prefix
   - 3 - Add Prefix
   - 4 - Sub Prefix
   - 5 - Plain Prefix
   - 6 - Reset Prefix

7. Click the Options tab, and select **2 - ON = Condiment Menu Items; OFF = Regular Menu Items** and **8 - Allow Menu Items in this Class to be Non-Priced**.

8. Click the Condiments Group tab and in the Member Condiment Groups section, select the condiment group that you created in Step 2.

9. Click **Save**.

10. Repeat Steps 4 through 9 to configure menu item classes for the remaining prefixes.

**Related Topics**
- Condiment Prefixes

### Activating Condiment Prefixes

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Classes**.

2. For all regular menu item classes, select **65 - Support Enhanced Prefix Mode (Parent Only)** and click **OK**.
   
   If you are not using condiment prefixes, but you select option **65 - Support Enhanced Prefix Mode (Parent Only)**, it is considered incorrect configuration and negatively impacts the application.

3. Click **Save**.

**Related Topics**
- Condiment Prefixes

### Deactivating Condiment Prefixes

You can deactivate condiment prefixes to prevent them from appearing in the Combo/Condiment Orderer.

1. In the EMC, select the Enterprise level, click **Configuration** and **Menu Item Classes**.

2. Double-click a regular menu item class with condiments.

3. Click the Condiments Group tab and change all Allowed Condiment Groups to Required Condiment Groups.

4. In the Allowed Condiment Groups section, select the condiment group you created in the section **Creating Menu Items Classes for Prefixes**.

5. Click the Forced Condiments tab and set the **Minimum** value for the previously allowed condiment groups to 0 (zero).
6. Repeat Steps 2 through 5 for all regular menu items with condiments.

7. Click Save.

Related Topics
• Condiment Prefixes

Configuring Touchscreen Buttons for Condiment Prefixes

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Page Design.

2. Locate the Combo/Condiment Orderer and deselect Allowed.

3. Click Save.

4. Insert a new button on the transaction screen, select Menu Item as the button type, and select a prefix as the menu item (for example, ADD).

5. Enter or generate a legend for the button, and click Save.

6. Repeat Steps 4 and 5 to configure touchscreen buttons for the remaining condiment prefixes.

Related Topics
• Condiment Prefixes

Setting Condiment Appearance

1. In the EMC, select the Enterprise, property, or revenue center, select Setup and Format Parameters.

2. Click the Options tab and select the appropriate options:
   • If you want to force as many condiments as possible to print together on each line of guest checks and customer receipts, select 4 - Wrap Condiments on Guest Checks.
   • If you want the workstation to hide previous round condiments and show only the parent menu item when a workstation operator picks up a check, select 35 - Hide Previous Round Condiments on Display.
   • If you want the check detail area to actively sort condiments while they are ordered, select 45 - Sort Current Round Condiments on Screen. Condiment sorting occurs only when items are in different print groups and the parent allows condiment sorting.

3. Click Save.

4. Select the Enterprise, property, or revenue center, click Setup and Control Parameters.

5. Click the Options tab and select the appropriate options:
   • If you want the workstation to show only condiments that customers are allowed to order with the parent menu item, select 37 - Enable Condiment Masking.
   • If you want to allow workstation operators to add condiments out of order (conversational ordering), select 44 - Permit Required Condiments To Be Entered Out Of Order.
6. Click **Save** to apply the changes.

7. Select the revenue center, click **Setup** and **Order Devices**.

8. Double-click a printer record and click the Options tab.

9. If you want condiments to print in red, select **10 - Print Condiments in Red (Overrides Print Class Settings)**.

10. Click **Save**.

**Related Topics**
- Condiment Groups and Condiment Sets

### Understanding the Popup Condiment Orderer

The Popup Condiment Orderer provides a screen workflow that automatically advances to all required condiment groups when ordering menu items.

The Popup Condiment Orderer resides in a template. The workstation operator uses this template to create a page that pops up for required condiments. When adding a menu item (for example, Steak) that requires condiment selection to a transaction, the page with the template appears as a popup where the workstation operator can select the required condiment groups (for example, meat temperature and sauce).

The workstation operator can also recall a Popup Condiment Orderer to modify the required condiments of a previously ordered menu item. The workstation operator can select the parent item or condiment in the check detail or select the Recall Popup Condiment Orderer function key (depending on configuration).

Unlike the regular Condiment Orderer, the Popup Condiment Orderer automatically pops up and closes.

Complete the following tasks to set up the Popup Condiment Orderer:
- Configure a Popup Condiment Orderer page
- Configure a revenue center to use the Popup Condiment Orderer
- Configure a menu item class to use the Popup Condiment Orderer

**Related Topics**
- Configuring a Popup Condiment Orderer Page
- Configuring a Revenue Center to Use the Popup Condiment Orderer
- Configuring a Menu Item Class to Use the Popup Condiment Orderer

### Configuring a Popup Condiment Orderer Page

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.

2. Insert a record for **Popup Condiment Orderer** if it does not exist.

3. Double-click the record to open it.

4. Select **Specify Template** and then select **Popup Condiment Orderer** from the Internal Templates list.
This template is preset with a Condiment Orderer control and a Done button. You cannot delete these elements from the template, nor can you copy elements to this template. The Popup Condiment Orderer template supports two key functions: Void and Transaction Cancel.

5. In the Popup Type drop-down list, select where you want the Popup Condiment Orderer to appear on the page. (The Popup Types do not apply to Ops clients running the Android and iOS mobile operating systems.)
   - Full Screen
   - Centered
   - Next to Check Detail Area
   - In Dynamic Content Area

6. Select **Allow selection in check detail area** if you want workstation operators to select the current menu item and its condiments in the check detail area while the Popup Condiment Orderer is open.

7. Select **Manually dismiss Condiment Orderer** to have the Popup Condiment Orderer remain open after the workstation operator selects all required condiments. The operator must use the **Done** function to close the Popup Condiment Orderer.

   If you configure required condiment groups with a zero minimum count, select **Manually dismiss Condiment Orderer**. Otherwise the Popup Condiment Orderer automatically closes because the application meets the minimum required count (zero) before the workstation operator orders a condiment in the group.

8. (Optional) Change the page settings, such as layout and button styles. You cannot modify the dimmed settings.

9. (Optional) Repeat steps 2 through 8 for each Popup Condiment Orderer page you want to create. Ops requires one page for initial condiment selection and subsequent editing, although you can configure two pages.

   When you designate Next Page/Panel for menu items (in menu item classes and on menu item buttons), Ops goes to the designated page or panel after the Popup Condiment Orderer closes (either manually or automatically).

10. Click **Save**.

Related Topics
   - Understanding the Popup Condiment Orderer

Configuring a Revenue Center to Use the Popup Condiment Orderer

1. In the EMC, select the revenue center, click **Setup** and **RVC Parameters**.

2. In the **Default Condiment Ordering Popup** field, select the default automatic popup to appear when the workstation operator orders a menu item with required condiments for the revenue center:
   - None
   - Popup Condiment Orderer
3. In the **Default Condiment Editing Popup** field, select the default automatic popup to appear when the workstation operator selects a menu item with required condiments in the check detail area for the revenue center:
   - None
   - Popup Condiment Orderer

4. Click **Save**.

**Related Topics**
- Understanding the Popup Condiment Orderer

### Configuring a Menu Item Class to Use the Popup Condiment Orderer

The Popup Condiment Orderer configuration in the Menu Item Classes module overrides the revenue center configuration in the RVC Parameters module.

If you do not configure a revenue center or menu item class to use the Popup Condiment Orderer, the feature is turned off. You can use a mix of the settings. For example, you can set the revenue center to use the Popup Condiment Orderer, and set specific menu items to use the revenue center parameter, other menu items to use a different Popup Condiment Orderer, and some menu items with no popup.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Classes**.
2. Double-click the menu item class record.
3. In the **Condiment Order Popup** field, select the automatic popup to appear when the workstation operator orders a menu item with required condiments:
   - No Popup
   - Use Revenue Center Parameter
   - Popup Condiment Orderer

4. In the **Condiment Edit Popup** field, select the automatic popup to appear when the workstation operator selects a menu item with required condiments in the check detail area:
   - No Popup
   - Use Revenue Center Parameter
   - Popup Condiment Orderer

To use gestures on transaction pages, set the **Condiment Edit Popup** to **No Popup** for the menu item classes, and use the **Recall Popup Condiment Orderer** function key to modify previously ordered required condiments.

5. Click **Save**.

**Related Topics**
- Understanding the Popup Condiment Orderer
11

Combo and Fixed Price Meals

A combo meal consists of two or more menu items grouped together in combo meal groups and sold to the customer for a single price. Quick service restaurants typically sell combo meals to increase business by packaging the most frequently requested menu combinations (for example, hamburger, fries, and a drink) and offering them for a lower price than à la carte items.

A combo meal group allows you to configure the menu items within a group so that Ops knows which items to combine. Two typical combo meal groups are combo sides and combo drinks. For example, you can configure a meal named Combo 1 with a primary menu item called Combo Sandwiches and additional Combo Groups (such as Combo Drinks and Combo Side Items).

A fixed price meal (FPM) is a complete meal offered at a fixed price. For example, during special occasions or holidays, restaurants sometimes serve multi-course meals with only a few menu item choices for each course, and charge a fixed total price.

There is no restriction on the number of FPMs or side items (courses). The workstation operator can order multiple meals on the same seat. If the parent menu item increments the seat number, ordering multiple meals adds them to different seats (for example, three pre-dinner specials). The sides can default to a placeholder menu item that the workstation operator replaces in a later round. Placeholder menu items can be shown or hidden in the check detail area.

You can configure FPMs like combo meals. Creating Combo Meal Groups contains information to assemble required items for a FPM, and assign alternate groups to allow guests to substitute items.

- Combo Meal Group Pricing
- Placeholder Menu Items in Combo Meals
- Creating Combo Meal Groups
- Creating Combo Meals
- Configuring Additional Combo Meal Settings
- Creating Combo Meal Pages
- Combo Meal Function Keys

Related Topics

- Creating Combo Meal Groups
- Creating Combo Meals
- Configuring Additional Combo Meal Settings
- Creating Combo Meal Pages
- Combo Meal Function Keys
Combo Meal Group Pricing

You can use many pricing scenarios for combo meal groups, as described in the following examples.

Pricing Combo Meal Groups Based on Side Items

You can price side items on the combo meal's side items level instead of the traditional pricing at the combo meal groups items level. In some instances, this simplifies combo meal price configuration. If you set prices in both places, the pricing on the combo meal groups item level takes precedence. Consider the following examples:

- (Traditional Pricing) Combo Meal #1 Drinks cost $0.99
- (Traditional Pricing) Combo Meal #2 Drinks cost $1.09
- (Side Item Pricing) Milk (drink choice) costs $1.50 (upcharge)

1 Combo Meal #1: Root Beer $0.99
1 Combo Meal #1: Milk $1.50
1 Combo Meal #2: Root Beer $1.09

Pricing Combo Meal Groups Based on Size

The following figure illustrates the configuration of a basic combo meal group using different sizes and associated prices. A combo meal group called Combo Drinks contains the menu items Small Coke, Medium Coke and Large Coke. The Medium Coke is the default drink for all applicable Order Types. The workstation operator does not need to make a selection when adding the combo meal item using the workstation. The application automatically adds the Medium Coke as the default selection. (A workstation operator can modify this choice using the sizing or substitute option.) You can use the prices of $1.00 for the Medium Coke and $2.00 for the Large Coke. To use the combo size meal functionality, set the Small Coke as the Size 1 Item, the Medium Coke as the Size 2 Item and the Large Coke as the Size 3 Item. You must set Size 1-4 Item settings for all sizable combo group items listed. To allow workstation operators to add or change combo meal item sizes, add Front of House buttons to the combo transaction page using the Page Design module.
Figure 11-1  Example of Pricing Based on Item Size

Pricing Combo Meal Groups Based on Menu Item Definition

The following figure shows another optional pricing convention. You can price any combo meal menu item (for example, a Hamburger Combo to include all combo side and drink items. Set the combo’s price in the menu item definition record (in the Menu Item Maintenance module), and deselect option 4 - Add Side Prices To Meal Price in the Combo Meals module.

Figure 11-2  Example of Pricing Based on Menu Item Definition
Another method is to lower the combo meal menu item price and then roll the price of the combo sides and combo drink items into the price of the primary combo meal menu item.

Related Topics

• Creating Combo Meal Groups
• Creating Combo Meals
• Configuring Additional Combo Meal Settings
• Creating Combo Meal Pages
• Combo Meal Function Keys

Placeholder Menu Items in Combo Meals

When ordering a combo meal or fixed price meal (FPM), the customer might not be ready to order dessert when placing their initial order. The placeholder functionality allows the workstation operator to add the meal without knowing each of the menu items. Placeholder items can stand in for missing items until the workstation operator changes the placeholder item for the real one in a subsequent service round, as illustrated in the following figure.

You must configure a placeholder menu item as a conventional menu item (MI) including inserting a MI master, MI definition and a $0.00 price record. Additionally, assign a MI class to its MI definition file using the placeholder option(s). Then add the placeholder menu item to each desired combo meal group (for example, combo sides) so that the application shows the placeholder item on the Child Orderer area of the screen. When the workstation operator selects the placeholder item, it occupies a place in the check to allow service total.
The workstation operator can replace the placeholder menu item at any time prior to tendering or closing the check. After replacing it with a valid item (as shown in the following figure), the workstation operator cannot change the item back to a placeholder item. However, the workstation operator can substitute with another valid item.

Related Topics

- Creating Combo Meal Groups
- Creating Combo Meals
- Configuring Additional Combo Meal Settings
- Creating Combo Meal Pages
- Combo Meal Function Keys

Creating Combo Meal Groups

You can configure combo meals using two Enterprise Management Console (EMC) modules: Combo Meal Groups and Combo Meals. Configure the Combo Meal Groups module first and then configure the Combo Meals module.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Combo Meal Groups.
2. Insert a record for a new combo meal group, or double-click an existing record.
3. Select the appropriate combo group configuration options:
• **1 - Allow Discounts** – Select this option if you want discounts to apply to items in the group. The discount being applied must have option **25 - Discount Combo Meal Group Items** set in the Discounts module.

• **2 - Substitution Group items use this sides price** – Select this option if you want to set the menu item price to the side’s combo meal price specified on the combo meal form. The price setting occurs when a workstation operator substitutes a combo meal side with a menu item from an alternate group. Deselect this option if you want to set the menu item price in the alternate group.

4. (Optional) If you want to allow swappable side items, add Alternate Groups using the Add link.

• When alternate groups are present, workstation operators can substitute combo side items with other combo meal groups. For example, the customer might want to have an onion rings side item that is generally available in Combo Meal #2 with a Combo Meal #4. You can add a Combo Onion Rings alternate group that allows menu item substitution with a Combo Fries group. Configuring alternate side groups allows the application to substitute these side menu items. You must configure an Alternate Side button (using the Page Design module) to substitute items in Ops.

• If you are using Simphony version 2.7 MR3 or later, you configure fixed price meals (FPM) in the Alternate Groups field. Customers often want to substitute an appetizer or salad for the entrée portion of an FPM and this field accommodates these substitutions.

5. Click the Items tab to configure all menu items within a combo meal group.

6. Click the Add and Delete links to add or remove menu items from the combo meal group.

7. Enter or select information in the following fields for each item:

**Table 11-1  Combo Meal Group Fields**

<table>
<thead>
<tr>
<th>Field or Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Menu Item</td>
<td>Select a menu item to use in the combo meal group. For instance, if the combo group is called Combo Side Items, items in this group could be Small Fries, Medium Fries, Large Fries (if using the Size 1-4 Items), and Onion Rings (among others). This field shows all menu item master records that contain a definition in the revenue center.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Enter the number of times the menu item is needed in the combo group. This field is available for instances when a value meal consists of two burgers and a soda (as an example).</td>
</tr>
<tr>
<td>1 - Default when no Order Type declared</td>
<td>Select this option to make the selected item the default item for the combo group without an Order Type.</td>
</tr>
</tbody>
</table>

---

Chapter 11
Creating Combo Meal Groups

11-6
Table 11-1  (Cont.) Combo Meal Group Fields

<table>
<thead>
<tr>
<th>Field or Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-9 Default for Order Types 1-8</td>
<td>These options make the selected item the default item when Order Type 1 (through 8) is active. Deselecting these options forces the workstation operator to select an item to fulfill the combo meal requirements.</td>
</tr>
<tr>
<td>10 - Autofill</td>
<td>If the operator orders one of the combo meals and more than one remaining item is required for the side, the quantity of the item ordered changes to the number of remaining items to complete the side requirements.</td>
</tr>
<tr>
<td>Size 1-4 Items</td>
<td>Select a menu item that will substitute for the Primary Menu Item when using the Combo Size Size 1 through Size 4 function keys (set in Page Design under Type). This list shows all menu items assigned to the combo group after saving the items to the database. In the database, the Size 1-4 fields of Combo Meal Group items are part of a self-referencing table. Because of this, EMC has two limitations: you cannot copy or paste combo meal groups, and the Size 1-4 Item fields populate only after you save items to the database. (For example, if you create a new combo group and add the items Soda and Large Soda, you must save these items before selecting either item in this field.)</td>
</tr>
<tr>
<td>Size 1-4 Menu Levels</td>
<td>Select a menu level that can affect the price of the substituted Size 1-4 Items.</td>
</tr>
</tbody>
</table>

8. If you want to set specific side items with a different price (upcharge), click the Prices sub-tab. For example, perhaps Fries cost $0.00, but there is an extra charge of $1.25 when the customer orders Onion Rings.

9. Click the Add and Delete links to add or remove prices for each item. You can configure up to 8 prices for a single item.

Set the following fields when adding a price:

- **Price** – Enter the price to charge for the item.
- **Prep Cost** – Enter the à la carte price of the combo group item.
- **Active On Level** – Select the menu level on which the price is active.
- (Optional) **Effectivity Group** – Select the effectivity group for this price.
- (Optional) **Date Start** and **Date End** – Enter start and end dates.

10. Click **Save**.

**Related Topics**

- **Combo and Fixed Price Meals**
- **Combo Meal Group Pricing**
- **Placeholder Menu Items in Combo Meals**
Creating Combo Meals

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration, and Combo Meals.
2. Insert a record for a new combo meal, or double-click an existing record.
3. Select the menu item that represents the combo meal in the Menu Item Master field and click OK.
4. Enter the Priority for the combo meal when workstation operators press the Auto Combo function key.
5. In the Auto Combo Algorithm drop-down list, select the setting for the application to use when a workstation operator creates a combo meal from menu items already listed on a check. When the workstation operator presses the Auto Combo function key, the application uses one of the following options to combine the combo meal items:
   - **0 - First Deal Found** – Select this option to have the application use and combine the first item(s) found.
   - **1 - Best Deal for Customer** – Select this option to combine the most expensive items as a combo meal.
   - **2 - Best Deal for Merchant** – Select this option to combine the least expensive items as a combo meal.
6. Select the appropriate options as described in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Disable Auto-Combo Recognition</td>
<td>Select this option to prevent the combo meal from being considered when the workstation operator presses the Auto Combo function key.</td>
</tr>
<tr>
<td>2 - Allow Auto-Combo in Previous Round</td>
<td>Select this option to allow the combo meal to consider previous-round items when the workstation operator presses the Auto Combo function key.</td>
</tr>
<tr>
<td>3 - Is Sized Combo Meal</td>
<td>Select this option to allow the combo meal to use Combo Size Size 1-4 function keys, changing the size of the items ordered.</td>
</tr>
<tr>
<td>4 - Add Side Prices To Meal Price</td>
<td>Select this option to add the prices of the meal's side items to the price of the meal on the Kitchen Display System (KDS) display and the printed guest check.</td>
</tr>
<tr>
<td>5 - Only Print Priced Sides On Guest Check</td>
<td>Select this option to prevent the meal's side items from printing on the guest check when they have no price, or when their price rolls into the price of the meal.</td>
</tr>
<tr>
<td>6 - No Charge For Condiments</td>
<td>Select this option when added condiments (to the meal) are non-priced.</td>
</tr>
</tbody>
</table>
Table 11-2 (Cont.) Combo Meal Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 - No Bulk Order With Quantity Order</td>
<td>This option controls the ordering process when a workstation operator adds more than one combo meal. Select this option to prompt the workstation operator for each non-default side item per meal. Deselect this option to allow the workstation operator to specify a count when ordering non-default side items. When you deselect this option the application does not continue to the next side item until all of the combo meals satisfy the side items requirement.</td>
</tr>
<tr>
<td>8 - Allow Resizing of Individual Sides</td>
<td>Select this option to allow the workstation operator to change the size of a single specific combo meal side item. Deselect this option to allow the workstation operator to resize the entire combo meal.</td>
</tr>
<tr>
<td>9 - Do Not Show With Combo Meal Choices</td>
<td>If workstation operators can create multiple combo meals from the existing menu items listed on a check and you select this option, a system-generated list of available choices does not include the combo meal. This combo meal only appears in the list when no combo meals are found.</td>
</tr>
<tr>
<td>10 - Keep Last Item Selected after Ordering a New Meal</td>
<td>Select this option if you expect modifications to the combo meal after adding the last side, keeping the combo meal selected. This is particularly useful if the last side is often modified.</td>
</tr>
<tr>
<td>11 - Is Defined Combo Meal</td>
<td>Select this option to allow the application to incorporate the meal items in the combo as individual menu items in the Auto Combo On The Fly process. For example, you can configure a Donut 6 combo meal and set option 11. When a customer orders a Donut 6 combo and then adds one more donut, the option allows the application to handle the Donut 6 combo as six individual donuts. The auto combo procedure creates an auto combo meal from the menu items added to the check in the current round and initiates a Donut 7 combo instead of adding a seventh donut at full price. This results in a lower price for the customer.</td>
</tr>
</tbody>
</table>

7. Do not price items within the combo meal’s Combo Group Price field for combo size meals as this could cause issues with the Size 1-4 Items fields in the Combo Meal Groups module. See Creating Combo Meal Groups for more information.

8. Click Save.

Related Topics

- Combo and Fixed Price Meals
- Combo Meal Group Pricing
• Placeholder Menu Items in Combo Meals
• Combo Meal Function Keys

Configuring Additional Combo Meal Settings

You can configure additional combo meal options in various Enterprise Management Console (EMC) modules.

1. To set tenders with incomplete combo meals:
   a. Select the Enterprise, property, or zone, click **Configuration** and **Tender/Media**.
   b. Double-click the tender media record.
   c. Click the Options tab and the Printing Options sub-tab.
   d. If you do not want the tender to be allowed when a meal is missing a side item, select **85 - Not Allowed With Incomplete Meals**.
   e. Click **Save**.

2. To set workstation operator privileges with incomplete combo meals and placeholder items:
   a. Select the Enterprise level, click **Configuration** and **Roles**.
   b. Double-click the role record.
   c. Click the Operations tab and the Transactions sub-tab.
   d. Select **161 - Allow Incomplete Item** to allow workstation operators to add a parent item without a required condiment. (The parent menu item must have **59 - Allow Item Incomplete Based on Role** set in the Menu Item Classes module.)
   e. Select **164 - Authorize/Perform Service Total/Payment with Placeholder item** to allow workstation operators to perform or authorize tendering a transaction with a placeholder item. (You must also set option **85 - Not Allowed With Incomplete Meals** in the Tender/Media module.)
   f. Click **Save**.

3. To set revenue center operating parameters for combo meals:
   a. Select the revenue center, click **Setup** and **RVC Parameters**.
   b. Click the Options tab.
   c. Select **51 - Allow Auto Combo Meal Recognition with the "Combo" key** to allow the combo key to function with Auto Combo Meal recognition.
   d. Select **52 - Allow Creation of Combo Meals from Previous Round Menu Items** to allow the Auto Combo Meal recognition to create combo meals from menu items that were ordered in previous rounds.
   e. Select **55 - Show Combo Meal Choices** to show a list of combo meal choices when the workstation operator attempts to create meals from menu items already on the check.
   f. Select **58 - Auto Combo Items On The Fly** to have the application create combo meals from the menu items added to the check in the current round.
   g. Click **Save**.
4. To set menu item class options:
   a. Select the Enterprise, property, revenue center, or zone, click **Configuration** and **Menu Item Classes**.
   b. Double-click the menu item class record.
   c. Click the Options tab.
   d. Select **47 - Suppress Price with Combo Meal** to make condiments free when ordered as part of a combo meal.
   e. Select **59 - Allow Item Incomplete Based On Role** to allow the workstation operator to add a menu item without satisfying the required condiment’s conditions. (The role privilege **161 - Allow Incomplete Item** must be set for the workstation operator ordering a parent item with this menu item class.)
   f. Select **60 - Placeholder** if the menu item is a placeholder in a combo meal.
   g. Select **61 - No Placeholder Display** to hide placeholder items in the check detail area.
   h. Click **Save**.

**Related Topics**
- Combo and Fixed Price Meals
- Combo Meal Group Pricing
- Placeholder Menu Items in Combo Meals
- Combo Meal Function Keys

### Creating Combo Meal Pages

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.
2. Open the Front of House page (typically the Transaction page) on which to place the combo meal keys and functions.
3. Click **Button** and create hardcoded combo meal menu item keys on the Transaction page.

**Figure 11-3  Combo Meal Menu Item Key**
4. Click **Other...** and add a **Condiment/Combo Orderer**. Add the Condiment/Combo Orderer to the same Transaction page as the combo menu items and function keys to view the combo meals and substitute side items easier.

5. Select the Condiment/Combo Orderer, select the Data tab, and then select **Display Title Bar**. This area prompts workstation operators when required combo meal sides or condiments are not ordered.

6. Select **Combo Meal Side** to have the application generate and show any combo meal side items.

7. (Optional) Create combo meal size keys (if needed). These keys allow toggling between sizes of combo meal items. You can name the combo size keys for an actual size such as small, medium, or large, or Combo Size 1, Combo Size 2, and so on.

8. Add the appropriate function keys to the Combo Meal Transaction page (for example **Combo**, **Un-Combo**, **Auto Combo** and **Combo Multi-Selection**).

9. Configure keys for all individual menu items available (in particular combo groups).

10. Click **Save**.

**Related Topics**

- Combo and Fixed Price Meals
- Combo Meal Group Pricing
- Placeholder Menu Items in Combo Meals
- Combo Meal Function Keys

### Combo Meal Function Keys

Workstation operators can use the following function keys with combo meals:
**Table 11-3  Combo Meal Function Keys**

<table>
<thead>
<tr>
<th><strong>Function Key</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Combo</td>
<td>This key allows the workstation operator to create one or more combo meals from existing menu items.</td>
</tr>
<tr>
<td>Combo</td>
<td>When the workstation operator uses this key, the selected item or the last item on the check becomes a combo meal. The item must be a primary combo item. For example, if the combo meal is a burger with fries and a drink, the burger item must be the highlighted item or the last item ordered prior to pressing this key.</td>
</tr>
<tr>
<td>Combo Alternate Side</td>
<td>This key allows the workstation operator to substitute a combo meal side with a selection from another combo meal group (for example, when a customer orders an appetizer instead of an entree in a combo meal).</td>
</tr>
<tr>
<td>Combo Bulk Order</td>
<td>This key allows the workstation operator to order multiple combo meals at a time. The workstation operator must meet each combo’s side item requirements before moving on to order the next combo’s side items.</td>
</tr>
<tr>
<td>Combo Multi Selection</td>
<td>This key allows the workstation operator to select existing menu items to combine into a combo meal. This function shows the check details in a window, which allows the workstation operator to select individual items to make up the combo meal. This gives the workstation operator greater control in determining what is included in the combo meal.</td>
</tr>
<tr>
<td>Un-Combo</td>
<td>This key separates an existing combo meal into individual à la carte items (non-combo pricing takes effect).</td>
</tr>
<tr>
<td>Type - Combo Order Size</td>
<td>Selecting this key changes the order size before ordering the combo meal.</td>
</tr>
<tr>
<td>Type - Combo Size 1-4</td>
<td>These keys change the combo size after ordering the combo meal. Using this key causes the workstation to resize the selected combo meal or combo meal side item to selected sizes 1 through 4. If the workstation operator does not select an item, the last item on the check is resized.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Combo and Fixed Price Meals
- Combo Meal Group Pricing
- Placeholder Menu Items in Combo Meals
- Creating Combo Meal Groups
- Creating Combo Meals
- Configuring Additional Combo Meal Settings
- Creating Combo Meal Pages
Page templates allow you to customize a workstation touchscreen page in various ways. Page templates are categorized into the following types:

- Classic templates – These templates are similar to Simphony First Edition touchscreen templates
- Blank templates – These templates are used for customized pages or a Log In page
- Tabbed templates – These templates are used for Sign In and Transaction pages

Tabbed templates allow the greatest functionality. With a tabbed template, you can configure multiple tabs on the page. Approximately 50 tabs and sub tabs can appear on a page, and each tab and sub tab contain up to 50 buttons. Having a large number of buttons on a single page allows you to configure a small number of pages for a revenue center. A tab is used for navigation. Navigation on a page is consistent from page to page (navigation bar and sub tabs).

Pages can contain buttons and more sophisticated content, such as dining tables, Screen Lookups (SLUs), numeric entry areas, and background panels for highlighted groups of controls. All buttons perform a function.

The content appearing on a page can be dynamic based on the menu levels, serving period, employee class, or other criteria. For example, you can show a Manager Functions tab only if the manager is assigned to one of three manager employee classes.


- Configuring Function Keys
- Adding Menu Item Keys to the Transaction Page
- Adding a Service Total Key to the Transaction Page
- Adding Payment Keys to the Transaction Page
- Adding Discount and Service Charge Keys to the Transaction Page
- Configuring Macros

**Configuring Function Keys**

Function keys allow workstation operators to perform a variety of tasks, such as opening a cash drawer, authorizing a credit card, adding and transferring checks, printing customer receipts, and many other operations.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.
2. Open the Front of House page on which to place a function key.
3. On the Edit tab, select the page area in which to define the function key.
1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Page Design.
2. Open the Front of House page (typically the Transaction page) on which to place the menu item buttons.
3. On the Edit tab, select the page area in which to define the menu item buttons.
4. Click Button to add a button.
5. On the General sub-tab, enter the button name in the Legend field.
6. In the Type drop-down, select Menu Item.
7. Click the black arrow beneath the Type drop-down.
8. Select the menu item and click OK.
9. In the Menu Item Display Name drop-down, select the appearance for the menu item name.
10. Position and size the button on the page. Use the Style arrow to change the color.
11. Click Save.
12. Repeat Steps 4 through 11 to create keys for each menu item.

Adding a Service Total Key to the Transaction Page

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Page Design.
2. Open the Front of House page (typically the Transaction page) on which to place the service total button.
3. On the Edit tab, select the page area in which to define the service total button.
4. Click Button to add a button.
5. On the General sub-tab, enter the button name (Service Total) in the Legend field.
6. In the Type drop-down, select Tender/Media.
7. Click the black arrow beneath the Type drop-down.
8. Select the Service Total tender and click OK.
9. Position and size the button on the page. Use the Style arrow to change the color.
10. Click Save.
Adding Payment Keys to the Transaction Page

You can create payment keys for each type of payment tender (for example, Cash, Auth, Auth and Pay, Final Authorization, Split Tender).

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.
2. Open the Front of House page (typically the Transaction page) on which to place the payment buttons.
3. On the Edit tab, select the page area in which to define the payment buttons.
4. Click **Button** to add a button.
5. On the General sub-tab, enter the button name in the **Legend** field.
6. In the **Type** drop-down, select **Payment Tenders**.
7. Click the black arrow beneath the **Type** drop-down.
8. Select the tender payment type and click **OK**.
9. In the Payment Configuration dialog, select the **Payment Type** and click **OK**.
10. Position and size the button on the page. Use the Style arrow to change the color.
11. Click **Save**.

Adding Discount and Service Charge Keys to the Transaction Page

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.
2. Open the Front of House page (typically the Transaction page) on which to place the Discount and Service Charge buttons.
3. On the Edit tab, select the page area in which to define the Discount and Service Charge buttons.
4. Click **Button** to add a button.
5. On the General sub-tab, enter the button name in the **Legend** field.
6. On the General sub-tab, select the appropriate function from the **Type** drop-down.
   - **Discount**
   - **Service Charge**
7. Click the black arrow beneath the **Type** drop-down.
8. Select one of the following and click **OK**.
   - Discount amount or percentage
   - Service Charge amount or percentage
9. Position and size the button on the page. Use the Style arrow to change the color.
10. Click **Save**.
Configuring Macros

A macro is a button that, when pressed, executes a series of commands. Macros save time when workstation operators frequently enter certain sequences or keystrokes. You can set macros to include menu items, service charges, discounts, tenders, function keys, alphanumeric keys, or a link to another macro.

Simphony allows a maximum of 255 macros in one revenue center. You can set each macro to include up to 16 steps (keys), and you can link up to 20 macros together.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Page Design.
2. Open the Front of House page on which to place the macro button.
3. On the Edit tab, select the page area in which to define the macro button.
4. Click Button to add a button.
5. On the General sub-tab, enter the button name in the Legend field.
6. In the Type drop-down, select Function.
7. Click the black arrow directly beneath the Type drop-down, select the Macro function, and click OK.
8. Click the Edit Macro Keys button, and add the appropriate steps in the proper sequence.
9. Highlight the macro button.
10. Position and size the button on the page. Use the Style arrow to change the color.
11. Click Save.
Guest Checks

A guest check contains a record of all sales on the check, from the guest's first order to final payment.

- Configuring Guest Check Numbers
- Configuring Guest Check Headers and Trailers
- Creating a Tender to End the Current Service Round of Checks
- Understanding Fast Transactions
- Configuring Fast Transactions
- Understanding Full Seat Checks
- Configuring the Workstation to Print Full Seat Checks
- Creating a Full Seat Check Button
- Splitting Off an Item
- Configuring a Split Off Item Button
- Conversational Ordering
- Creating Menu Item Master Groups for Conversational Ordering
- Configuring Menu Level Sets for Conversational Ordering
- Configuring Menu Item Classes for Conversational Ordering
- Configuring Menu Items for Conversational Ordering
- Creating Front of House Buttons for Conversational Ordering
- Configuring Employee Privileges for Automatic Check Firing
- Configuring Automatic Check Firing
- Understanding Suspend and Resume
- Configuring Suspend and Resume
- Creating a Suspend and Resume Button
- Setting the Employee Auto Sign Out Period
- Understanding Follow Me
- Configuring Follow Me Checks
- Order Handling on Open Checks
- Holding and Sending Items to Order Devices
- Setting the Service Total to Send Items to be Prepared While the Check Remains Open
- Setting the Hold and Fire Option
- Setting the Hold and Fire Tender Notification
Configuring Guest Check Numbers

The guest check number can be between 1 and 9999 (a four-digit number). Generally, check numbers start in numeric order. If a workstation operator begins check number 1007, the next check number for the revenue center is 1008.

If you have multiple revenue centers and want to keep unique check numbers for each revenue center, you can assign an exclusive range of check numbers per revenue center. For example, Revenue Center 1 could have checks from 1000 to 1999 and Revenue Center 2 could have checks from 2000 to 2999.

1. In the EMC, select the revenue center, click Setup and RVC Parameters.

2. To set guest check numbers to generate automatically, enter the Min Guest Check # and Max Guest Check # on the General tab.

   When Simphony generates check numbers automatically, after reaching the Max Guest Check # value, the next check number is the Min Guest Check # value.

3. To set workstation operators to manually assign guest check numbers, click the Options tab and select 1 - Operator Assigns Check Numbers.

   This option is typically used by properties that have guest checks with pre-printed numbers (rather than using roll printers).

4. Click Save.

Configuring Guest Check Headers and Trailers

Guest check headers and trailers are leading and trailing lines that print on guest checks. Typically, the header lines include the name of the property or revenue center and address. The trailer lines generally show gratitude or promotional information about upcoming events. At hotels, guest check trailers are often configured to show room charge information for the customer to complete. You can also set a header or trailer line to print logos rather than text.

Headers print automatically on guest checks. You must set trailers to print per tender/media record.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Descriptors and Guest Check Headers or Guest Check Trailers.

2. For each line, enter information in the following fields:

   • Text – Enter the text to appear on the header or trailer.

   • (Optional) Use Logo – Select this option if you want to print a logo rather than text on the guest check header or trailer.
3. Click Save.

4. To configure trailers to print for each tender media record, in the EMC, select the Enterprise, property or zone, click Configuration and Tender/Media.

5. Double-click the tender record.

6. Click the Options tab and the Printing Options sub tab.

7. Set the appropriate options as described in the following table:

<table>
<thead>
<tr>
<th>Table 13-1</th>
<th>Trailer Printing Options for a Tender Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>20 - Print Sales Itemizers</td>
<td>Select this option to print the sales itemizer lines on guest checks, customer receipts, and memo checks when workstation operators use the tender record. Deselect this option to suppress printing of the sales itemizers.</td>
</tr>
<tr>
<td>21 - Print Summary Totals</td>
<td>Select this option to print the summary totals (subtotal, tax, amount due, and change due) on guest checks, customer receipts, and memo checks workstation operators press the key. Deselect this option to suppress printing of the summary totals.</td>
</tr>
<tr>
<td>22 - Print Check Trailer</td>
<td>Select this option to print the guest check trailer lines at the end of the guest check.</td>
</tr>
<tr>
<td>28 - Print Guest Check Trailer on Fast Transaction Customer Receipt</td>
<td>Select this option to print the guest check trailer on the customer receipt when workstation operators use the tender to close a fast transaction. Deselect this option if you do not want the trailer to print on customer receipts.</td>
</tr>
</tbody>
</table>

8. Click Save.

Creating a Tender to End the Current Service Round of Checks

You can configure the following two types of service total tenders that are commonly used in restaurants to end the current service round of guest checks:

- Service total tenders that send menu items to order devices
- Service total tenders that send menu items to order devices and print the guest check

1. If you want to have the tender send menu items to order devices:
   a. In the EMC, select the Enterprise or property, click Configuration and Tender/Media.
   b. Insert a new record, enter a name for the new tender record (for example, Send), and double-click the new tender record.
c. In the **Key Type** field, select **Service Total**.
d. Click **Menu Levels** and select all main and sub menu levels.
e. Click **Save**.

2. If you want to have the tender send menu items to order devices and print the guest check:
a. Select the Enterprise or property, click **Configuration** and **Tender/Media**.
b. Insert a new record, enter a name for the new tender record (for example, Print), and double-click the new tender record.
c. In the **Key Type** field, select **Service Total**.
d. Click **Options** and **Printing Options**.
e. Select the following options:
   • 13 - Print Memo Check
   • 23 - Print Check on Demand
   • 21 - Print Summary Totals
   • 20 - Print Sales Itemizers
f. Click **Menu Levels** and select all main and sub menu levels.
g. Click **Save**.

### Understanding Fast Transactions

A fast transaction does not require a workstation operator to use a **Begin Check** key to start a new transaction. Workstation operators can quickly start transactions by pressing a menu item key or scanning an item. This functionality is often used in a retail/concession environment where a workstation operator stands in one place and quickly begins transactions repeatedly. It is also often used for bartenders who start more transactions than a typical food server, and rarely assign customers to a specific table or check number.

**Related Topics**
- Configuring Fast Transactions

### Configuring Fast Transactions

1. In the EMC, select the revenue center, click **Setup** and **RVC Parameters**.
2. Click the Options tab.
3. Select **15 - Allow Fast Transactions**.
4. If you do not want customer receipts to automatically print after each fast transaction, select **9 - On Demand Customer Receipts**.
5. Click **Save**.
6. Select the Enterprise, property, revenue center, or zone, click **Setup** and **Format Parameters**.
7. Click the Options tab.
8. Select **21 - Print order number at bottom of Receipts** to have the check number print at the bottom of the customer receipt to be used as an order number.

9. Click **Save**.

10. Select the Enterprise, property, or zone, click **Configuration** and **Tender/Media**.

11. Double-click the tender record.

12. Click the Options tab and the Printing Options sub tab.

13. Select **28 - Print Guest Check Trailer on Fast Transaction Customer Receipt** to print the guest check trailer on the customer receipt when a workstation operator uses the tender to close a fast transaction.

14. Click **Save**.

**Related Topics**

- **Understanding Fast Transactions**

**Understanding Full Seat Checks**

A full seat check is a check that shows each seat's menu items with the subtotal separated by the seat header. Unlike a seat check, each full seat check includes a check header, a check trailer, and a paper cut. This feature is available from Simphony version 2.5 Maintenance Release 1.

**Figure 13-1   Example of Full Seat Check**

![Example of Full Seat Check](image)

**Related Topics**

- **Configuring the Workstation to Print Full Seat Checks**
- **Creating a Full Seat Check Button**
Configuring the Workstation to Print Full Seat Checks

1. In the EMC, select the Enterprise or property, click Configuration and Tender/Media.
2. Add a new record, and then toggle to Form View.
3. Select 2 - Service Total in the Key Type drop-down list.
4. Click the Options tab and Printing Options sub-tab.
5. Select 16 - Print Full Seat Check.  
   If you also select 14 - Print Seat Check, option 16 overrides option 14.
6. Select the following options:
   • 21- Print Summary Totals 
   • 22 - Print Check Trailer 
   • 23 - Print Check on Demand 
7. Click the Menu Levels tab, and then select all main and sub menu levels.
8. Click the Output tab, and then select the following options:
   • Print on Customer Receipts 
   • Print on Guest Checks 
   • Print on Journal 
9. Click Save.
10. Add a touchscreen button for the tender/media record that you created in step 2.  
    Creating a Full Seat Check Button contains more information about configuring the touchscreen button.

Related Topics
• Understanding Full Seat Checks

Creating a Full Seat Check Button

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Page Design.
2. Open the Front of House page on which to place the Full Seat Check button.
3. On the Edit tab, select the page area in which to define the Full Seat Check button.
4. Click Button to add a button.
5. On the General sub-tab, enter the button name in the Legend field.
6. Select Tender/Media from the Type drop-down.
7. Click the black arrow directly beneath the Type drop-down and select Full Seat Check.
8. Highlight the Full Seat Check button.
9. Position and size the button on the page. Use the Style arrow to change the color.
10. Click **Save**.

**Related Topics**

- **Understanding Full Seat Checks**

## Splitting Off an Item

A Split Off Item is a function key that enables workstation operators to separate (split) one or more items from a multiple quantity menu item entry so that it can be modified independently from the original item.

For example, a customer orders 3 burgers with 2 pieces of cheese and bacon. The customer then later requests to add ketchup to one burger. The workstation operator uses **Split Off Item** to separate one of the burgers and adds ketchup to it.

**Figure 13-2  Example of a Check Before and After Splitting an Item**

When a workstation operator splits a multiple quantity menu item with condiments (required or non-required condiments) the following results appear on the check:

- The condiments of the original item and their quantities are carried over to each split item.
- The quantity of the original parent menu item is reduced by the number of items split.

For example, if the workstation operator originally adds 3 burgers, after splitting one item, the original item entry shows as 2 burgers while the new split entry shows as 1 burger.
Related Topics
- Configuring a Split Off Item Button

Configuring a Split Off Item Button

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Page Design.
2. Open the Front of House page on which to place the Split Off Item button.
3. On the Edit tab, select the page area in which to define the Split Off Item button.
4. Click Button to add a button.
5. On the General sub-tab, enter the button name in the Legend field.
6. Select Function from the Type drop-down.
7. Click the black arrow directly beneath the Type drop-down and select Menu Item.
8. Highlight the Split Off Item button.
9. Position and size the button on the page. Use the Style arrow to change the color.
10. Click Save.

Related Topics
- Splitting Off an Item

Conversational Ordering

Conversational ordering allows workstation operators to add specially configured menu items for guests who order these items in no particular sequence. For example, in a coffee shop, the workstation operator requires the following items:
- Drink Type (Espresso, Latte, Mocha, Tea)
- Drink Size (Small, Medium, Large)
- Drink Temperature (Hot, Iced)
- Condiments or Modifiers (Whipped Cream, Cinnamon, Skim Milk)

When using conversational ordering, the workstation operator adds the order as a guest states items (for example, an iced mocha, medium size, with whipped cream), improving Speed of Service (SOS), ease of ordering for guests, and overall order accuracy.

Setting up conversational ordering consists of completing the tasks listed in the following table:
- Creating Menu Item Master Groups
- Configuring Menu Level Sets
- Configuring Menu Item Classes
- Setting Menu Items
- Creating Front of House buttons
Creating Menu Item Master Groups for Conversational Ordering

1. In the EMC, select the Enterprise, property, or zone, click Configuration and Menu Item Master Groups.
2. Insert a new Menu Item Master Group. In the coffee shop example, you could create the following groups: Drinks, Espresso, Latte, Mocha, and Americano.
3. Click Save.

Related Topics
- Conversational Ordering

Configuring Menu Level Sets for Conversational Ordering

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Menu Level Sets.
2. Insert a new Menu Level Set. In the coffee shop example, you could create Size and Temperature Menu Level Sets.
3. Select the Default Master Group for each Menu Level Set.
   In the coffee shop example, you could select Drinks as the Default Master Group.
4. Double-click a Menu Level Set to open it in form view.
5. In the General section, select 2 - Bound to parent to bind the Menu Item Master Group (for example, Drinks) to the custom Menu Levels (for example, Size and Temperature).

   When a guest initially orders a drink by either Size or Temperature, those menu items link to the Menu Item Master Group, which also link to Anonymous Menu Level Entry Options. This allows the workstation operator to add items in the exact order that the guest states or orders them.
6. In the Menu Level Entries section, click Add.
7. Enter menu level names for the Menu Level Set (for example, you could add Small, Medium, and Large Menu Level Entries to the Size Menu Level Set).
8. For each Menu Level Entry, select the Default and Anonymous options.
   Selecting these options allows the menu level sets to serve as temporary $0.00 placeholders for menu items when guests order them out of sequence.
9. Click Save.
Related Topics
  • Conversational Ordering

Configuring Menu Item Classes for Conversational Ordering

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Menu Item Classes.

2. Insert a new Menu Item Class record.
   • For each menu item that a guest can order through Conversational Ordering, create at least two Menu Item Classes to accommodate the guest in ordering the same menu item in different ways. In the coffee shop example, each coffee type might have two classes: Latte Anonymous and Latte Defined. Create the Anonymous class first.
   • Create a generic Menu Item Class to assign only to Menu Item Definitions that are $0.00 priced menu items. In the coffee shop example, the Menu Item Class Drink Anonymous can be used for Menu Item Definitions such as {SIZE} Large Drink or {TEMP} Hot Drink. This Menu Item Class is assigned to the Default Master Group named Drinks.

3. Double-click a Menu Item Class to open it in form view.

4. On the General tab, in the Condiment Order Type drop-down list, select 2 - Replace in Condiment Group. Setting this option replaces the previously selected condiment with the latest condiment choice when the workstation operator selects condiments. If you set the Increment option, a priced condiment can be added to a transaction, such as a shot of espresso.

5. Click the Options tab.

6. For each Menu Item Class with Anonymous in the name, select the following options:
   • 8 - Allow Menu Items in this Class to be Non-Priced
   • 49 - Participates in Menu Item Master Switching
   • 50 - Anonymous Menu Item

7. For each Menu Item Class with Defined in the name, select the following options:
   • 8 - Allow Menu Items in this Class to be Non-Priced
   • 49 - Participates in Menu Item Master Switching

8. For the generic Menu Item Class (for example, Drink Anonymous), select the following options:
   • 8 - Allow Menu Items in this Class to be Non-Priced
   • 49 - Participates in Menu Item Master Switching
   • 50 - Anonymous Menu Item

9. Click the Condiment Groups tab.

10. For each Menu Item Class, select the appropriate condiment groups:
    • Required Condiment Groups – These condiment groups must be entered when a workstation operator adds menu items in this class.
• Allowed Condiment Groups – These condiment groups are allowed to be entered as condiments for menu items in this class.

• Member Condiment Groups – These condiment groups consist of menu items in this class.

11. Click Save.

Related Topics
• Conversational Ordering

Configuring Menu Items for Conversational Ordering

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Menu Item Maintenance.

2. Insert a menu item master record for each menu item (including condiments) that can be ordered using conversational ordering. You need to account for all potential ordering combinations a guest might use. Use braces {} to surround the generic variables such as {SIZE} and {TEMP}.

In the coffee shop example shown in the following figure, you might have records for {SIZE} {TEMP} Drink, {SIZE} Hot Drink, and so on.
3. Select the **Major Group**, **Family Group**, and **Master Group**.

4. Click the Definition Records tab in the lower area of the page.

5. Set the following for each record:
   - Menu Item Class
   - Menu Item Price
   - Menu Level Availability
   - Default Condiments

6. Click **Save**.

**Related Topics**
- [Conversational Ordering](#)
Creating Front of House Buttons for Conversational Ordering

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration and Page Design.
2. Open the Front of House page on which to place menu item master buttons.
3. On the Edit tab, select the page area in which to define the menu items (including condiments) (typically the transaction area).
4. Click Button to add a button.
5. On the General sub-tab, select the appropriate function from the Type drop-down.
6. Click the black arrow beneath the Type drop-down.
7. Position and size the button on the page. Use the Style arrow to change the color.
8. In the Legend field, enter the button name.
9. Click Save.
10. Repeat these steps to create buttons for each of the menu item master names.

Related Topics
• Conversational Ordering

Configuring Employee Privileges for Automatic Check Firing

1. In the EMC, select the Enterprise level, click Configuration and Roles.
2. Double-click an employee role, click the Operations tab and the Guest Checks sub-tab.
3. Select the appropriate privileges. The following table describes the privileges corresponding to automatic check firing.

Table 13-2 Employee Guest Check Privileges for Automatic Check Firing

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>183 - Begin Autofire Check using [Begin Autofire Check] Key</td>
<td>Select this option to allow employees in this role to create checks that automatically fire at a preset time using the Begin Autofire Check function key.</td>
</tr>
<tr>
<td>184 - Authorize/Perform Pickup of Autofire Check Belonging to Another Operator</td>
<td>Select this option to allow employees in this role to pick up and edit checks that fire at a preset time from other employees.</td>
</tr>
<tr>
<td>185 - Authorize/Perform Edit of Autofire Date/Time</td>
<td>Select this option to allow employees in this role to modify the date and time that checks are set to automatically fire.</td>
</tr>
</tbody>
</table>

4. If you want to allow employees in this role to generate the Autofire Open Check Report from the workstation, click the Ad Hoc Reports sub-tab and select 31030 - Run Autofire Open Check Report.
5. Click Save.
Configuring Automatic Check Firing

1. In the EMC, select the revenue center, click **Setup and RVC Parameters**.
2. Click the Autofire tab and configure the settings as described in the following table:

<table>
<thead>
<tr>
<th>Fields and Options</th>
<th>Description</th>
</tr>
</thead>
</table>
| (Optional) Autofire Employee           | If you want a specific employee to become the owner of all checks, including those placed using Transaction Services, after they fire, select a workstation operator and click **OK**.  
  • If you select an Autofire Employee, all sales totals post to the designated workstation operator and the checks appear under the Autofire Employee in the Open Check Report.  
  • If you do not select an Autofire Employee, the check operator remains the owner of the check after the check fires. |
| Autofire Workstation                   | Select the workstation from which the checks fire and print. The application uses this value to determine the order output devices and workstation printers to use when a check fires. |
| Default Autofire Tender/Media          | Select a tender that workstation operators must use to end the current service round of checks that fire automatically.  
  You can assign any service total type tender. Oracle Hospitality recommends configuring a separate service total tender for automatic check firing to allow workstation operators to identify the designated touchscreen button. Creating a Tender to End the Current Round of Checks contains information about configuring a service total tender. |
| Backup Autofire Delay (Mins)           | Enter the amount of time (in minutes) that the autofire workstation must try to fire the checks. The default value is 5 minutes.  
  After the Backup Autofire Delay time elapses, if the autofire workstation is unsuccessful at firing the check, the workstation at which the check was originally created tries to fire the check. If both workstations fail, a memo chit prints and a workstation operator must manually fire the check. |
| (Optional) Maximum Days                 | Enter the maximum number of days for which workstation operators can schedule checks to fire automatically. |
Table 13-3  (Cont.) Automatic Check Firing Fields

<table>
<thead>
<tr>
<th>Fields and Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Optional) 1 - Print Autofire Memo at Time of Entry</td>
<td>Select this option if you want a memo chit to print when workstation operators create checks to fire automatically.</td>
</tr>
<tr>
<td>(Optional) 2 - Print Guest Check at Time of Autofire</td>
<td>Select this option if you want a guest check to print when a check automatically fires to order devices.</td>
</tr>
<tr>
<td></td>
<td>If you select this option, guest checks print at the guest check printer assigned to the autofire workstation.</td>
</tr>
<tr>
<td>3 - Enable Autofire in this Revenue Center</td>
<td>Select this option to allow the revenue center to create checks that fire automatically.</td>
</tr>
</tbody>
</table>

3. Click **Save**.
4. Select the Enterprise, property, revenue center, or zone, click **Descriptors** and **Autofire Check Offline Header**.
5. In the **Text** column, enter the header lines to print on memo chits when checks fail to fire automatically.
6. If you want to add a logo to the header, select **Use Logo**, click the ellipsis point (...) symbol in the Logo column, select the logo from the list, and click **OK**.
7. Click **Save**.
8. Select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.
9. Insert a new button on the transaction page, select **Function** as the Type, and select **Begin Autofire Check** from the function list.
10. Click **Save**.

**Understanding Suspend and Resume**

With Suspend/Resume workstation operators can:

- Suspend a check started by another employee, and sign in to the workstation.
- Suspend a check when the workstation automatically signs out an employee.
- Suspend a check using a Tender/Media key.

When suspended, the check is stored in the memory until a workstation operator resumes it.

**Related Topics**

- Configuring Suspend and Resume
- Creating a Suspend and Resume Button
- Setting the Employee Auto Sign Out Period
Configuring Suspend and Resume

1. In the EMC, select the revenue center, click **Setup** and **RVC Parameters**.
2. Click the Options tab.
3. Select **60 - Enable Suspend/Resume**.
4. Click **Save**.
5. Select the Enterprise, property, or zone, click **Configuration** and **Tender/Media**.
6. Insert a record with the tender name.
7. Double-click the tender record.
8. On the General tab, in the **Key Type** field, select **2 - Service Total**.
9. Click the Options tab and the Ops Behavior sub tab.
10. Select **74 - Suspend Order**.
11. Click **Save**.

**Related Topics**
- Understanding Suspend and Resume

Creating a Suspend and Resume Button

To allow workstation operators to manually suspend a check, you need to add a button assigned to the service total tender record.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.
2. Open the Front of House page on which to place the Suspend/Resume button.
3. On the Edit tab, select the page area in which to define the Suspend/Resume button.
4. Click **Button**.
5. On the General sub-tab, enter the button name in the **Legend** field.
6. Select **Tender/Media** from the **Type** drop-down.
7. Click the black arrow directly beneath the **Type** drop-down, select the tender you created for the suspend and resume service total, and click **OK**.
8. Position and size the button on the page. Use the Style arrow to change the color.
9. Click **Save**.

**Related Topics**
- Understanding Suspend and Resume

Setting the Employee Auto Sign Out Period

To automatically suspend a check and sign out an employee, you need to define the automatic operator popup interval.
1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Setup** and **Control Parameters**.

2. Click the Configuration tab.

3. In the **Automatic Operator "Popup" Interval (min:sec)** field, enter the amount of time (in minutes and seconds) that the workstation waits before signing out an inactive popup workstation operator.

4. Click **Save**.

**Related Topics**
- Understanding Suspend and Resume

---

### Understanding Follow Me

Follow Me extends the functionality of the suspend and resume feature in Simphony. Follow Me allows workstation operators to use suspended checks across workstations in the same revenue center. This feature increases speed of service in a typical pub and fast casual restaurant environment.

For example, a pub may have three workstations and up to twelve bartenders working simultaneously. Each bartender can sign in and sign out on any workstation. A bartender can begin a check on workstation 1, prepare a drink, and then log on to workstation 2 to resume the check. The check is suspended on workstation 1 and automatically resumed on workstation 2. Any menu items, discounts, and service charges that were added on workstation 1 appear on workstation 2. A check can be open on only one workstation at a time.

The journal logs the suspend and resume history of each check and lists the workstation on which the suspend and resume transaction was performed.

**Related Topics**
- Configuring Follow Me Checks

---

### Configuring Follow Me Checks

1. In the EMC, select the revenue center, click **Setup, RVC Parameters**, and **Options**.

2. Select **68 - Enable Follow Me**.

   When you set Follow Me, option **60 – Enable Suspend/Resume** dims, and vice versa. You cannot select both Follow Me and Suspend/Resume; they are mutually exclusive. When you set Follow Me, each workstation in the revenue center participates in the Follow Me operation.

3. Select the property, click **Setup**, and **Workstations**.

4. On the General tab, enter information in the fields as described in the following table:
Table 13-4 Workstation Timeout Settings

<table>
<thead>
<tr>
<th>Timeout Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Inactivity Timeout</td>
<td>The number of seconds the workstation waits before prompting the workstation operator to cancel a transaction. If you set this value to 0 (zero), the Cancel dialog does not appear. If you select <strong>Enable Follow Me</strong> in the RVC Parameters module, the guest check is automatically suspended rather than cancelled.</td>
</tr>
<tr>
<td>Check Inactivity Dialog Timeout</td>
<td>The number of seconds the workstation shows the Do you need more time? Inactivity dialog before automatically cancelling the transaction. If you set this value to 0 (zero), the Cancel dialog does not appear.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Related Topics**

- Understanding Follow Me

---

**Order Handling on Open Checks**

This section describes how to configure Simphony to:

- Send orders to order devices (such as remote printers or a kitchen display system (KDS)) when performing a Service Total while the guest check remains open
- Manually or automatically send items on a guest check to order devices in groups over a period of time at pre-set times

**Related Topics**

- Setting the Service Total to Send Items to be Prepared While the Check Remains Open
- Setting the Hold and Fire Option
- Setting the Hold and Fire Tender Notification
- Setting a Reminder for Items on Hold
- Setting Checks with Items on Hold to End Current Service Round
- Setting Check Handling with Held Items When Closing Checks

---

**Holding and Sending Items to Order Devices**

The following table describes how to configure the workstation to hold and send menu items on open guest checks to order devices.
Table 13-5  Configure Workstations to Hold Items on Guest Checks

<table>
<thead>
<tr>
<th>Task</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable option to hold items on guest checks and add touchscreen buttons</td>
<td>Setting the Hold and Fire Option</td>
</tr>
<tr>
<td>Enable workstation notifications for held menu items when tendering</td>
<td>Setting the Hold and Fire Tender Notification</td>
</tr>
<tr>
<td>Configure workstations to remind workstation operators of checks with items on hold after signing into the workstation</td>
<td>Setting a Reminder for Items on Hold</td>
</tr>
<tr>
<td>Configure guest checks with items on hold to end current service round and add touchscreen buttons</td>
<td>Setting Checks with Items on Hold to End Current Service Round</td>
</tr>
<tr>
<td>Configure how to handle items on hold when closing checks</td>
<td>Setting Check Handling with Items on Hold when Closing Checks</td>
</tr>
<tr>
<td>(Optional) Configure Check Screen Look Up (SLU) to display checks with only held items</td>
<td>Configuring Check Screen Lookup (SLU) to Show Checks with only Held Items</td>
</tr>
</tbody>
</table>

Setting the Service Total to Send Items to be Prepared While the Check Remains Open

1. In the EMC, select the property click **Configuration** and **Tender/Media**.
2. Insert a Service Total tender record if it does not exist.
3. Double-click the record to open it.
4. On the General tab, in the **Key Type** field, select **2 - Service Total**.
5. Select the Options tab, and the Ops Behavior sub-tab.
6. Select option **95 - Send Order**.
7. Click **Save**.
8. Add a touchscreen button for the tender/media record that you created in step 2. **Workstation Touchscreen Pages** contains more information about configuring touchscreen buttons (for example, Service Total, Hold, Transaction Hold, Timed Fire, and View Fire Times).

**Related Topics**
- Order Handling on Open Checks

Setting the Hold and Fire Option

1. In the EMC, select the revenue center, click **Setup**, and **RVC Parameters**.
2. Select the Options tab, and then select **70 - Enable Hold and Fire**.
3. Click **Save**.

**Related Topics**
- Order Handling on Open Checks
Setting the Hold and Fire Tender Notification

1. In the EMC, select the revenue center, click Setup, and Control Parameters.
2. Select the Options tab, and then select 66 - Enable Hold and Fire Final Tender Notification.
3. Click Save.

Related Topics
• Order Handling on Open Checks

Setting a Reminder for Items on Hold

1. In the EMC, select the Enterprise level, click Setup and Control Parameters.
2. Click the Configuration tab.
3. In the Confirm Threshold Period for Items on Hold (minutes) field, enter the time that should elapse before notifying workstation operators of checks with items on hold.
   If you set the Confirm Threshold Period for Items on Hold (minutes) to 0, the workstation shows a reminder each time a workstation operator signs in to the workstation.
4. Click Save.

Related Topics
• Order Handling on Open Checks

Setting Checks with Items on Hold to End Current Service Round

1. In the EMC, select the property, click Configuration and Tender/Media.
2. Insert a Hold Service Total tender record if it does not exist.
3. Double-click the record to open it.
4. On the General tab, in the Key Type field, select 2 - Service Total.
5. Select the Options tab, and the Ops Behavior sub-tab.
6. Select a Hold Type for the service total tender. The Hold Type is used with Hold and Fire to establish the order device output instruction for menu items on the guest check. The following options are available.
   • 1 - Hold Order – Holds the entire guest check.
   • 2 - Keep Held Status – Sends all items to the order device except those on hold.
   • 3 - Fire Order – Sends all menu items, including items on hold, to order devices. Items that you configure to send at a preset time are exempt from this service total type.
7. Repeat Steps 2 through 6 to configure remaining hold service total tenders (for example, Transaction Hold, Timed Fire, and View Fire Times).

8. Click Save.

9. Add touchscreen buttons for the tender/media records that you created in Step 2. Workstation Touchscreen Pages contains more information about configuring touchscreen buttons (for example, Hold, Transaction Hold, Timed Fire, and View Fire Times).

Related Topics
• Order Handling on Open Checks

Setting Check Handling with Held Items When Closing Checks

1. In the EMC, select the property, click Configuration and Tender/Media.

2. Double-click a Service Total tender record to open it.

3. Select the Options tab and the Ops Behavior sub-tab.

4. Select a Hold Type for each type of Service Total tender used when making a payment and closing a guest check. The following table describes the Hold Types and their affect on the workstation messages.

<table>
<thead>
<tr>
<th>Hold Type</th>
<th>Workstation Message When Closing a Check with Items on Hold</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Hold Order</td>
<td>Select this option to have the workstation show a message asking the workstation operator whether to send the items on hold to the order devices or to close the check without sending the items.</td>
</tr>
<tr>
<td>2 - Keep Held Status</td>
<td>Select this option to have the workstation show a message asking the workstation operator whether to send the items on hold to the order devices or to close the check without sending the items.</td>
</tr>
<tr>
<td>3 - Fire Order</td>
<td>Select this option to have the workstation send all items on hold to the order devices. This is the default Hold Type.</td>
</tr>
</tbody>
</table>

5. Click Save.

Related Topics
• Order Handling on Open Checks

Printing Multiple Languages on Guest Checks and Customer Receipts

You can show guest check detail and print a receipt showing both primary and secondary languages configured for the property. For example, English and Arabic can appear on the guest check detail area and print on the same receipt. When
configured, all areas of the check show both languages, except the check number, table number and employee name and number. These numerals print in the primary language.

Related Topics
- Configuring Right to Left Reading Languages
- Creating a Print Language List Button
- Creating Print Language Buttons

Configuring Right to Left Reading Languages

To show guest check detail and print customer receipts and guest checks in the right to left orientation configured for a language, set the following:

- Enterprise Language
- Workstation Language
- Secondary Print Language

1. In the EMC, select the Enterprise level, click **Setup** and **Languages**.
2. Double-click the language record to open it.
3. Select **Right-To-Left** to have the check detail area and customer receipt appear in Ops and print in right-to-left orientation.
4. Click **Save**.

You can print custom numerals on a customer receipt or guest check. For example, Arabic digits can print on the receipt rather than Latin digits. Simphony version 2.7 and later does not support custom numerals in the Ops check detail appearance.

5. Select the property, click **Setup**, **Workstations**, and **General**.
6. Select the language you want to appear on the workstation from the **Language** list.

You can override the default language on the workstation for specific employees using the Employee Maintenance module. Employees with a different language configured in Employee Maintenance see that language after signing in to the workstation.

7. Click **Save**.
8. Select the property, click **Setup**, **Property Parameters**, and **General**.
9. Select primary and secondary languages from the **Language 1** and **Language 2** lists.
10. Select the language from the Select Secondary Print Language list. Selecting **0 – None** causes only the default language to print. When printing multiple languages, the system prints item names in the order configured for the property.
11. Click **Save** to apply the changes.
12. Select the Enterprise, property, revenue center, or zone, click **Setup**, **Format Parameters**, and **Options**.
13. Select **52 - Print Secondary Language on Guest Checks/Customer Receipt**.
14. Click Save.

**Related Topics**
- Printing Multiple Languages on Guest Checks and Customer Receipts

**Creating a Print Language List Button**

When printing multiple languages, you can have each workstation operator select the language from a list in Ops using the Print Language List button.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.
2. Add a button to the appropriate screen with the function **Print Language List**.
3. Click **Save**.

**Related Topics**
- Printing Multiple Languages on Guest Checks and Customer Receipts
- Workstation Touchscreen Pages

**Creating Print Language Buttons**

The Print Language function allows the workstation operator to select a specific language. For example, if the secondary language is Arabic, the Print Language 2 button prints the customer receipt in Arabic. Follow these steps to create one or more Print Language buttons.

1. In the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.
2. Add a button to the appropriate screen with the function **Print Language 2**. Depending on the number of languages, you can create other Print Language buttons (for example, **Print Language 3** and **Print Language 4**).
3. Click **Save**.

**Related Topics**
- Printing Multiple Languages on Guest Checks and Customer Receipts
- Workstation Touchscreen Pages
Resetting Daily Totals

A business day refers to the beginning and end times of a day of business. A business day can have any begin time, but typically a business day starts in the early morning hours during a slow or closed period of operations (for example, 3:00 a.m. or 4:00 a.m.). A calendar day always begins at 12:00 a.m.

To reset daily check and employee totals, a property or revenue center must start a new business day.

- Start of Day
- Start of Day Business Rules
- Start of Day with Offline Workstations or Server
- Configuring Start of Day

Related Topics
- Configuring Start of Day

Start of Day

Start of Day (SOD) is the process that begins a new business day at a property. The SOD can be set to run automatically or manually.

When the time of day occurs that a new business day is automatically configured to start (for example, at 4:00 a.m. each day), the following actions occur in the order listed:

- Simphony increases the Business Day and updates the status of checks and employees.
- The PC Autosequence runs, and typically performs the following actions:
  - Batches and settles credit cards
  - Runs custom applications for a property
- After the SOD Autosequence completes, Simphony checks to see whether it is time to run other autosequences (such as Start of Week Autosequence, Start of Pay Period Autosequence, and so on).

Many properties like to start a new business day manually at their own time (after a night auditor balances reports). Often these properties stop their Simphony and property management systems at the same time, roll to a new business day, and then bring the systems back up. An administrator can manually run SOD in Simphony using an interaction called PC Autosequence (in the Enterprise Management Console (EMC)) or by pressing a button on the workstation. When SOD begins manually, Simphony performs the same actions as if it were run automatically. The only difference is the method by which SOD begins.

Related Topics
- Configuring Start of Day
Start of Day Business Rules

Simphony has business rules to determine how and when a business day can begin, and which business day is beginning. The rules exist for both automatic and manual Start of Day (SOD).

When starting a new business day, the following rules apply:

• SOD cannot be run twice in 8 hours.
• SOD cannot be run twice between midnight and noon.
• SOD cannot be run twice between noon and midnight.
• When a business day is scheduled to run automatically, it is not possible to start the business day manually with a PC Autosequence.

A business day is calculated based on noon (12:00 p.m.) to noon times.

• If SOD is run before noon, Simphony assumes the business day completed is for the previous calendar day. (If SOD runs at 3:05 a.m. on the 17th, the 16th is the business day that is closing, and the 17th is the business day being started.)
• If SOD is run after noon, Simphony assumes the business day completed is for the current calendar day. (If SOD is run at 11:52 p.m. on the 17th, the 17th is the business day that is closing, and the 18th is the business day being started.)

Related Topics
• Configuring Start of Day

Start of Day with Offline Workstations or Server

Workstations are aware of the business date configuration so that offline reports show relevant information. Consider the following scenario:

• Every business day begins at 3:00 p.m.
• On Tuesday at approximately 11:00 a.m., a property loses communication with the database (the property is in Yellow Mode).
• The site is offline until Friday afternoon.

In this situation, workstations run reports as if Start of Day (SOD) occurred. For example, a report taken for today on Wednesday at 4:00 p.m., shows data from Wednesday at 3:00 a.m. (the time SOD would have occurred) to the current second when the report was taken. In addition, if days are configured for manual SOD, workstation reports assume that the business day begins 24 hours after the previous SOD occurred. In this situation, a dialog box appears on workstations informing the manager that a new business day has begun.

Catch-Up mode increases the business day after the Simphony server goes offline during an automatically scheduled SOD time period. Consider the following scenario:

• SOD is set to run automatically at 4:00 a.m.
• At 2:00 a.m., the Simphony server experiences a power failure.
• At 6:00 a.m., the Simphony server is online again.
In Catch-Up mode, the SOD Autosequence does not start. With Catch-Up mode, the business day still starts at 4:00 a.m. When Simphony comes online at 6:00 a.m., the PERIOD_INSTANCE table is populated with rows to indicate that the business day started. The rows do not show a 6:00 a.m. run time, however. Catch-Up mode knows that the application was supposed to have started at 4:00 a.m., so the rows are created with 4:00 a.m. as the start time. Simphony can catch-up from up to two missed automatic start of days and make the appropriate PERIOD_INSTANCE entries.

Related Topics

- Configuring Start of Day

Configuring Start of Day

1. In the EMC, select the Enterprise level, click Configuration and Roles.
2. Select the role type (such as manager), click the Operations tab, and the PMC Procedures sub-tab.
3. Select the appropriate start of day role privileges:
   - 30058 – Run Start of Day from OPS – Select this option to allow all employees with the role to increment the business date from the property’s Check and Posting Service (CAPS) workstation.
   - 30059 – Prevent Running SOD from OPS with Open Checks – Select this option so that Start of Day (SOD) cannot run when open checks exist.
4. Click Save.
5. If you want to allow a manager or administrator to manually run SOD from a workstation, select the Enterprise, property, or revenue center, click Configuration and Page Design.
   If you do not want to allow manual SOD, skip to Step 14.
6. Select the page on which to place the Start of Day button. The Start of Day button allows a manager or administrator to manually run the Start of Day on a workstation.
7. Add a Start of Day button:
   a. In the Legend field, enter Run Start of Day.
   b. In the Type field, select Function.
   c. Click the arrow beneath the Type field and select Start of Day.
   d. Position and size the new button on the page.
8. Click Save.
9. Select the property, and then click Setup, Property Parameters, and Options.
10. If you want to allow a manager or administrator to manually run SOD from a workstation, select 48 – Run Start of Day from OPS.
11. Select the Calendar tab.
12. Select Run Manually for each day of the week.
13. In the Manual SOD Safety catch time field, set the time when the application automatically increments the business date if someone forgets to manually run SOD.
The application checks to see whether SOD occurred within a 24-hour period for the selected property. This time is based on the time zone of the property.

14. Click **Save**.

15. Select the Enterprise level, click **Configuration** and **PC Autosequences**.

16. Insert a PC Autosequence record and name it **Increment Business Day**.

17. Open the record and select the **Allowed Properties** to view the autosequence.

18. (Optional) Add **Parameters** as appropriate. For example, you can enter a property number and exclude a revenue center number.

19. On the Steps tab, add a step and in the **Step Type** drop-down list, and select **3 – Increment Business Date**.

20. Click **Save**.

**Related Topics**
- Resetting Daily Totals
- Start of Day
- Start of Day Business Rules
- Start of Day with Offline Workstations or Server
Simphony is a data driven solution that relies on configuration data stored in a central database. Transactions that are added on Simphony clients are also stored within databases.

Simphony is comprised of two sets of databases that are used for the following purposes:

- Online transaction processing
- Online analytical (reports) processing

Two processes move data between the database:

- Data Transfer Service (DTS) – Moves configuration data from the transaction database to the analytical database
- Direct Posting Service (DPS) – Moves transaction data from the transaction database to the analytical database

Understanding the Database Update Frequency

You can establish how often database synchronization jobs are run on the workstations. By default, the workstations and Kitchen Display System (KDS) Controllers wait 30 minutes to retrieve the latest updates from the database.

The Database Update Frequency setting exists in three modules in the Enterprise Management Console (EMC):

- Property Parameters
- Workstations
- KDS Controller

The Workstations module setting or KDS Controller setting takes precedence over the Property Parameters setting. If the workstation's Database Update Frequency setting is greater than the Property Parameters setting, the highest configured value within the entire Workstations module for the property is used for the purge jobs event scheduling calculation. For example, if the workstation's Database Update Frequency field has a configured value of 180 seconds, an additional 30 minutes is added to the event schedule. In other words, the Check and Posting Service (CAPS) totals purge job does not run until 33 minutes have elapsed from the moment that the Clear Totals button is first clicked.
Setting the Database Update Frequency

1. In the EMC, select the property, click Setup and Property Parameters.
2. Click the Workstations tab.
3. In the Database Update Frequency field, enter the number of seconds that workstations and KDS Controllers wait to retrieve the latest updates from the database.
4. Click Save.
5. If you want to override this setting for the workstation, select the property, click Setup and Workstations.
6. Double-click the workstation.
7. On the General tab, set the Database Update Frequency timeout value.
8. Click Save.
9. If you want to override this setting for the KDS, select the property, click Setup and KDS Controllers.
10. Double-click the KDS record.
11. On the General tab, set the Database Update Frequency timeout value.
12. Click Save.

Understanding the Clear Totals Operation

If you have the appropriate privileges, you can purge unwanted transaction totals accumulated during testing and training periods prior to going live. Clearing totals immediately purges the totals for all of the designated property’s revenue centers from the Enterprise. You cannot clear totals for individual revenue centers.

The Clear Totals operation performs the following tasks:

- Immediately purges the property’s transaction totals and check related data on and prior to the selected business date from the Enterprise
- Initiates a request to run a purge job for the reporting database (Oracle Hospitality Reporting and Analytics Advanced) totals
- Purges the MRequest Queues data
- Purges the Journal log file data
- (Optional) Purges Cash Management data

After the Clear Totals operation begins, two data purging events are scheduled to run for the following purge jobs:

- Check and Posting Service (CAPS) Database – This event runs first based on the Database Update Frequency setting, plus an additional 30 minutes. When the
scheduled time is reached, the application purges the designated property’s CAPS database.

- Workstation DataStore Data – This event runs second based on the Database Update Frequency setting, plus an additional 45 minutes. When the scheduled time is reached, the application purges the DataStore data from the designated property’s workstations.

**Related Topics**
- Running the Clear Totals Operation

## Running the Clear Totals Operation

Before clearing totals, you must batch and settle all credit card transactions dated prior to the specified business date. You cannot clear totals when unbatched credit cards exist. Oracle recommends that you generate and save all credit card related reports from either the Enterprise Management Console (EMC) or Oracle Hospitality Reporting and Analytics for historical reference.

Time Zone synchronization between the Simphony application server and workstations is important for the Clear Totals operation to work correctly. The Client Application Loader (CAL) keeps the time settings on Simphony clients in sync with the Simphony application server. Some devices do not use CAL for configuration, and these devices can become out of sync with the Simphony application server. Therefore, before running the Clear Totals operation, ensure that the time settings on non-CAL devices are set to match the Simphony application server’s time settings as closely as possible.

1. In the EMC, select the property, click **Tasks** and **Clear Totals**.
2. Select the **Business Date** from the drop-down list.
3. Click **Clear Totals**. The Result window shows the status of each purged job.
4. Select the property, click **Setup** and **Workstations**.
5. Look at the column named **Totals Cleared Through**, verify that the date and time appears in the column for each workstation at the property.
6. Double-click the Check and Posting Service (CAPS) workstation and then click the Service Host tab.
7. Verify that the date and time appears in the **Totals Cleared Through** column for the CAPS workstation.

EGateway log files show the date and time a Clear Totals operation was performed.

**Related Topics**
- Understanding the Clear Totals Operation
Printers and ordering devices are critical types of hardware that allow communication between the Front of House and other areas of a restaurant, such as the kitchen and bar.

An order device generally refers to hardware used to print orders that need to be prepared, such as hot and cold items that print in the kitchen, or alcoholic beverages that print at the bar. Often an order device is a roll printer, but it may also be a Kitchen Display System (KDS) display. Remote printers and remote kitchen printers are often used interchangeably with order device.

- Understanding Print Controller
- Roll Printer
- Slip Printer
- Internet Protocol (IP) Printer
- Bluetooth Printer
- Oracle MICROS Mini Printer
- Configuring a Printer
- Logo Printing
- Uploading a Logo to Simphony
- Assigning a Logo to Guest Checks and Customer Receipts
- Order Receipt Layouts
- Configuring an Order Receipt Layout
- KDS Controller
- Configuring a KDS Controller
- Configuring a KDS Display
- Configuring the KDS Bump Bar
- KDS Bump Bar Functions
- Configuring KDS Course Overrides
- Configuring a Backup KDS Controller
- Upgrading an Order Device
- Upgrading the RDC Operating System
- Resetting the RDC Factory Settings
- Installing the KDS Client
- Configuring the Deployment Schedule to Install CAL on KDS
Understanding Print Controller

A Print Controller is a service that sends print jobs to a printer. Each Operations (Ops) process has a built-in Print Controller. A workstation typically acts as a Print Controller. When a workstation operator performs an action that causes a guest check, order receipt, or other printing type to print, the Ops process does not communicate directly with the printer receiving the print job. Instead, the Ops process sends a message to the Print Controller (usually a workstation) that controls the printer. This Print Controller then receives notification that the print job succeeded or failed, and routes the success or failure information back to the workstation that sent the print job.

Ensure that employees in a revenue center know which workstations act as Print Controllers for remote printers. This knowledge helps in troubleshooting printing problems.

Oracle Hospitality recommends that you have both a primary printer and a backup printer, and that primary and backup printers reside on two different Print Controllers. This configuration prevents a single point of failure from causing multiple remote printers to stop printing.

A single Print Controller can control multiple printers. For example, one workstation can control the following printers:

- Local printer that is physically attached to the workstation (used for guest checks and customer receipts)
- Hot food printer that is a remote Ethernet kitchen printer (used for order receipts)

In this configuration, if the workstation loses power or network connectivity, other workstations cannot print to either of these printers. This is generally not a problem because the print jobs print to the backup printer as appropriate.

In another example, one workstation can control the following printers:

- Local printer that is physically attached to the workstation
- Hot food printer that is a remote Ethernet kitchen printer
- Cold food printer that is a remote Ethernet kitchen printer and backs up the hot food printer

Oracle Hospitality does not recommend this configuration. In this example, if the workstation loses power or network connectivity, other workstations cannot print to any of these printers. In this scenario, no order receipts print to the hot or cold printers in the kitchen. Kitchen operations would likely be severely impacted.

Related Topics

- Configuring a Printer

Roll Printer

A roll printer uses a roll of paper as its source media. Thermal printers and impact printers are two types of roll printers that you can use with Simphony.
Thermal Printer

A thermal printer does not use ink. Special thermal paper is provided for these printers to burn the text onto the paper. Thermal printers are primarily used as guest check and customer receipt printers. They are used infrequently in kitchens due to the heat reaction. Thermal printers are ideal in public areas as the printing operation is quiet.

Impact Printer

An impact printer is something of a retronym. All printers were impact printers prior to the invention of the thermal printer. An impact printer is primarily used in kitchens to print order receipts. Impact printers can print in black and red, and they can be used with two-ply paper.

Related Topics

• Configuring a Printer

Slip Printer

A slip printer does not contain paper. The workstation operator must add a piece (or slip) of paper per print job. Properties who use custom stationery (often containing a company logo or other similar artwork) generally use slip printers for guest checks and customer receipts. Slip printers are also used for check endorsement printing. The slips that are used by these printers are often called hard checks because they are usually made of card stock.

Related Topics

• Configuring a Printer

Internet Protocol (IP) Printer

An IP printer communicates with the Print Controller through a computer network that uses the Internet Protocol (IP) address for communication.

Related Topics

• Configuring a Printer

Bluetooth Printer

Bluetooth printing refers to printing from an Oracle MICROS Tablet E-Series to a wireless printer through the Bluetooth protocol.

There is a one-to-one relationship between a tablet and a Bluetooth printer. After you identify and configure a Bluetooth printer in the Enterprise Management Console (EMC) and pair it with a specific Oracle MICROS Tablet E-Series as the Print Controller Service Host, you cannot assign another Oracle MICROS Tablet E-Series to the same Bluetooth printer.

Related Topics

• Configuring a Printer
Oracle MICROS Mini Printer

The Oracle MICROS Mini Printer attaches to the right side of the Oracle MICROS E-Series Base Station. It can print the following items:

- Guest Checks
- Customer Receipts
- Kitchen Display System (KDS) Runner Order Receipts
- Order Device Output
- Workstation Reports

The Oracle MICROS Mini Printer is a 32 column printer with paper that is 2 inches in width.

The Oracle MICROS Mini Printer does not have auto-cut capability; it has a serrated edge to help tear the paper. Because of this, workstation operators need to have a slight delay occur to allow the opportunity to tear individual print jobs before printing a second voucher or order receipt. Note the following configuration settings that can affect a printing delay:

- Regardless of the credit card option setting 4 - Prompt Before Printing Second Voucher (in the RVC Parameters module), the first print job occurs and then the workstation operator receives a Print second voucher prompt message. Before responding to the prompt, the workstation operator can tear the first print job and then respond to the prompt by pressing either the Enter/Yes or Clear/No buttons on the Oracle MICROS Tablet E Series to continue with the second print job.

- You can assign employee time chit printers in the Workstation module. If you assign the Oracle MICROS Mini Printer (a non-auto-cut printer) as the Empl Time Chit Printer and the Empl Time Card Printer, the time chit prints and workstation operators receive a Print Time Card prompt when clocking in and out on a workstation. Before responding to the prompt, the delay affords workstation operators the time to tear off the time chit. Workstation operators can respond to the prompt by pressing either the Enter/Yes or Clear/No buttons on the Oracle MICROS Tablet E Series to continue with the time card print job. If you assign another printer (besides the Oracle MICROS Mini Printer) for either of the Employee Time Chit or Employee Time Card printing jobs, workstation operators do not receive a prompt as the print jobs print independently of each other.

You cannot attach the Oracle MICROS Mini Printer to a Sales Recording Module (SRM).

Related Topics
- Configuring a Printer

Configuring a Printer

1. In the EMC, select the property, click Setup and Printers.
2. Insert a printer record and name the printer.
3. Double-click the printer record to open it in form view.
4. Select the Workstation from the drop-down list.
5. Select the **Printer Type** from the drop-down list.
6. If the roll printer is a thermal printer, select **Thermal printer**.
7. (Optional) If you want the printer to print logos, select **Enable Logo Printing**. Simphony does not support logo printing on printers with multi-language cards.
   
   When configuring Epson TM-P60 and TM-T88 Ethernet Thermal printers, you must also configure the logo to print in the center of the guest check or customer receipt by selecting the paper size of the printer from the **Center Logo Using** drop-down list.
   
   • For Epson TM-P60 Ethernet Thermal printers, set the paper size to **2 1/4" (58mm) Paper**.
   
   • For Epson TM-T88 Ethernet Thermal printers, set the paper size to **3 1/8" (80mm) Paper**.
   
   See **Logo Printing** for more information about setting up logos to print on guest checks and customer receipts.
8. Set the appropriate values for the printer type. Specific fields become active based on the printer type you selected.

<table>
<thead>
<tr>
<th>Table 16-1 Printer Configuration by Printer Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>COM Port</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
<tr>
<td>PIN</td>
</tr>
<tr>
<td>ID</td>
</tr>
<tr>
<td>Address</td>
</tr>
<tr>
<td>Port</td>
</tr>
</tbody>
</table>

9. Click **Save**.
10. Select the property, click **Setup** and **Workstations**.
11. Double-click the workstation to open it in form view.
12. Click the Printers tab.
13. Select the appropriate printer for each type of print job you want it to print.
14. Click **Save**.
15. Select the Enterprise, property, revenue center, or zone, click **Setup** and **Format Parameters**.
16. Click the Configuration tab and enter the appropriate information in the following fields:
### Table 16-2  Print Output Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines on First Page</td>
<td>Enter the maximum number of lines to print on the first page of the guest check before prompting for a new check to begin a new order receipt.</td>
</tr>
<tr>
<td>Lines on Other Pages</td>
<td>Enter the maximum number of lines to print on successive pages of the guest check before prompting for a new check to begin a new order receipt.</td>
</tr>
<tr>
<td>Line Feeds Before First Page</td>
<td>Enter the number of lines to advance before printing the guest check header. You can add extra space for the check so it appears properly in custom check presentation binders.</td>
</tr>
<tr>
<td>Line Feeds Before Other Pages</td>
<td>Enter the number of lines to advance before printing begins on the next successive page. The line feeds set here are included in the number configured for the Lines on Other Pages field. For example, if you set this field to 5 and set Lines on Other Pages to 30, the pages have 25 lines of text.</td>
</tr>
<tr>
<td>Minimum Lines Per Roll Check/Receipt</td>
<td>Enter the minimum number of lines to print on guest checks and customer receipts. Blank lines are added after printing to achieve the minimum. Use this field if you want guest checks and customer receipts that are printed on a roll printer to have a minimum length in order to fit into guest check covers.</td>
</tr>
<tr>
<td>Number of Guest Check Information Lines</td>
<td>Enter the number of detail lines (0 through 30) that can be entered in a System Interface Module (SIM) dialog box.</td>
</tr>
</tbody>
</table>

17. Click **Save**.

### Related Topics
- Understanding Print Controller
- Roll Printer
- Slip Printer
- Internet Protocol (IP) Printer
- Bluetooth Printer
- Oracle MICROS Mini Printer

### Logo Printing

You can print the logo of your Enterprise, property, or revenue center on guest checks and customer receipts. Simphony only supports monochrome bitmap image files. Use Microsoft Paint to convert an image to a monochrome bitmap. Adhere to the following rules governing the size of your logo:
• The image area must not exceed 98,304 pixels. (Keep in mind that a logo that is 512 x 384 pixels exceeds 98,304 pixels.)
• The image width must not exceed 512 pixels.
• The image height must not exceed 384 pixels.
• The bitmap file must not exceed 8 kilobytes in size.

Simphony does not support logo printing on printers with multi-language cards.

Complete the following tasks to set up logo printing:
• Upload a logo to Simphony
• Assign a logo to guest checks and customer receipts
• Set the printer to print the logo

Related Topics
• Uploading a Logo to Simphony
• Assigning a Logo to Guest Checks and Customer Receipts

Uploading a Logo to Simphony

1. In the EMC, select the Enterprise level, click Configuration and Print Logos.
2. Insert a new record and double-click it to open in form view.
3. Click Load Image.
4. Select the image and click Open to upload it to Simphony. After the logo uploads, an image preview appears.
5. Alternately, you can copy the image to your clipboard and click Paste Image to upload it to Simphony.
6. Click Save.

Related Topics
• Logo Printing

Assigning a Logo to Guest Checks and Customer Receipts

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Descriptors and Guest Check Headers.
2. Select a check box in the Use Logo column.
   If you select Use Logo for an existing record that has content in the Text column, that text no longer appears on printed guest checks and customer receipts.
3. Click the ellipsis button in the Logo column, select the image you uploaded, and click OK.
4. Click Save.
5. If you want to assign the logo to customer receipts and guest check trailers, repeat these steps but select the Guest Check Trailers and Customer Receipt Headers modules in Step 1.
You must also select **28 - Print Guest Check Trailer on Fast Transaction**

**Customer Receipt** for tender records in the Tender/Media options. If you do not set this option, trailers do not print on customer receipts when the tender is used to close a fast transaction.

6. Click **Save**.

**Related Topics**
- Logo Printing

---

## Order Receipt Layouts

You can configure the style of an order receipt (sometimes called a chit) that appears on a Kitchen Display System (KDS) Display. You can choose from a variety of layout styles to meet the customer requirements. Order receipt layouts generally fall into the categories described in the following table:

### Table 16-3 Order Receipt Layouts

<table>
<thead>
<tr>
<th>Order Receipt Layout</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard chits</td>
<td>These chits do not show information (for example, seats or order types). They only show menu items.</td>
</tr>
<tr>
<td>Chits with seats</td>
<td>These chits are used in revenue centers with seat handling.</td>
</tr>
<tr>
<td>Chits with order types</td>
<td>These chits are used in revenue centers with order types (for example, to distinguish between Dine-In and Take-Out orders).</td>
</tr>
<tr>
<td>Chits with seats and order types</td>
<td>These chits are used in revenue centers where both seat handling and order types are important to the operations.</td>
</tr>
<tr>
<td>Lists</td>
<td>The list views do not show individual chits. Each menu item is listed on top of the next item (similar to a spreadsheet).</td>
</tr>
</tbody>
</table>

**Related Topics**
- Configuring an Order Receipt Layout

---

## Configuring an Order Receipt Layout

1. In the EMC, select the property, click **Setup** and **KDS Displays**.
2. Click the Display tab.
3. In the Chit Display Options section, select information in the following fields:
   a. Click **Select**, select the **KDS Chit Layout Style**, and click **OK**. If you want to see sample chit styles, click **Help**.
   b. Select the **Serpentine Mode**:
      - **0 - TSR** – Select this mode to arrange the KDS with the number of vertical columns set in the **Chit Columns** field.
      - **1 - Horizontal** – Select this mode to arrange the KDS with the number of horizontal rows set in the **Chit Rows** field.
2. **Vertical** – Select this mode to arrange the KDS with the number of vertical columns set in the **Chit Columns** field, and using the **Chit Rows** field to set the number of rows to appear.

c. In the **Menu Item Font** field, select the font size for menu items on the KDS Display.

d. In the **Order Type Font** field, select the font size for order type text on the KDS Display.

4. Click **Save**.

### Related Topics
- **Order Receipt Layouts**

---

## KDS Controller

A Kitchen Display System (KDS) Controller is a Windows service that controls KDS Displays and performs other KDS-related functions. KDS Controllers move data to and from the KDS Displays. When an order is placed on a workstation, the KDS Controller routes the order to the appropriate KDS Display(s). When an order is bumped from a KDS Display, the KDS Controller routes the information about the order to the reporting database. Updates to KDS Displays (changing a Tool Bar or Bump Bar button) are routed through the KDS Controller.

### Related Topics
- **Configuring a KDS Controller**
- **Configuring a KDS Display**
- **Configuring the KDS Bump Bar**
- **Configuring KDS Course Overrides**
- **Configuring a Backup KDS Controller**
- **KDS Bump Bar Functions**

---

## Configuring a KDS Controller

1. In the EMC, select the property, click **Setup** and **KDS Controllers**.
2. Insert a new record, enter a record name, and double-click the new record.
3. On the General tab, configure the settings as described in the following table:

### Table 16-4  KDS Controller Fields

<table>
<thead>
<tr>
<th>Fields and Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Prevent Chit Bump on Expo Display if Chit Exists on Prep Display</td>
<td>Select this option to prevent a chit from being bumped from an Expo Display if the chit still exists on one of the Prep Displays.</td>
</tr>
</tbody>
</table>
### Table 16-4  (Cont.) KDS Controller Fields

<table>
<thead>
<tr>
<th>Fields and Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 - Display Next Course after Previous Course Complete</td>
<td>If the property is using dining courses, select this option to show one course at a time on Kitchen Display Systems (KDS). That is, menu items from course 2 appear on KDS Displays only after menu items from course 1 are bumped.</td>
</tr>
<tr>
<td>3 - Show Only Active Orders</td>
<td>Select this option to allow a Speed of Service (SOS) Display to show only tables that have open orders.</td>
</tr>
<tr>
<td>4 - Expo-only Items Display as Done</td>
<td>Select this option to change the status of menu items that do not go to Prep Stations to Done when they fire.</td>
</tr>
<tr>
<td>5 - Exclude CAL Updates from Service Host Change</td>
<td>If the property does not use the Client Application Loader (CAL), select this option to exclude updates to CAL for Service Host changes made in the KDS Controller.</td>
</tr>
<tr>
<td>6 - Enable Item Started Timings</td>
<td>If the KDS is not using Dynamic Order Mode (DOM) and is configured to show every item in an order on separate chits (select Order Devices module option 3 - Single Item Per Sub-Order), select this option to have the application recalculate an order’s target done time (TDT) when the kitchen staff starts on the item with the longest prep time. After the application recalculates the TDT, the system adjusts all of the fire times for the remaining items (based on individual prep times) to ensure that all items complete at the new TDT.</td>
</tr>
<tr>
<td>7 - Include Theme In The Device Name</td>
<td>Select this option to have the KDS Display the current Kitchen Theme after the name of the device on the KDS status bar.</td>
</tr>
<tr>
<td>8 - Enable load balancing</td>
<td>Select this option to turn on KDS load balancing for the KDS Controller.</td>
</tr>
<tr>
<td></td>
<td>Load balancing distributes new orders to KDS Prep Stations based on which station has the least number of items. KDS Prep Stations are assigned to distribution groups and orders route to the KDS Prep Station with the fewest un-bumped menu items within a distribution group.</td>
</tr>
<tr>
<td>9 - Enable Backup Controller Automatic Takeover</td>
<td>If the KDS Controller has a backup service host, select this option to allow the backup KDS Controller to take over automatically when the primary controller is down.</td>
</tr>
<tr>
<td>Database Update Frequency</td>
<td>Enter the number of seconds you want the KDS Controller to wait to retrieve the latest updates from the database.</td>
</tr>
</tbody>
</table>
### Table 16-4  (Cont.) KDS Controller Fields

<table>
<thead>
<tr>
<th>Fields and Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Wait for Prep Suborder</strong></td>
<td>If the property is using dining courses, enter the number of seconds that you want the KDS to wait for Prep Suborders before displaying an expo order as All Prep Done. Oracle Hospitality recommends entering a value of 1 or 2. The value 0 (zero) does not work with KDS Prep Times.</td>
</tr>
<tr>
<td><strong>Media Viewer URL</strong></td>
<td>Enter the uniform resource locator (URL) of the Internet Information Services (IIS) website where you defined the Media Viewer (for example, MyPC:8080).</td>
</tr>
<tr>
<td><strong>Number of Zones</strong></td>
<td>Enter the number of kitchen zones to use for collecting food orders. You can define up to 26 zones. The default value is 0, indicating that zones are not used.</td>
</tr>
<tr>
<td><strong>Production Count Increment Type</strong></td>
<td>Select when to add ordered items to the production counter:</td>
</tr>
<tr>
<td></td>
<td>• If you want the application to increase the production counter as soon as workstation operators end the current round of a check, select <strong>1 - Sent from POS</strong>.</td>
</tr>
<tr>
<td></td>
<td>• If you want the application to increase the production counter when workstation operators send checks to the KDS, select <strong>2 - Sent (Fired) from EXPO</strong>. Oracle Hospitality recommends using this option in a non-DOM environment.</td>
</tr>
<tr>
<td><strong>Production Count Decrement Type</strong></td>
<td>Select when to decrease the count of items from the production counter:</td>
</tr>
<tr>
<td></td>
<td>• If menu items appear on two or more prep stations and you want the application to decrease the count when any prep station bumps the item, select <strong>First Prep Done</strong>.</td>
</tr>
<tr>
<td></td>
<td>• If you want the application to decrease the count when all prep stations bump the item, select <strong>All Prep Done</strong>. When using this option, you must set all order devices to DOM when the revenue center is in DOM and all order devices to non-DOM when the revenue center is in non-DOM.</td>
</tr>
<tr>
<td><strong>Time (sec)</strong></td>
<td>Enter the number of seconds to elapse before automatically bumping all closed orders after reaching the Check Count.</td>
</tr>
</tbody>
</table>
Table 16-4  (Cont.) KDS Controller Fields

<table>
<thead>
<tr>
<th>Fields and Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Count</td>
<td>Enter the number of checks that are allowed to appear on the KDS before automatically bumping.</td>
</tr>
</tbody>
</table>

4. Click the Service Host tab.
5. Click Select adjacent to the Service Host field, select a service host from the list, and click OK.
6. (Optional) Click Backup Service Host and configure a backup KDS Controller. Configuring a Backup KDS Controller contains more information about how to configure a backup KDS Controller.
7. (Optional) Click Item Status Colors and select the colors in which you want items to appear on KDS Expo Displays when the status of items change. The following table describes the Item Status Color fields.

Table 16-5  Item Status Colors Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Sent Color</td>
<td>Select in which color items appear when workstation operators send orders to the KDS.</td>
</tr>
<tr>
<td>Status Fired Color</td>
<td>Select in which color items appear when they fire to the Prep Display.</td>
</tr>
<tr>
<td>Status Bumped Color</td>
<td>Select in which color items appear when they are bumped from the Prep Display.</td>
</tr>
<tr>
<td>Status Started Color</td>
<td>Select in which color items appear when they are Prep started. This feature only functions with KDS Prep stations, in non-DOM Mode, and with Item Started Timings deactivated.</td>
</tr>
<tr>
<td>Item Select Color</td>
<td>Select in which color items show when kitchen staff selects an item on the order.</td>
</tr>
<tr>
<td>Item Mark Color</td>
<td>Select in which color items appear when kitchen staff places items on hold.</td>
</tr>
<tr>
<td>Item Recall Color</td>
<td>Select in which color items appear when kitchen staff recalls an order.</td>
</tr>
<tr>
<td>Item Recallable Color</td>
<td>Select in which color recallable items appear.</td>
</tr>
</tbody>
</table>

8. Click Save.
9. Select the property, click Setup and RVC Configuration.
10. Double-click the revenue center for which you want to assign the KDS Controller.
11. On the General tab, select the KDS Controller.
12. Click Save.

Related Topics
• KDS Controller
• KDS Bump Bar Functions

Configuring a KDS Display

1. In the EMC, select the property, click **Setup** and **KDS Displays**.
2. Insert a new record, enter a name for the KDS Display, and double-click the new KDS Display record.
   If you are configuring a Windows 32 KDS Display, append the prefix WSKDS to the KDS Display name, for example, WSKDSDISPLAY1. Do not include a space between the prefix and the display name.
3. Select the **KDS Controller** for the display and enter the **IP Address** of the display.
4. Select a KDS **Tool Bar** and a **Bump Bar**.
5. Select the appropriate platform of the KDS Display:
   • If the KDS is PC-based, select **0 - PC-based**.
   • If you are using an OASYS KDS Display, select **1 - SEI OASYS**.
6. If you selected **1 - SEI OASYS** in Step 5, select the **Card ID** or slot number of the SEI card in the OASYS box and the **Video ID** to identify the KDS Display.
7. From the **Display Orientation** drop-down list, select the orientation type for the display.
8. Select option **1 - Enable Item Select**.
9. If the display is a Speed of Service (SOS) Display, select the appropriate options as described in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 - Only Active Tables</td>
<td>Select this option to show only tables that are currently active on the display.</td>
</tr>
<tr>
<td>3 - Dynamic Display</td>
<td>Select this option to turn on the Dynamic Display feature.</td>
</tr>
<tr>
<td>4 - Display Zone</td>
<td>Select this option to show KDS zones (collection points) on the display. This option only becomes active if you select <strong>3 - Dynamic Display</strong>.</td>
</tr>
<tr>
<td>5 - Display Rvc Separator</td>
<td>Select this option to separate orders by revenue center. This option only becomes active if you select <strong>3 - Dynamic Display</strong>.</td>
</tr>
</tbody>
</table>
10. Click the Display tab.
11. Configure the Display Screen Options as described in the following table:
### Table 16-7  KDS Display Screen Options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display Type</strong></td>
<td>Select the type of KDS Display:</td>
</tr>
<tr>
<td></td>
<td>• <strong>1 - SOS</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>2 - Expo</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>3 - Prep</strong></td>
</tr>
<tr>
<td><strong>ToolBar Positions</strong></td>
<td>If you selected the <strong>Platform Type PC-based</strong> in Step 5, select the tool bar location on the display.</td>
</tr>
<tr>
<td><strong>Panels</strong></td>
<td>Select the number of panels or logical monitors you want to appear on the display.</td>
</tr>
<tr>
<td></td>
<td>A KDS Display can contain one or two panels to allow various order devices to print to a different section of the display. The left side represents hot items and the right side represents cold items.</td>
</tr>
<tr>
<td><strong>Panel Layout</strong></td>
<td>If you selected 2 from the <strong>Panel</strong> drop-down list, select whether the panels appear side-by-side or one on top of the other.</td>
</tr>
</tbody>
</table>

12. Configure the order chit appearance in the display as described in the following table:

### Table 16-8  KDS Chit Display Options

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>KDS Chit Layout Style</strong></td>
<td>Select the type of layout for the order chits on the display. Depending on the chit layout style that you select, the <strong>Order Type Font</strong> drop-down list becomes active.</td>
</tr>
<tr>
<td></td>
<td>If you want to preview the chit layout styles, click <strong>Help</strong> adjacent to the <strong>KDS Chit Layout Style</strong> drop-down list, and select the chit style you want to view.</td>
</tr>
<tr>
<td><strong>Serpentine Mode</strong></td>
<td>Select the arrangement of order chits on the display:</td>
</tr>
<tr>
<td></td>
<td>• If you want incoming orders to appear starting from the top left corner, filling the first column, then spilling into the top of the next column, and so on, select <strong>0 - TSR</strong>. TSR Mode only works on PC-based clients.</td>
</tr>
<tr>
<td></td>
<td>• If you want incoming orders to appear from left to right, row by row, starting from the top left corner and moving across, select <strong>1 - Horizontal</strong>.</td>
</tr>
<tr>
<td></td>
<td>• If you want incoming orders to appear starting from the bottom right corner, moving up and then moving to the left, select <strong>2 - Vertical</strong>.</td>
</tr>
<tr>
<td><strong>Menu Item Font</strong></td>
<td>Select the font size for menu items to appear on the display.</td>
</tr>
</tbody>
</table>
Table 16-8  (Cont.) KDS Chit Display Options

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order Type Font</td>
<td>Select the font size for the Order Type text to appear on the display.</td>
</tr>
<tr>
<td>Chit Columns</td>
<td>Enter the number of columns to use on the display for order chits.</td>
</tr>
<tr>
<td>Chit Rows</td>
<td>If you selected Horizontal or Vertical from the Serpentine Mode drop-down list, select the number of rows to use on the display for order chits.</td>
</tr>
</tbody>
</table>

13. If the display is an SOS Display:
   a. In the Table Columns field, enter the number of columns to use to present table numbers for the SOS Table Display.
   b. In the SOS Timeout field, enter the amount of time the kitchen staff can view a table in the regular Expo Display screen before the display returns to the SOS Table Display.
   c. If you selected 3 - Dynamic Display in Step 9 for the SOS Display, configure the following settings:

Table 16-9  Dynamic SOS Display Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOS Zone Font</td>
<td>Select the font size for SOS zones to appear on the display. Oracle Hospitality recommends using values between 10 and 12.</td>
</tr>
<tr>
<td>SOS Sort Method</td>
<td>Select the sort method for the display:</td>
</tr>
<tr>
<td></td>
<td>• If you want to sort by table number, select 0 - Sort by Table Number.</td>
</tr>
<tr>
<td></td>
<td>• If you want to sort by the elapsed time of the oldest order on the table from oldest to newest, select 1 - Sort Oldest to Newest. You must deselect 5 - Display Rvc Separator.</td>
</tr>
<tr>
<td></td>
<td>• If you want to sort by the elapsed time of the oldest order on the table from newest to oldest, select 2 - Sort Newest to Oldest. You must deselect 5 - Display Rvc Separator.</td>
</tr>
<tr>
<td>Min Table State</td>
<td>This field is not supported.</td>
</tr>
<tr>
<td>Max Table State</td>
<td>This field is not supported.</td>
</tr>
</tbody>
</table>

14. If you want to set each column on the KDS Recall and Review list, click Recall/Review List, select the Column Type to display on Column 1 to Column 6, and enter the Width for each column relative to the total screen width.

15. If you want to specify which production items show on the KDS Display:
   a. Click the Production Item tab.
   b. From the KDS Production Location drop-down list, select where to place the production items on the display.
• If you want production items to appear above the order chit, select **1 - Top**.

• If you want production items to appear below the order chit and above the KDS toolbar (if used), select **2 - Bottom**.

c. From the **KDS Production Columns** drop-down list, select the number of production items that you want to show per line or production bar. When possible, the KDS displays the maximum number of items in each bar. If there are not enough items to fill the last bar, the remaining items are evenly distributed across the line.

d. In the Production Items section, click **Add** and select a production item to appear on the KDS. Repeat this step until all of the production items to display on the KDS appear in the list.

16. Click **Save**.

**Related Topics**
- **KDS Controller**
- **KDS Bump Bar Functions**

**Configuring the KDS Bump Bar**

KDS bump bars are physical devices attached to KDS displays. Bump bars are used to select and bump orders. Additionally, you can program KDS bump bars to perform other functions.

1. In the EMC, select the Enterprise, property, or zone, click **Setup** and **KDS Bump Bars**.

2. Insert a **KDS Bump Bar** record if it does not exist.

3. Double-click the record to open it.

4. To configure the KDS bump bar with Oracle Hospitality default Scancode Values and Functions, click **Create Default**.

5. To configure the KDS bump bar with specific Scancode Values and Functions, click **Add** and then follow these steps:

   a. Enter the **Scancode Value** of the button. The bump bar manufacturer sets the Scancode Value.

   b. Select the corresponding **Function**.

   c. Continue to add all appropriate KDS bump bar functions. **KDS Bump Bar Functions** contains a list of the KDS bump bar functions.

6. Click **Save**.

**Related Topics**
- **KDS Controller**
- **KDS Bump Bar Functions**
## KDS Bump Bar Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arrow up</strong></td>
<td>In list mode, the KDS display moves up to the next line</td>
</tr>
<tr>
<td><strong>Arrow down</strong></td>
<td>In list mode, the KDS display moves down to the next line</td>
</tr>
<tr>
<td><strong>Arrow left</strong></td>
<td>In chit mode, the KDS display moves one chit at a time to the left</td>
</tr>
<tr>
<td><strong>Arrow right</strong></td>
<td>In chit mode, the KDS display moves one chit at a time to the right</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Exit the transaction</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Close the KDS application</td>
</tr>
<tr>
<td><strong>Done</strong></td>
<td>Mark an order as complete and remove the chit from the screen</td>
</tr>
<tr>
<td><strong>Done Item</strong></td>
<td>Mark an item on the chit as complete</td>
</tr>
<tr>
<td><strong>End</strong></td>
<td>Move to the last page of the KDS display</td>
</tr>
<tr>
<td><strong>Home</strong></td>
<td>Move to the first page of the KDS display</td>
</tr>
<tr>
<td><strong>Mark</strong></td>
<td>Hold an order</td>
</tr>
<tr>
<td><strong>Mark Item</strong></td>
<td>Hold an item in an order</td>
</tr>
<tr>
<td><strong>Media Viewer</strong></td>
<td>View media files:</td>
</tr>
<tr>
<td></td>
<td>• Related to the items in an order</td>
</tr>
<tr>
<td></td>
<td>• On recipe preparations or other work-related tasks</td>
</tr>
<tr>
<td><strong>Minimize</strong></td>
<td>Minimize the KDS application to the toolbar (Microsoft Windows 32-bit displays)</td>
</tr>
<tr>
<td><strong>Order Started</strong></td>
<td>Mark an order as started</td>
</tr>
<tr>
<td><strong>Order Started First</strong></td>
<td>Mark the first order on the current page as started</td>
</tr>
<tr>
<td><strong>Page down</strong></td>
<td>Scroll down the page</td>
</tr>
<tr>
<td><strong>Page up</strong></td>
<td>Scroll up the page</td>
</tr>
<tr>
<td><strong>Page left</strong></td>
<td>Scroll to the previous page</td>
</tr>
<tr>
<td><strong>Page right</strong></td>
<td>Scroll to the next page</td>
</tr>
<tr>
<td><strong>Prep Start/Stop</strong></td>
<td>Change an item’s status to start for the Prep Station (only for single item per sub-order chits (SIPS))</td>
</tr>
<tr>
<td><strong>Production Summary</strong></td>
<td>View a list of all production items in the kitchen</td>
</tr>
<tr>
<td><strong>Pull Order</strong></td>
<td>Pull an order from another KDS Prep Station in the Prep Station’s primary distribution group</td>
</tr>
<tr>
<td><strong>Push Order</strong></td>
<td>Push an order to another KDS Prep Station in the revenue center</td>
</tr>
<tr>
<td><strong>Recall Last Item</strong></td>
<td>Recall the last order marked as complete and restart the timer</td>
</tr>
<tr>
<td><strong>Recall</strong></td>
<td>Recall an order from the 50 orders marked as complete during the last 15 minutes and restart the timer</td>
</tr>
<tr>
<td><strong>Recall Item</strong></td>
<td>Recall an item marked as complete</td>
</tr>
<tr>
<td><strong>Recall Last Item</strong></td>
<td>Recall the last item marked as complete</td>
</tr>
</tbody>
</table>
Table 16-10  (Cont.) KDS Bump Bar Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review</td>
<td>Recall an order from the 50 orders marked as complete during the last 15 minutes, without restarting the timer</td>
</tr>
<tr>
<td>Review Last</td>
<td>Review the last order marked as complete, without restarting the timer</td>
</tr>
<tr>
<td>Summary Condensed</td>
<td>View a consolidated list of active orders for the display station, without condiments</td>
</tr>
<tr>
<td>Summary Expanded</td>
<td>View a consolidated list of active orders for the display station, including condiment items</td>
</tr>
<tr>
<td>Select Next</td>
<td>Select the next order on the display</td>
</tr>
<tr>
<td>Select Previous</td>
<td>Select the previous order on the display</td>
</tr>
<tr>
<td>Select Next Item</td>
<td>Select the next item on the chit</td>
</tr>
<tr>
<td>Select Previous Item</td>
<td>Select the previous item on the chit</td>
</tr>
<tr>
<td>Table Detail</td>
<td>View table details in the Speed of Service (SOS) display for checks begun by table</td>
</tr>
</tbody>
</table>

Related Topics

• KDS Controller
• Configuring a KDS Controller
• Configuring a KDS Display
• Configuring the KDS Bump Bar
• Configuring KDS Course Overrides
• Configuring a Backup KDS Controller

Configuring KDS Course Overrides

You can allow wait staff to override the normal delivery of a menu item's course and have the change appear on the Kitchen Display System (KDS) Display. For example, a guest can order an appetizer and the staff can deliver it at the same time as the other guest's entrée, making the prep staff aware of this course change through the order receipts shown on the KDS Displays.

1. In the EMC, select the revenue center, click **Setup** and **Order Devices**.
2. Double-click a KDS order device and click the Options tab.
3. In the KDS Options section, select **17 - Print Course Header** to include the course header on the KDS chit display.
4. Click **Save**.
5. Select the revenue center, click **Setup** and **RVC Parameters**.
6. Click the Options tab and deselect **50 - Enable Dynamic Order Mode (DOM)**.
7. Click **Save**.
8. Select the property, click **Setup** and **KDS Controllers**.
9. Double-click a KDS controller and select 2 - Display Next Course after Previous Course Complete.

10. Enter 2 in the Wait for Prep Suborder field.

11. Click Save.

12. Select the Enterprise, property, revenue center, or zone, click Configuration and Menu Item Maintenance.

13. Add condiment menu items for courses with the following names (or use similar names):
   • As Appetizer
   • As Entrée

14. Click Save.

15. Select the Enterprise, property, revenue center, or zone, click Configuration and Menu Item Classes.

16. Add menu item classes for courses with the following names (or use similar names):
   • As Appetizer
   • As Entrée

17. Add condiment menu item classes to apply course name overrides as necessary.

18. For each new condiment menu item class, select the following options:
   • 2 - ON = Condiment Menu Items; OFF = Regular Menu Items
   • 8 - Allow Menu Items in this Class to be Non-Priced
   • 45 - Use KDS/Dining Course Number
   • 46 - Override KDS Course Number of Parent Class

19. Click the General tab, select the appropriate KDS/Dining Course for each menu item class, and click Save.

20. Select the Enterprise, property, revenue center, or zone, click Configuration and Print Classes.

21. Create print class records that output to all appropriate KDS Displays.

22. Click Save.

Related Topics
• KDS Controller
• KDS Bump Bar Functions

Configuring a Backup KDS Controller

1. In the EMC, select the property, click Setup and KDS Controllers.

2. Double-click the KDS Controller for which you want to assign a backup KDS Controller, and click Backup Service Host.

3. Click Select adjacent to the Service Host field, select a backup service host from the list and click OK.

4. Click Save.
5. If you want the backup KDS Controller to automatically take over when the primary KDS Controller is down, click **General** and select **9 - Enable Backup Controller Automatic Takeover**.

6. Select the Enterprise level, click **Configuration** and **Roles**.

7. Double-click an employee role, click **Operations** and **PMC Procedures**.

8. Select **30057 - Backup/Restore KDS Controller**, and click **Save**.

9. Select the Enterprise, property, revenue center, or zone, click **Configuration** and **Page Design**.

10. Insert a new button on the transaction page, select **Function** in the **Type** drop-down list, and select **Restore Primary KDS**.

    This touchscreen button allows workstation operators to activate the primary KDS Controller that the current revenue center is using when it comes back online, if the backup KDS Controller is currently active.

11. If you did not configure the backup KDS Controller to automatically take over for the primary KDS Controller, insert another new button on the transaction page.

    a. Select **Function** in the **Type** drop-down list.

    b. Select **Active Backup KDS**.

12. Click **Save**.

**Related Topics**

- KDS Controller
- KDS Bump Bar Functions

---

**Upgrading an Order Device**

You might need to upgrade the Remote Display Controller (RDC) in order to run Kitchen Display System (KDS) version 2.1. This is available with Simphony version 2.3 and later.

There are two RDC models (GX and LX) and each model has a different platform. The part number on the RDC indicates the model. The RDC Platform Update is version 4.2.2.0 and it can automatically identify which model of RDC is being used and install the correct files.

Upgrading an order device consists of completing the following tasks:

- Upgrading the operating system to the required platform
- Resetting factory settings
- Installing the KDS Client

**Related Topics**

- Upgrading the RDC Operating System
- Resetting the RDC Factory Settings
- Installing the KDS Client
Upgrading the RDC Operating System

The RDCPlatformUpdate.zip file consists of two self-extracting zip files that are to be executed on an existing Client Application Loader (CAL) server.

1. Run the CALClientUpdate(4.1.3.66).exe.
   This is a self-extracting zip file that contains the updated CAL client for both Remote Display Controller (RDC) models (GX and LX). This executable file creates the CAL package on the CAL server to deploy the CAL client to the RDC.
   This is the same version of CAL client that ships with newer RCDs, so you may notice that the CAL package does not appear to update some RDCs.
2. Run the ClientOSUpdate(4.2.2.0).exe. Each of these CAL packages restarts the RDC several times during the update.
   This is a self-extracting zip file that contains the updated RDC operating system image for both RDC models (GX and LX). This executable file creates the CAL package on the CAL server to deploy the operating system update to the RDC.

Related Topics

- Upgrading an Order Device

Resetting the RDC Factory Settings

Previous configuration data on the device might interfere with the new platform and software. To facilitate the best possible upgrade, return the unit to the factory settings prior to loading the new Kitchen Display System (KDS) software.

2. Click the Default Settings tab.
3. Select the Reset to Default Settings option, and click Yes.
4. Save the settings. The device restarts after resetting the configuration.
5. Set the current date and time on the unit.
   If the date and time on the unit do not match that of the server, the Client Application Loader (CAL) software does not work properly. Typically, the property list fails to load when these values are not correct.
6. Set the Internet Protocol (IP) address of the RDC to be a static value that works on the network. Some units cannot pick up a Dynamic Host Configuration Protocol (DHCP) issued IP address after the upgrade.
   a. To test the network configuration, open Internet Explorer on the RDC.
   b. Enter the Uniform Resource Locator (URL) to the Simphony Egateway service that is hosting the CAL server (for example, http://[http://:8050/egateway/egateway.asmx]). If you can access this URL, the network is ready to connect to the server.

   The unit does not require Domain Name System (DNS) or Windows Internet Name Service (WINS) entries.
Related Topics
• Upgrading an Order Device

Installing the KDS Client

Follow the Kitchen Display System (KDS) instructions to install and configure the KDS client software.

1. If type with a keyboard and nothing appears in the fields, press F12 and try again.
2. When selecting the Remote Display Controller (RDC) from the list:
   a. Ensure that the Automatic DHCP Address is turned off.
   b. Ensure that there are values in the Netmask and Default Gateway fields.
   c. Ignore the value in the Select Product to Install on Workstation field.

Related Topics
• Upgrading an Order Device

Configuring the Deployment Schedule to Install CAL on KDS

1. Select the Enterprise, click Setup, and then click CAL Packages.
2. Expand WS KDS Display from the left pane, and then select the latest KDS CAL package.
3. Click the Deployment Schedule tab, and then click Add Deployment.
4. Select 1- Property/Enterprise as the Deployment Type, select a Property, and then select 0- Install as the Action to Take.
5. If the property has Microsoft Windows 32 clients that are not configured as KDS Displays:
   a. Click Add Deployment again, and then select 2- Specific Service Host as the Deployment Type.
   b. In the Service Host column, click the ellipsis (...) point button, select a Microsoft Windows 32 workstation client that is not a KDS Display, and then click OK.
   c. Select 1- Skip as the Action to Take.
   d. Repeat Steps 5-a through 5-c for all Microsoft Windows 32 clients that are not KDS Displays.
6. Click Save.
Peripheral Devices

Peripheral devices connect with and relay information to or from Simphony. For example, common POS peripheral devices include magnetic card readers, cash drawers, coin dispensers, printers, pole displays, and scales.

- Assigning and Unassigning a Cash Drawer
- Configuring a Cash Drawer
- Coin Dispenser
- Configuring a Coin Dispenser
- Magnetic Stripe Reader
- Installing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices
- Configuring a Magnetic Stripe Reader
- Testing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices
- Barcode Reader Setup Methods
- Configuring a Barcode Reader Using the Barcodes Module Method
- Configuring a Barcode Reader Using the Number Lookup (NLU) Method
- Fingerprint Scanning
- Configuring the Biometrics CAL Package Deployment
- Configuring Employee Privileges for the Fingerprint Reader
- Setting the Front of House to Assign Employee Personal Identification Number (PIN)
- Configuring the Workstation Employee Fingerprint Sign In Options
- Scanning a Fingerprint
- Configuring a Scale

Assigning and Unassigning a Cash Drawer

You can assign a cash drawer in the following ways:

- By Workstation
- By Workstation Operator

Giving multiple employees access to a single cash drawer is less secure than requiring employees to be assigned to a cash drawer.

When you set the option Assign Cash Drawer By User Workstation in the Workstations module, workstation operators can assign themselves to a cash drawer using the one of the following function keys:
• 848 - Assign Cash Drawer
• 839 - Assign Cash Drawer 1
• 840 - Assign Cash Drawer 2

The following table compares these function keys:

Table 17-1 Assign Cash Drawer Function Key Comparison

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>848 - Assign Cash Drawer</td>
<td>Assigns the drawer to the workstation operator who is signed in. If two drawers are used with the workstation, the application assigns drawer 1 if both are unassigned. If drawer 1 is assigned, the application assigns drawer 2, and vice-versa. Using this key opens the cash drawer. If the cash drawer is unassigned, using this key prompts the workstation operator to assign the cash drawer number. If a workstation operator attempts to assign the drawer when another workstation operator is already assigned, the following error message appears: All Cash Drawers Currently Assigned. All workstation operators can use this function key. At the end of a shift, the workstation operator or a privileged manager needs to unassign the drawer to allow another workstation operator to use the drawer.</td>
</tr>
<tr>
<td>839 - Assign Cash Drawer 1 and 840 - Assign Cash Drawer 2</td>
<td>Assigns the drawer to the workstation operator who is signed in. If two drawers are used with the workstation, these keys allow the workstation operator to select the drawer he or she wants to assign. (To offer a choice, you must configure both keys on the touchscreen.) Using this key does not open the cash drawer. If the cash drawer is unassigned, using this key prompts the workstation operator to assign the cash drawer number, while the top of the screen shows INACTIVE (no one is assigned). If the workstation operator attempts to assign the drawer when another workstation operator is already assigned, no error message appears. The top of the screen show NAME (of the person assigned to the drawer). Thus, one person may assign the drawer and override the workstation operator who is already assigned. All workstation operators cannot use this function key. At the end of a shift, it is not necessary to unassign the drawer because another workstation operator may override the assigned workstation operator.</td>
</tr>
</tbody>
</table>

The 849 - Unassign Cash Drawer function key unassigns the drawer from the workstation operator, regardless of whether the workstation operator assigned the drawer using function 848 or 839/840. All workstation operators can always unassign themselves from a drawer. You can prevent this by removing the Unassign Cash Drawer function key from the touchscreen or restrict its access using a lockout macro.

Related Topics
• Configuring a Cash Drawer

Configuring a Cash Drawer

1. In the EMC, select the property, click **Setup** and **Workstations**.
2. Double-click the workstation to be used with the cash drawer.
3. Click the Transactions tab.
4. Select the number of **Cash Drawers** (0, 1, or 2) that are physically installed at the workstation.

5. In the **Cash Drawer Beep Timeout** field, enter the number of seconds the cash drawer can be open before the workstation begins beeping. If you set this value to 0 (zero), no beeping occurs.

6. In the **Cash Drawer Notify Timeout** field, enter the number of seconds the cash drawer can be open before the workstation posts a message to the journal log file. If you set this value to 0 (zero), no message posts to the journal log.

7. Click the Options tab and the Hardware/Cash Drawer sub-tab.

8. Select the appropriate cash drawer options.

### Table 17-2  Cash Drawer Workstation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require Cash Drawer to be Closed Before New Transaction</td>
<td>Select this option to require the workstation operator to close the cash drawer before beginning a new transaction. Deselect this option to allow transactions to begin while a cash drawer is open.</td>
</tr>
<tr>
<td>Assign Cash Drawer By User Workstation</td>
<td>Select this option if you want workstation operators to assign themselves to the cash drawer using the one of the function keys (848 - Assign Cash Drawer, 839 - Assign Cash Drawer 1, or 840 - Assign Cash Drawer 2). Only the workstation operator assigned to the drawer can open it.</td>
</tr>
<tr>
<td>Use Other Cash Drawer for Other Currency</td>
<td>Select this option if two cash drawers are in use for the workstation and one is dedicated to foreign currency.</td>
</tr>
<tr>
<td>Require Cash Drawer Assignment to Begin Transaction</td>
<td>Select this option to require a workstation operator to have a cash drawer assigned prior to beginning a transaction at the workstation.</td>
</tr>
</tbody>
</table>

9. Click **Save**.

10. Select the Enterprise, property, revenue center, or zone, click **Setup and Control Parameters**.

11. Click the Options tab.

12. Select the appropriate cash drawer options.
### Table 17-3  Cash Drawer Control Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>23 - Open Drawer Only if Balance Due is 0.00</td>
<td>Select this option to prevent a tender/media key from opening the cash drawer unless the balance due is $0.00. Deselect this option to allow a tender/media key to open the cash drawer even if there is a balance due on the transaction. If the transaction’s subtotal is $0.00 and you set 36 – Do Not Open Cash Drawer if Subtotal is 0.00, the setting of option 23 is irrelevant.</td>
</tr>
<tr>
<td>33 - Employee ID Required With [No Sale] Key</td>
<td>Select this option if you want the workstation to prompt for the signed-in workstation operator’s employee ID after pressing the No Sale key. This feature is used by staydown operators (such as bartenders or sales clerks) who might need to walk away from the workstation, and by prompting for employee ID, mischievous persons cannot open the drawer. Deselect this option to allow workstation operators to use the No Sale key any time a privileged employee is signed in.</td>
</tr>
<tr>
<td>36 - Do Not Open Drawer if Subtotal is 0.00</td>
<td>Select this option to prevent the cash drawer from opening for transactions in which the subtotal is $0.00. Deselect this option to allow the cash drawer to open whenever a workstation operator uses a tender/media key that is programmed to open the drawer.</td>
</tr>
<tr>
<td>42 - Always Open Cash Drawer if Change Due</td>
<td>Select this option if you want the cash drawer to open even when there are no tenders on the check that should usually open the drawer. There must be change due for the transaction, and the current tender must not be configured to open the drawer. This option is typically used for Tender/Media records such as gift certificates, where change is issued only if the gift certificate exceeds the value of the transaction (thus, the drawer should be opened to issue change), but the drawer should remain closed when the gift certificate does not exceed the transaction’s total.</td>
</tr>
<tr>
<td>65 - Allow open of Cash Drawer on Service Charge</td>
<td>Select this option to allow the cash drawer to open for transactions where the service charge has a value greater than $0.00 but the subtotal is $0.00. If you selected 36 - Do Not Open if Subtotal is $0.00, you must also select this option to allow the cash drawer to open for service charge only guest checks.</td>
</tr>
</tbody>
</table>

13. Click **Save**.
14. Select the Enterprise, click **Configuration** and **Roles**.
15. Select the role type, click **Operations** and **Miscellaneous**.
16. Select the appropriate options for cash drawer privileges.

### Table 17-4  Cash Drawer Privilege Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>17 - Authorize/Perform unassignment of cash drawer from others</td>
<td>Select this option if you want employees in the employee class to use the Unassign Cash Drawer key to unassign cash drawers from other workstation operators. You should not select this option for every employee, but you should typically set it only for management employee classes. Setting this option allows workstation operators in the employee class to use function keys 839 - Assign Cash Drawer 1 and 840 - Assign Cash Drawer 2.</td>
</tr>
<tr>
<td>34 - Authorize Open Cash Drawer Using the [No Sale] Key</td>
<td>Select this option to allow employees associated with the role to open the cash drawer outside of a transaction using the No Sale key, and to authorize non-privileged employees to do so.</td>
</tr>
<tr>
<td>88 - Authorize Cash Drawer Reconnection</td>
<td>Select this option to allow employees associated with the role to authorize a cash drawer cable reconnection on a workstation.</td>
</tr>
</tbody>
</table>

17. Click **Save**.

**Related Topics**

- Assigning and Unassigning a Cash Drawer

**Coin Dispenser**

A coin dispenser (sometimes called a coin changer) is a device attached to a workstation that holds coins. A coin dispenser is not assigned to a workstation or server. When connected to a workstation and configured, a cash tender sends commands to the coin dispenser to dispense coins. The coin dispenser controls only the coin portion of a cash transaction. If the customer presents $20.00 to pay a $16.45 guest check, the coin dispenser automatically dispenses $0.55, but the workstation operator must give the remaining $3.00 to the customer.

The coin dispenser hardware varies the coins that are dispensed to avoid depleting a single type of coin. For example, if the device dispenses $0.55 three times in a row, it is probable that both of the following combinations dispense at least once:

- 1 Quarter and 3 Dimes
- 2 Quarters and 1 Nickel

**Related Topics**

- Configuring a Coin Dispenser
Configuring a Coin Dispenser

1. In the EMC, select the property, click **Setup** and **Workstations**.
2. Double-click the workstation to open it in form view.
3. Click the Devices tab.
4. In the Peripheral Device Configuration section, click **Add**.
5. In the **Select Peripheral Device Type** drop-down list, select **Coin Dispenser**.
6. Enter the **COM Port**, and click **OK**.
7. Click **Save**.
8. On the workstation, allow the configuration change to download to the client.
9. Connect the coin dispenser’s serial cable to the appropriate COM port.
10. Restart the workstation.
11. If the workstation is a Win32 client, modify the device settings for the COM port to match the COM Port you set in Step 6.
   
   Ensure that a workstation with a coin dispenser attached does not have a printer or other device configured for the same COM port as the coin dispenser. Having another device connected but not in use can cause problems with coin dispenser operations.
12. Restart the workstation.
13. Verify that the coin dispenser is connected and ready for operation:
   
   a. Sign in to the workstation as an employee with PMC privileges.
   b. Launch PMC and click the Functions tab.
   c. Click **Device Diagnostics**.
   d. Click **Dispense Change**. The coin dispenser should dispense a penny.

**Related Topics**
- **Coin Dispenser**

Magnetic Stripe Reader

Workstation operators scan magnetic stripe cards using a magnetic stripe reader (MSR) attached to a workstation. Magnetic cards are commonly used as:

- Credit Cards
- Gift Cards
- Employee Identification Cards

**Related Topics**
- **Configuring a Magnetic Stripe Reader**
Installing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices

The magnetic stripe reader (MSR) sleeve for Oracle MICROS Tablet E-Series 8-inch and 11-inch devices supports Transaction Vault Second Generation (TV2G) and data encryption.

Before installing the magnetic stripe reader (MSR) sleeve driver for Oracle MICROS Tablet E-Series devices, ensure that the device has the following prerequisite requirements:

- Microsoft Windows 8.1 operating system
- Microsoft .NET Framework 4.0 or later

Contact Oracle Support to obtain the VeriFone E23x card reader driver before you begin the following steps.

1. If a previous version of the driver exists, uninstall the old driver components before installing the new driver.
   a. Open Control Panel and click Programs and Features.
   b. Uninstall the following program components:
      - E23x Driver Installer versions
      - E23x OPOS DLL
      - Microsoft POS for .NET 1.12
      - OPOS Common Control Objects 1.13.001

2. Run the E23xDriverInstaller_1.2.0.exe file, and click Yes each time you are prompted.

3. Run the E23x_OPOS_DLL_Install_1.5.2.0.exe file, and click Yes each time you are prompted.

   The driver and OPOS DLL installation configures a default OPOS device name for the magnetic stripe reader (MSR). Configure Simphony to use the exact name to use the MSR.

Related Topics
- Configuring a Magnetic Stripe Reader
- Testing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices

Configuring a Magnetic Stripe Reader

1. In the EMC, select the property, click Setup and Workstations.
2. Double-click the workstation to be used with the magnetic stripe reader (MSR).
3. Click the Options tab and the Display/Security sub-tab.
4. Select the appropriate MSR options.
### Table 17-5  MSR Workstation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 - Mag Card Entry Required for Employee ID</td>
<td>Select this option if you want all employee ID entries at the workstation to be made by swiping a magnetic employee ID card. The workstation does not accept an employee ID number entered through the keyboard or touchscreen.</td>
</tr>
<tr>
<td>50 - Mag Card or Fingerprint Scan Required for Employee ID</td>
<td>Select this option if you want all employee ID entries at the workstation to be made using a fingerprint scan or by swiping a magnetic card. That is, employees must swipe a card or scan a fingerprint.</td>
</tr>
<tr>
<td>51 - Mag Card and Fingerprint Scan Required for Employee ID</td>
<td>Select this option if you want all employee ID entries at the workstation to be made using a fingerprint scan and by swiping a magnetic card. That is, employees must both swipe a card and scan a fingerprint.</td>
</tr>
</tbody>
</table>

5. If you are using an encrypted MSR (for example, the MSR sleeve for Oracle MICROS Tablet E-Series 8-inch and 11-inch devices with Transaction Vault Second Generation (TV2G)), complete the following steps:

   a. Click the Hardware/Cash Drawer sub-tab.

   b. Select **55 - Enable Encrypted Magnetic Stripe Reader Support**.

      After you select this option, you cannot turn it off. Before setting this option, ensure that the credit card processor or gateway supports encryption functionality.

6. Click the Devices tab.

7. Click **Add** and select a magnetic stripe reader from the **Select Peripheral Device Type** drop-down list.

8. Select the COM Port Settings (if necessary) and click **OK**.

9. Click **Save**.

**Related Topics**
- Magnetic Stripe Reader
- Testing the MSR Sleeve for Oracle MICROS Tablet E-Series 8 and 11 Inch Devices

### Testing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices

You can test the magnetic stripe reader (MSR) swiper functionality after you install the driver and configure the MSR.

1. Copy the **e23xservice.exe** and **e23xD.dll** files to the [Drive]\Program Files \Verifone\E23xOPOS folder.

2. Close the ServiceHost application.
3. Run `e23xservice.exe`.

4. In the OPOS MSR section of the dialog box, select the following options:
   - Open
   - Claim
   - Enable
   - D. Ev (Data Events)

   After each successful swipe attempt, the D. Ev option is deselected.

5. Swipe the magnetic card. If the card swipe was successful, a message appears with the card data.

Related Topics
- Installing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices
- Configuring a Magnetic Stripe Reader

Barcode Reader Setup Methods

A barcode is an optical machine-readable representation of data. Barcodes are used to quickly order items. Workstation operators scan barcodes using barcode scanners attached to workstations. When a barcode is scanned, the workstation software processes the data and matches it with a menu item programmed in the Simphony database.

The following two methods allow you to configure barcode menu item ordering:
- Use the Barcodes module in the Enterprise Management Console (EMC)
- Use the number lookup (NLU) method

The following table outlines the differences between the two methods:

<table>
<thead>
<tr>
<th>Barcodes Module Method</th>
<th>NLU Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Greater configuration flexibility</td>
<td>Less flexible configuration</td>
</tr>
<tr>
<td>More complex configuration</td>
<td>Simplified configuration</td>
</tr>
<tr>
<td>Associate many different barcodes with the same menu item</td>
<td>Not supported</td>
</tr>
<tr>
<td>(for example, pricing chewing gum items the same)</td>
<td></td>
</tr>
<tr>
<td>Associate two different prices of one definition</td>
<td>Not supported</td>
</tr>
<tr>
<td>with different barcodes (for example, small or large coffee)</td>
<td></td>
</tr>
<tr>
<td>Allows up to 14-digit barcode</td>
<td>Allows up to 12-digit barcode</td>
</tr>
</tbody>
</table>

Related Topics
- Configuring a Barcode Reader Using the Barcodes Module Method
- Configuring a Barcode Reader Using the Number Lookup (NLU) Method
Configuring a Barcode Reader Using the Barcodes Module Method

1. In the EMC, select the Enterprise, property, or revenue center click **Configuration** and **Barcodes**.

2. Insert a barcode record.

3. In the **Barcode** column, enter the numeric value that the barcode represents.

4. Click the ellipsis point (...) symbol in the **Master** column, select the master menu item to be ordered when the barcode is entered, and click **OK**.

5. In the **Definition** column, select the Menu Item Definition (belonging to the selected Menu Item Master) to be ordered when the barcode is entered. If you select **0 - All Definitions**, the workstation determines which definition to order at the time the barcode is entered, based on active Menu Levels and other criteria.
   
   This column is only active when you set the Menu Item Master column to a value other than **0 - None**.

6. In the **Price #** column, select the Menu Item Price (belonging to the selected Menu Item Definition) to be ordered when the barcode is entered. If you select **0 - All Prices**, the workstation determines which price to order at the time the barcode is entered, based on active Menu Levels and other criteria.
   
   This column is only active when you set the Menu Item Definition column to a value other than **0 - All Definitions**.

7. In the **Alternate Price** column, enter the price to charge for the item when the barcode is entered.
   
   This value is used only when you set a value greater than 0.00; if the value is 0.00, the price from the Menu Item Price record is used.

8. In the **Alternate Prep Cost** column, enter the prep cost to use for the item when it is ordered by the barcode.
   
   This value is used only when you set a value greater than 0.00; if the value is 0.00, the prep cost from the Menu Item Price record is used.

9. Click **Save**.

10. Select the Enterprise or property, click **Setup** and **Barcode Format Sets**.

11. Insert a barcode format set record, and then double-click it.

12. Click **Add**.

13. In the **Input Length** field, enter the number of digits in the scanned barcodes.

14. In the **Returned Start** field, enter the first digit to use in the numeric value to return.

15. In the **Returned Length** field, enter the number of digits to read as the numeric value to return.

16. Click **Save**.

17. Select the property, click **Setup** and **Workstations**.

18. Double-click the workstation to be used with the barcode reader.
19. Click the Transactions tab.

20. Select the **Barcode Format Set** for the workstation to use.
   The Barcode Format Set determines how the workstation reads barcodes of
   various lengths.

21. Click the Devices tab.

22. Click **Add** and select the barcode reader from the **Select Peripheral Device Type**
    drop-down list.

23. Select the COM Port Settings (if necessary) and click **OK**.

24. Click **Save**.

25. Select the revenue center, click **Setup** and **RVC Parameters**.

26. From the **Barcode Menu Item NLU Group #** drop-down list, select the number
    lookup (NLU) that is reserved for barcodes.

    When you select a value other than **0 - None**, workstation operators can order any
    Menu Item Definition associated with the Barcode Group by scanning or manually
    entering a barcode. For example, if you set this field to **3 - Barcode**, the menu
    item NLU Group 3 function key can be added to a touchscreen, and the
    workstation operator can manually enter a barcode and press the key to order the
    item.

27. Click **Save**.

**Related Topics**

- Barcode Reader Setup Methods

---

### Configuring a Barcode Reader Using the Number Lookup (NLU) Method

1. In the EMC, select the Enterprise, property, revenue center, or zone, click
   **Descriptors** and **NLU Names**.

2. Enter the name of the NLU descriptor (for example, Barcode Items) in the **Text**
   field.

3. Click **Save**.

4. Select the revenue center, click **Setup** and **RVC Parameters**.

5. From the **Barcode Menu Item NLU Group #** drop-down list, select the number
    lookup (NLU) that you created in Step 2.

6. Click the Options tab.

7. If you want to perform a check digit verification (CDV) on every NLU entry, select
   **33 - Enable UPC Algorithm for Barcode NLU Entries**.

8. If you want barcodes entered in 8-digit UPC-E format to be expanded to 12-digit
   UPC-A format, select **34 - Convert UPC-E to UPC-A**. If you selected option **33** in
   Step 7, select option **34** as well.

9. Click **Save**.

10. Select the Enterprise, property, revenue center, or zone, click **Configuration** and
    **Menu Item Maintenance**.
11. Search for and select a menu item definition record for a menu item that can be ordered by barcode.

12. Select the **NLU Group** from the drop-down list. This is the same NLU that you created in Step 2.

13. Enter the barcode value for the menu item in the **NLU Number** field.

14. Click **Save**.

**Related Topics**
- Barcode Reader Setup Methods

---

**Fingerprint Scanning**

This section describes fingerprint scanning. Fingerprint scanning provides greater security by verifying an employee’s identity. You can use an external USB fingerprint reader with the following devices to scan fingerprints:
- Oracle MICROS Tablet E-Series
- Oracle MICROS Workstation 6
- Oracle MICROS Workstation 5a
- Oracle MICROS PC Workstation 2015
- A PC running a Simphony version 2.x client that is attached to the PC with a USB connection

You can require employees to scan fingerprints when performing the following operations:
- Signing in to a workstation
- Clocking in and out
- Authorizing privileged operations

Privileged employees can perform the following actions:
- Enroll themselves and other employees’ fingerprints in Simphony
- Register up to ten different fingers (in the event that employee digits become incapacitated (cut, removed, or bandaged)

Auditors can determine whether an employee performed an authorization using a fingerprint reader, manual entry, or magnetic card swipe.

**Related Topics**
- Configuring the Biometrics CAL Package Deployment
- Configuring Employee Privileges for the Fingerprint Reader
- Setting the Front of House to Assign Employee Personal Identification Number (PIN)
- Configuring the Workstation Employee Fingerprint Sign In Options
- Scanning a Fingerprint
Configuring the Biometrics CAL Package Deployment

1. In the EMC, select the Enterprise level, click Setup and CAL Packages.
2. Select Biometrics in the navigation tree.
3. Click the Deployment Schedules tab.
4. Click Add Deployment.
5. Select 1 - Property/Enterprise in the Deployment Type drop-down list.
6. Select 0 - Enterprise in the Property field.
7. Select 0 - Install in the Action to Take drop-down list.
8. Click Save.

Related Topics
• Fingerprint Scanning

Configuring Employee Privileges for the Fingerprint Reader

1. In the EMC, select the Enterprise level, click Configuration and Roles.
2. Select the role type, click the Operations tab, and the PMC General/Reports sub-tab.
3. Select 30001 - Run PMC to allow employees associated with the role to open the Property Management Console (PMC) using function key 300.
4. Click the PMC Procedures sub-tab.
5. Select 30055 - Assign Employee Fingerprint Scan and 30052 - Assign Employee PIN.
6. Click Save.

Related Topics
• Fingerprint Scanning

Setting the Front of House to Assign Employee Personal Identification Number (PIN)

1. In the EMC, select the Enterprise, property, revenue center, or zone, click Configuration, and Page Design.
2. Open the Front of House Home or Sign In page.
3. On the Edit tab, click Button.
4. On the General sub-tab, enter Assign PIN in the Legend field.
5. Select Function from the Type drop-down.
6. Click the black arrow directly beneath the Type drop-down and select Assign Employee PIN.
7. Position and size the button on the page. Use the Style arrow to change the color.
8. Click **Save**.

**Related Topics**
- Fingerprint Scanning

## Configuring the Workstation Employee Fingerprint Sign In Options

1. In the EMC, select the property, click **Setup** and **Workstations**.
2. Double-click the workstation to use with a fingerprint reader.
3. Click the **Options** tab.
4. Select the appropriate security options as described in the following table.

<table>
<thead>
<tr>
<th>Table 17-7 Employee Security Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>47 - Fingerprint Scan Required for Employee ID</td>
</tr>
<tr>
<td>48 - Employee ID or Fingerprint Scan Required for Employee ID</td>
</tr>
<tr>
<td>49 - Employee ID and Fingerprint Scan Required for Employee ID</td>
</tr>
<tr>
<td>50 - Mag Card or Fingerprint Scan Required for Employee ID</td>
</tr>
<tr>
<td>51 - Mag Card and Fingerprint Scan Required for Employee ID</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Related Topics**
- Fingerprint Scanning

## Scanning a Fingerprint

You can scan a fingerprint using a workstation or the Simphony Enterprise Management Console (EMC).

1. If you want to scan a fingerprint using a workstation:
   a. Sign in to the workstation as an employee with the proper role privileges.
   b. Open the Edit Employee PIN function.
   c. Select the employee whose fingerprints need to be scanned.
   d. Click the **Enroll Fingerprint** button.
   e. Follow the prompts to enroll up to three fingers for one employee.
   f. Click **Yes** at the prompt to scan the same finger three times, or click **No** to scan different fingers.
g. Place the finger to scan on the fingerprint reader, and then remove it when the scan is complete. The scanner flashes red while scanning and turns blue after the scan is complete. Repeat this step for each finger.

2. If you want to scan a fingerprint using the Simphony Enterprise Management Console (EMC):
   a. Select the Enterprise, property, or revenue center, click **Configuration**, and **Employee Maintenance**.
   b. Search for and select the employee record.
   c. On the General sub-tab, click the **Fingerprint Enrollment** button.
   d. Follow the prompts to enroll one or more fingerprints.

**Related Topics**
- **Fingerprint Scanning**

---

**Configuring a Scale**

A scale connects to the workstation and is used for menu items that are priced by weight (for example, salad bar). You can configure Simphony to calculate weight in ounces, pounds, or kilograms.

1. In the EMC, select the property, click **Setup** and **Workstations**.
2. Double-click the workstation to open it in form view.
3. Click the Devices tab.
4. In the Peripheral Device Configuration section, click **Add**.
5. In the **Select Peripheral Device Type** drop-down list, select **Scale (Serial)**.
6. Enter the **COM Port** to which the scale connects.
7. Select the following settings, and click **OK**:
   - **Baud Rate**: 9600
   - **Parity**: E
   - **Data Bits**: 7
   - **Stop Bits**: 1
8. Click the Options tab and the Hardware/Cash Drawer sub tab.
9. Select **13 - Enable Scale Interface** to allow communication between the workstation and scale.
10. (Optional) If you are using an Oracle MICROS Tablet E-Series, click the Display/Security sub tab and deselect **39 - Floating tablet**.
11. Click **Save**.
12. On the workstation, allow the configuration change to download to the client.
13. Connect the scale’s serial cable to the workstation’s serial COM port.
14. Connect the scale’s power cord to the outlet.
15. Restart the workstation.
16. Verify that the scale is connected and ready for operation:
a. Sign in to the workstation as an employee with PMC privileges.
b. Launch PMC and click the Functions tab.
c. Click Device Diagnostics.
d. Click Get Scale Weight.
e. Place a weighed menu item on the scale and add the menu item to a guest check.

Related Topics
- Understanding Tare Weight
- Configuring a Weighed Menu Item
- Setting the Tare Weight for a Menu Item
Simphony provides reports at the Enterprise and property levels. You can assign privileges to allow employees to run reports.

- Allowing Employees to Run Reports
- List of PMC Reports
- Configuring Employee Privileges for Oracle Hospitality Reporting and Analytics
- Configuring the Log Files for Oracle Hospitality Reporting and Analytics

**Related Topics**
- Allowing Employees to Run Reports
- Configuring Employee Privileges for Oracle Hospitality Reporting and Analytics
- Configuring the Log Files for Oracle Hospitality Reporting and Analytics
- List of PMC Reports

### Allowing Employees to Run Reports

1. In the EMC, select the Enterprise level, click **Configuration** and **Roles**.
2. Select the role type, click the Operations tab, and the PMC General/Reports sub-tab.
3. Select **30001 - Run PMC** to allow employees associated with the role to launch the Property Management Console (PMC) on the workstation using Function Key 300, Launch PMC.
4. Select **10022 - Run PMC Reports in Another Revenue Center** to allow employees associated with the role to run PMC Autosequences (Reports) for revenue centers other than the revenue center to which they are assigned.
5. Click the Ad Hoc Reports tab.
6. In the Report Options section, select the reports you want employees to run.
7. Click **Save**.

**Related Topics**
- Reporting
- List of PMC Reports

### List of PMC Reports

**Online PMC Reports**

Authorized employees can run the following Property Management Console (PMC) reports when the workstation is in online mode:
<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Report</td>
<td>Provides financial reporting for a property, revenue center, or employee. The Employee Financial Report is based on all sales-related entries, such as checks opened, menu items ordered, and the number and amount of service charges, discounts, and tenders applied. You can use this report to balance the server's bank, to determine tips paid, and to track individual performance.</td>
</tr>
<tr>
<td>Employee Open Check Report</td>
<td>Provides a list of all open checks belonging to an employee at the time the report is taken.</td>
</tr>
<tr>
<td>Employee Closed Check Report</td>
<td>Provides a list of all checks that have been closed by an employee, including reopened checks that were closed again and checks closed as memo checks. In addition, special symbols on the report indicate whether the check was transferred, re-opened, split, or added.</td>
</tr>
<tr>
<td>Employee Tip Report</td>
<td>Summarizes the total tip activity by employee.</td>
</tr>
<tr>
<td>Employee Labor Detail Report</td>
<td>Provides an account of work performed by each employee. The report includes the dates, times, and job rates of each clock-in and clock-out, the total hours of regular and overtime worked at each job code, and the gross pay earned.</td>
</tr>
<tr>
<td>Employee Labor Summary Report</td>
<td>Provides a summary of the regular and overtime hours worked by each employee at each of their assigned pay rates.</td>
</tr>
<tr>
<td>Cashier Financial Report</td>
<td>Provides financial information for each cashier, including tenders and tips paid.</td>
</tr>
<tr>
<td>Major Group Sales Report</td>
<td>Provides sales totals for each major group.</td>
</tr>
<tr>
<td>Family Group Sales Report</td>
<td>Provides sales totals for each family group.</td>
</tr>
<tr>
<td>Menu Item Summary Report</td>
<td>Summarizes all menu items.</td>
</tr>
<tr>
<td>Menu Item Sales Report</td>
<td>Provides sales totals for each menu item.</td>
</tr>
<tr>
<td>Time Period Detail Report</td>
<td>Shows each time period as a full report, with a similar format to a system financial report (sales, check profiles, tracking group).</td>
</tr>
<tr>
<td>Time Period Summary Report</td>
<td>Shows each time period on a single line with sales information.</td>
</tr>
<tr>
<td>Serving Period Financial Report</td>
<td>Provides financial reporting by serving period.</td>
</tr>
<tr>
<td>Table Sales Report</td>
<td>Provides sales totals for each table.</td>
</tr>
<tr>
<td>Clock-in Status Report</td>
<td>Provides a list of employees who are currently clocked in or on a break.</td>
</tr>
<tr>
<td>Labor Availability Report</td>
<td>Provides a count of all employees clocked in or on break as of the time the report is taken.</td>
</tr>
<tr>
<td>Job Code Report</td>
<td>Summarizes all accumulated employee labor totals by job code.</td>
</tr>
</tbody>
</table>
Table 18-1  (Cont.) PMC Reports in Online Mode

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autofire Open Check Report</td>
<td>Provides a list of all checks that are scheduled for autofire at the time the report is run. Checks are grouped by employee and sorted by scheduled date and time.</td>
</tr>
<tr>
<td>Employee Journal Report</td>
<td>Provides a journal of all sales transactions by a specific employee shown in a check detail layout.</td>
</tr>
<tr>
<td>Check Journal Report</td>
<td>Provides a journal of all sales transactions in a check detail layout.</td>
</tr>
<tr>
<td>Tax Summary Report</td>
<td>Provides a list of tax rates.</td>
</tr>
</tbody>
</table>

Offline PMC Reports

Authorized employees can run the following Property Management Console (PMC) reports when the workstation is in offline mode:

Table 18-2  PMC Reports in Offline Mode

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Report</td>
<td>Provides financial reporting for a revenue center or employee. The Employee Financial Report is based on all sales-related entries, such as checks opened, menu items ordered, and the number and amount of service charges, discounts, and tenders applied. You can use this report to balance the server's bank, to determine tips paid, and to track individual performance.</td>
</tr>
<tr>
<td>Cashier Financial Report</td>
<td>Provides financial information for each cashier, including tenders and tips paid.</td>
</tr>
<tr>
<td>Open Check Report</td>
<td>Provides a list of all open checks belonging to an employee at the time the report is taken.</td>
</tr>
</tbody>
</table>

Related Topics

- Reporting
- Allowing Employees to Run Reports
- Configuring Employee Privileges for Oracle Hospitality Reporting and Analytics
- Configuring the Log Files for Oracle Hospitality Reporting and Analytics

Configuring Employee Privileges for Oracle Hospitality Reporting and Analytics

1. In the EMC, select the Enterprise, property, or revenue center, click Configuration and Employee Maintenance.
2. Search for the employee record.

3. Click the Employee Records tab near the lower part of the screen, and then double-click the object number of the appropriate record.

4. Click the Reporting tab to configure an employee’s settings as they pertain to logging in to Reporting and Analytics.

5. If you want to grant the employee an active account in the Reporting and Analytics database, select **Active**.

6. To make the employee a default user for all Reporting and Analytics employee records associated with the same role, select **Default User**. This allows new employees in Reporting and Analytics who share the same role to use the same settings as this employee.

7. From the **Role** drop-down, select **Workstation Report**.

8. Click **Save**.


**Related Topics**

- Reporting
- List of PMC Reports

### Configuring the Log Files for Oracle Hospitality Reporting and Analytics

1. In the EMC, select the Enterprise level, click **Setup** and **Enterprise Parameters**.

2. Click the mymicros.net tab and enter the appropriate information. The following table describes the fields.

**Table 18-3  Reporting and Analytics Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logs to Keep</td>
<td>Enter the number of Data Transfer Service (DTS) logs to retain.</td>
</tr>
<tr>
<td>Error Files to Keep (days)</td>
<td>Enter the number of days the application retains error file logs.</td>
</tr>
<tr>
<td>Verbosity</td>
<td>Select the Verbosity level for DTS logging.</td>
</tr>
<tr>
<td></td>
<td>You should typically set this value to <strong>Normal</strong>. Set verbose logging to <strong>Extended</strong> or <strong>Super</strong> for troubleshooting as these elevated levels create large log files and slow performance.</td>
</tr>
<tr>
<td>mymicros.net Machine Name</td>
<td>Enter the name of the Reporting and Analytics server computer using the format <a href="http://YourMyMicrosUrl">http://YourMyMicrosUrl</a>.</td>
</tr>
</tbody>
</table>
### Table 18-3 (Cont.) Reporting and Analytics Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise mylabor URL</td>
<td>If DTS uses a different Internet Protocol (IP) address to connect to Oracle Hospitality Labor Management, enter the uniform resource locator (URL). Use the format <a href="http://Name">http://Name</a> or IP address of the Reporting and Analytics portal server. If you leave this blank, DTS uses the Reporting and Analytics machine name to post Labor Management. Workstations do not use this URL.</td>
</tr>
<tr>
<td>Organization ID</td>
<td>Do not change this value unless instructed by your Oracle representative. This field represents the Enterprise organization ID used for reporting to Oracle Hospitality Reporting and Analytics.</td>
</tr>
<tr>
<td>17 - Send selected translations to Simphony Reports</td>
<td>Select this option if you want to send definition translations to Simphony reports. You must also select the <strong>Send Translations for this Language to Simphony Reports</strong> option in the Language module for each language to be sent to Simphony reports.</td>
</tr>
</tbody>
</table>

3. Click **Save**.


**Related Topics**

- Reporting
- List of PMC Reports
Auditing

Simphony allows you to examine and evaluate various application activities at the Enterprise and property levels.

- Understanding the Audit Trail
- Using the Audit Trail
- Understanding Audit This Record
- Using Audit This Record

Understanding the Audit Trail

You can use the Audit Trail module to view changes made to the Simphony application. The Audit Trail records and reports all additions, changes, and deletions made through the EMC and through PMC Procedures. In addition, the Audit Trail reports on successful and failed logins to EMC, PMC Report takers, Key Manager activity, and Audit Trail purges.

 Related Topics
- Using the Audit Trail

Using the Audit Trail

You must have the privilege to access the audit trial at the Enterprise or property level. When an Audit Trail report is taken, the activity is logged to the Audit Trail. All Audit Trail Reports taken are logged as an Enterprise level activity.

1. Select the Enterprise or property, click Tasks, and then click Audit Trail.
2. To perform a quick search on the Search tab:
   a. Select the timeframe from the All Changes In drop-down list.
   b. Click the Run Quick Search button.
   When you perform a quick search, the application ignores the values in the standard search fields.
3. To perform a standard search, enter or select information in the following fields, and then click the Search button.
Table 19-1  Audit Trail Standard Search Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Select an application from the drop-down list. Depending on your selection, the Module drop-down list is active or dimmed. For example, when you select EMC, the Module drop-down list shows a list of EMC modules.</td>
</tr>
<tr>
<td>Module</td>
<td>Select a module from the drop-down list. This field is active only when the Application selection allows a choice of modules. Depending on your selection, the Object Numbers field is active or dimmed. For example, when you select EMC from the Application drop-down list and Discounts from the Module drop-down list, the Object Numbers field becomes active.</td>
</tr>
<tr>
<td>(Optional) Object Numbers</td>
<td>Enter an object number or range to retrieve results based on specific records only. Leave this field blank to have the search engine find all object numbers.</td>
</tr>
<tr>
<td>Operation</td>
<td>Select an operation from the drop-down list. This field is active based on a combination of the Application and Module selections.</td>
</tr>
<tr>
<td>Zone/Location</td>
<td>Select a zone or location. When you open the Audit Trail from the Enterprise level, this field allows a selection of any property, zone, or revenue centers. When you open the Audit Trail from the property level, this field allows a selection of revenue centers within the property.</td>
</tr>
<tr>
<td>Employee</td>
<td>Click the Select link, select an employee, and then click OK. When you select a specific employee, only changes made by that employee are included in the list. Click the Me link to include only the logged-in employee.</td>
</tr>
<tr>
<td>Date Range</td>
<td>Select the date range to use to query the Audit Trail. Select User-Defined to activate the Start and End fields.</td>
</tr>
<tr>
<td>(Optional) Start and End</td>
<td>To narrow your query to a specific date or date range, select the start and end dates and times. Select All Dates to include all dates in the query.</td>
</tr>
<tr>
<td>(Optional) Old/New Values</td>
<td>Enter text for use in the query. This can be useful in finding a specific change to a record, such as “When was the item Hamburger renamed to Cheeseburger?”</td>
</tr>
</tbody>
</table>
Table 19-1  (Cont.) Audit Trail Standard Search Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preserve Previous Results</td>
<td>Select this option to merge the search results with the previous search results, instead of overwriting them. Deselect this option to see only the results of the most recent search.</td>
</tr>
</tbody>
</table>

4. If the number of results that will be returned exceeds the pre-set thresholds for Audit Trail results (for example, 10,000 records or more), the application prompts you to confirm the action.

5. To view the search results for a quick search or a standard search, click the Results tab.
   a. To save the results, click the Save to Disk button, select the directory, and then click the Save button.
   b. To copy the results into another application (such as Notepad or email) without storing the information, click the Formatted Results button, and then click the Copy button.

6. To manually remove old records from the Audit Trail table in the database, click the Purge tab.
   The Purge tab is visible only at the Enterprise level, and you must have the Purge Audit Trail privilege.

7. Select the date before which the records will be purged, and then click the Purge button. For example, if you select 9/1/2016, the application deletes all records from September 1, 2016 and earlier.
   Records are deleted based on the UTC date of the Audit Trail record.

In addition to this manually initiated purge, the Data Transfer Service (DTS) purges Audit Trail records automatically.

Related Topics
• Understanding the Audit Trail

Understanding Audit This Record

In almost every module, you can audit an individual record or a group of similar records. The results usually show the record or records at a specific position. For example, consider the following actions:

1. Add a Tender Media record at Object Number 1234.
2. Change the record’s name to Cash.
3. Delete the record.
4. Add a new record at Object Number 1234.
5. Change the record’s name to MasterCard.

After performing these steps, the Audit This Record results show all five of the changes (not just the changes for steps 4 and 5). Although the first Tender Media record was deleted, it is considered “this record” for functional purposes. In short, all
records at the same object number are treated as “this record” and are included in the results.

Related Topics
• Using Audit This Record

Using Audit This Record

1. Select the Enterprise or property, and then open a module that contains at least one record.

2. Highlight one or more records, right-click inside the first column, and then select either Audit This Record (single record) or Audit Selected Records (multiple records). The Audit Record tab shows the information for the selected records. Alternatively, from the EMC toolbar, click Edit, and then select Audit This Record.

3. To run specific queries on the selected record or records, click the Show Advanced Options link.

4. Use the same search parameters that are available in the Audit Trail module. See Using the Audit Trail for more information.

Related Topics
• Understanding Audit This Record
Dining Room Tables and Seating

You can manage the dining room using Simphony with a standard table management interface, or using the enhanced Table Management System (available with Simphony version 2.6 and later).

- Standard and Enhanced Table Management
- Configuring the Standard Table Management Interface
- Creating Standard Dining Tables
- Table Management
- Reservation List
- Wait List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Configuring Table Management Privileges
- Configuring Reservation Privileges
- Configuring Wait List Privileges
- Configuring Servers for Table Management
- Configuring Properties for Table Management
- Configuring Custom Images for Table Management
- Configuring KDS or Dining Course Colors and Images for Table Management
- Configuring the Service Total Tender for Table Management
- Enhanced Dining Tables
- Setting Dining Table Classes
- Setting Enhanced Dining Table Attributes
- Configuring Enhanced Dining Tables
- Setting Table Decorator Images
- Configuring Server and Table Availability
- Setting Table Management Options
- Configuring Table Suggestion Factors
- Table Management Alerts
- Configuring Alerts
- Table Management Sections
- Configuring Sections
- Creating the Front of House Reservation List
- Creating the Front of House Wait List
Standard and Enhanced Table Management

Dining staff can manage tables in Simphony using one of the following methods:

- Standard table management interface
- Enhanced or integrated tables (available with the Table Management System)

The following table outlines the differences between the two table management methods:

| Table 20-1  Differences Between Standard and Enhanced Table Management |
|-------------|-----------------|-----------------|
| Function    | Standard Tables | Enhanced Tables |
| Accept reservations | No              | Yes             |
| Manage a Reservation List | No              | Yes             |
| Manage a Wait List     | No              | Yes             |
Table 20-1  (Cont.) Differences Between Standard and Enhanced Table Management

<table>
<thead>
<tr>
<th>Function</th>
<th>Standard Tables</th>
<th>Enhanced Tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provide wait quotes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Show table status</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Estimate table turn times</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Assign tables to sections and employees</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Join and split tables</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Suggest tables</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Use function keys on the workstation for bussing and transferring tables</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Interface with Oracle Hospitality Reservations Management Cloud Service</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Interface with Oracle Hospitality Gift and Loyalty Advanced Cloud Service</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Related Topics

- Configuring the Standard Table Management Interface
- Creating Standard Dining Tables
- Setting Dining Table Classes
- Setting Enhanced Dining Table Attributes
- Configuring Enhanced Dining Tables

Configuring the Standard Table Management Interface

1. In the EMC, select the Enterprise level, click Setup and Interfaces.
2. Insert a record for Standard Table Management and open it in form view.
3. In the Interface Type drop-down list, select 3 - Table Management.
4. In the Communications Type drop-down list, select 1 - TCP.
5. In the Timeout field, enter the amount of time (in seconds) that Simphony waits for a response from the standard table management interface before showing a communications failure message.
6. In the Ping Frequency field, enter the amount of time (in seconds) that Simphony pings the standard table management server (for example, every 5 seconds).
7. Click the Options tab and select the appropriate options as described in the following table.

Table 20-2  Standard Table Management Interface Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 - Enable Interface Log</td>
<td>Select this option to have debug information post to the Interface log file.</td>
</tr>
</tbody>
</table>
Table 20-2  (Cont.) Standard Table Management Interface Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 - ON = Use 9 digits for Terminal IDs; OFF = Use 2 digits for Terminal IDs</td>
<td>Select this option to transmit the entire 9-digit workstation ID to the standard table management system.</td>
</tr>
<tr>
<td>8 - Enable Offline Posting</td>
<td>Select this option to allow offline posting to the Simphony point of sale (POS).</td>
</tr>
<tr>
<td>9 - Determine Link Status Using Ping</td>
<td>Select this option if you want the Simphony POS to ping the standard table management system.</td>
</tr>
<tr>
<td>10 - ON = Use 5-digit RVC #; OFF = Use 3-digit RVC #</td>
<td>Select this option if you want the standard table management system posting message to support a 5-digit revenue center number. (Otherwise, the posting is limited to a 3-digit revenue center number.)</td>
</tr>
<tr>
<td>11 - ON = Use 8-digit Check #; OFF = Use 4-digit Check #</td>
<td>Select this option if you want the standard table management system posting message to support an 8-digit check number. (Otherwise, the posting is limited to a 4-digit check number.)</td>
</tr>
</tbody>
</table>

8. In the TCP Host Name field, enter the name or IP address of the standard table management server for the interface.

9. In the Port Number field, enter 0 (zero).

10. Click the Properties tab, and select each property that uses the standard table management system interface.

11. Click the Service Host tab and select the service host that can run the standard table management system interface.

12. Click Save.

13. Select the revenue center, click Setup and RVC Parameters.

14. Click the Interfaces tab.

15. Select the TMS Operator to whom a check that is opened by the standard table management system is assigned, before being picked up by a server.

16. Select the TMS User Workstation to which a check that is opened by the standard table management system is assigned.

17. In the TMS Link drop-down list, select the standard table management interface.

18. Click Save.

Related Topics

- Standard and Enhanced Table Management
- Enhanced Dining Tables

Creating Standard Dining Tables

1. In the EMC, select the Enterprise, property, or revenue center, click Configuration and Page Design.

2. Double-click the Front of House page on which to define standard dining tables.
3. On the Edit tab, select the page area on which to place the standard dining tables.

4. Select Other... and Dining Table.

5. Move and adjust the table size on the page. Leave space between tables on the page layout to ensure visibility of indicators and table state. You can increase the grid configuration on the page from 24 (default) to 48 using the Change Grid Size link.

6. Repeat Steps 4 and 5 to create additional standard dining tables.

7. Click Save.

Related Topics
• Standard and Enhanced Table Management
• Enhanced Dining Tables

Table Management

You can integrate dining room management, reservation list, wait list, customer preferences and seating, and staff availability with the Simphony Table Management System, Reservation List, and Wait List.

The Simphony Table Management System (TMS) allows you to perform the following actions:
• Make reservations
• Maintain a Wait List
• Seat guests immediately at available tables
• Control the number of reservations allowed during specific time periods
• See an overview of enhanced dining tables and status
• Update the table status based on coursing
• Manage the seating layout with table, section, and server assignments
• Change table seating capacities
• Estimate wait quote times

Related Topics
• Table Management Configuration Levels

Reservation List

The Reservation List contains all reservation requests for the revenue center. Hosting staff with access to the Reservation List can create, edit, and cancel reservation requests from the list.

Related Topics
• Configuring Reservation Privileges
• Creating the Front of House Reservation List
• Setting Reservation Timing Parameters
• Reservation Configuration Levels
Wait List

Often a guest arrives and asks for a table. When tables are not immediately available for seating, the guest may request a wait time and add their name to a Wait List. The Wait List contains all wait requests for the revenue center. The Wait List also shows reservations prior to the scheduled arrival. Reservations appear on the Wait List a configured number of minutes prior to the schedule seating time. Hosting staff with access to the Wait List can add, change, and abandon wait requests from this list. Hosting staff can manage the Wait List on its own page or as a popup in the host view.

Related Topics

- Configuring Wait List Privileges
- Creating the Front of House Wait List
- Setting Wait List Timing Parameters
- Wait List Configuration Levels

Table Management, Reservation, and Wait List Configuration Prerequisites

Before configuring reservations, you must complete the following tasks:

- Configure the Simphony Table Management System (TMS)
- Configure the Simphony Wait List to accept and seat guests with reservations

If the property is using a Wait List, but does not take reservations, you only need to configure the TMS before setting up the Wait List. (A Reservation List is not required with the Wait List.)

The Simphony TMS, Reservations, and Wait List integrate with loyalty applications such as Oracle Hospitality Gift and Loyalty, and third party loyalty applications based on the loadable loyalty modules. When you use Simphony TMS, Reservations, or Wait List with loyalty applications, workstation operators can associate the loyalty account with the reservation request or walk-in guest. After associating guest loyalty information with the table request, the information follows the guest through the life of the guest check. If you want to use the Simphony TMS, Reservations, or Wait List with a loyalty application, you must configure the loadable loyalty module. Loyalty Configuration Tasks contains more information about configuring the loyalty module.

Related Topics

- Table Management Configuration Levels
- Configuring Reservation Privileges
- Creating the Front of House Reservation List
- Setting Reservation Timing Parameters
- Reservation Configuration Levels
Configuring Table Management Privileges

1. In the EMC, select the Enterprise, click Configuration and Roles.
2. Select the role type, click the Operations tab and the Guest Management sub-tab.
3. Select the appropriate options for the privileges. The following table summarizes the privileges associated with table management functionality and the recommended roles to have the privilege set.

### Table 20-3 Table Management Privileges

<table>
<thead>
<tr>
<th>Tab Location</th>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allows the Employee to ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guest Management</td>
<td>32020</td>
<td>Edit Section Layout</td>
<td>Edit a section layout.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32021</td>
<td>Activate Section Layout</td>
<td>Activate a defined section layout as the Active Layout.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32022</td>
<td>Delete Section Layout</td>
<td>Delete an existing section layout.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32031</td>
<td>Assign Employee to Table</td>
<td>Assign an employee to a table or section in TMS.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32032</td>
<td>Mark Table Clean or Dirty</td>
<td>Mark a table as clean or dirty.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32033</td>
<td>Change Table State</td>
<td>Mark tables as being Available, Closed, Reserved, or Merged.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32034</td>
<td>Seat Unsuggested Table</td>
<td>Seat a table request at a table that is different than the table that was suggested by the TMS Table Suggestion System.</td>
<td>Host, Manager</td>
</tr>
</tbody>
</table>
### Table 20-3  (Cont.) Table Management Privileges

<table>
<thead>
<tr>
<th>Tab Location</th>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allows the Employee to ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guest Management</td>
<td>32037</td>
<td>View Legend</td>
<td>View the TMS Legend and use the available functions contained within the form.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32038</td>
<td>Allow Seating Guest Above or Below Table Capacity</td>
<td>Seat a table request at a table that does not support a different seating capacity (other than the cover count on the table seating request).</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32039</td>
<td>Allow Seating Guest at Table that does not Meet all Required Table Preferences</td>
<td>Seat a table request at a table that does not meet all of the seating preferences defined on the table seating request.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32040</td>
<td>Edit Server Availability</td>
<td>Edit the server availability.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Ad Hoc Reports</td>
<td>31044</td>
<td>Run Employee Section Assignment Report</td>
<td>Run the Employee Section Assignment Report.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Transactions</td>
<td>22</td>
<td>Post Payment to Checks Belonging to Another Operator</td>
<td>Unseat a table request.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Transactions</td>
<td>37</td>
<td>Authorize/Perform Posting of Payment</td>
<td>Unseat a table request.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Transactions</td>
<td>38</td>
<td>Authorize/Perform Closing of Checks with a Zero Balance</td>
<td>Unseat a table request.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Checks</td>
<td>18</td>
<td>Authorize/Perform Pickup of a Check Belonging to Another Operator</td>
<td>Unseat a table request.</td>
<td>Host, Manager</td>
</tr>
</tbody>
</table>

4. Click **Save**.
Configuring Reservation Privileges

1. In the EMC, select the Enterprise, click **Configuration** and **Roles**.
2. Select the role type, click **Operations** and **Guest Management**.
3. Select the appropriate options for the privileges. The following table summarizes the privileges associated with reservation functionality and the recommended roles to have the privilege set:

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>32006</td>
<td>Greet Wait List Entry</td>
<td>Greet a reservation request if the party arrives earlier than the time in which the reservation automatically moves to the Wait List.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32007</td>
<td>Mark as No Show</td>
<td>Mark a reservation request as a no-show if the guest does not arrive.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32010</td>
<td>Add Reservation Entry</td>
<td>Create a reservation request.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32011</td>
<td>Edit Reservation Entry</td>
<td>Edit an existing reservation request.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32012</td>
<td>Cancel Reservation Entry</td>
<td>Cancel a reservation request.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32013</td>
<td>Approve Reservation Entry</td>
<td>Approve a reservation that is requesting a date or time outside the acceptable or allowable timeframe.</td>
<td>Host, Manager</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**Related Topics**
- Reservation List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Reservation Configuration Levels

Configuring Wait List Privileges

1. In the EMC, select the Enterprise, click **Configuration** and **Roles**.
2. Select the role type, click the Operations tab and the Guest Management sub-tab.
3. Select the appropriate options for the privileges.
The following table summarizes the privileges associated with wait list functionality and the recommended roles to have the privilege set:

**Table 20-5  Wait List Privileges**

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>32001</td>
<td>Add Wait List Entry</td>
<td>Create a new Wait List request.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32002</td>
<td>Edit Wait List Entry</td>
<td>Edit an existing Wait List request.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32003</td>
<td>Abandon Wait List Entry</td>
<td>Abandon a Wait List request.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32004</td>
<td>Seat Wait List Entry</td>
<td>Seat a Wait List request.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32005</td>
<td>Unseat Wait List Entry</td>
<td>Unseat a Wait List request.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32006</td>
<td>Greet Wait List Entry</td>
<td>Greet a Wait List request.</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32007</td>
<td>Mark as No Show</td>
<td>Mark a reservation request as a no-show if the guest does not arrive.</td>
<td>Host, Manager</td>
</tr>
</tbody>
</table>

4. Click **Save**.

Related Topics

- Wait List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Wait List Configuration Levels

### Configuring Servers for Table Management

1. In the EMC, select the Enterprise, property, or revenue center, click **Configuration** and **Employee Maintenance**.

2. Search for and select the employee record.

3. In the **Check Name** field, enter the server’s name as you want it to appear on the workstation. If you do not enter a Check Name, the workstation shows a blank name.

4. Select the Operator Records sub-tab near the lower area of the screen.

5. In the **TMS Color** field, select the color to distinguish the server from other servers on the host page, and click **OK**.

   Although you can set a different color for each revenue center within a property, Oracle recommends that you use a single color for the server across the property. If you do not set a TMS Color, the workstation shows white.

6. In the **Server Efficiency** field, enter 0 (zero) if you want the Simphony Table Management System (TMS) to ignore the server in the table suggestions.
The Table Suggestion System (within TMS) sets the Server Efficiency rating to determine the next table recommended for seating. This rating is a value between 0 (zero) and 100, and represents the number of covers that the server can efficiently service at one time.

7. Click Save.

Configuring Properties for Table Management

1. In the EMC, select the property, click Setup and Properties.
2. Highlight the property record.
3. In the Symphony Platform field, select 2 - Extensible Clients and Architecture.
4. Click Save.

Configuring Custom Images for Table Management

You can load custom images into the Simphony application to represent table seating configuration and statuses. The Table Management System (TMS) uses both custom images and images packaged with Simphony. All images are transparent .PNG files.

Table images show a graphical representation of the table and chairs. These images can be a square or round table surrounded by any number of chairs.

Table decorators show a graphical representation of the table status (for example, dirty, closed, or reserved).

1. In the EMC, select the Enterprise, property, or revenue center, click Setup and Content.
2. Double-click the content name row to view the image set for that name.
3. Select the Import from a file link to import custom images.
4. Browse to the file location, select the image file, and click Open.
5. Repeat Steps 2 through 4 for each table image and table decorator you want to import.
6. Click Save.

Configuring KDS or Dining Course Colors and Images for Table Management

You can set a color or image to indicate the Kitchen Display System (KDS) or dining course that the table is being serviced under.

1. In the EMC, select the Enterprise or property, click Descriptors and KDS/Dining Course.
2. Insert dining course records if they do not exist.
3. In the Course Color field, select a color for each dining course name.

This color appears as the dining course indicator on the table image in the workstation. For example, appetizers can be green, entrées can be yellow, and desserts can be red.
4. (Optional) In the Course Image Name field, select a the course decorator image to represent the dining course (in place of a course color). The image you select replaces the default Occupied image on the table. To remove a Course Image that was previously set, select 0 - None and click OK.

5. Click Save.

Configuring the Service Total Tender for Table Management

You must configure a unique tender media record to process seating and unseating of guests.

1. In the EMC, select the Enterprise, click Configuration and Tender/Media.
2. Create a tender media record and name it TMS.
3. Double-click the record to open it.
4. Set the Key Type to 2-Service Total.
5. Click Save.

Enhanced Dining Tables

Complete the following tasks to set up enhanced dining tables:

• Set Dining Table Classes
• Set Enhanced Dining Table Attributes
• Configure Enhanced Tables

Related Topics

• Configuring the Standard Table Management Interface
• Creating Standard Dining Tables
• Setting Dining Table Classes
• Setting Enhanced Dining Table Attributes
• Configuring Enhanced Dining Tables

Setting Dining Table Classes

You can group and configure similar tables using the Dining Table Classes module.

1. In the EMC, select the Enterprise, property, or revenue center, click Setup and Dining Table Class.
2. Insert a dining table class.
3. Select or enter information for the following fields.
### Table 20-6 Dining Table Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the dining table class. The name identifies the class (for example, 2 Tops, 4 Tops, and so on).</td>
</tr>
<tr>
<td>(Optional) Default Background Color</td>
<td>Select a background color to represent the table. Select a different color than the page background so as not to blend similar colors. If you associate a transparent table image with the dining table class, the background color appears with the image. If you select 0–None, the application shows the table image and background color of the page.</td>
</tr>
<tr>
<td>(Optional) Default Text Color</td>
<td>Select the text color to represent the table number or name. Select a different color than the page background so as not to blend similar colors. If you select 0–None, the application shows the default text color of black.</td>
</tr>
<tr>
<td>(Optional) Default Image</td>
<td>Select the image to represent the table.</td>
</tr>
<tr>
<td>Minimum Covers</td>
<td>Enter the lowest number of covers that the dining table class can accommodate (for example, a 2–Top can accommodate a minimum of 1 person).</td>
</tr>
<tr>
<td>Maximum Covers</td>
<td>Enter the largest number of covers that the dining table class can accommodate (for example, a 2–Top can accommodate a maximum of 2 people). You can overlap covers to seat a specific cover count within one or more dining table classes (for example, 4 covers on a 4–Top or 6–Top).</td>
</tr>
<tr>
<td>Options</td>
<td>If you are using enhanced dining tables within the dining table class, select 1 – Enhanced Dining Table. If you are using legacy standard tables, deselect Enhancement Dining Table.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

#### Related Topics
- **Standard and Enhanced Table Management**
- **Enhanced Dining Tables**

---

### Setting Enhanced Dining Table Attributes

You can set characteristics of the table for use in the table suggestion process.

1. In the EMC, select the property, click **Setup** and **TMS Table Attributes**.
2. Select or enter information for the following fields.
### Table 20-7  TMS Table Attributes Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the attribute, characteristic, or guest preference associated with a table (for example, Accessible, Window Seats, City View, Ocean View, or Booth).</td>
</tr>
<tr>
<td>Code</td>
<td>Enter the attribute code associated with a guest preference in the request (for example, ADA, WIND, CITY, OCN, or BTH).</td>
</tr>
<tr>
<td>(Optional) Is Exclusive</td>
<td>Select this option if the table attributes must be met before being included in table seating suggestions. For example, the Accessible attribute is exclusive.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

**Related Topics**
- Standard and Enhanced Table Management
- Enhanced Dining Tables

## Configuring Enhanced Dining Tables

Dining tables represent the physical location where a party can be seated with a Quick Seating operation or from the Wait List.

1. In the EMC, select the property, click **Setup** and **Tables**.
2. Select or enter information for the following fields.

### Table 20-8  Tables Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Number (# symbol)</td>
<td>Enter a unique table number for all revenue centers within the property. The Table Number appears on the workstation and represents the internal number used to distinguish one table from another within the property.</td>
</tr>
</tbody>
</table>
| Name                         | Enter a unique table name for all revenue centers within the property. The table name appears on the workstation and represents the local facing name or number used to differentiate the table from others. Values in the Name field can be:  
  • All numeric  
  • All alpha  
  • Alpha and then numeric |
### Table 20-8  (Cont.) Tables Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Select the dining table class. The dining table class defines the type of table. All instances of this table number use the color, image, and cover configurations defined for the selected dining table class. Create only tables that are to be used for seating within a revenue center. Creating non-seatable tables (such as bar tabs) prevents the table suggestion system from properly distributing tables. Do not delete tables unless you no longer need them for reports. Oracle Hospitality recommends that you assign tables that are not used to a dining table class named to indicate this status. For example, create a dining table class named NOT IN USE and assign unused tables to this class. Tables assigned to the NOT IN USE class cannot be used for seating, but remain in the Simphony Table Management System for reporting purposes.</td>
</tr>
</tbody>
</table>

Table Attributes

You can associate one or more attributes with a table. When you set attributes, the application matches guest preferences with tables. For example, when a guest prefers window seats, tables associated with a window seating attribute move up in the table suggestion process.

3. Click Save.

**Related Topics**

- Standard and Enhanced Table Management
- Enhanced Dining Tables

### Setting Table Decorator Images

1. In the EMC, select the Enterprise, property, or revenue center, click Setup and TMS Parameters.

2. (Optional) Select the link next to each Dining Table Decoration Image Name to view a list of images (set as custom images).

   Dining table images are optional but useful as part of daily table management operations. See Configuring Custom Images for Table Management for more information about setting custom images.

3. Select an image to represent each of the following statuses:
### Table 20-9  Dining Table Decoration Images

<table>
<thead>
<tr>
<th>Table Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>The application uses this decorator when a workstation operator selects one or more tables. Table selection is only available on a page with the Host Command Area. Table selection allows the workstation operator to apply a specific action to the selected table(s).</td>
</tr>
<tr>
<td>Dirty</td>
<td>The application uses this decorator when a table is in a status of Dirty. Workstation operators can still seat guests at dirty tables.</td>
</tr>
<tr>
<td>Seated</td>
<td>The application uses this decorator when a guest is newly seated at a table. This status remains until the guest places an order. After placing an order, the table status changes to Occupied.</td>
</tr>
<tr>
<td>Occupied</td>
<td>The application uses this decorator after a guest places an order at the table. This status remains until the guest tenders the check. The image associated with the Occupied status is overridden when you set images for dining courses. See Configuring KDS or Dining Course Colors and Images for Table Management for more information about setting dining course images.</td>
</tr>
<tr>
<td>Printed</td>
<td>The application uses this decorator when the workstation operator prints the guest check. The table is considered occupied, and the Printed status appears in addition to the Occupied status.</td>
</tr>
<tr>
<td>Paid</td>
<td>The application uses this decorator after a guest completes the dining experience and tenders the check. This status remains for the duration of time set in the Auto Reset Paid Status (Minutes) field. Host staff can seat new guests at tables marked as Paid. After a host seats a guest at a Paid table, the table status resets.</td>
</tr>
<tr>
<td>Parent</td>
<td>The application uses this decorator to identify the table as the parent table in a merged table grouping. This status appears in addition to the other status indicators.</td>
</tr>
<tr>
<td>Child</td>
<td>The application uses this decorator to identify the table as the child table in a merged table grouping. This decorator includes a text overlay that identifies the child’s parent table number and name. The application clears both Parent and Child decorators when the workstation operator removes the merged table grouping.</td>
</tr>
<tr>
<td>Closed</td>
<td>The application uses this decorator to indicate a status of Closed. Host staff cannot seat guests at closed tables.</td>
</tr>
</tbody>
</table>
### Table 20-9  (Cont.) Dining Table Decoration Images

<table>
<thead>
<tr>
<th>Table Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserved</td>
<td>The application uses this decorator to indicate a status of Reserved. The Table Suggestion process does not consider reserved tables for seating.</td>
</tr>
<tr>
<td>User Suggested</td>
<td>The application uses this decorator to identify the table as the host staff recommended seating placement for the highlighted table request on the Wait List.</td>
</tr>
<tr>
<td>System Suggested</td>
<td>The application uses this decorator to identify the table as the system recommended seating placement for the highlighted table request on the Wait List.</td>
</tr>
<tr>
<td>Highlighted</td>
<td>Do not use this decorator.</td>
</tr>
<tr>
<td>Host Area</td>
<td>This image is not a table decorator, but an optional image placement for the Host Command Area. You can use this image to place the restaurant logo on the host page.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

## Configuring Server and Table Availability

1. In the EMC, select the Enterprise, property, or revenue center, click **Setup** and **TMS Parameters**.

2. Click the Configuration tab and the Table Suggestion tab.

3. In the **Default Server Available Time (Minutes)** field, enter the default number of minutes to use when making a server unavailable in the Table Management System (TMS). You can set this to a duration between 1 and 480 minutes.

4. In the **Auto Reset Paid Status (Minutes)** field, enter the number of minutes that the table decorator shows as paid on the host page before returning to an available status. You can define a buffer of time between when the table service moves from tendered, cleaned, and available for a new seating. Setting a value of 0 (zero) or blank defaults the time to 1 minute.

5. Click **Save**.

## Setting Table Management Options

1. In the EMC, select the Enterprise, property, or revenue center, click **Setup** and **TMS Parameters**.

2. On the Configuration tab, select **Enable Table Management** to turn on Table Management System (TMS) functions in Simphony. Select this option only for properties and revenue centers that use the TMS features. This option increases workstation resources and communications bandwidth for the enterprise.

3. If you are using a loyalty program to look up and process transactions, select the **Loyalty Module ID** from the drop-down list. If you are not using a loyalty program, select **None**.
4. Select the appropriate TMS Options at the bottom of the screen. The following table describes the options.

**Table 20-10  ** TMS Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Unassigned Tables on Section Layout</td>
<td>Select this option to automatically close tables that are not assigned to a section when a workstation operator activates a section layout.</td>
</tr>
<tr>
<td>Activation</td>
<td></td>
</tr>
<tr>
<td>Allow Multiple Loyalty Accounts per Guest</td>
<td>This option determines whether the workstation operator can associate multiple loyalty accounts with a guest check. Select this option to allow the workstation operator to associate additional loyalty accounts with the guest check by selecting seats. Deselect this option to limit one loyalty account per guest check.</td>
</tr>
<tr>
<td>Check</td>
<td></td>
</tr>
<tr>
<td>Enable Guest Information Chit Printing</td>
<td>Select this option to print a chit when the host staff seats the table request.</td>
</tr>
<tr>
<td>Update Table On KDS Bump Event</td>
<td>Use this option only when the property or revenue center uses a Kitchen Display System (KDS). This option determines when the dining course updates on the host page table image. Select this option to update the KDS or dining course on the table image after the workstation operator bumps the menu from the KDS. Deselect this option to update the KDS or dining course on the table image after the workstation operator performs a service total.</td>
</tr>
<tr>
<td>Prompt for Employee on Unassigned Table</td>
<td>This option determines whether the host staff can seat a table without a server assignment. Select this option to have the workstation operator assign a server during seating.</td>
</tr>
<tr>
<td>Enable Seating Of Unavailable Tables</td>
<td>Select this option to allow the host staff to seat guests at a table defined as unavailable (including Closed, Dirty, and Reserved).</td>
</tr>
</tbody>
</table>

Table 20-10  (Cont.) TMS Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore Cover Count</td>
<td>This option determines the initial guest count set on the guest check when the host staff seats the table request. Select this option if you do not want the cover count shown on the guest check; instead the application relies on guest check configuration to determine the guest count value. Deselect this option to have the cover count set on the table request and provided to the guest check as the initial guest count. Set this option if you want to maintain a valid cover count for the seating record, yet increment the guest count from 0 (zero) to a number based on the menu items ordered (entrée count). When you select Ignore Cover Count, you must also deselect the option Use Number of Seats for Guest Count in the RVC Parameters module.</td>
</tr>
<tr>
<td>Enable Edit Seating Capacity</td>
<td>Select this option to allow the workstation operator to change the seating capacity of a table from its configured number of seats.</td>
</tr>
<tr>
<td>Set Seating Capacity on Table Merge</td>
<td>Select this option to have the workstation operator enter the new number of seats for a table when merging tables.</td>
</tr>
<tr>
<td>Enable Create and Edit buttons on Wait List and Reservation List Screens</td>
<td>This option determines whether to show the Create and Edit buttons on the Wait List and Reservation List screens. The workstation operator can click the buttons in Ops (rather than double-tap the Reservation List or Wait List).</td>
</tr>
</tbody>
</table>
Table 20-10  (Cont.) TMS Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Offline Reservations</td>
<td>Select this option to allow workstation operators to create reservations when connectivity to the Table Management Service is not available. This is primarily used at properties when the host workstations are unable to access the service but want to create reservations. Setting this option does not restrict the workstation operator’s ability to add records to the Wait List. When you enable offline reservations, the potential to overbook seating increases as the reservations are not recorded to a single destination. After the application re-establishes connectivity to the service, the application reports offline reservations to the service. If the remaining inventory becomes zero, the offline reservations being reported to the service are removed without notification. In cases where more than one source of reservations are defined (for example, multiple hosting workstations or online reservations), Oracle Hospitality discourages use of this option. Oracle Hospitality recommends that you disable offline reservations.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

Configuring Table Suggestion Factors

The Table Suggestion process uses several optional factors to determine the next parties to seat, and the tables that the Table Management System (TMS) suggests for seating. Although the table suggestion factors all work together, Oracle Hospitality recommends that you use only a few factors initially to become accustomed to how the listing and suggestion process works for the property.

1. In the EMC, select the Enterprise, property, or revenue center, click **Setup** and **TMS Parameters**.

2. Click the Table Suggestion tab.

3. Use the arrow buttons to move and rank the suggestion factors. The factor order alters the table suggestion calculations.

Table 20-11  Table Suggestion Factors

<table>
<thead>
<tr>
<th>Table Suggestion Factor</th>
<th>Places a Greater Value On ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation Waiting</td>
<td>Reservations that have been waiting longer than other requests in the seating order.</td>
</tr>
<tr>
<td>Waiting Past Quote</td>
<td>Reservation or walk-in requests where the request has been waiting longer than their scheduled seating time or quoted wait time.</td>
</tr>
</tbody>
</table>
Table 20-11  (Cont.) Table Suggestion Factors

<table>
<thead>
<tr>
<th>Table Suggestion Factor</th>
<th>Places a Greater Value On ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation Waiting Past Quote</td>
<td>Reservation requests where the request has been waiting longer than the scheduled seating time.</td>
</tr>
<tr>
<td>Reservation Greeted</td>
<td>Reservation requests where the party has arrived and hosting staff greeted them.</td>
</tr>
<tr>
<td>Reservation</td>
<td>Reservation requests versus non-reservation requests (walk-ins) in the seating order.</td>
</tr>
<tr>
<td>VIP Waiting</td>
<td>Reservation requests where the party is designated as a VIP and have been waiting versus non-VIP reservation and walk-in requests that have been waiting in the seating order.</td>
</tr>
<tr>
<td>VIP</td>
<td>Reservation and walk-in requests where the party is designated as a VIP in the seating order.</td>
</tr>
<tr>
<td>Table Dirty</td>
<td>Any table marked as Dirty.</td>
</tr>
<tr>
<td>Table Paid</td>
<td>Any table marked as Paid.</td>
</tr>
<tr>
<td>Server Check Count</td>
<td>Any server based on their current service check count (open and closed).</td>
</tr>
<tr>
<td>Server Cover Count</td>
<td>Any server based on their current service cover count.</td>
</tr>
<tr>
<td>Server Efficiency</td>
<td>Any server based on their Server Efficiency Rating.</td>
</tr>
<tr>
<td>Server Last Assigned</td>
<td>Any table based on the table’s current server assignment and the time since the server received a new table seating.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**Table Management Alerts**

You can set two optional types of table management alerts: Service Alerts and Check Alerts.

Service Alerts show the duration since the last service interaction (for example, guest ordered a menu item). If you do not set Service Alerts, the table management system does not track service intervals on the guest check.

Check Alerts show how long the guest has been seated at the table. This alert changes as the service interaction passes defined thresholds. If you do not set Check Alerts, the table management system only tracks the duration of time the guest check is open and does not change the Check Alert color.

**Related Topics**
- Configuring Alerts
Configuring Alerts

1. In the EMC, select the revenue center, click Setup and Service Alert.
2. Enter the name of the service alert as you want it to appear to the workstation operator (for example, Recent Service, No Touch Warning, or Service Warning).
3. Set the Service Alert Time to the number of minutes since the last service total elapses before triggering the service alert. To start the alert immediately upon seating of the guest, set the time to 0 (zero). The application resets the timer to 0 when the workstation operator performs a service total with a new menu item on the guest check.
4. Select the Service Alert Color to distinguish one alert from another in the service alert table area on the host page. Only seated tables show a service alert color.
5. Click Save.
6. In the EMC, select the revenue center, click Setup and Check Alert.
7. Enter the name of the check alert as you want it to appear to the workstation operator (for example, In Service, Turn Waiting, or Turn Alert).
8. Set the Check Alert Time to the number of minutes since the check was opened before triggering the next check alert. To start the alert immediately upon seating of the guest, set the time to 0 (zero). The application resets the timer to 0 when the workstation operator performs a service total with a new menu item on the guest check. The check alert remains as the last alert until the workstation operator closes the guest check.
9. Select the Check Alert Color to distinguish one alert from another in the check alert table area on the host page. Only seated tables show a check alert color.
10. Click Save.

Related Topics
- Table Management Alerts

Table Management Sections

You can group tables within an area or station to indicate assignment to a specific server. Optional seating section templates allow you to set predefined table layouts where the application automatically assigns tables to a specific section. You can create seating section layouts at the property level.

Related Topics
- Configuring Sections

Configuring Sections

1. In the EMC, select the property, click Setup and Section.
2. Enter the name of the section as you want it to appear to the workstation operator and in reports.
3. Select the color used to distinguish one section from another when viewing tables on the host page. Only tables that are assigned to a section inherit the section color.

4. Click **Save**.

5. In the EMC, select the property, click **Setup** and **Seating Section Templates**.

6. Enter the name of the section template as you want it to appear to the workstation operator.

7. Select **Add** to define a table as part of the template.
   a. From the new record, click the build box to view a list of tables defined for the revenue center. Alternatively, you can enter the Table ID and press **Tab**.
   b. Select the section from the available list or enter the Section ID.

8. Click **Save**.

**Related Topics**
- Table Management Sections

**Creating the Front of House Reservation List**

The Reservation List allows hosting staff to manage all reservation requests. Oracle Hospitality recommends that you create a Reservations List on a page for the reservation functions. You can use the template provided in Simphony. If a property uses future reservations or multiple dining room layouts, a Tabbed Template provides workstation operators with a smoother means to navigate between wait lists, reservation lists, and table layouts.

The Table Management System (TMS), Wait List, and Reservation functions must reside within the same content area on a page in order to interact.

1. In the EMC, select the Enterprise, property, or revenue center, click **Configuration** and **Page Design**.

2. Double-click the Front of House page on which to place the reservation list.

3. On the Edit tab, select the page area in which to define the reservations.

4. Select **Other**, **Table Management**, and then **Reservation Area**.

   The reservations list contains buttons for creating future reservations. You can place the reservations list alone or within the Host Command Area, where hosting staff can hide and recall it. Oracle Hospitality recommends placing the reservations list on its own page. After placing the reservations area, the Reservation List settings appear in two sections:

   - **Reservation List Columns** – The columns section allows you to set Reservation List columns and formats that appear on the workstation. You can configure the content, width, and order in which the columns appear on the Reservation List.
   
   - **Summary Area** – The summary section allows you to set the reservation details that appear on the workstation when a workstation operator highlights a reservation in the Reservation List.

5. Highlight the reservation area, and select **Reservation List Columns**.
6. In the **Header** and **Detail Font Size** fields, select the size of the font used to show the reservation heading and detail.

7. For each Reservation List column, select the **Enable** option if you want the column name to appear in the workstation Reservation List, and then enter the column width for each column.

**Table 20-12  Reservation List Columns**

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel Date</td>
<td>If a reservation is cancelled or the guest does not arrive, this column shows the date and time of cancellation.</td>
</tr>
<tr>
<td>Alert Icon</td>
<td>The alert icon is always enabled and is the first column shown in the Reservation List. This column contains icons to indicate status or properties of the reservation record. Alert icons represent the request method, VIP status, and seating preferences.</td>
</tr>
<tr>
<td>Confirmation Number</td>
<td>Symphony issues a confirmation number after a workstation operator or guest creates a reservation.</td>
</tr>
<tr>
<td>Covers</td>
<td>This column shows the number of covers for the reservation.</td>
</tr>
<tr>
<td>Created</td>
<td>This column shows the date and time the reservation was created.</td>
</tr>
<tr>
<td>Greeted</td>
<td>This column shows the time when the host staff greeted the guest.</td>
</tr>
<tr>
<td>Time</td>
<td>The time is always enabled and is the second column shown in the Reservation List. This column shows the time when the reservation is scheduled to be seated.</td>
</tr>
<tr>
<td>Guest Name</td>
<td>This column shows the name in which the reservation was created.</td>
</tr>
<tr>
<td>Pager Number</td>
<td>Do not use this column.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>This column shows the guest's phone number.</td>
</tr>
<tr>
<td>Request Method</td>
<td>This column shows an icon representing the source of the reservation (phone or Internet).</td>
</tr>
<tr>
<td>VIP</td>
<td>This column shows an icon representing the VIP flag if the guest has a VIP status.</td>
</tr>
<tr>
<td>Wait Quote</td>
<td>Do not use this column.</td>
</tr>
</tbody>
</table>

8. Click the black up and down arrows in the top portion of the Reservation List Columns section to sort and move each enabled column to the order you want them to appear in the workstation Reservation List.

9. Select **Summary Area**.

10. Select **Show Summary** if you want reservation details to appear in the Reservation List when a workstation operator highlights a reservation.
11. In the **Summary Height** field, enter a static height for the summary information. When you enter 0 (zero), the height of the summary area appears dynamically, depending on the amount of content and details associated with the highlighted reservation.

12. In the **Label** and **Detail Font Size** fields, select the size of the font used to show the summary label and details.

13. For each Reservation summary field:
   - Select the **Enable** option if you want the summary content to appear in the workstation Reservation List.
   - Select the **New Line** option if you want the summary information to appear on a new line in the workstation Reservation List.

The information in the Summary Area is the same as the Reservation List Columns, with the addition of the content listed in the following table.

**Table 20-13  Reservation List Summary**

<table>
<thead>
<tr>
<th>Summary Content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>This summary option contains text included in the Notes field of the reservation record. This field holds up to 255 characters of text and automatically wraps in the summary area.</td>
</tr>
<tr>
<td>Referral Notes</td>
<td>This summary option contains text included in the Referral Notes field of the reservation record. This field holds up to 255 characters of text and automatically wraps in the summary area.</td>
</tr>
</tbody>
</table>

14. Click **Save**.

**Related Topics**

- Reservation List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Reservation Configuration Levels

**Creating the Front of House Wait List**

The Wait List allows hosting staff to manage all table requests (including walk-ins and pending reservations). Oracle Hospitality recommends that you create a Wait List on a page for the table request functions. You can use the templates provided in Simphony. If the property uses future reservations or multiple dining room layouts, a Tabbed Template provides workstation operators with a smoother means to navigate between wait lists, reservation lists, and table layouts.

The Table Management System (TMS), Wait List, and Reservation functions must reside within the same content area on a page in order to interact.

1. In the EMC, select the Enterprise, property, or revenue center, click **Configuration** and **Page Design**.
2. Double-click the Front of House page on which to place the wait list.

3. On the Edit tab, select the page area in which to define the wait list.

4. Select Other..., Table Management, and Wait List.

The Wait List contains buttons for creating walk-in table requests. You can place the Wait List alone or within the Host Command Area, where hosting staff can hide and recall it. Oracle Hospitality recommends creating a Wait List on the same page as the tables to simplify the seating process. After placing the wait list, the Wait List settings appear in two sections:

- **Wait List Columns** – The columns section allows you to set Wait List columns and formats that appear on the workstation. You can configure the content, width, and order in which the columns appear on the Wait List.

- **Summary Area** – The summary section allows you to set the wait list details that appear on the workstation when a workstation operator highlights a table request in the Wait List.

5. Highlight the Wait List, and select **Wait List Columns**.

6. In the **Header** and **Detail** fields, select the size of the font used to show the Wait List heading and detail.

7. For each Wait List column, select the **Enable** option if you want the column name to appear in the workstation Wait List, and then enter the column width for each column.

### Table 20-14  Wait List Columns

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandon Time</td>
<td>Do not configure the Wait List to contain this column.</td>
</tr>
<tr>
<td>Alert Icon</td>
<td>The alert icon is always enabled and is the first column shown in the Wait List. This column contains icons to indicate status or properties of the table request record. Alert icons represent the quote status, request method, VIP status, and seating preferences.</td>
</tr>
<tr>
<td>Confirmation Number</td>
<td>The confirmation number appears only for table requests that originate from the Reservation List.</td>
</tr>
<tr>
<td>Covers</td>
<td>This column shows the number of covers for the table request.</td>
</tr>
<tr>
<td>Created</td>
<td>This column shows the date and time the table request was created.</td>
</tr>
<tr>
<td>Greeted</td>
<td>This column shows the time when the host staff greeted the guest.</td>
</tr>
<tr>
<td>Guest Name</td>
<td>This column shows the name for the table request.</td>
</tr>
<tr>
<td>Pager Number</td>
<td>This column shows the pager number for the table request.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>This column shows the guest’s phone number.</td>
</tr>
</tbody>
</table>
Table 20-14 (Cont.) Wait List Columns

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request Method</td>
<td>This column shows an icon representing the source of the table request (walk-in, phone-in, or Internet).</td>
</tr>
<tr>
<td>VIP</td>
<td>This column shows an icon representing the VIP flag if the guest has a VIP status.</td>
</tr>
<tr>
<td>Wait Quote</td>
<td>This column shows the estimated wait quote time given for the table request.</td>
</tr>
</tbody>
</table>

8. Click the black up and down arrows in the top portion of the Wait List Columns section to sort and move each enabled column to the order you want them to appear in the workstation Wait List.

9. Select **Summary Area**.

10. Select **Show Summary** if you want table request details to appear in the Wait List when a workstation operator highlights a table request.

11. In the **Summary Height** field, enter a static height for the summary information. When you enter 0 (zero), the height of the summary area appears dynamically, depending on the amount of content and details associated with the highlighted table request.

12. In the **Label** and **Detail** fields, select the size of the font used to show the summary label and details.

13. For each Wait List summary field:
   - Select the **Enable** option if you want the summary content to appear in the workstation Wait List.
   - Select the **New Line** option if you want the summary information to appear on a new line in the workstation Wait List.

The information in the Summary Area is the same as the Wait List Columns, with the addition of the content listed in the following table.

Table 20-15 Wait List Summary

<table>
<thead>
<tr>
<th>Summary Content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimated Wait Time</td>
<td>This summary option contains the approximate time remaining until a table will be ready for the guest. This value differs from the wait quote, which is a static amount of time that the guest was quoted. The Estimated Wait Time changes as tables are freed up and new table seating requests are made.</td>
</tr>
<tr>
<td>Notes</td>
<td>This summary option contains text included in the Notes field of the table request record. This field holds up to 255 characters of text and automatically wraps in the summary area.</td>
</tr>
</tbody>
</table>
### Table 20-15  (Cont.) Wait List Summary

<table>
<thead>
<tr>
<th>Summary Content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Referral Notes</td>
<td>This summary option contains text included in the Referral Notes field of the table request record. This field holds up to 255 characters of text and automatically wraps in the summary area.</td>
</tr>
</tbody>
</table>

14. Click **Save**.

**Related Topics**
- Wait List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Wait List Configuration Levels

## Front of House Table Management Tasks

Oracle Hospitality recommends that you create table management forms on a page for the enhanced dining table functions. You can use the templates provided in Simphony. If the property uses future reservations or multiple dining room layouts, a Tabbed Template provides workstation operators with a smoother means to navigate between wait lists, reservation lists, and table layouts.

The Table Management System (TMS), Wait List, and Reservation functions must reside within the same content area on a page in order to interact.

Creating table management operations for the Front of House consists of completing the following tasks:
- Setting the Host Command Area
- Setting the Dining Table Status
- Setting Employee Lines
- Creating a Section Layout
- Creating Enhanced Dining Tables
- Setting Table Management Functions in the Guest Check Detail Area
- Creating a button for the Employee Section Assignment Report

### Host Command Area

You need to place a Host Command Area on a page for hosting staff to use the Simphony Table Management System (TMS) operations. The Host Command Area is the primary mechanism used to manage all hosting related functions in the TMS. This area determines the way hosting staff:
- Enables and disables TMS functions
- Accesses TMS features
- Administers the hosting page
Related Topics
• Configuring the Host Command Area

Configuring the Host Command Area

1. In the EMC, select the Enterprise, property, or revenue center, click Configuration and Page Design.

2. Double-click the Front of House page on which to define the Host Command Area.

3. On the Edit tab, select the page area on which to place the Host Command Area. You must place the Host Command Area in the same content area on the page as the tables in order for the host features to function.

4. Select Other..., Table Management, and Host Command Area.
   Hosting staff performs a long button press on the Host Command Area to access the TMS functions. As such, carefully consider the Host Command Area sizing and placement to ensure that hosting staff can easily see and press this area on the workstation.

5. The Host Command Area can optionally show an image in place of the silver portion of the area. You can set the image in the TMS Parameters module as the Dining Table Decoration Image Name. The image you select scales to the size of the Host Command Area.

6. Click Save.

Related Topics
• Host Command Area

Dining Table Status

Dining Table Status contains information about the highlighted table and associated open checks. Hosting staff can hide and recall the optional Dining Table Status from the Host Command Area, as well as move the Dining Table Status on the workstation with a click, hold, and drag motion. The sizing and placement of the Dining Table Status should not prevent hosting staff from accessing the table images. In addition, the Dining Table Status should be large enough so that text is legible to all hosting staff as the text size scales based on the screen sizing.

The following figure shows an example of the Dining Table Status.
Configuring the Dining Table Status

1. In the EMC, select the Enterprise, property, or revenue center, click **Configuration** and **Page Design**.

2. Double-click the Front of House page on which to define the Dining Table Status.

3. On the Edit tab, select the page area on which to place the Dining Table Status. Place the Dining Table Status in the same content area on the page as the Host Command Area and tables so that hosting staff can access the functions and view information.

4. Select **Other...**, **Table Management**, and **Dining Table Status**.

5. Click **Save**.

Related Topics

- Dining Table Status
Employee Lines

Hosting staff can hide and recall the optional Employee Lines Area from the Host Command Area. This area shows lines from the assigned tables to a text box containing the assigned server’s name. The following figure shows an example of the Employee Lines Area.

Figure 20-2   Employee Lines Area

Related Topics
- Configuring Employee Lines

Configuring Employee Lines

1. In the EMC, select the Enterprise, property, or revenue center, click Configuration and Page Design.
2. Double-click the Front of House page on which to define the Employee Lines Area. (This is the page with enhanced table images.)
3. On the Edit tab, select the page area on which to place the Employee Lines Area.
Place the Employee Lines Area in the same content area on the page as the Host Command Area and tables in order for the hosting staff to access the functions and view information.

4. Select Other..., Table Management, and Employee Lines Area.

5. Adjust the size and placement of the Employee Lines Area to ensure that it covers all enhanced tables on the page. Tables that are not covered by the Employee Lines Area do not show server assignment lines.

6. Click Save.

Related Topics
- Employee Lines

Section Layout

The Section Layout contains controls to create and administer Seating Section Layouts for table, section, and server assignments. Hosting staff can hide and recall the optional Section Layout from the Host Command Area or from a separate page. Oracle Hospitality recommends creating a Section Layout on a separate page. Hosting staff can easily assign tables to a section when:
- Tables are present on the same page as the Section Layout.
- Tables are accessible while editing a Section Layout.

The following figure shows an example of the Section Layout.

Figure 20-3  Section Layout
Creating a Section Layout

1. In the EMC, select the Enterprise, property, or revenue center, click **Configuration** and **Page Design**.
2. Create the Front of House page on which to define the Section Layout.
3. Select **Other...**, **Table Management**, and **Section Layout**.
4. Adjust the Section Layout size to ensure that the text is visible to hosting staff. The text size scales with the Section Layout size.
5. Click **Save**.

Related Topics
• **Section Layout**

Creating Enhanced Dining Tables

You can use all functions of the Simphony Table Management System (TMS) using enhanced dining tables. You cannot use legacy standard tables with TMS. Enhanced dining tables show overlays on the outer edges of the table that indicate status, coursing, and alerts.

1. In the EMC, select the Enterprise, property, or revenue center, click **Configuration** and **Page Design**.
2. Double-click the Front of House page on which to define enhanced dining tables.
3. On the Edit tab, select the page area on which to place the enhanced dining tables.
4. Select **Other...**, **Table Management**, and **Dining Table (Enhanced)**.
5. Move and adjust the table size on the page. Leave space between tables on the page layout to ensure visibility of indicators and table state. You can increase the grid configuration on the page from 24 (default) to 48 using the Change Grid Size link.
6. Set the unique properties of the enhanced dining table:
   a. Enter the table number in the **Table #** field.
      This must match the Table Number set in the Tables module. See **Configuring Enhanced Dining Tables** for more information.
   b. In the Next Page/Panel section, select the black Panel arrow, and then select the host page from the list.
   c. (Optional) Enter a table number in the **Legend** field. If the Legend is blank, the table number or name shown on the host page uses the table number or name defined for the Table # field. If you want to use a different name or number for the table, you can enter an override value in the Legend field.
7. Repeat Steps 4 through 6 to create additional enhanced dining tables.
8. Click **Save**.
Setting Table Management Functions in Check Detail

1. In the EMC, select the Enterprise, property, or revenue center, click **Configuration** and **Page Design**.

2. Double-click the Front of House page that contains the Check Detail area.

3. Select the Check Detail area on the page.

4. Select **Show Seat Number** to provide the workstation operator with a visual representation of the seat number associated with a menu item or guest on the check detail area.

5. Select **Enable Gestures** to allow the workstation operator to access a menu of options when long-pressing on the guest check.

   The long-press options include:
   
   • Change Item Seat
   • Change Item Course
   • View By Item Entry
   • View By Seat
   • View By Course

6. Select the view mode from the **Initial View Mode** drop-down.

   This is the view shown when the workstation operator initially sees the guest check. Oracle recommends selecting the **View By Seat** mode for restaurants that allow multiple loyalty accounts on a single guest check.

7. Click **Save**.

Creating the Employee Section Assignment Report Button

1. In the EMC, select the Enterprise, property, or revenue center, click **Configuration** and **Page Design**.

2. Open the Front of House page on which to place the Employee Section Assignment Report button.

3. On the Edit tab, select the page area in which to define the button.

4. Click **Button**.

5. Position and size the button on the page. Use the Style arrow to change the color.

6. In the **Legend** field, enter the button name.

7. Select **Ad Hoc Report** from the **Type** drop-down.

8. Click the black arrow, select **44 – Employee Section Assignment Report** from the report list, and click **OK**.

9. Click **Save**.
Configuring Table Cancellation Reasons

You can optionally create Reservation and Wait List Reasons to indicate why a guest cancels or abandons a table request.

1. In the EMC, select the Enterprise, property, or revenue center, click **Descriptors** and **TMS Reasons**.
2. Enter a reason in the **Text** field. You can create a maximum of 32 reasons.
3. Click **Save**.

Setting Reservation Timing Parameters

1. In the EMC, select the Enterprise, property, or revenue center, click **Setup** and **TMS Parameters**.
2. On the Configuration tab, enter information in the following fields:

   **Table 20-16  Reservation Timing Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation to Waitlist Delay</td>
<td>Enter how far in advance a reservation appears on the Wait List before the scheduled seating time. Reservation records that are visible on the Wait List impact the quote times and table suggestions.</td>
</tr>
<tr>
<td>Maximum Reservation Notice (Days)</td>
<td>Enter how far in advance a reservation can be made. This value includes the current business day. For example, a value of 90 indicates that guests can make reservations no more than 90 days in advance.</td>
</tr>
<tr>
<td>Minimum Reservation Notice (Minutes)</td>
<td>Enter the amount of advanced time when reservations can no longer be made for the same business day. For example, a value of 30 indicates that guests cannot make reservations less than 30 minutes in advance.</td>
</tr>
</tbody>
</table>

3. Select the appropriate options for reservation functions.

   **Table 20-17  Reservation Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require Reason Code on Abandon/Cancel</td>
<td>Select this option to have the application prompt the workstation operator to enter a cancellation reason for the reservation request.</td>
</tr>
<tr>
<td>Enable Reservation Approval</td>
<td>Select this option if you want the workstation operator to obtain approval when creating a reservation outside of a date or time available in the Table Management System (TMS) inventory.</td>
</tr>
</tbody>
</table>
Table 20-17  (Cont.) Reservation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Create and Edit Buttons</td>
<td>Select this option to show Create and Edit buttons following the Reservation List in Ops. When you enable the buttons, the workstation operator can also double-tap the screen to create or edit reservations.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**Related Topics**

- Reservation List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Reservation Configuration Levels

### Setting Wait List Timing Parameters

1. In the EMC, select the Enterprise, property, or revenue center, click **Setup** and **TMS Parameters**.

2. On the Configuration tab, enter information in the following fields:

**Table 20-18  Wait List Timing Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation To Waitlist Delay</td>
<td>Enter how far in advance a reservation appears on the Wait List before the scheduled seating time. Reservation records that are visible on the Wait List impact the quote times and table suggestions.</td>
</tr>
<tr>
<td>Wait Quote Interval (Minutes)</td>
<td>Enter the wait quote time increments (for example, every 2 minutes or 5 minutes).</td>
</tr>
<tr>
<td>Auto Abandon Wait List Delay (Minutes)</td>
<td>Enter the number of minutes that a table request record remains on the Wait List before the application automatically updates it as Abandoned (for walk-ins) or No-Show (for reservations). The application removes the record from the Wait List after reaching this time threshold.</td>
</tr>
<tr>
<td>Wait Quote Alert Threshold (Minutes)</td>
<td>Enter the number of minutes to elapse before flagging the table request on the Wait List as Overdue for seating. Enter 0 (zero) to flag the table request as soon as the time quote elapses.</td>
</tr>
</tbody>
</table>

3. Select the appropriate options to enable or disable wait list functions. The following table describes the options.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require Reason Code on Abandon/Cancel</td>
<td>Select this option to have the application prompt the workstation operator to enter a reason for abandoning or cancelling a table request.</td>
</tr>
<tr>
<td>Enable Wait List Chit Printing</td>
<td>Select this option to print a chit when the host staff creates or updates a table request. The chit contains table request information and the estimated wait time.</td>
</tr>
<tr>
<td>Enable Create and Edit Buttons</td>
<td>Select this option to show Create and Edit buttons following the Wait List in Ops. When you enable the buttons, the workstation operator can also double-tap the screen to create or edit table requests.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**Related Topics**
- Wait List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Wait List Configuration Levels

**Reservation Periods**

Optional Reservation Period settings control reservation inventory and allow walk-in table requests. They also define projected turn times for tables based on time and cover count. If the property does not take reservations, Oracle Hospitality recommends configuring Reservation Periods so that hosting staff can use the Estimate Wait Quote feature on the Wait List.

Setting Reservation Periods consists of completing the following tasks:
- Setting the reservation period timeframe
- Setting reservations intervals and covers
- Setting occupancy
- Setting seating capacity and quantity
- Setting anticipated turn times for tables

**Related Topics**
- Configuring Effectivity
- Configuring Acceptance Limits
- Configuring Occupancy Limits
- Configuring Seating Limits
- Configuring Target Turn Times
Configuring Effectivity

1. In the EMC, select the revenue center, click Setup and Reservation Periods.
2. Insert a record with a name that describes the reservation period (for example, Weekday or Weekend).
3. Double-click the record to open it.
4. On the Effectivity tab, select the appropriate options as described in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effectivity Start Date</td>
<td>The Effectivity Start Date defines the first calendar day that the reservation period is effective. Deselecting the start date causes the reservation period for the reservation and wait lists to remain in effect indefinitely.</td>
</tr>
<tr>
<td>Effectivity End Date</td>
<td>The Effectivity End Date defines the last calendar day that the reservation period is effective. Deselecting the end date causes the reservation period for the reservation and wait lists to remain in effect indefinitely.</td>
</tr>
<tr>
<td>Recurrence Day Of Week</td>
<td>The Recurrence Day of Week defines the effective days of the week in the reservation period. You must select at least one day in order to save the reservation period.</td>
</tr>
<tr>
<td>Recurrence Time Of Day</td>
<td>The Recurrence Time of Day defines the time of the day that is effective in the reservation period. Deselecting the Active Start Time causes the reservation period for the reservation and wait lists to remain in effect starting at 00:00:00 on the applicable calendar days. Deselecting the Active End Time causes the reservation period for the reservation and wait lists to remain in effect until 23:59:59 on the applicable calendar days.</td>
</tr>
</tbody>
</table>

5. Click Save.

Related Topics
• Reservation Periods

Configuring Acceptance Limits

Acceptance Limits define the following reservation period items:
• The interval (in minutes) in which reservations can be made
• The maximum new covers allowed within the interval

1. In the EMC, select the revenue center, click Setup and Reservation Periods.
2. Open the reservation period record.
3. Click the General tab and the Acceptance Limits tab.
4. Click the Add link.
5. Enter information in the Acceptance Limits fields:

<table>
<thead>
<tr>
<th>Table 20-21 Acceptance Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Begin Time</td>
</tr>
<tr>
<td>End Time</td>
</tr>
<tr>
<td>Cycle</td>
</tr>
<tr>
<td>Acceptance Limits</td>
</tr>
</tbody>
</table>

6. Click Save.

Related Topics
- Reservation Periods

Configuring Occupancy Limits

Occupancy Limits define the maximum number of covers allowed at any time. Occupancy Limits are typically set by building codes based on available exits.

1. In the EMC, select the revenue center, click Setup and Reservation Periods.
2. Open the reservation period record.
3. Click the General tab and the Occupancy Limits tab.
4. Click the Add link.
5. Enter information in the Occupancy Limits fields:

<table>
<thead>
<tr>
<th>Table 20-22 Occupancy Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Begin Time</td>
</tr>
<tr>
<td>End Time</td>
</tr>
</tbody>
</table>
**Table 20-22  (Cont.) Occupancy Limits**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Occupancy Limit</td>
<td>This value limits the revenue center occupancy. Entering 250 prevents new reservations for the defined Acceptance Limits cycle after the number of covers for all reservations within that timeframe reaches or exceeds the limit. If you do not create an Occupancy Limit, the application uses the default value of 9999 covers.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

**Related Topics**
- Reservation Periods

**Configuring Seating Limits**

Seating Limits define the number of available reservations allocated based on the cycle defined in the Acceptance Limits and Party Size.

1. In the EMC, select the revenue center, click **Setup** and **Reservation Periods**.
2. Open the reservation period record.
3. Click the General tab and the Seating Limits tab.
4. Click the **Add** link.
5. Enter information in the Seating Limits fields:

**Table 20-23  Seating Limits**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Time</td>
<td>Enter the time when the defined Seating Limit begins. If you do not create a Seating Limit, the application uses the default value of 00:00:01.</td>
</tr>
<tr>
<td>End Time</td>
<td>Enter the time when the defined Seating Limit ends. If you do not create a Seating Limit, the application uses the default value of 00:00:00.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Enter the number of covers in the party. If you do not create a Seating Limit, the application uses the default value of Unlimited. The Capacity value cascades to lower values if you do not set a lower value. For example, if you set a capacity of 4, this cover includes requests for a party of 1 through 4. However, setting a lower capacity of 2 applies to parties of 1 or 2, and the capacity of 4 applies to parties of 3 or 4.</td>
</tr>
<tr>
<td>Quantity</td>
<td>This value limits the number of reservations available for the Cycles within this timeframe. If you do not create a Seating Limit, the application uses the default value of Unlimited. This value only defines the number allotted and does not represent the current inventory.</td>
</tr>
</tbody>
</table>

6. Click **Save**.
Configuring Target Turn Times

Target Turn Times define the target time from seating to request completion for a seated party. Target Turn Times also affect the following seating-related operations:

- Prevent reservation overbooking
- Estimate wait times for walk-in table requests
- Anticipate the tables that will be available in order to distribute the table seating appropriately

1. In the EMC, select the revenue center, click **Setup** and **Reservation Periods**.
2. Open the reservation period record.
3. Click the General tab and the Target Turn Times tab.
4. Click the **Add** link.
5. Enter information in the Target Turn Times fields:

### Table 20-24 Target Turn Times

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Time</td>
<td>Enter the time when the defined Cover Count and Target Turn Time begins. If you do not create a Target Turn Time, the application uses the default value of 00:00:01.</td>
</tr>
<tr>
<td>End Time</td>
<td>Enter the time when the defined Cover Count and Target Turn Time ends. If you do not create a Target Turn Time, the application uses the default value of 00:00:00.</td>
</tr>
<tr>
<td>Cover Count</td>
<td>Enter the number of covers seated at the table. If you do not create a Target Turn Time, the application uses the default value of Unlimited. The Cover Count value cascades to lower values if you do not set a lower value. For example, if you set a cover count of 4, this cover includes requests for a party of 1 through 4. However, setting a lower capacity of 2 applies to parties of 1 or 2, and the capacity of 4 applies to parties of 3 or 4.</td>
</tr>
</tbody>
</table>
Table 20-24  (Cont.) Target Turn Times

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minutes</td>
<td>Enter the anticipated turn time (in minutes) for a table seating of the defined Cover Count during the specified timeframe. If you do not create a Target Turn Time, the application uses the default value of 60. For example, if you enter 45, table seatings that encompass the defined cover count during the timeframe assume the seating request is 45 minutes in duration.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

Related Topics
- Reservation Periods

Table Management Configuration Levels

The following table shows the hierarchy levels within the Enterprise Management Console (EMC) that allow you to configure table management operations.

Table 20-25  Table Management Configuration Levels

<table>
<thead>
<tr>
<th>Configuration Module</th>
<th>Enterprise</th>
<th>Property</th>
<th>Revenue Center</th>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Dining Table Classes</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Employee Maintenance</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>TMS Parameters</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>TMS Privileges</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reservation Periods</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>TMS Table Attributes</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>KDS/Dining Course Colors</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Loyalty Module</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Page Design Properties</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Seating Section Templates</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Sections</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Tables</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
Reservation Configuration Levels

The following table shows the hierarchy levels within the Enterprise Management Console (EMC) that allow you to configure reservation operations.

Table 20-26 Reservation Configuration Levels

<table>
<thead>
<tr>
<th>Configuration Module</th>
<th>Enterprise</th>
<th>Property</th>
<th>Revenue Center</th>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>TMS Parameters</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TMS Reasons</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Reservation Periods</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS Table Attributes</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Loyalty Module</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Page Design</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

Related Topics

- Reservation List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Configuring Reservation Privileges
- Creating the Front of House Reservation List
- Setting Reservation Timing Parameters

Wait List Configuration Levels

The following table shows the hierarchy levels within the Enterprise Management Console (EMC) that allow you to configure wait list operations.

Table 20-27 Wait List Configuration Levels

<table>
<thead>
<tr>
<th>Configuration Module</th>
<th>Enterprise</th>
<th>Property</th>
<th>Revenue Center</th>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>TMS Parameters</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TMS Reasons</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Reservation Periods</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wait Quote Configuration</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
### Table 20-27  (Cont.) Wait List Configuration Levels

<table>
<thead>
<tr>
<th>Configuration Module</th>
<th>Enterprise</th>
<th>Property</th>
<th>Revenue Center</th>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>TMS Table Attributes</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Loyalty Module</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Page Design</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

#### Related Topics
- Wait List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Configuring Wait List Privileges
- Creating the Front of House Wait List
- Setting Wait List Timing Parameters
You can use the Enterprise Cash Management (ECM) module to track the amount of cash located within a property. You can track the physical currency that is collected and the exact location of funds (for example, in a till, safe, bank deposit, or server bank). ECM follows currency as it progresses through the following phases:

- Enters the building (for example, cash tender, paid-in, or change order received from the bank)
- Moves through the building (for example, from tills to a safe or bank deposit)
- Leaves the building (for example, paid out to a vendor, change given to a guest, or taken to a bank for deposit)

As money flows through the operation, ECM logs all currency actions for reporting and auditing purposes.

- Configuring Data Retention Limits
- Specifying Ad Hoc Reports
- Configuring ECM Privileges
- Allowing Users to View Blind Totals
- Allowing Assigned Receptacle Access
- Configuring Accounting Methods for Users
- Allowing Users to Override Employee Class Options
- Tracking Tender Transaction Items
- Tracking Service Charge Transactions
- Tracking Discount Transactions
- Creating, Editing, and Deleting Cash Management Reasons
- Cash Management Classes
- Adding Transaction Items
- Adding Counting Units
- Cash Pull Threshold Set
- Creating, Editing, and Deleting a Cash Pull Threshold Set
- Cash Count Threshold Set
- Creating, Editing, and Deleting a Cash Count Threshold Set
- PAR Level Set
- Creating, Editing, and Deleting a PAR Level Set
- Count Sheet
- Creating, Editing, and Deleting a Count Sheet
- Adding and Deleting a Page
Configuring Data Retention Limits

You can set the length of time Enterprise Cash Management (ECM) data remains present in the database at the enterprise and property levels.

1. In the Enterprise Management Console (EMC), select the Enterprise level, click **Setup, Enterprise Parameters**, and **Miscellaneous**.

2. In the Purging section, set the **Days To Keep** for ECM Transaction Detail. This is the number of days from the time a transaction is reported to the enterprise that the application retains it for use in reporting and auditing (for example, from 1 day to 999 days). After the number of days to keep expires, a scheduled event purges the ECM data.

3. Click **Save**.
Specifying Ad Hoc Reports

You must assign privileges to the employee to run specific property reports related to active receptacle sessions at the property.

1. In the EMC, select the Enterprise level, click **Configuration** and **Roles**.
2. Select the role type, click **Operations, Ad Hoc Reports**, and **Report Options**.
3. Select the appropriate Enterprise Cash Management (ECM) reports.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Till Report</td>
<td>Provides information about the active till session on the workstation to which the workstation operator running the report is assigned. The printed report shows only values related to the operator’s activity.</td>
</tr>
<tr>
<td>Run Cash Pull Report</td>
<td>Provides a list of cash pull transactions that have been performed for the business day.</td>
</tr>
<tr>
<td>Run Till Banking Report</td>
<td>Provides information about all active till sessions for the location.</td>
</tr>
<tr>
<td>Run Safes Report</td>
<td>Provides information about all active safe sessions for the location.</td>
</tr>
<tr>
<td>Run Paid-In/Paid-Out Report</td>
<td>Provides information about all paid-in and paid-out transactions that were recorded for the business day.</td>
</tr>
<tr>
<td>Run Over/Short Detail Report</td>
<td>Provides information about over and short conditions that were recorded for the business day.</td>
</tr>
<tr>
<td>Run Bank Deposits Report</td>
<td>Provides information about all active bank deposit sessions for the location.</td>
</tr>
<tr>
<td>Run Server Bank Report</td>
<td>Provides information about the active server bank session for the user running the report.</td>
</tr>
<tr>
<td>Run Petty Cash Report</td>
<td>Provides information about all active petty cash sessions for the location.</td>
</tr>
<tr>
<td>Run Server Banking Report</td>
<td>Provides information about all active server banking sessions for the location.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

Configuring ECM Privileges

1. In the EMC, select the Enterprise level, click **Configuration** and **Roles**.
2. Select the role type, click the Operations tab and the Cash Management sub-tab.
3. Select the appropriate options for the privileges. The following table summarizes the privileges associated with ECM functionality and the recommended roles to have the privilege set.
### Table 21-2  ECM Privileges

<table>
<thead>
<tr>
<th>Section</th>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to Perform or Authorize...</th>
<th>Recommended Role(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Operations</td>
<td>249</td>
<td>Change Count Sheet</td>
<td>Changing the count sheet that the receptacle session uses</td>
<td>Manager</td>
</tr>
<tr>
<td>General Operations</td>
<td>250</td>
<td>Pull Cash</td>
<td>A cash pull</td>
<td>Cashier, Manager</td>
</tr>
<tr>
<td>General Operations</td>
<td>258</td>
<td>Threshold Level Exception</td>
<td>A Cash Pull Threshold Exception (bypass the threshold notification) when prompted and permitted</td>
<td>Manager</td>
</tr>
<tr>
<td>General Operations</td>
<td>260</td>
<td>View Receptacle Session Status</td>
<td>Viewing of summary information for all active receptacle sessions</td>
<td>Manager</td>
</tr>
<tr>
<td>General Operations</td>
<td>267</td>
<td>Update Balance on Count</td>
<td>Updating the balance on a count when the amount is outside the count threshold values</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>201</td>
<td>Assign Till to Cash Drawer</td>
<td>Assignment of a till to a cash drawer on a workstation</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>202</td>
<td>Unassign Till from Cash Drawer</td>
<td>Unassignment of a till to a cash drawer on a workstation</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>203</td>
<td>Assign User to Till</td>
<td>Perform or authorize the assignment of an employee to an active till session</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>204</td>
<td>Unassign User from Till</td>
<td>Unassignment of an employee to an active till session</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>205</td>
<td>Count Till</td>
<td>Counting of a till session</td>
<td>Cash Handler</td>
</tr>
<tr>
<td>Section</td>
<td>Option Number</td>
<td>Privilege Name</td>
<td>Allow the Employee to Perform or Authorize...</td>
<td>Recommended Role(s)</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------</td>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Till Operations</td>
<td>206</td>
<td>Adjust Till Count</td>
<td>Adjustment of the last count for a till session</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>207</td>
<td>Paid-In/Paid-Out</td>
<td>Posting of an ECM paid-in or paid-out on a till session Workstation operators can perform standard paid-in and paid-out transactions through Tender/Media configuration.</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>209</td>
<td>Transfer Funds</td>
<td>Transfer of items from a till session to another cash receptacle session</td>
<td>Cashier, Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>210</td>
<td>Deposit Funds</td>
<td>Deposit of cash from a till session to a bank deposit session</td>
<td>Cash Handler</td>
</tr>
<tr>
<td>Till Operations</td>
<td>212</td>
<td>Close Till</td>
<td>Closing of a till session</td>
<td>Cash Handler</td>
</tr>
<tr>
<td>Till Operations</td>
<td>213</td>
<td>Reopen Till</td>
<td>Reopening of a till session</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>251</td>
<td>Quick Start Till</td>
<td>Opening of a till session and assignment of the current operator to a workstation cash drawer</td>
<td>Cash Handler</td>
</tr>
<tr>
<td>Till Operations</td>
<td>259</td>
<td>Adjust Till Starting Amount</td>
<td>Adjustment of the till starting amount</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank</td>
<td>241</td>
<td>Start Server Bank</td>
<td>Opening of a new server bank session</td>
<td>Manager</td>
</tr>
<tr>
<td>Operations</td>
<td>242</td>
<td>Count Server Bank</td>
<td>Counting of a server bank session</td>
<td>Manager</td>
</tr>
<tr>
<td>Section</td>
<td>Option Number</td>
<td>Privilege Name</td>
<td>Allow the Employee to Perform or Authorize...</td>
<td>Recommended Role(s)</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------</td>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>243</td>
<td>Adjust Server Bank Count</td>
<td>Adjustment of the last count for a server bank session</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>265</td>
<td>Adjust Server Bank Starting Amount</td>
<td>Adjustment of the server bank session starting amount</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>244</td>
<td>Paid-In/Paid-Out</td>
<td>Posting of an ECM paid-in or paid-out on a server bank session</td>
<td>Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Workstation operators can perform standard paid-in and paid-out transactions through Tender/Media configuration.</td>
<td></td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>245</td>
<td>Transfer Funds</td>
<td>Transferring of funds from a server bank session to another cash receptacle session</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>246</td>
<td>Deposit Funds</td>
<td>Deposit of cash from a server bank session to a bank deposit session</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>247</td>
<td>Close Server Bank</td>
<td>Closing of a server bank session</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>214</td>
<td>Open Safe</td>
<td>Opening of a new safe session</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>215</td>
<td>Count Safe</td>
<td>Counting of a safe session</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>216</td>
<td>Adjust Safe Count</td>
<td>Adjustment of the last count for a safe session</td>
<td>Manager</td>
</tr>
<tr>
<td>Section</td>
<td>Option Number</td>
<td>Privilege Name</td>
<td>Allow the Employee to Perform or Authorize...</td>
<td>Recommended Role(s)</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>217</td>
<td>Paid-In/Paid-Out</td>
<td>Posting of an ECM paid-in or paid-out on a safe session Workstation operators can perform standard paid-in and paid-out transactions through Tender/Media configuration.</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>218</td>
<td>Transfer Funds</td>
<td>Transferring of funds from a safe session to another cash receptacle session</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>219</td>
<td>Deposit Funds</td>
<td>Deposit of cash from a safe session to a bank deposit session</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>220</td>
<td>Close Safe</td>
<td>Closing of a safe session</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>261</td>
<td>Add Funds to Safe</td>
<td>Adding new funds into ECM through a safe receptacle</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>262</td>
<td>Remove Funds from Safe</td>
<td>Removing funds from ECM through a safe receptacle</td>
<td>Manager</td>
</tr>
<tr>
<td>Petty Cash Operations</td>
<td>222</td>
<td>Open Petty Cash</td>
<td>Opening of a new petty cash session</td>
<td>Manager</td>
</tr>
<tr>
<td>Petty Cash Operations</td>
<td>223</td>
<td>Count Petty Cash</td>
<td>Counting of a petty cash session</td>
<td>Manager</td>
</tr>
<tr>
<td>Petty Cash Operations</td>
<td>224</td>
<td>Adjust Petty Cash Count</td>
<td>Adjustment of the last petty cash session count</td>
<td>Manager</td>
</tr>
<tr>
<td>Section</td>
<td>Option Number</td>
<td>Privilege Name</td>
<td>Allow the Employee to Perform or Authorize...</td>
<td>Recommended Role(s)</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------</td>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Petty Cash Operations</td>
<td>225</td>
<td>Paid-In/Paid-Out</td>
<td>Posting of an ECM paid-in or paid-out on a petty cash session&lt;br&gt;Workstation operators can perform standard paid-in and paid-out transactions through Tender/Media configuration.</td>
<td>Manager</td>
</tr>
<tr>
<td>Petty Cash Operations</td>
<td>226</td>
<td>Transfer Funds</td>
<td>Transferring of funds from a petty cash session to another cash receptacle session</td>
<td>Manager</td>
</tr>
<tr>
<td>Petty Cash Operations</td>
<td>227</td>
<td>Deposit Funds</td>
<td>Deposit of cash from a petty cash session to a bank deposit session</td>
<td>Manager</td>
</tr>
<tr>
<td>Petty Cash Operations</td>
<td>228</td>
<td>Close Petty Cash</td>
<td>Closing of a petty cash session</td>
<td>Manager</td>
</tr>
<tr>
<td>Bank Deposit Operations</td>
<td>233</td>
<td>Create a Bank Deposit</td>
<td>Opening of a new bank deposit session</td>
<td>Manager</td>
</tr>
<tr>
<td>Bank Deposit Operations</td>
<td>234</td>
<td>Transfer Funds</td>
<td>Transferring of funds from a bank deposit to another cash receptacle session</td>
<td>Manager</td>
</tr>
<tr>
<td>Bank Deposit Operations</td>
<td>237</td>
<td>Adjust Cash Deposit</td>
<td>Adjustment of a cash deposit amount in a bank deposit session</td>
<td>Manager</td>
</tr>
<tr>
<td>Bank Deposit Operations</td>
<td>239</td>
<td>Reconcile Bank Deposit</td>
<td>Reconciliation of a bank deposit session</td>
<td>Manager</td>
</tr>
<tr>
<td>Bank Deposit Operations</td>
<td>264</td>
<td>Adjust Bank Deposit Reference</td>
<td>Adjustment of a reference on a bank deposit session</td>
<td>Manager</td>
</tr>
</tbody>
</table>
Table 21-2  (Cont.) ECM Privileges

<table>
<thead>
<tr>
<th>Section</th>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to Perform or Authorize...</th>
<th>Recommended Role(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Operations</td>
<td>230</td>
<td>Create Change Order</td>
<td>Creation of a new Change Order request from a safe session</td>
<td>Manager</td>
</tr>
</tbody>
</table>

4. Click **Save**.

Allowing Users to View Blind Totals

In some cases, you can require that workstation operators view the difference between the amount entered during a count and the amount expected by application transaction activity. Selecting **View Blind Totals** allows workstation operators within the Employee Class to view application expected values and the difference on the count sheet. When an over or short condition exists, the workstation operator can select the reason for the variance.

1. In the EMC, select the property, click **Configuration** and **Employee Classes**.
2. Select the role type and click **Operator Options**.
3. Select **25 - View Blind Totals**.
4. Click **Save**.

Allowing Assigned Receptacle Access

Enterprise Cash Management (ECM) requires that a workstation operator be assigned to a till or server bank receptacle session to perform transactions against the session. Managers need access to work within these receptacle sessions without being assigned to the sessions. You can create an Employee Class for management workstation operators with a configuration set that allows them to perform transactions against the till or server banking session without prior assignment.

1. In the EMC, select the property, click **Configuration** and **Employee Classes**.
2. Select the role type and click **Operator Options**.
3. Select **26 - Allow Assigned Receptacle Access** if you want workstation operators to view and perform transactions for till and server bank receptacles when the operator is not the owner or an assigned user.
4. Click **Save**.

Configuring Accounting Methods for Users

You can specify the type of accounting method a workstation operator uses to track cash management activities. The method you select determines the type of front of house receptacles the workstation operator can access.

1. In the EMC, select the property, click **Configuration** and **Employee Classes**.
2. Select the role type.

3. Select the appropriate **Cash Management Accounting Method** on the General tab:
   - **None** – Selecting this option prevents the workstation operator from executing till or server banking transactions.
   - **Till Banking** – Select this option for workstation operators that maintain and work from a till that is assigned to a workstation (for example, bartenders and cashiers).
   - **Server Banking** – Select this option for workstation operators who maintain and work from an individual server bank on their person (for example, servers who are responsible for accepting payment on guest checks). This accounting method does not allow workstation operators to perform transaction activity on a till session when the operator is an assigned user.

4. Click **Save**.

**Allowing Users to Override Employee Class Options**

You can optionally override Employee Class configuration options for individual workstation operators.

1. In the EMC, select the Enterprise, zone, property, or revenue center, click **Configuration** and **Employee Maintenance**.

2. Select a property and revenue center, and click **Search**.

3. Select **Operator Records**.

4. Select **Override Class Options** for an employee.

5. Select the override options.

<table>
<thead>
<tr>
<th>Table 21-3</th>
<th>Override Employee Class Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Options</td>
<td>When you select <strong>Override Class Options</strong>, the application automatically selects the Operator Options for the employee’s revenue center. You can override the option <strong>25 - View Blind Totals</strong> here.</td>
</tr>
<tr>
<td>Cash Management Accounting Method</td>
<td>When you select a Cash Management accounting method here for an employee, you override the accounting method set in the Employee Class module.</td>
</tr>
<tr>
<td>Cash Drawer</td>
<td>This option indicates the cash drawer that is defined for the workstation operator within the revenue center: 0 (no cash drawer assignment, user prompted), 1, or 2. The Quick Start till operation uses the defined cash drawer.</td>
</tr>
</tbody>
</table>

6. Click **Save**.
Tracking Tender Transaction Items

You can identify tender media transaction items (for example, cash, check, and other currency based tenders) that you want Enterprise Cash Management (ECM) to track.

1. In the EMC, select the Enterprise, zone, or property, click **Configuration** and **Tender/Media**.
2. Double-click the tender media record.
3. Click the Options tab and the Ops Behavior tab.
4. Select the appropriate Tender options.
   - **91 – Cash Management Transaction Item** – Select this option to include the tender record in Cash Management tracking and reporting.
   - **(Optional) 92 – Affects Cash Pull Threshold** – Select this option if you want transactions performed for this tender record to affect the Cash Pull Threshold Set balance. Select this option for tender records that would represent a loss if they are lost or stolen (for example, cash and checks). You must select option 91 to use option 92.
5. Click **Save**.

Related Topics
- Enterprise Cash Management
- ECM Workstation Hardware
- Enterprise Cash Management Configuration Levels

Tracking Service Charge Transactions

You can identify service charge transactions (for example, gift card sales) that you want Enterprise Cash Management (ECM) to track.

1. In the EMC, select the Enterprise, zone, or property, click **Configuration** and **Service Charges**.
2. Double-click the service charge.
3. Select **28 - Cash Management Transaction Item** to include the service charge record in Cash Management tracking and reporting.
4. Click **Save**.

Related Topics
- Enterprise Cash Management
- ECM Workstation Hardware
- Enterprise Cash Management Configuration Levels

Tracking Discount Transactions

You can identify discount transactions (for example, coupons and promotional vouchers) that you want Enterprise Cash Management (ECM) to track.
1. In the EMC, select the Enterprise, zone, or property, click **Configuration** and **Discounts**.

2. Double-click the discount.

3. Select the appropriate discount options on the General tab:
   - **33 - Cash Management Transaction Item** – Select this option to include the discount record in Cash Management tracking and reporting.
   - (Optional) **34 - Affects Cash Pull Threshold** – Select this option if you want transactions performed for this discount record to increase the value in a receptacle. You must select option **33** to use option **34**.

4. Click **Save**.

**Related Topics**
- Enterprise Cash Management
- ECM Workstation Hardware
- Enterprise Cash Management Configuration Levels

## Creating, Editing, and Deleting Cash Management Reasons

Certain Enterprise Cash Management (ECM) operations allow (and sometimes require) the workstation operator to enter a reason for performing the operation. For example, workstation operators must provide a reason for adjusting transactions.

1. In the EMC, select the Enterprise, zone, property, or revenue center, click **Descriptors** and **Cash Management Reasons**.

2. Highlight the Cash Management transaction and select **Add Reason**.

3. Enter the reason name, based on the following guidelines:
   - You can define multiple reasons for each transaction.
   - You can use each reason name only once per transaction type.

4. Click **Save**.

5. If you want to edit a reason, highlight the reason record, change the reason name, and click **Save**.
   
   After you change a reason, the new reason appears when viewing historical reporting activity.

6. If you want to delete a reason, highlight the reason record and select **Delete Reason**.
   
   The application allows you to delete only reasons that are not referenced in historical reporting activity.

## Cash Management Classes

You can configure a Cash Management class for the type of records you want to track in ECM. You must define a class for the currency to be accepted, and to track non-cash items in ECM (for example, credit card vouchers, gift cards, and coupons).

Within the Cash Management class, you can specify unique counting units associated with the transaction items within the class (for example, bank notes and coins).
Adding Transaction Items

You must map transaction items (for example, tenders) to the Cash Management class to measure their impact (increase or decrease) on the balance of all transactions. Enterprise Cash Management (ECM) tracks only transaction items that are mapped to the class.

1. In the EMC, select the Enterprise, zone, property, or revenue center, click Setup and Cash Management Classes.
2. Insert a Cash Management class record and then double-click it.
3. Select Transaction Items.
4. Enter the name of the class to track in ECM (for example, Cash, US Dollars, Vouchers, and so on).
5. Select an available Currency from the list to associate with the Cash Management class. You can only associate the currency with a single class. Select 0 - None for non-currency tracking (for example, vouchers and stored value cards) as these items are always based on the property’s local currency.
6. Select Allow in Bank Deposit if you want transaction items mapped with this Cash Management class to be included in bank deposits (for example, cash, personal checks, and travelers checks).
7. Select Add Transaction Item.
8. Select a Transaction Item Type.
9. Select a Transaction Item. The Cash Management Transaction Item options in the tender, service charge, or discount determine the items that appear in this Transaction Item list. You can use each transaction item only once per class.
10. Click Save.

Related Topics
- Cash Management Classes

Adding Counting Units

After you add a denomination unit to a Cash Management class, Enterprise Cash Management (ECM) includes the unit when building Count Sheets and PAR Level Sets. The following figure shows an example of the units mapping setup.
1. Select **Counting Units**.

2. Select **Add Unit**.

3. Enter the name of the unit (for example, Pennies, Fives, Twenties, Travelers Checks, and so on).

4. When you select **Denominated**, the unit has a consistent cash value (for example, notes and coins). Do not select this option for this transaction items that have inconsistent cash values (for example, personal checks, credit cards, and gift cards).

5. If the unit is denominated, the **Numerator** defines the units value relative to the base currency unit. For example, when the base currency is US dollars, the base currency unit is 1 ($1.00).

6. If the unit is denominated, the **Denominator** defines the number of units relative to the base currency unit. For example, when the base currency is US dollars, the base currency unit is 1 ($1.00).

7. After you enter the numerator and denominator, the **Value** field shows the calculated value per unit.

8. Click **Save**.

**Related Topics**

- **Cash Management Classes**

---

**Cash Pull Threshold Set**

The Cash Pull Threshold Set optionally provides a group of balance-based levels to compare against a till or server banking session during a transaction. The threshold set indicates when notifications should take place for cash pulls to minimize the risk by limiting the amount of cash circulating in the front of house. You can add one or more threshold levels to a Cash Pull Threshold Set.

**Related Topics**

- **Creating, Editing, and Deleting a Cash Pull Threshold Set**
Creating, Editing, and Deleting a Cash Pull Threshold Set

1. In the EMC, select the Enterprise, zone, property, or revenue center, click Setup and Cash Pull Threshold Sets.

2. Insert a record, enter the name of the Cash Pull Threshold Set and click OK.

3. Double-click the record to open it.

4. Enter the Chit Quantity.

   This is the number of chits that print when a workstation operator performs a cash pull. A cash pull chit represents the funds that are removed from the till or server bank.

5. Select Add and then enter the name of the threshold set.

   The name is part of the notification that appears in the application.

6. Enter the Amount.

   This is the amount-based threshold that elevates the cash pull notification to the threshold level. If you configure more than one threshold level, subsequent amounts cannot be equal to or lower than the previous cash pull amount in the same set.

7. When you select Approval, a workstation operator with the Threshold Level Exception privilege can authorize the operator to ignore the exception and allow them to process transactions against the receptacle without performing a cash pull.

8. Click Save.

9. If you want to edit a cash pull threshold set, highlight the record, change the values, and click Save.

   You cannot edit the last defined level. This requires the workstation operator to perform a cash pull first in order to execute additional activities against the till or server bank later.

10. If you want to delete a cash pull threshold set, highlight the record and select Delete.

    You cannot delete a Cash Pull Threshold Set associated with one or more templates.

Related Topics

- Cash Pull Threshold Set

Cash Count Threshold Set

The Cash Count Threshold Set optionally provides an allowable variance threshold for countable receptacles. The threshold is the difference between counted totals and expected totals. The threshold indicates the overage and shortage amounts allowed to complete a receptacle count. You can add one or more cash count threshold sets to a count sheet.

Related Topics

- Creating, Editing, and Deleting a Cash Count Threshold Set
Creating, Editing, and Deleting a Cash Count Threshold Set

1. In the EMC, select the Enterprise, zone, property, or revenue center, click **Setup** and **Cash Count Threshold Sets**.

2. Add a Cash Count Threshold Set, enter the name, and click **OK**.

3. Enter the **Short** amount.
   This value is the minimum variance amount allowed to complete the receptacle count.

4. Enter the **Over** amount.
   This value is the maximum variance amount allowed to complete the receptacle count.

5. Enter the number of **Max Count Attempts**.
   This value limits the number of times a workstation operator can attempt to submit a count when the count is over or short beyond the defined threshold.

6. Click **Save**.

7. If you want to edit a cash count threshold set, highlight the record, change the values, and click **Save**.

8. If you want to delete a cash count threshold set, highlight the record and select **Delete**.
   You cannot delete a Cash Count Threshold Set associated with one or more templates.

**Related Topics**
- **Cash Count Threshold Set**

PAR Level Set

Periodic Automatic Replenishment (PAR) Level Sets specify the suggested quantity to maintain of each currency denomination kept in a safe (for example, rolls of coins or quantity of a denominated note). PAR Level Sets are comprised of count units drawn from the list of denominated items in a Cash Management class. The PAR determines the values required when issuing a Change Order request to return the receptacle back to the PAR based on the last known count of the receptacle. The use of a PAR Level Set is optional.

**Related Topics**
- **Creating, Editing, and Deleting a PAR Level Set**

Creating, Editing, and Deleting a PAR Level Set

1. In the EMC, select the Enterprise, zone, property, or revenue center, click **Setup** and **PAR Level Sets**.

2. Insert a record and enter the **PAR Level Set** name.

3. Double-click the record to open it.
4. Select the **CM Class**.
   
   The **CM Class** list includes all Cash Management classes that you created. These Cash Management classes contain the units that are allowed within the PAR Level Set.

5. Add a Counting Unit using one of the following methods:
   
   - Select **Add All Units** to have ECM add all defined units for the Cash Management class to the PAR Level.
   - Select **Add Unit** to manually add specific units.

6. For each of the defined units, enter the quantity of units to maintain as part of the PAR Level Set for each day of the week.

7. Click **Save**.

8. If you want to edit a PAR Level Set, highlight the record, change the values, and click **Save**.

9. If you want to delete a PAR Level Set, highlight the record and select **Delete**.
   
   You cannot delete a PAR Level Set associated with one or more templates.

**Related Topics**

- PAR Level Set

---

## Count Sheet

A workstation operator uses a Count Sheet during the physical counting of a receptacle session. Create unique Count Sheets to determine the items and order in which a count is performed, as well as the format for the printed Count Sheet results. Creating a Count Sheet is similar to building a report.

**Related Topics**

- Creating, Editing, and Deleting a Count Sheet
- Adding and Deleting a Page
- Adding and Deleting a Group
- Adding and Deleting a Unit
- Sorting and Modifying the Order of Pages, Groups, and Units
- Viewing the Totals Page

## Creating, Editing, and Deleting a Count Sheet

1. In the EMC, select the Enterprise, zone, property, or revenue center, click **Setup** and **Count Sheets**.

2. Insert a record, enter a unique name for the Count Sheet, and click **OK**.

3. Click **Save**.

4. If you want to edit a count sheet, highlight the count sheet record, change the values, and click **Save**.
   
   When you change a count sheet, the application removes all units associated with the group.
5. If you want to delete a count sheet, highlight the record and select **Delete**.

You cannot delete a Count Sheet associated with one or more templates.

**Related Topics**

• Count Sheet

### Adding and Deleting a Page

A Count Sheet Page is similar to a chapter in a report. Pages allows you to see totals for all values counted within the page.

1. Select **Add** in the Pages section.
2. Enter a name for each page (for example, Cash and Vouchers).
3. If you want to delete a page, highlight the page name record and select **Delete**.
   
   The application deletes all units associated with a group for the selected page along with the page.
4. Click **Save**.

**Related Topics**

• Count Sheet

### Adding and Deleting a Group

Transaction Items are reported in Count Sheet Groups. Groups also allow you to see totals for all values counted within the group.

1. Highlight a page.
2. Select **Add** in the Groups section.
3. Enter a name for each group. As an example, you can have a Cash page with the groups Notes (paper currency) and Coins.
4. Select the Cash Management Class for each group. When you select a value from the **Class** drop-down, the Name column shows the name of the class if it was not previously entered. Change the Name value to show its representation on the count sheet screen view and print copy.
5. Select the appropriate Group options.
### Table 21-4  Count Sheet Group Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Allow Multiple Entries (optional)</td>
<td>Selecting this option allows unique entry of certain items (for example, gift cards and checks). If you select <strong>1 - Allow Multiple Entries</strong>, the Group provides a multiple entry list when performing a count. This type of count is used to include non-denominated transaction items such as personal checks or gift cards as part of a count, where the amount of each individual item must be tracked (for example, check and gift card amounts).</td>
</tr>
<tr>
<td>2 - Reference Required (optional)</td>
<td>If you select <strong>2 - Reference Required</strong>, Ops prompts the workstation operator to enter a reference on the count sheet (for example, gift card number, personal check number, credit card, or voucher number) for each amount entered.</td>
</tr>
</tbody>
</table>

6. Add other groups that you want to track as part of this page.

7. If you want to delete a group, highlight the group record and select **Delete**. The application deletes all units associated with a group along with the group.

8. Click **Save**.

**Related Topics**
- Count Sheet

---

### Adding and Deleting a Unit

A unit is optional but recommended for groups that report based on counting units. If you do not add a unit, a Total entry appears for the group.

1. Select a group.

2. Select **Add** in the Units section to add all units to be counted as part of this group.

3. Select the **Unit Type** for each unit. Only the Unit Types associated with the Cash Management class for the group are available in the Units list. When you select a value from the Units drop-down, the Name column shows the name of the unit selected. Change the Name value to show its representation on the count sheet screen view and print copy. You can use each Unit Type only once on a page.

4. To delete a unit, highlight a unit row and select **Delete Unit**.

**Related Topics**
- Count Sheet
Sorting and Modifying the Order of Pages, Groups, and Units

Use the up and down arrows to sort and alter the order in which pages, groups on a page, and units within a group appear on the screen view and printed Count Sheet.

All units that are part of the selected group remain with the group as it moves. Units that are part of groups for the selected page remain with the page as it moves. Groups that are part of the selected page remain with the page as it moves.

Related Topics
• Count Sheet

Viewing the Totals Page

At the end of the Count Sheet, a Totals page represents the values entered for all classes. The overall balance of the Count Sheet is based on the configured Balancing Class.

Related Topics
• Count Sheet

Creating, Editing, and Deleting an Account

You can use accounts to report general ledger accounting information for Enterprise Cash Management (ECM) paid-in and paid-out transactions (for example, produce, meat, bakery, or flower shop).

1. In the EMC, select the Enterprise, zone, property, or revenue center, click Setup and Accounts.
2. Insert a record, enter a unique name for the account, and click OK.
3. Select Deactivate Account to deactivate or suspend an account that is no longer being used. A newly created account is active by default.
4. If you want to edit an account, highlight the record, change the values, and click Save.
5. If you want to delete an account, highlight the record and select Delete.
   The application only allows you to delete accounts that are not referenced in historical reporting activity. If an account is assigned to a vendor, you cannot delete it. You can unassign the account from the vendor.
6. Click Save.

Creating, Editing, and Deleting a Vendor

You can use a vendor to associate companies with Enterprise Cash Management (ECM) paid-in and paid-out transactions for reporting purposes.
1. In the EMC, select the Enterprise, zone, property, or revenue center, click Setup and Vendors.

2. Insert a record, enter a unique name for the vendor, and click OK.

3. (Optional) Select an account from the drop-down list to associate with the vendor. The vendor always uses the selected account for any ECM paid-in or paid-out transactions.

4. Select the appropriate vendor options.

Table 21-5 Vendor Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Deactivate Vendor</td>
<td>A newly created vendor is active by default. Select this option to prevent further selection of the vendor when performing transactions. For example, you can use this option to place a credit hold.</td>
</tr>
<tr>
<td>2 - Invoice Data Required (optional)</td>
<td>Select this option to require the workstation operator to enter invoice information (for example, Date, Invoice Number, and Description) when performing a transaction for the vendor that can collect invoice data (for example, paid-out).</td>
</tr>
<tr>
<td>3 - Require Reference on Use</td>
<td>Select this option to require the workstation operator to enter a reference when performing a transaction that requires a vendor.</td>
</tr>
</tbody>
</table>

5. If you want to edit a vendor, highlight the record, change the values, and click Save.

6. If you want to delete a vendor, highlight the record and select Delete. The application only allows you to delete vendors that are not referenced in historical reporting activity.

7. Click Save.

Creating and Editing a Template

You must use a template to set the initial configuration and operating values for all new receptacle tracking sessions. This includes setting the amount, assigning a count sheet, and specifying how the application handles the opening balance after the workstation operator closes the receptacle.

1. In the EMC, select the Enterprise, zone, property, or revenue center, click Setup and Templates.

2. Insert a template record with a unique name and click OK.

3. Double-click the template record to open it.

4. Enter or select information in the following fields:
   
   - **Description** – The optional Description field in a template provides further understanding of the template that might not be distinguishable by looking at the template name. The Description is not shown as part of the receptacle when the workstation operator opens the receptacle from a template.
- **Receptacle Type** – Depending on your Receptacle Type selection, additional fields are available. The following table describes the fields and receptacle types.

### Table 21-6 Template Receptacle Types and Fields

<table>
<thead>
<tr>
<th>Field or Option</th>
<th>Safe</th>
<th>Till</th>
<th>Server Bank</th>
<th>Bank Deposit</th>
<th>Petty Cash</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Amount</td>
<td>Optional</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Starting Amount Source</td>
<td>Required</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prompt for Starting Amount</td>
<td>Optional</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cash Pull Threshold</td>
<td>Optional</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cash Pull Destination</td>
<td>Optional</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count Sheet</td>
<td>Required</td>
<td>Required</td>
<td>Required</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>PAR Level</td>
<td>Optional</td>
<td>Required</td>
<td>Required</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>Maximum</td>
<td></td>
<td>Required</td>
<td>Required</td>
<td>Required</td>
<td></td>
</tr>
<tr>
<td>Minimum</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Required</td>
</tr>
<tr>
<td>Cash Deposit Routing</td>
<td>Optional</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Start Amount** – The starting amount determines the initial currency value of the session upon opening.

- **Starting Amount Source** – The starting amount source determines where the starting amount for the session originates. If you select **None**, the starting amount is considered to be part of the receptacle and funds are not transferred from a source receptacle session. For example, a server who self funds a bank does not receive a funds transfer from the safe when opening the bank. Selecting a defined safe transfers the starting amount from the safe session to the receptacle session upon opening.

- **Prompt for Starting Amount** – Select this option to prompt the workstation operator to enter the starting amount for the receptacle session upon opening. When you select this option, the application ignores the value in the starting amount field.

- **Cash Pull Threshold** – This field defines the Cash Pull Threshold Set that a receptacle session uses. If you set cash pull values, select a threshold set from the drop-down list to be used for the template.

- **Cash Pull Destination** – Select a destination receptacle into which funds from cash pull operations will transfer; if you select **None**, funds do not transfer and ownership remains with the receptacle session.

- **Count Sheet** – The Count Sheet value in a template determines the Count Sheet that is used to count the receptacle.
• **Cash Count Threshold** – This field defines the Cash Count Threshold Set that a receptacle session uses. If you set cash count values, select a Threshold Set from the drop-down list to be used for the template.

• **Close on Count Completion** – Select this option to have the application attempt to automatically reconcile the receptacle session upon completion of the count. This process transfers funds from the receptacle session to the sessions designated under Starting Amount Source and Cash Deposit Routing to bring the session to zero. When you deselect this option, the session remains open after the count completes. The workstation operator must manually reconcile all funds and close the receptacle.

• **PAR Level** – The PAR Level defines the PAR Level Set to use for the safe session.

• **Maximum** – The Maximum balance determines the largest amount of funds permitted as part of a receptacle session. The application prevents workstation operators from processing most activity that takes the session balance beyond this amount. If you do not set a maximum balance, it defaults to 0 (no maximum).

• **Minimum** – The Minimum balance determines the lowest amount of funds permitted as part of a receptacle session. The application prevents workstation operators from processing most activity that takes the session balance below this amount. If you do not set a minimum balance, the application defaults to 0 (no minimum).

• **Cash Deposit Routing** – Select the destination receptacle (safe or bank deposit) session to receive funds that transfer from a receptacle session as part of a cash deposit operation. When you select **None**, the application prompts the workstation operator to select a location to deposit cash.

5. If you want to edit a template, highlight the template record, change the values and click **Save**.

### Creating, Editing, and Deactivating Receptacles

A receptacle represents a physical or virtual location used to store funds and draw transactions.

1. In the EMC, select the Enterprise, zone, property, or revenue center, click **Setup** and **Receptacles**.

2. Insert a record, enter a unique name for the receptacle, and click **OK**.

3. Enter or select information in the receptacle fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receptacle Type</td>
<td>Select the type of receptacle:</td>
</tr>
<tr>
<td></td>
<td>• 0 - None</td>
</tr>
<tr>
<td></td>
<td>• 1 - Safe</td>
</tr>
<tr>
<td></td>
<td>• 2 - Till</td>
</tr>
<tr>
<td></td>
<td>• 3 - Server Bank</td>
</tr>
<tr>
<td></td>
<td>• 4 - Bank Deposit</td>
</tr>
<tr>
<td></td>
<td>• 5 - Petty Cash</td>
</tr>
</tbody>
</table>
Table 21-7  (Cont.) Receptacle Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template Name</td>
<td>Select the template to use for this receptacle.</td>
</tr>
<tr>
<td>Location</td>
<td>Select the location where the receptacle is defined. The location allows you to specify a receptacle name and configuration to be used in multiple locations. If you select Property, a receptacle is defined for each property based on the values entered. If you select Revenue Center, a receptacle is defined within each revenue center. For example, each property has one safe to maintain all cash transactions for the entire property. Create a safe receptacle from the enterprise or zone, and specify property in the Location field. The safe receptacle is defined at all properties under the chosen level. The Location field allows you to define a receptacle type that is commonly used across an enterprise or region without uniquely defining it at each property or revenue center.</td>
</tr>
<tr>
<td>Options</td>
<td>Selecting Deactivate Receptacle prevents workstation operators from performing further activity against the receptacle.</td>
</tr>
</tbody>
</table>

4. If you want to edit a receptacle, highlight the record, change the values, and click Save.

5. If you want to deactivate a receptacle, highlight the record and select Deactivate Receptacle.

Deleting a receptacle is not permitted.

6. Click Save.

Setting Cash Management Parameters

1. In the EMC, select the Enterprise, zone, property, or revenue center, click Setup and Cash Management Parameters.

2. Click the Configuration tab.

3. Enter or select the appropriate information in the Cash Management Parameters fields.
Table 21-8  Cash Management Parameters Configuration Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash Pull Notification Frequency</td>
<td>This value determines when the application notifies workstation operators of the cash pull threshold levels being reached or exceeded.</td>
</tr>
<tr>
<td></td>
<td>• 0-None – Cash pull notifications are disabled (default); workstation operators can use the manual process for cash pulls.</td>
</tr>
<tr>
<td></td>
<td>• 1-On Threshold Level Only – Notify the workstation operator once upon reaching or exceeding a defined threshold level in the Threshold Level Set.</td>
</tr>
<tr>
<td></td>
<td>• 2-On Each Transaction – Notify the workstation operator with each new check access attempt upon reaching or exceeding a defined threshold level in the Threshold Level Set.</td>
</tr>
<tr>
<td>Receptacle Balancing Class</td>
<td>Select the class that is based on the currency in which the location operates. All transaction items included in the Cash Management class selection determine the appearance of the receptacle balance on views and reports.</td>
</tr>
<tr>
<td>Change Order Report Count</td>
<td>This value determines the number of reports to print when a workstation operator creates a new Change Order request.</td>
</tr>
<tr>
<td>Counting Method</td>
<td>Select the method in which the workstation operator must enter counting units when performing a count or change order.</td>
</tr>
<tr>
<td></td>
<td>• 1-Quantity – The workstation operator must enter the quantity of the counting units. The application calculates the value based on the quantity entered for the associated counting unit.</td>
</tr>
<tr>
<td></td>
<td>• 2-Value – The workstation operator must enter the value of the counting units. The application calculates the quantity based on the value entered for the associated counting unit.</td>
</tr>
<tr>
<td>Paid-In/Paid-Out Chit Count</td>
<td>This value determines the number of chits to print when the workstation operator performs an ECM paid-in or paid-out transaction.</td>
</tr>
<tr>
<td>Server Banking Template</td>
<td>Select the default template to use when a workstation operator opens a new server banking session. You can override this setting in the Employee Classes module.</td>
</tr>
</tbody>
</table>

4. Click the Options tab.
5. Select the appropriate Cash Management Parameter options.
Table 21-9  Cash Management Parameter Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Enable Cash Management</td>
<td>This option activates all ECM features and functions in the application. Selecting <strong>Enable Cash Management</strong> increases both required workstation resources and bandwidth for communications with the Enterprise. You can define all ECM configurations without selecting this option. This allows you to configure ECM beforehand and activate ECM with a single option.</td>
</tr>
<tr>
<td>11 - Require Reason on Adjust Starting Amount</td>
<td>Select this option to require the workstation operator to select a reason code when adjusting a starting amount.</td>
</tr>
<tr>
<td>12 - Require Reason on Adjust Count</td>
<td>Select this option to require the workstation operator to select a reason code when adjusting a previously entered count.</td>
</tr>
<tr>
<td>13 - Require Reason on Adjust Cash Deposit</td>
<td>Select this option to require the workstation operator to select a reason code when adjusting a cash deposit transaction.</td>
</tr>
<tr>
<td>14 - Require Reason on Paid-In</td>
<td>Select this option to require the workstation operator to select a reason code when performing a paid-in transaction.</td>
</tr>
<tr>
<td>15 - Require Reason on Paid-Out</td>
<td>Select this option to require the workstation operator to select a reason code when performing a paid-out transaction.</td>
</tr>
<tr>
<td>16 - Require Reason on Transfer</td>
<td>Select this option to require the workstation operator to select a reason code when transferring funds from one receptacle to another.</td>
</tr>
<tr>
<td>17 - Require Reason on Adjust Bank Deposit Reference</td>
<td>Select this option to require the workstation operator to select a reason code when adjusting a bank deposit reference.</td>
</tr>
<tr>
<td>20 - Require Deposit Reference</td>
<td>Select this option to require the workstation operator to select a reason code when creating a new bank deposit.</td>
</tr>
<tr>
<td>21 - Require Reference for Receptacle Counts</td>
<td>Select this option to require the workstation operator to enter a reference when counting a receptacle.</td>
</tr>
<tr>
<td>24 - Require Reference for Cash Pull</td>
<td>Select this option to require the workstation operator to enter a reference when performing a cash pull.</td>
</tr>
<tr>
<td>25 - Require Reason on Over/Short</td>
<td>Select this option to require the workstation operator to enter a reason code when posting an operation that finds a variance in values.</td>
</tr>
</tbody>
</table>
### Table 21-9  (Cont.) Cash Management Parameter Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>26 - Allow Count of Assigned Till</td>
<td>Select this option to allow the workstation operator to count a till that is assigned to a workstation. When you deselect it, you unassign the till from the workstations to count. After upgrading to Simphony version 2.7 MR2, existing customers who want to continue to count assigned tills need to set this option.</td>
</tr>
<tr>
<td>27 - Require Check Closed Before Receptacle Close</td>
<td>Select this option to allow the workstation operator to close a till or server banking session only after all checks with assigned users as the check owner are closed. The operator must close all open checks before closing the till or server banking session.</td>
</tr>
<tr>
<td>28 - Restrict a Single User per Till</td>
<td>Select this option to restrict a till session to only allow a single user. When the workstation operator has option 26 – Allow Assigned Receptacle Access set in the Employee Class, the Allow All button is exposed to the operator during the assignment operation.</td>
</tr>
<tr>
<td>29 - Save Count Progress</td>
<td>Select this option to allow the workstation operator to save an incomplete count sheet when counting a receptacle session.</td>
</tr>
</tbody>
</table>

### Creating Front of House Screens

Oracle Hospitality recommends that you create a page with tabs on which to place the Enterprise Cash Management (ECM) functions. Create and configure tabs to expose operations by receptacle type. Create buttons on the page for the required ECM functions listed. The following figure shows an example of a page with ECM functions created in the Page Design module.
2. On each tab, create buttons for each of the functions listed in the following table.

**Table 21-10 ECM Front of House Tabs and Buttons**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safe</td>
<td>Add Funds</td>
<td>Add money to the safe.</td>
</tr>
<tr>
<td></td>
<td>Adjust Count</td>
<td>Correct values from the previous count.</td>
</tr>
<tr>
<td></td>
<td>Change Count Sheet</td>
<td>Adjust the count sheet that workstations operators use to perform a count.</td>
</tr>
<tr>
<td></td>
<td>Close Receptacle</td>
<td>Close the safe’s tracking session.</td>
</tr>
<tr>
<td></td>
<td>Count Receptacle</td>
<td>Count the money in the safe.</td>
</tr>
<tr>
<td></td>
<td>Deposit Cash</td>
<td>Deposit cash into the safe.</td>
</tr>
<tr>
<td></td>
<td>Open New Change Order Request</td>
<td>Open a Change Order when a safe is low on a particular denomination or to stock up for an event.</td>
</tr>
<tr>
<td></td>
<td>Open New Receptacle</td>
<td>Open a new safe tracking session.</td>
</tr>
<tr>
<td></td>
<td>Paid-In</td>
<td>Accept funds for the safe outside of a guest check.</td>
</tr>
<tr>
<td></td>
<td>Paid-Out</td>
<td>Distribute funds from the safe outside of a guest check.</td>
</tr>
<tr>
<td></td>
<td>Remove Funds</td>
<td>Remove money from a safe session and from tracking.</td>
</tr>
<tr>
<td>Tab</td>
<td>Button Name</td>
<td>Function</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bank Deposit</td>
<td>Transfer Funds</td>
<td>Transfer money from the safe to another receptacle.</td>
</tr>
<tr>
<td></td>
<td>Adjust Bank Deposit</td>
<td>Change the reference of a bank deposit session.</td>
</tr>
<tr>
<td></td>
<td>Reference</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Adjust Cash Deposit</td>
<td>Change the amount of a cash deposit that was placed into the bank deposit session.</td>
</tr>
<tr>
<td></td>
<td>Open New Receptacle</td>
<td>Open a new bank deposit tracking session.</td>
</tr>
<tr>
<td></td>
<td>Reconcile Bank Deposit</td>
<td>Close the bank deposit.</td>
</tr>
<tr>
<td></td>
<td>Transfer Funds</td>
<td>Transfer money from the bank deposit to another receptacle.</td>
</tr>
<tr>
<td>Till</td>
<td>Adjust Count</td>
<td>Correct values from the previous count.</td>
</tr>
<tr>
<td></td>
<td>Adjust Till Starting Amount</td>
<td>Change the starting amount of a till session after opening it.</td>
</tr>
<tr>
<td></td>
<td>Assign Till to Cash Drawer</td>
<td>Assign a till to a cash drawer.</td>
</tr>
<tr>
<td></td>
<td>Assign User(s) to Till</td>
<td>Assign one or more operators to the till session on the workstation.</td>
</tr>
<tr>
<td></td>
<td>Change Count Sheet</td>
<td>Adjust the count sheet that workstations operators use to perform a count.</td>
</tr>
<tr>
<td></td>
<td>Close Receptacle</td>
<td>Close the till's tracking session.</td>
</tr>
<tr>
<td></td>
<td>Count Receptacle</td>
<td>Count the money in the till.</td>
</tr>
<tr>
<td></td>
<td>Deposit Cash</td>
<td>Deposit cash into the till.</td>
</tr>
<tr>
<td></td>
<td>Paid-In</td>
<td>Accept funds for the till outside of a guest check.</td>
</tr>
<tr>
<td></td>
<td>Paid-Out</td>
<td>Distribute funds from the till outside of a guest check.</td>
</tr>
<tr>
<td></td>
<td>Pull Cash</td>
<td>Remove cash from the till session.</td>
</tr>
<tr>
<td></td>
<td>Quick Start Till</td>
<td>Quickly assign a workstation operator and till to a cash drawer on the workstation.</td>
</tr>
<tr>
<td></td>
<td>Transfer Funds</td>
<td>Transfer money from the till to another receptacle.</td>
</tr>
<tr>
<td></td>
<td>Unassign Till from Cash Drawer</td>
<td>Restrict the till to a limited number of operations. This function does not close the till.</td>
</tr>
</tbody>
</table>
Table 21-10 EC Front of House Tabs and Buttons

<table>
<thead>
<tr>
<th>Tab</th>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Unassign User(s) from Till</td>
<td>Prevent the workstation operator from performing transactions on the till. This function does not close the till.</td>
</tr>
<tr>
<td>Server Bank</td>
<td>Adjust Count</td>
<td>Correct values from the previous count.</td>
</tr>
<tr>
<td></td>
<td>Adjust Server Bank Starting Amount</td>
<td>Change the starting amount of a till session after opening it.</td>
</tr>
<tr>
<td></td>
<td>Close Receptacle</td>
<td>Close the server bank's tracking session.</td>
</tr>
<tr>
<td></td>
<td>Count Receptacle</td>
<td>Count the money in the server bank.</td>
</tr>
<tr>
<td></td>
<td>Deposit Cash</td>
<td>Deposit cash into the server bank.</td>
</tr>
<tr>
<td></td>
<td>Paid-In</td>
<td>Accept funds for the server bank outside of a guest check.</td>
</tr>
<tr>
<td></td>
<td>Paid-Out</td>
<td>Distribute funds from the server bank outside of a guest check.</td>
</tr>
<tr>
<td></td>
<td>Pull Cash</td>
<td>Remove cash from the server bank session.</td>
</tr>
<tr>
<td></td>
<td>Transfer Funds</td>
<td>Transfer money from the server bank to another receptacle.</td>
</tr>
<tr>
<td>General</td>
<td>View Receptacle Status</td>
<td>Look at summary information for all receptacle sessions.</td>
</tr>
<tr>
<td></td>
<td>Till Assignment Status (Smart Key)</td>
<td>Determine whether a till is assigned to a cash drawer on the workstation.</td>
</tr>
</tbody>
</table>

Related Topics
- Configuring a Till Through Extensibility

Configuring a Smart Key on a Workstation

A smart key prevents the use of a workstation until you assign a till session to a cash drawer on the workstation. After assignment, the key permits the workstation operator to sign into the workstation. Follow these steps to implement the optional smart key.

1. In the EMC, select the Enterprise, zone, property, or revenue center, click **Configuration** and **Page Design**.
2. Select the Sign In Page.
3. On the Edit tab, click **Button**.
4. Enter information in the Page Design fields.
Table 21-11  Page Design Edit Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend</td>
<td>Enter the name of the button (for example, Till Status).</td>
</tr>
<tr>
<td>Type</td>
<td>Select Function from the drop-down list.</td>
</tr>
<tr>
<td>Sub Type</td>
<td>Click the black arrow, and then select Smart Key.</td>
</tr>
<tr>
<td>Auto Active</td>
<td>Select this option to make the button automatically active.</td>
</tr>
</tbody>
</table>

5. Click the **Edit Smart Keys** button.

6. Click **Add**.

7. Enter information in the fields as described in the following table for Smart Key entry number 1.

Table 21-12  Smart Key 1 Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Select Till Assigned from the drop-down list.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter 1.</td>
</tr>
<tr>
<td>Legend</td>
<td>Enter the name of the button (for example, Sign In).</td>
</tr>
<tr>
<td>Type</td>
<td>Select Function from the drop-down list.</td>
</tr>
<tr>
<td>Sub Type</td>
<td>Click the black arrow, and then select Sign-In.</td>
</tr>
</tbody>
</table>

8. Click **Add**.

9. Enter information in the fields as described in the following table for Smart Key entry number 2.

Table 21-13  Smart Key 2 Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Select Default from the drop-down list.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter 2.</td>
</tr>
<tr>
<td>Legend</td>
<td>Enter the name of the button (for example, Assign Till).</td>
</tr>
<tr>
<td>Type</td>
<td>Select Function from the drop-down list.</td>
</tr>
<tr>
<td>Sub Type</td>
<td>Click the black arrow, and then select Assign Till To Cash Drawer.</td>
</tr>
</tbody>
</table>

10. Click **Close**.

11. Click **Save**.

Related Topics
* Configuring a Till Through Extensibility
Configuring a Till Through Extensibility

ECM provides the **Designate till number during assignment** capability through extensibility. When you set the InitiatingCommand.Arguments to a valid receptacle object number, the application attempts to use that till when assigning a till to a workstation. If the till is not found or is assigned to another workstation, the application prompts the workstation operator for the till to assign.

**Related Topics**
- Creating Front of House Screens
- Configuring a Smart Key on a Workstation

ECM Reporting

Enterprise Cash Management (ECM) reporting for receptacles and activity is available at the Enterprise and property hierarchy levels.

**Related Topics**
- Assigning Enterprise Reports
- Creating ECM Property Reports

ECM Enterprise Reports

Enterprise reports provide information about active and completed receptacle sessions for the Enterprise in Oracle Hospitality Reporting and Analytics, including the reports listed in the following table. These reports contain drill-down options to allow simple auditing for all receptacle tracking sessions related to the report.

**Table 21-14 ECM Enterprise Reports**

<table>
<thead>
<tr>
<th>Report</th>
<th>Contains Information About</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safe Report</td>
<td>All safe sessions (regardless of their state) for the selected location and business date</td>
</tr>
<tr>
<td>Petty Cash Report</td>
<td>All petty cash sessions (regardless of their state) for the selected location and business date</td>
</tr>
<tr>
<td>Till Report</td>
<td>All till sessions (regardless of their state) for the selected location and business date</td>
</tr>
<tr>
<td>Bank Deposit Report</td>
<td>All bank deposit sessions (regardless of their state) for the selected location and business date</td>
</tr>
<tr>
<td>Count Adjustment Report</td>
<td>Count adjustments that were performed for any receptacle tracking session for the selected properties</td>
</tr>
<tr>
<td>Starting Amount Adjustment Report</td>
<td>Adjustments to starting amounts that were defined for any receptacle session for the selected location and business date</td>
</tr>
<tr>
<td>Over/Short Detail Report</td>
<td>Over and short conditions that were reported for receptacle session for the selected location and business date</td>
</tr>
<tr>
<td>Paid-In/Paid-Out Report</td>
<td>Paid-in and paid-out transactions that were reported for any receptacle tracking sessions for the selected properties</td>
</tr>
</tbody>
</table>
Table 21-14  (Cont.) ECM Enterprise Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Contains Information About</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Report</td>
<td>All transactions and operations that were performed for receptacle sessions. All transactions and operations are listed chronologically, allowing an auditor to view an exact account of all activities performed from open to close for the receptacle session.</td>
</tr>
</tbody>
</table>

Related Topics
- Assigning Enterprise Reports
- Creating ECM Property Reports

Assigning Enterprise Reports

Enterprise reports must be assigned to an employee role in Oracle Hospitality Reporting and Analytics before authorized employees can run them. An administrator typically assigns the reports to a role.

1. In Reporting and Analytics, click Admin, Warehouse, Reports, and Report Roles.
2. Highlight a role and click Select.
3. On the Role Reports screen, click Add.
4. Select the report names from the list and click Save.
5. Create a report category:
   a. Click Admin, Warehouse, Reports, and Report Categories.
   b. Click Add.
   c. On the Report Categories screen, enter the Name of the new report category, a Description, and specify a Sort Order.
   d. Click Save.

Related Topics
- ECM Reporting
- ECM Enterprise Reports

Creating ECM Property Reports

Property reporting at the workstation provides reports on active and completed receptacle sessions. Create front of house buttons for each property report listed in the following table. Workstation Touchscreen Pages contains more information about configuring front of house buttons.
Table 21-15  Enterprise Cash Management (ECM) Property Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Contains Information About</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safes Report</td>
<td>Active safe sessions for the location</td>
</tr>
<tr>
<td>Server Bank Report</td>
<td>The active server bank session for the operator logged in to the workstation</td>
</tr>
<tr>
<td>Server Banking Report</td>
<td>Active server banking sessions for the location</td>
</tr>
<tr>
<td>Till Report</td>
<td>Active till sessions assigned on the workstation</td>
</tr>
<tr>
<td>Till Banking Report</td>
<td>Active till sessions for the location</td>
</tr>
<tr>
<td>Cash Pull Report</td>
<td>Cash pull transactions posted for the current business date</td>
</tr>
<tr>
<td>Over/Short Detail Report</td>
<td>Over and short conditions recorded for the current business date</td>
</tr>
<tr>
<td>Bank Deposit Report</td>
<td>Active bank deposit sessions for the location</td>
</tr>
<tr>
<td>Petty Cash Report</td>
<td>Active petty cash sessions for the location</td>
</tr>
<tr>
<td>Paid-In/Paid-Out Report</td>
<td>Paid-in and paid-out transactions recorded for the current business date</td>
</tr>
</tbody>
</table>

Related Topics

- ECM Reporting
- ECM Enterprise Reports

ECM Workstation Hardware

The following table lists the workstation hardware models and operating systems supported for Enterprise Cash Management (ECM) receptacle operations and functions. Some functionality related to the operation of tills is limited with tablets, handhelds, and other mobile devices. These devices are indicated in the table with an asterisk (*).

The receptacle’s tracking session includes ECM tracked transactions that are processed as part of normal guest check operations, regardless of the hardware model or supported operating system from which they originated.

Table 21-16  Workstation Hardware

<table>
<thead>
<tr>
<th>Model</th>
<th>Operating System</th>
<th>ECM Features Supported?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle MICROS Workstation 6</td>
<td>Windows 8.1</td>
<td>Yes</td>
</tr>
<tr>
<td>Oracle MICROS Tablet E-Series (8-inch and 11-inch)</td>
<td>Windows 8.1</td>
<td>Yes*</td>
</tr>
<tr>
<td>Oracle MICROS Workstation 5a</td>
<td>Win32</td>
<td>Yes</td>
</tr>
<tr>
<td>Oracle MICROS PC Workstation 2015</td>
<td>Win32</td>
<td>Yes</td>
</tr>
<tr>
<td>Oracle MICROS PC Workstation 2010</td>
<td>Win32</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table 21-16  (Cont.) Workstation Hardware

<table>
<thead>
<tr>
<th>Model</th>
<th>Operating System</th>
<th>ECM Features Supported?</th>
</tr>
</thead>
<tbody>
<tr>
<td>DT Research 362</td>
<td>POSReady 7</td>
<td>Yes*</td>
</tr>
<tr>
<td>DT Research 365</td>
<td>Windows 7</td>
<td>Yes*</td>
</tr>
<tr>
<td>Zebra MC40 (formerly the</td>
<td>Android 4.1</td>
<td>Yes*</td>
</tr>
<tr>
<td>Motorola MC40)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apple iPad – All Models</td>
<td>iOS 8</td>
<td>No</td>
</tr>
<tr>
<td>Certified Consumer Devices</td>
<td>Android 4.4</td>
<td>Yes*</td>
</tr>
<tr>
<td>(Android)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Related Topics

- Enterprise Cash Management
- Tracking Tender Transaction Items
- Tracking Service Charge Transactions
- Tracking Discount Transactions

Enterprise Cash Management Configuration Levels

The following table lists the hierarchy levels within the Enterprise Management Console (EMC) that allow configuration of Enterprise Cash Management (ECM) operations.

Table 21-17  EMC Configuration Levels

<table>
<thead>
<tr>
<th>EMC Configuration Name</th>
<th>Enterprise</th>
<th>Property</th>
<th>RVC</th>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cash Count Threshold Sets</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cash Management Classes</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cash Management Parameters</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cash Management Reasons</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cash Pull Threshold Sets</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Count Sheets</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Employee Classes</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 21-17  (Cont.) EMC Configuration Levels

<table>
<thead>
<tr>
<th>EMC Configuration Name</th>
<th>Enterprise</th>
<th>Property</th>
<th>RVC</th>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Maintenance</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Page Design</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>PAR Level Sets</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Vendors</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Templates</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Receptacles</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Roles</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Related Topics

- Enterprise Cash Management
- Tracking Tender Transaction Items
- Tracking Service Charge Transactions
- Tracking Discount Transactions
Oracle Hospitality Gift and Loyalty is a customer relationship management (CRM) application that allows properties to manage point-based loyalty card programs and stored value cards (SVC) (also known as gift cards). Gift and Loyalty tracks customer activities (such as frequency of visits, spending, and loyalty account balance) and reports the information through Simphony’s enterprise reporting module. Simphony then sends this information to Gift and Loyalty.

The following table lists common types of loyalty programs:

<table>
<thead>
<tr>
<th>Loyalty Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Points earned per transaction or per visit</td>
<td>An award given for X number of visits. The award could be a discount, coupon for future visit, or stored value added to the loyalty account for later redemption.</td>
</tr>
<tr>
<td>Points earned per dollar spent</td>
<td>An award given for X dollars spent. The award could be a discount, coupon for future visit, or stored value added to the loyalty account for later redemption.</td>
</tr>
<tr>
<td>Discount card</td>
<td>Each time the workstation operator swipes a card, the check receives an automatic discount. Restaurants typically use discount cards to control employee meal discounts.</td>
</tr>
<tr>
<td>Category club card</td>
<td>The customer earns points when ordering a specific type of menu item (for example, burgers).</td>
</tr>
</tbody>
</table>

A stored value program allows a guest to establish a prepaid account to use for purchases at a property. The prepaid payment vehicle is a stored value card (SVC) with an associated monetary value. A gift card is an example of a stored value card containing a prepaid amount.

- Loyalty and Stored Value Configuration Prerequisites
- Loyalty Configuration Tasks
- Configuring Loyalty and Stored Value Privileges
- Setting Loyalty Options
- Configuring the Loyalty Driver
- Configuring the Loyalty Module
- Stored Value Configuration Tasks
- Setting Stored Value Options
- Configuring the Stored Value Driver
- Configuring the Stored Value Module
• Creating Front of House Loyalty and Stored Value Buttons
• Voiding Points on a Re-opened Check
• XProcessor Extension Application Migration

Loyalty and Stored Value Configuration Prerequisites

Simphony supports the Gift and Loyalty drivers only on WinCE and Win32 operating systems.

Complete the following tasks before configuring the Loyalty and Stored Value Interfaces and Drivers:

1. Install Simphony version 2.5 Maintenance Release (MR) 1 or later at the property.
2. Obtain access to the Enterprise Management Console (EMC) within Simphony.
3. Configure unique Tender/Media and Discount records for loyalty transactions. Take note of the record number and type as you need the values to post transactions for Reporting and Analytics and third party loyalty applications. Oracle Hospitality Reporting and Analytics and third party loyalty applications use the configured Simphony Tender/Media and Discount records to post loyalty transactions to the guest check.
4. (Optional) If the site is using the XProcessor Extension Application for Gift and Loyalty, configure the Gift and Loyalty interface and XProcessor Extension Application at the Enterprise level. Deploy each interface only to the correct locations and clients. After you upgrade the appropriate clients to Simphony version 2.5 MR1 or later, see XProcessor Extension Application Migration for instructions.
   a. Leave the XProcessor installed at the Enterprise level until all clients have been upgraded to Simphony version 2.5 MR1 or later and are using the Gift and Loyalty interface.
   b. Retrieve the data extension overrides for each property (such as uniform resource locator (URL), userid, user_password, and timeout_seconds). Take note of these settings as you need this information to create the integrated Gift and Loyalty interface.
   c. Take note of the current functions the site uses through XProcessor. You need this information to create buttons for the Gift and Loyalty interface.
5. (Optional) If a third party developed a driver, use the driver configuration settings provided by the third party. Third party drivers may have unique fields.

Related Topics
• Loyalty Configuration Tasks

Loyalty Configuration Tasks

Complete the following tasks to set up the loyalty interface:
• Carry out the configuration prerequisites
• Configure loyalty privileges
• Set loyalty options
• Configure the Loyalty driver
• Configure the Loyalty module
• Create Front of House loyalty buttons
• Allow workstation operators to void loyalty points issued on re-opened checks
• (If applicable) Migrate the XProcessor Extension Application

Related Topics
• Loyalty and Stored Value Configuration Prerequisites
• Configuring Loyalty and Stored Value Privileges
• Setting Loyalty Options
• Configuring the Loyalty Driver
• Configuring the Loyalty Module
• Creating Front of House Loyalty and Stored Value Buttons
• Voiding Points on a Re-opened Check
• XProcessor Extension Application Migration

Configuring Loyalty and Stored Value Privileges

1. In the EMC, select the Enterprise level, click Configuration and Roles.
2. Select the role type, click Operations and Stored Value Cards.
3. Select the appropriate options for the privileges. The following table summarizes the privileges associated with Loyalty and Stored Value functionality.

Table 22-2 Loyalty and Stored Value Privileges

<table>
<thead>
<tr>
<th>Section</th>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Select This Option to Allow Employees to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue Functions</td>
<td>104</td>
<td>Authorize/Perform Issue Stored Value Function</td>
<td>Issue a stored value card.</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>105</td>
<td>Authorize/Perform Void Issue Stored Value Entry</td>
<td>Void an issued card.</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>106</td>
<td>Authorize/Perform Issue Stored Value Batch Function</td>
<td>Issue a batch of stored value cards.</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>107</td>
<td>Authorize/Perform Void Issue Stored Value Batch Entry</td>
<td>Void a batch of stored value cards.</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>108</td>
<td>Authorize/Perform Activate Stored Value Function</td>
<td>Activate a stored value card.</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>109</td>
<td>Authorize/Perform Void Activate Stored Value Entry</td>
<td>Void the activation of a stored value card.</td>
</tr>
<tr>
<td>Section</td>
<td>Option Number</td>
<td>Privilege Name</td>
<td>Select This Option to Allow Employees to...</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------</td>
<td>--------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>110</td>
<td>Authorize/Perform Activate Stored Value Batch Function</td>
<td>Activate a batch of stored value cards.</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>111</td>
<td>Authorize/Perform Void Activate Stored Value Batch Entry</td>
<td>Void the activation of a batch of stored value cards.</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>112</td>
<td>Authorize/Perform Reload Stored Value Function</td>
<td>Reload (add credit) a dollar amount to an existing stored value card.</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>113</td>
<td>Authorize/Perform Void Reload Stored Value Entry</td>
<td>Void a reload transaction.</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>114</td>
<td>Authorize/Perform Redeem Authorization Stored Value Function</td>
<td>Perform a redemption authorization.</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>115</td>
<td>Authorize/Perform Void Redeem Authorization Stored Value Entry</td>
<td>Void a redemption authorization.</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>116</td>
<td>Authorize/Perform Redeem Stored Value Function</td>
<td>Perform a redemption transaction (a customer makes a purchase using a stored value card, and the application deducts a dollar amount from the customer's account).</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>117</td>
<td>Authorize/Perform Void Redeem Stored Value Entry</td>
<td>Void a redemption transaction.</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>118</td>
<td>Authorize/Perform Manual Redemption Stored Value Function</td>
<td>Perform a manual redemption.</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>119</td>
<td>Authorize/Perform Void Manual Redemption Stored Value Entry</td>
<td>Void a manual redemption transaction.</td>
</tr>
<tr>
<td>Point Functions</td>
<td>120</td>
<td>Authorize/Perform Issue Stored Value Points Function</td>
<td>Issue points to a stored value card.</td>
</tr>
<tr>
<td>Point Functions</td>
<td>121</td>
<td>Authorize/Perform Void Issue Stored Value Points Entry</td>
<td>Void the issued points on a stored value card.</td>
</tr>
<tr>
<td>Point Functions</td>
<td>122</td>
<td>Authorize/Perform Redeem Stored Value Points Function</td>
<td>Perform a points redemption transaction.</td>
</tr>
<tr>
<td>Point Functions</td>
<td>123</td>
<td>Authorize/Perform Void Redeem Stored Value Points Entry</td>
<td>Void a points redemption transaction.</td>
</tr>
<tr>
<td>Section</td>
<td>Option Number</td>
<td>Privilege Name</td>
<td>Select This Option to...</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>103</td>
<td>Authorize/Perform Manual Entry of Stored Value Card Number</td>
<td>Manually enter the stored value card account number.</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>124</td>
<td>Authorize/Perform Stored Value Cash Out Function</td>
<td>Debit some or all of the remaining balance on a stored value card.</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>179</td>
<td>Authorize/Perform Void Stored Value Cash Out Function</td>
<td>Void a cash out transaction.</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>125</td>
<td>Authorize/Perform Stored Value Balance Inquiry Function</td>
<td>Check a stored value card balance.</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>126</td>
<td>Authorize/Perform Stored Value Balance Transfer Function</td>
<td>Transfer the balance from one stored value card to another.</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>127</td>
<td>Authorize/Perform Stored Value Point Inquiry Function</td>
<td>Check a stored value card point balance.</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>128</td>
<td>Authorize/Perform Stored Value Report Generation Function</td>
<td>Generate stored value card reports.</td>
</tr>
<tr>
<td>Loyalty Options</td>
<td>166</td>
<td>Authorize/Perform Loyalty Coupon Inquiry</td>
<td>Request a list of coupons that are available for a loyalty account.</td>
</tr>
<tr>
<td>Loyalty Options</td>
<td>167</td>
<td>Authorize/Perform Accept Loyalty Coupon Function</td>
<td>Redeem a coupon associated with a loyalty account.</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>168</td>
<td>Authorize/Perform Void Accept Loyalty Coupon Entry</td>
<td>Void the coupon redemption.</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>169</td>
<td>Authorize/Perform Issue Loyalty Coupon Function</td>
<td>Issue a coupon to a loyalty account.</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>170</td>
<td>Authorize/Perform Issue Loyalty Points Function</td>
<td>Issue points to a loyalty account.</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>171</td>
<td>Authorize/Perform Void Issue Loyalty Points Entry</td>
<td>Void the point issuance.</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>172</td>
<td>Authorize/Perform Redeem Loyalty Points Function</td>
<td>Accept or redeem points to apply towards the balance of a check.</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>173</td>
<td>Authorize/Perform Void Redeem Loyalty Points Entry</td>
<td>Void the points redemption.</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>174</td>
<td>Authorize/Perform Redeem and Issue Loyalty Points Function</td>
<td>Redeem points and issue additional points to a loyalty account.</td>
</tr>
</tbody>
</table>
Table 22-2  (Cont.) Loyalty and Stored Value Privileges

<table>
<thead>
<tr>
<th>Section</th>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Select This Option to Allow Employees to…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loyalty Operations</td>
<td>175</td>
<td>Authorize/Perform Void Redeem and Issue Loyalty Points Entry</td>
<td>Void the points redemption and issuance.</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>176</td>
<td>Authorize/Perform Loyalty Balance Inquiry Function</td>
<td>Request a points balance for a loyalty account.</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>177</td>
<td>Authorize/Perform Loyalty Unique Item Inquiry Function</td>
<td>Request a list of unique menu items that were ordered on a program associated with a loyalty account.</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>178</td>
<td>Authorize/Perform Loyalty Balance Transfer Function</td>
<td>Transfer the points balance associated with one loyalty account number to another loyalty account.</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>180</td>
<td>Authorize/Perform Apply Loyalty Card to Check</td>
<td>Use the Oracle Hospitality Gift and Loyalty operation that applies a card account against the guest check. Depending on the configuration in Gift and Loyalty, setting this privilege could trigger one or more operations, such as redeem points, apply coupons, redeem a gift card, and issue points.</td>
</tr>
</tbody>
</table>

4. Click the Transactions tab.

5. Select the appropriate Stored Value coupon privileges in the Service Charge and Discount Options section:
   - **130 - Authorize/Perform “Accept Coupon” Stored Value Function** – Select this option to allow employees to perform the Accept Coupon stored value function.
   - **131 - Authorize/Perform “Void Accept Coupon” Stored Value Function** – Select this option to allow employees to perform the Void Accept Coupon stored value function.

6. Click Save.

Related Topics
- Loyalty Configuration Tasks

Related Topics
- Stored Value Configuration Tasks
Setting Loyalty Options

1. In the EMC, select the Enterprise, property, or revenue center, click Configuration and Loyalty.
2. Insert a record and enter Loyalty as the name.
3. Double-click the record to open it.
4. Select the appropriate Loyalty Options as described in the following table.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support Offline Transactions</td>
<td>Select this option to allow offline loyalty transactions.</td>
</tr>
<tr>
<td>Always Print Loyalty Results</td>
<td>Select this option to have a chit print automatically after each successful loyalty operation.</td>
</tr>
<tr>
<td>Never Display Loyalty Results</td>
<td>Select this option to require the workstation operator to touch the workstation in order to show loyalty results.</td>
</tr>
<tr>
<td>Remove Loyalty Results Print Button</td>
<td>Select this option if you do not want a Print button to appear on the loyalty results screen. Select this option in conjunction with the Always Print Loyalty Results option.</td>
</tr>
<tr>
<td>Remove Guest Name Lookup Button</td>
<td>Select this option if you do not want the Guest Name Lookup button to appear on the account number entry screen. This option deactivates the Guest Name Lookup function.</td>
</tr>
<tr>
<td>Remove Phone Number Lookup Button</td>
<td>Select this option if you do not want the Phone Number Lookup button to appear on the account number entry screen. This option deactivates the Phone Number Lookup function.</td>
</tr>
</tbody>
</table>

5. Click Save.

Related Topics
- Loyalty Configuration Tasks

Configuring the Loyalty Driver

1. In the EMC, select the Enterprise, property, or revenue center, click Setup and Loyalty Driver.
2. Insert a record and enter an appropriate gift and loyalty driver name.
3. Double-click the record to open it.
4. On the General tab, click the Import from a file link.
5. Browse to C:\MICROS\Simphony2\GatewayService\handlers, select LoyaltyCommandModule.dll, and click Open.
6. Select the Configuration tab.
7. In the Assembly/Class section, enter information in the following fields:
Table 22-4  Assembly/Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>This value identifies the module (for example, LoyaltyDriver).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the name you want to appear in Simphony Front of House windows and dialogs (for example, [Provider Name] Loyalty).</td>
</tr>
<tr>
<td>Description</td>
<td>Do not leave this field blank. As an example, enter Loyalty Driver.</td>
</tr>
</tbody>
</table>

8. In the iCareDriver Properties section, enter information in the following fields:

Table 22-5  iCareDriver Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate File</td>
<td>If the site has implemented a unique certificate file, specify the location of the certificate file on the local machine.</td>
</tr>
<tr>
<td>Communications Offline Retry Count</td>
<td>This value is the number of transactions that workstation operators can complete offline before attempting an online transaction. You cannot change the value in this field as it is based on the Tender Media or Service Charge records configured for offline use.</td>
</tr>
<tr>
<td>Communications Timeout Seconds</td>
<td>You cannot change the value in this field as it is based on the Tender Media or Service Charge records configured for offline use.</td>
</tr>
<tr>
<td>Ignore Server Certificate</td>
<td>Select True when the site is not implementing a unique certificate file. This allows secure communication between the driver and endpoint.</td>
</tr>
<tr>
<td>Log iCare Client Debug Data</td>
<td>If the client is using Gift and Loyalty, specify whether the application includes debug information in the log file.</td>
</tr>
<tr>
<td>Log iCare Client Message Data</td>
<td>If the client is using Gift and Loyalty, specify whether the application includes client messages in the log file.</td>
</tr>
<tr>
<td>Login</td>
<td>Leave this field blank at the enterprise level. This value is set at the property level.</td>
</tr>
<tr>
<td>Password</td>
<td>Leave this field blank at the enterprise level. This value is set at the property level.</td>
</tr>
<tr>
<td>Web Address</td>
<td>Enter the path to Gift and Loyalty, including location, port number and service path. Use the following format: https://[GiftLoyaltyLocation]:[GiftLoyaltyPortNumber]/ws/services/StoredValueService.</td>
</tr>
<tr>
<td></td>
<td>If the site is using a third party payment provider application (rather than Gift and Loyalty), enter the path to the third party payment provider application. This may be a Web address or local path.</td>
</tr>
</tbody>
</table>

9. Click Save.

Related Topics

- Loyalty Configuration Tasks
Configuring the Loyalty Module

1. In the EMC, select the Enterprise, property, or revenue center, click **Setup** and **Loyalty Module**.

2. Insert a record and enter **LoyaltyModule** as the name.

3. Double-click the record to open it.

4. On the General tab, click the **Import from a file** link.

5. Browse to C:\MICROS\Simphony2\EgatewayService\handlers, select **LoyaltyCommandModule.dll**, and click **Open**.

6. Click the Configuration tab.

7. In the Assembly/Class section, enter information in the following fields:
   - **Module ID** – This value identifies the module.
   - **Display Name** – Enter the name you want to appear in Simphony Front of House windows and dialogs (for example, [Provider Name] Loyalty).
   - **Description** – Enter a description of the loyalty module. Do not leave this field blank.

8. In the Common Properties section, enter information in the following fields:
   - **Currency ISO Code** – Enter the code (3 alpha characters) that represents the currency being used (for example, USD).
   - **Language ISO Code** – Enter the code (2 alpha characters) that represents the language being used (for example, EN).

   If the currency or language is different at the property, override these values at the property level.

9. In the Loyalty Module Properties section, enter information in the following fields:
   - **Account Number Maximum Length** – Enter the maximum length of a loyalty account number (up to 24 digits).
   - **Account Number Minimum Length** – Enter the minimum length of a loyalty account number (down to 7 digits).
   - **Cash Module Name** – Enter the name of the cash module to use for redemptions (for example, Cash:Cash).

10. Click **Save**.

11. Select the property, click **Setup** and **Loyalty Driver**.

12. Double-click the gift and loyalty driver record to open it.

13. Click the **Override This Record** link, and then click **Yes** to confirm.

14. Click the Configuration tab.

15. In the iCare Driver Properties section, enter information in the following fields:
Stored Value Configuration Tasks

Complete the following tasks to set up the stored value interface:

- Carry out the configuration prerequisites
- Configure stored value privileges
- Set stored value options
- Configure the Stored Value driver
- Configure the Stored Value module
- Create Front of House stored value buttons
- Allow workstation operators to void loyalty points issued on re-opened checks
- (If applicable) Migrate the XProcessor Extension Application

Related Topics

- Configuring Loyalty and Stored Value Privileges
- Setting Stored Value Options
- Configuring the Stored Value Driver
- Configuring the Stored Value Module
- Creating Front of House Loyalty and Stored Value Buttons
- XProcessor Extension Application Migration

Setting Stored Value Options

1. In the EMC, select the Enterprise, property, or revenue center, click Configuration and Stored Value.
2. Insert a record and enter Stored Value as the name.
3. Double-click the record to open it.
4. Select the appropriate Stored Value Options. The following table describes the options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support Offline Transactions</td>
<td>Select this option to allow offline stored value transactions.</td>
</tr>
</tbody>
</table>
Table 22-6  (Cont.) Stored Value Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always Print Stored Value Results</td>
<td>Select this option to have a chit print automatically after each successful stored value operation.</td>
</tr>
<tr>
<td>Never Display Stored Value Results</td>
<td>Select this option to require the workstation operation to touch the workstation in order to show loyalty results.</td>
</tr>
<tr>
<td>Remove Stored Value Results Print Button</td>
<td>Select this option if you do not want a Print button to appear on the stored value results screen. Select this option in conjunction with the Always Print Stored Value Results option.</td>
</tr>
<tr>
<td>Remove Guest Name Lookup Button</td>
<td>Select this option if you do not want the Guest Name Lookup button to appear on the account number entry screen. This option deactivates the Guest Name Lookup function.</td>
</tr>
<tr>
<td>Remove Phone Number Lookup Button</td>
<td>Select this option if you do not want the Phone Number Lookup button to appear on the account number entry screen. This option deactivates the Phone Number Lookup function.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Related Topics**
- Stored Value Configuration Tasks

**Configuring the Stored Value Driver**

1. In the EMC, select the Enterprise, property, or revenue center, click **Setup and Stored Value Driver**.
2. Insert a record and enter an appropriate stored value card driver name.
3. Double-click the record to open it.
4. On the General tab, click the **Import from a file** link.
5. Browse to C:\MICROS\Simphony2\EgatewayService\handlers, select StoredValueCommandModule.dll, and click **Open**.
6. Click the Configuration tab.
7. In the Assembly/Class section, enter information in the following fields:

Table 22-7  Assembly/Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>This value identifies the module (for example, SVCDriver).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the name you want to appear in Simphony Front of House windows and dialogs (for example, [Provider Name] Stored Value).</td>
</tr>
</tbody>
</table>
Table 22-7  (Cont.) Assembly/Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Do not leave this field blank. As an example, enter SVC Driver.</td>
</tr>
</tbody>
</table>

8. In the iCareDriver Properties section, enter information in the following fields:

Table 22-8  iCareDriver Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate File</td>
<td>If the site has implemented a unique certificate file, specify the location of the certificate file on the local machine.</td>
</tr>
<tr>
<td>Communications Offline Retry Count</td>
<td>This value is the number of transactions that workstation operators can complete offline before attempting an online transaction. You cannot change the value in this field as it is based on the Tender Media or Service Charge records configured for offline use.</td>
</tr>
<tr>
<td>Communications Timeout Seconds</td>
<td>You cannot change the value in this field as it is based on the Tender Media or Service Charge records configured for offline use.</td>
</tr>
<tr>
<td>Ignore Server Certificate</td>
<td>Select True when the site is not implementing a unique certificate file. This allows secure communication between the driver and endpoint.</td>
</tr>
<tr>
<td>Log iCare Client Debug Data</td>
<td>If the client is using Gift and Loyalty, specify whether the application includes debug information in the log file.</td>
</tr>
<tr>
<td>Log iCare Client Message Data</td>
<td>If the client is using Gift and Loyalty, specify whether the application includes client messages in the log file.</td>
</tr>
<tr>
<td>Login</td>
<td>Leave this field blank at the enterprise level. This value is set at the property level.</td>
</tr>
<tr>
<td>Password</td>
<td>Leave this field blank at the enterprise level. This value is set at the property level.</td>
</tr>
<tr>
<td>Web Address</td>
<td>Enter the path to Gift and Loyalty, including location, port number and service path. Use the following format: https://[GiftLoyaltyLocation]:[GiftLoyaltyPortNumber]/ws/services/StoredValueService. If the site is using a third party payment provider application (rather than Gift and Loyalty), enter the path to the third party payment provider application. This may be a Web address or local path.</td>
</tr>
</tbody>
</table>

9. Click **Save**.

**Related Topics**

- Stored Value Configuration Tasks
Configuring the Stored Value Module

1. In the EMC, select the Enterprise, property, or revenue center, click Setup and Stored Value Module.
2. Insert a record and enter SVCModule as the name.
3. Double-click the record to open it.
4. On the General tab, click the Import from a file link.
5. Browse to C:\MICROS\Simphony2\EgatewayService\handlers, select StoredValueCommandModule.dll, and click Open.
6. Click the Configuration tab.
7. In the Assembly/Class section, enter information in the following fields:
   - Module ID – This value identifies the module.
   - Display Name – Enter the name you want to appear in Simphony Front of House windows and dialogs.
   - Description – Enter a description of the stored value module. Do not leave this field blank.
8. In the Common Properties section, enter information in the following fields:
   - Currency ISO Code – Enter the code (3 alpha characters) that represents the currency being used (for example, USD).
   - Language ISO Code – Enter the code (2 alpha characters) that represents the language being used (for example, EN).
   If the currency or language is different at the property, override these values at the property level.
9. In the Stored Value Module Properties section, enter information in the following fields:
   - Account Number Maximum Length – Enter the maximum length of a stored value account number (up to 24 digits).
   - Account Number Minimum Length – Enter the minimum length of a stored value account number (down to 7 digits).
   - Cash Module Name – Enter the name of the cash module to use for redemptions (for example, Cash:Cash).
   - Max Card Activation Quantity – Enter the maximum number of stored value cards that can be activated with the Activate Multiple card operation.
   - Max Card Issue Quantity
     – Enter the maximum number of stored value cards that can be issued with the Activate Multiple card operation.
10. Click Save.
11. Select the property, click **Setup** and **Stored Value Driver**.
12. Double-click the stored value card driver record to open it.
13. Click the **Override This Record** link, and then click **Yes** to confirm.
14. Click the Configuration tab.
15. In the iCare Driver Properties section, enter information in the following fields:
   - **Login** – Enter the login for the property ID or the login for the provider.
   - **Password** – Enter the password for the property ID or the provider.
16. Click **Save**.

**Related Topics**
- **Stored Value Configuration Tasks**

## Creating Front of House Loyalty and Stored Value Buttons

You can create buttons on a page for the loyalty and stored value functions.

1. In the EMC, select the Enterprise, property, or revenue center, click **Configuration** and **Page Design**.
2. Open the Front of House page on which to place loyalty and stored value buttons.
3. On the Edit tab, select the page area in which to define the loyalty and stored value functions (typically the payment or function area).
4. Click **Button**.
5. On the General sub-tab, select the appropriate function from the **Type** drop-down.
   - **Loyalty Function**
   - **Stored Value Function**
6. Click the black arrow beneath the Type drop-down.
7. Select either **iCare Loyalty** or **iCare Stored Value**, and click **OK**.
8. On the Loyalty or Stored Value Operation Selection dialog, select the appropriate **Module Type** (**iCareLoyaltyModule** or **iCareSVCMODULE**), select the appropriate function in the Functions drop-down, and click **OK**.
9. Position and size the button on the page. Use the Style arrow to change the color.
10. In the **Legend** field, enter the button name and click **Save**. The following tables list the loyalty and stored value button names and functions.

    Buttons marked with an asterisk (*) are only available with Gift and Loyalty; these functions are not available with third party payment providers. Do not use the Look Up Patron operation as it is not functional alone. Instead, see **Setting Loyalty Options** for information about lookup methods.

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balance Inquiry</td>
<td>Request a points balance for a loyalty account.</td>
</tr>
</tbody>
</table>
### Table 22-9  (Cont.) Loyalty Buttons

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unique Items Inquiry*</td>
<td>Request a list of unique menu items that have been ordered on a program associated with a loyalty account.</td>
</tr>
<tr>
<td>Issue Points</td>
<td>Issue points to a loyalty account.</td>
</tr>
<tr>
<td>Coupon Inquiry</td>
<td>Request a list of coupons that are available for a loyalty account.</td>
</tr>
<tr>
<td>Redeem Coupon</td>
<td>Redeem a coupon to apply towards the balance of a guest check.</td>
</tr>
<tr>
<td>Issue Coupon</td>
<td>Issue an ad hoc coupon from Gift and Loyalty to a guest loyalty account.</td>
</tr>
<tr>
<td>Transfer Loyalty Account</td>
<td>Transfer the points balance and customer personal information associated with one loyalty account number to another loyalty account.</td>
</tr>
</tbody>
</table>
| Apply Card to Check*        | The Apply Card to Check function sends an Apply request to Gift and Loyalty for the account number. Based upon Gift and Loyalty configuration, the workstation operator can select the following actions:  
  • Apply Coupon  
  • Redeem Points  
  • Redeem Stored Value Card (SVC)  
  • Apply Coupon and Redeem SVC  
  • Issue Points  
  The Apply Card to Check function requires a special configuration to share data between the Loyalty and Stored Value modules. To configure the Apply Card to Check button, on the General tab in the Text field, enter the **SVCModuleName** and **Record Number**. Use the format SVCModuleName:RecordNumber to process SVC actions associated with this function. You can find the Record Number and Module Name in EMC by highlighting the enterprise, selecting **Setup**, and then selecting **Stored Value Module**.  
  A property can load more than one type of loyalty module, although Oracle does not recommend doing so. If the property uses multiple loyalty modules, manually enter the module name in the Arguments field for the second module. |

### Table 22-10  Stored Value Buttons

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balance Inquiry</td>
<td>Request the current monetary value for a stored value account or gift card.</td>
</tr>
<tr>
<td>Issue SVC</td>
<td>Issue one stored value account number for a dollar value that is determined at the time of purchase.</td>
</tr>
<tr>
<td>Issue Multiple SVCs*</td>
<td>Issue multiple stored value account numbers for a dollar value that is determined at the time of purchase.</td>
</tr>
<tr>
<td>Activate SVC</td>
<td>Activate one stored value account. The application prompts the workstation operator to enter the pre-defined dollar value for validation.</td>
</tr>
</tbody>
</table>
Table 22-10  (Cont.) Stored Value Buttons

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Multiple SVCs*</td>
<td>Activate multiple stored value account numbers for a dollar value that is determined at the time of purchase. The application prompts the workstation operator to enter the pre-defined dollar value for validation.</td>
</tr>
<tr>
<td>Reload</td>
<td>Add funds to an existing stored value account.</td>
</tr>
<tr>
<td>Transfer</td>
<td>Transfer the funds and customer personal information (if applicable) associated with one stored value account to another stored value account.</td>
</tr>
<tr>
<td>Authorize</td>
<td>Authorize a gift card for use as payment on a guest check.</td>
</tr>
<tr>
<td>Redeem</td>
<td>Pay a guest check balance using a gift card.</td>
</tr>
<tr>
<td>Cash Out</td>
<td>Obtain a cash payment for any remaining balance on a stored value account.</td>
</tr>
<tr>
<td>Redeem SVC/Issue Points*</td>
<td>The Redeem SVC/Issue Points function combines the Redeem SVC and Loyalty Issue Points functions. The application prompts the workstation operator to redeem a gift card, and then automatically issues points. The Redeem SVC/Issue Points function requires a special configuration to share data between the Loyalty and Stored Value modules. To configure the Redeem SVC/Issue Points button, on the General tab in the Text field, enter the <strong>LoyaltyModuleName</strong> and <strong>Record Number</strong>. Use the format LoyaltyModuleName:RecordNumber to process loyalty actions associated with this function. You can find the Record Number and Module Name in EMC by highlighting the Enterprise level, clicking <strong>Setup</strong> and <strong>Loyalty Module</strong>. A property can load more than one type of stored value module, although Oracle does not recommend doing so. If the property uses multiple stored value modules, manually enter the module name in the Arguments field for the second module.</td>
</tr>
</tbody>
</table>

11. Repeat the preceding steps to create buttons for each of the loyalty and stored value functions listed in the tables.

Related Topics

-  Loyalty Configuration Tasks

Related Topics

-  Stored Value Configuration Tasks

Voiding Points on a Re-opened Check

To allow workstation operators to void loyalty points issued on re-opened guest checks, the check number must remain the same after reopening a check. By default, a guest check number increments each time a workstation operator re-opens the check, preventing the voiding of points due to check numbering mismatch.

1. In the EMC, select the revenue center, click **RVC Parameters** and **Options**.
2. Select **37 - Keep The Same Check Number When a Check is Reopened**. This allows a re-opened guest check to retain its original guest check number. When
you deselect this option, Simphony assigns a re-opened guest check to a new check number.

3. Click **Save**.

**Related Topics**
- Loyalty Configuration Tasks

## XProcessor Extension Application Migration

Beginning with Simphony version 2.5 MR1, properties can install the Loyalty driver for Gift and Loyalty Advanced (in place of the XProcessor Extension Application). You must upgrade the appropriate clients to Simphony version 2.5 MR1 or later before completing the steps in this section.

1. Browse to the Client Application Loader (CAL) server’s Win32 or WinCE subdirectory for Gift and Loyalty Advanced:
   - CAL\Win32\ICareProcessor2.0 directory
   - CAL\WinCE\ICareProcessor2.0 directory

2. Delete the ICareProcessor2.0 directory.

3. In the EMC, select the Enterprise level, click **Setup** and **CAL Packages**.

4. Delete the CAL Client package that was used to deploy the ICareProcessor2.0 directory to the workstation(s).

5. Delete the following files from the disk:
   - Micros.XProcessor.dll
   - Micros.XProcessor.SVC.dll
   - Micros.XProcessor.SVC.ICare.dll

6. Select the Enterprise, property, or revenue center, click **Setup** and **Extension Application**.

7. Delete the Extension Application for XProcessor.

8. Select the Enterprise, property, or revenue center, click **Setup** and **Payments**.

9. Delete the XProcessor Payment driver.

10. Select the Enterprise or property, click **Configuration** and **Tender/Media**.

11. Delete XProcessor Close Check.

12. Delete the iCareSvcProcessor.icare.xml file.

13. Select the Enterprise level, click **Configuration** and **Data Extensions**.

14. Delete the data extensions for each property.

15. Select the Enterprise, property, or revenue center, click **Configuration** and **Page Design**.

16. Double-click the page record containing Gift and Loyalty buttons to open it.

17. Delete all Gift and Loyalty buttons.

Depending on the property’s Gift and Loyalty configuration, additional menu items, discounts, service charges, or tenders may have been used. If these items are in use, leave these additional items and do not delete them.
18. If the property was using the Check Reprocessor service, remove the installed check reprocessor files from the enterprise service host as the Gift and Loyalty interface has its own plug-ins.

19. Browse to the Handlers directory where the Check Reprocessor ran and open the ChkReprocSvcHost.DLL.config file.

20. Delete the following tag:

   `<pluginAssembly displayname="XProcessor Reprocessor"
   fullname="Micros.XProcessor.SVC.dll, Version=0.0.0.0, Culture=neutral,
   PublicKeyToken=null" />

   Leave the tags `<pluginAssemblies>` and `</pluginAssemblies>`.

21. Delete the following files from the Handlers directory:

   - Micros.XProcessor.Payment.dll
   - Micros.Ops.Extensibility.dll
   - Micros.XProcessor.dll
   - Micros.XProcessor.SVC.dll
   - Micros.XProcessor.SVC.iCare.dll

Related Topics

- Loyalty Configuration Tasks

Related Topics

- Stored Value Configuration Tasks
Setting Up the Web Service

A web service allows communication between Simphony and third party solutions.

- Understanding Transaction Services
- Configuring the Transaction Services Workstation Client
- Configuring the Transaction Services Employee

Understanding Transaction Services

Transaction Services is a web service that allows Simphony to interface with third party applications (for example, hotel self-service kiosks or room service devices, menu boards, and Enterprise online ordering). Transaction Services is commonly installed in stadiums that use self-ordering devices. Guests can place orders using a third party application that interfaces with a Transaction Services client. The client then sends the guest checks to Simphony.

Related Topics

- Configuring the Transaction Services Workstation Client
- Configuring the Transaction Services Employee

Configuring the Transaction Services Workstation Client

You can configure Transaction Services to run on the same hardware device as a Simphony client. Kiosks are usually configured as Transaction Services clients. Obtain the following information before you begin the configuration:

- Transaction Services workstation name
- Number of revenue centers using Transaction Services

1. In the EMC, select the property, click Setup and Workstations.
2. Insert a record and enter the workstation name.
3. Double-click the workstation record.
4. In the Type field, select 3 - POSAPI Client.
5. Select the Service Host ID where the workstation will run.
6. In the Address / Host Name field, enter the machine where Transaction Services is installed.
7. Click the Transactions tab.
8. Enter the Minimum and Maximum Check Numbers to use.
9. In the Default Order Type field, select the order type that the Transaction Services workstation client uses.
10. Ensure that the Cash Drawer Settings show 0 (zero).
11. Click the Order Devices tab.
12. Select all order devices that use the Transaction Services client for the revenue center shown in the list. If multiple revenue centers use Transaction Services, select the appropriate order devices for each revenue center.
13. Click the Printers tab.
14. Select the printer to use for each print job.
15. Click the Revenue Centers tab.
16. Select the revenue centers in which this instance of Transaction Services operates.
17. Ensure that no peripheral devices appear on the Devices tab.
18. Click Save.
19. Repeat Steps 1 through 18 for each Transaction Services workstation client.

Related Topics
• Understanding Transaction Services

Configuring the Transaction Services Employee

Transaction Services requires that you assign a default transaction employee to the Transaction Services client. This employee does not need to be a real employee, but is required to link to the appropriate revenue center that uses Transaction Services.

1. In the EMC, select the Enterprise, property, or revenue center, click Configuration and Employee Maintenance.
2. Click the Insert Record button to add an employee.
3. Assign the employee with an operator record in the revenue center in which Transaction Services operates. Take note of the employee record number.
4. Click Save.

Related Topics
• Understanding Transaction Services
Importing and Exporting Data

Beginning with Simphony version 2.8, the Simphony Import/Export Service allows you to:

- Import and export Simphony application data in a comma-separated values (CSV) format, to or from spreadsheet applications
- Import configuration data into the Simphony application database that can be called by external systems, such as a web service application programming interface (API)
- Export configuration data from Simphony that can be called by external systems, such as an on premise inventory management application

The main benefits of this service are:

- Allows you to load configuration data in bulk (for example, making a large number of price changes for menu items, which reduces the amount of time it takes to configure systems)
- Allows third parties to integrate with customer databases (either self-hosted or hosted within an Oracle facility), without providing direct access to the application file server or database
- Allows third parties to build custom interfaces
- Configuring the Import/Export Service Privileges
- Configuring the Import/Export Service
- Increasing the Import File Size
- Import/Export Service Components

**Related Topics**

- Configuring the Import/Export Service Privileges
- Configuring the Import/Export Service
- Increasing the Import File Size
- Import/Export Service Components

**Configuring the Import/Export Service Privileges**

You need to set privileges to allow the appropriate employees to use the Simphony Import/Export Service.

1. In the EMC, select the Enterprise level, click **Configuration** and **Roles**.
2. Select the role type and click the EMC Modules tab.
3. To allow import of information, select **Edit**, **Add**, **Delete**, and **Add Override** for the appropriate entities in the File column.
4. To allow export of information, select View for the appropriate entities in the File column.

5. Click Save.

Related Topics

• Importing and Exporting Data
• Import/Export Service Components

Configuring the Import/Export Service

Before configuring the Import/Export Service, you must have the appropriate Enterprise Management Console (EMC) Enterprise privileges assigned to you.

1. In the EMC, select the Enterprise level, click Setup and Enterprise Parameters.
2. Click the Import/Export tab.
3. Enter the appropriate values in the fields. The following table describes the settings that you can configure for the Import/Export service.

Table 24-1 Import/Export Service Settings

<table>
<thead>
<tr>
<th>Field or Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root Path for Export/Import File Operations</td>
<td>Enter the location to store the encrypted import and export request files.</td>
</tr>
<tr>
<td></td>
<td>If you change the default location, restart the MICROS Data Request Processing Service for the changes to take effect.</td>
</tr>
<tr>
<td>Max No. of Records to Commit Per Batch</td>
<td>Enter the maximum number of records to commit per batch when importing. You can enter any value from 1000 through 20000.</td>
</tr>
<tr>
<td></td>
<td>If you change the default value, restart the MICROS Data Request Processing Service for the changes to take effect.</td>
</tr>
<tr>
<td>Default Date Time Format</td>
<td>Select the date and time format to use when processing import and export requests.</td>
</tr>
</tbody>
</table>

4. Click Save.

Related Topics

• Importing and Exporting Data
• Import/Export Service Components

Increasing the Import File Size

Complete these steps if the Enterprise requires you to import files larger than the default 4MB size.

1. Browse to [Drive Letter]:MICROS\Simphony2\SimphonyImportExport\WebApp\ and open the Web.config file.
2. Add the following line within a comment:
Uncomment the following line:

```xml
<httpRuntime targetFramework="4.5" executionTimeout="240" maxRequestLength="10243"/>
```

Enter the maximum import file size for the maxRequestLength parameter in Kilobits. By default, this value is set to 10 MB.

Save the changes.

Related Topics
- Importing and Exporting Data
- Import/Export Service Components

Import/Export Service Components

The Simphony Data Import/Export service is comprised of four components and a Microsoft Windows service. The following table lists the components and their capabilities.

<table>
<thead>
<tr>
<th>Component</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>EGateway URL</td>
<td>Provides access to the Simphony configuration for self-hosted and Enterprise hosting center environments.</td>
</tr>
<tr>
<td>Web Service (REST API)</td>
<td>Assists developers with programmatic integration and the development of third party application programming interfaces (API).</td>
</tr>
<tr>
<td>Web Service (SOAP API)</td>
<td>The SOAP API has the same functionality as the REST API, except this web service is constructed using the SOAP format rather than the REST format.</td>
</tr>
<tr>
<td>Web Application</td>
<td>This user interface (UI) allows you to:</td>
</tr>
<tr>
<td></td>
<td>• Import and export data manually</td>
</tr>
<tr>
<td></td>
<td>• Export data automatically using the scheduler</td>
</tr>
<tr>
<td></td>
<td>• Review the status of completed import and export jobs</td>
</tr>
<tr>
<td></td>
<td>The Web Application is available for all users with Simphony Enterprise Management Console (EMC) logon credentials.</td>
</tr>
<tr>
<td>MICROS Data Request Processing Service (Windows Service)</td>
<td>This Windows service runs as part of throttling and scheduling processes (rather than on demand servicing requests).</td>
</tr>
</tbody>
</table>

Related Topics
- Importing and Exporting Data
- Configuring the Import/Export Service Privileges
- Configuring the Import/Export Service
- Increasing the Import File Size
Handling Time Zone Changes on a Moving Property

A cruise ship is a constantly moving property. As a ship moves around the world, the time zone settings for the shipboard systems need to change daily to align with the time zone in which the ship is sailing.

There are two methods of changing the time zone:

- A ship’s master clock communicates the current time zone settings. When someone changes the master clock’s time zone, all shipboard systems (for example, property management system (PMS) and point of sale (POS)) automatically update their settings to ensure consistent date and time stamp posting across all applications.
- A system administrator manually sets the ship’s time zone within the PMS and POS applications.

Oracle recommends that you perform the following tasks:

- Close all checks before changing the time zone.
- Change the time zone once per day during a slow period of operations (for example, between 2:00 a.m. and 5:00 a.m.).
- **Start of Business Day**
- **Workstation Control Privileges**
- **Changing the Time Zone**
- **Configuring Start of Day**
- **Configuring Workstation Control Privileges**

Related Topics

- **Changing the Time Zone**

Start of Business Day

In food service and hotel environments, a business day refers to the beginning and end times of a day of business. A business day can have any begin time, but typically a business day starts in the early morning hours during a slow or closed period of operations (for example, 3:00 a.m. or 4:00 a.m.). In contrast, a calendar day always begins at 12:00 a.m.

In a cruise ship environment the PMS controls the business date. POS transactions (for example, dinner or drinks) post to rooms in the PMS. The POS and PMS must be in sync to communicate and balance these transactions. When initializing the Start of Day (SOD) on a ship, change the PMS date before changing the POS date.

On cruise ships, Simphony allows a manual SOD to run twice in one calendar day. The rooms empty at approximately the same time on a cruise ship and the financial...
information resets. The ship’s PMS and POS are closed out after the last guest leaves the ship, which is typically between 12:00 p.m. and 1:00 p.m. The SOD changes in the PMS and POS at that time, and the next cruise begins. Both the PMS and POS change the SOD again at about 3:00 a.m. the following day when the cruise is under way.

**Related Topics**
- Configuring Start of Day

### Workstation Control Privileges

You can configure the control of workstation operations during critical events, such as:
- Running Start of Day
- Locking and unlocking workstations
- Locking and unlocking revenue centers
- Updating workstations
- Reloading workstations

You can set the workstation control privileges for each employee role type (for example, manager, server, and host).

**Related Topics**
- Configuring Workstation Control Privileges

### Changing the Time Zone

1. Close all checks in the Front of House.
2. Select the Enterprise level, click **Setup** and **Properties**.
3. Select the new time zone for the ship from the **Time Zone** drop-down list.
4. Click **Save**. The Client Application Loader (CAL) Client deploys the new time zone to the property and automatically updates the time zones of the workstations connected to the property.

   Time zones do not update on workstation tablet devices running generic Android operating systems when the property time zone changes.

**Related Topics**
- Handling Time Zone Changes on a Moving Property

### Configuring Start of Day

A system administrator on a ship must take the workstations offline and then manually set the daily start and end times.

1. In the EMC, select the Enterprise level, click **Configuration** and **Role**.
2. Select the appropriate role type (such as manager), click the Operations tab and then click the PMC Procedures sub-tab.
3. Select the appropriate privileges as described in the following table:
Table 25-1  Start of Day Role Privileges

<table>
<thead>
<tr>
<th>Privilege Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>30058 – Run Start of Day from OPS</td>
<td>Select this option to allow all employees with the role to increment the business date from the property's Check and Posting Service (CAPS) workstation.</td>
</tr>
<tr>
<td>30059 – Prevent Running SOD from OPS with Open Checks</td>
<td>Select this option so that Start of Day cannot run when open checks exist.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

5. Select the Enterprise, property, or revenue center, click **Configuration** and **Page Design**.

6. Select the page on which to place the Start of Day button.

7. Add a Start of Day button:
   a. In the **Legend** field, enter **Run Start of Day**.
   b. In the **Type** field, select **Function**.
   c. Click the arrow beneath the **Type** field and select **Start of Day**.
   d. Position and size the new button on the page.

8. Click **Save**.

9. Select the property, click **Setup** and **Property Parameters**.

10. Click the Options tab and select **48 – Run Start of Day from OPS**.

11. Click the Calendar tab and select **Run Manually** for each day of the week.

12. In the **Manual SOD Safety catch time** field, set the time when the application automatically increments the business date if someone forgets to manually run SOD.

   The application checks to see whether SOD occurred within a 24-hour period for the selected property. This time is based on the time zone of the property.

13. Click **Save**.

14. Select the Enterprise level, click **Configuration** and **PC Autosequences**.

15. Insert a PC Autosequence record and name it **Increment Business Day**.

16. Open the record and select the **Allowed Properties** to view the autosequence.

17. (Optional) Add **Parameters** as appropriate.

   For example, you can enter a property number and exclude a revenue center number.

18. On the Steps tab, add a step and in the **Step Type** drop-down list, and select **3 - Increment Business Date**.

19. Click **Save**.

**Related Topics**

- **Start of Business Day**

---

**ORACLE**

25-3
Configuring Workstation Control Privileges

To set the control of workstation operations during critical events:

1. In the EMC, select the Enterprise level and then click Configuration, Roles, the appropriate role type (such as manager), and Miscellaneous.

2. Select the appropriate privileges:
   - **10019 - Unlock UWS or Revenue Center** – Select this option to allow employees in the role to unlock a workstation or revenue center from the locked dialog.
   - **10020 - Use Workstation Control** – Select this option to allow employees in the role to use the Workstation Control key to access various workstation functions (for example, locking and unlocking workstations and revenue centers, and updating the database). Selecting this option also allows employees to unlock a workstation or revenue center from the locked dialog.

3. Click Save.

4. Select the Enterprise, property, or revenue center, click Configuration and Page Design.

5. Select the page on which to place the Workstation Control button.

6. Add a Workstation Control button:
   a. In the Legend field, enter Workstation Control.
   b. In the Type field, select Function.
   c. Click the arrow beneath the Type field and select Workstation Control.
   d. Position and size the new button on the page.

7. Click Save.

Related Topics

- Workstation Control Privileges
Built in log archiving capabilities are included in Simphony version 2.8 and later. Rather than deleting the oldest log file when a log reaches its maximum size, Simphony compresses the oldest log file up to 2 percent of its original size and then stores it in an AutoArchive folder, which is located in the same directory as the original logs. This reduces the disk space consumed by the log files and allows you to keep the files for a longer period of time. For example, if the maximum file size for a single log file is 1 MB and the total amount of disk space (log size) that can be used by all log files is 10 MB or 10 logs, when the application generates the 11th log, it compresses the oldest log file and moves it to the AutoArchive folder.

Simphony names the archived files after their log files and includes the date and time of compression. You can easily search the log files for a particular date. For example, if the log file is Log_PEPPER_172.txt, the archived file is Log_Pepper_172.DateOfCreation_TimeOfCreation.zip.

Simphony purges archived log files only when one of the following configured thresholds is met:

**Table 26-1  Log Archive Purge Thresholds**

<table>
<thead>
<tr>
<th>Purge Threshold</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LogArchiver.MinDiskUsedPercent</td>
<td>This threshold defines the free disk space threshold. When the free disk space falls below the configured percentage, the application purges the archived files. The minimum disk space is set to 10% by default.</td>
</tr>
<tr>
<td>LogArchiver.MaxDiskUsedMB</td>
<td>This threshold defines the maximum size for the archived files. When the total size of all the archives exceeds the configured amount, the application purges the archived files. The size is set to 100 MB by default.</td>
</tr>
<tr>
<td>LogArchiver.DaysToKeep</td>
<td>This threshold defines the number of days to keep the archived logs before purging. The number of days to keep is set to 21 days by default.</td>
</tr>
</tbody>
</table>

The ArchiveHistory.txt file, which resides in the original log directory, tracks archiving operations. When this file reaches 20 KB, Simphony renames it to ArchiveHistory.previous.txt. Simphony retains only one ArchiveHistory.previous.txt file at a time.

Log archiving is active by default for application servers and services, while it is deactivated by default for workstation services due to the constrained disk space of workstations.

- Modifying the Default Log Archive Purge Settings for Application Services
- Enabling Log Archiving for Workstations
Modifying the Default Log Archive Purge Settings for Application Services

To modify the default archive purge settings, you need to add entries to four application service configuration files. The following table lists the configuration files for the application services and their locations:

<table>
<thead>
<tr>
<th>Application Service</th>
<th>Configuration File Name</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>EGateway Service</td>
<td>Web.config</td>
<td>[Driver]:\MICROS\Simphony2\EGatewayService</td>
</tr>
<tr>
<td>Data Transfer Service (DTS)</td>
<td>DataTransferService.exe.config</td>
<td>[Driver]:\MICROS\Simphony2\DataTransferService</td>
</tr>
<tr>
<td>Direct Posting Service (DPS)</td>
<td>DirectPostingService.exe.config</td>
<td>[Driver]:\MICROS\Simphony2\DirectPostingService</td>
</tr>
<tr>
<td>Sequencer Service</td>
<td>SequencerService.exe.config</td>
<td>[Driver]:\MICROS\Simphony2\SequencerService</td>
</tr>
</tbody>
</table>

1. Browse to the file location and open the configuration file.
2. Add the following entries:
   - If you want to turn off log archiving, add `<add key="LogArchiver.Enabled" value="false" />` to the configuration file.
   - If you want to change the free disk space threshold, add `<add key="LogArchiver.MinDiskUsed-Percent" value="MinDiskUsedPercent" />` to the configuration file.
   - If you want to change the maximum size for the archived files, add `<add key="LogArchiver.MaxDiskUsedMB" value="MaxDiskUsedMB" />` to the configuration file.
   - If you want to change the number of days to keep the archived logs, add `<add key="LogArchiver.DaysToKeep" value="DaystoKeep" />` to the configuration file.
3. Repeat Steps 1 and 2 for each configuration file listed in the table.

Related Topics
- Log File Management

Enabling Log Archiving for Workstations

1. Browse to the [Driver]:\MICROS\webserver\wwwroot\EGateway folder and open the Web.config file.
2. Add the following entries to the Web.config file:
• <add key="LogArchiver.Enabled" value="true" />

• <add key="LogArchiver.MinDiskUsedPercent" value="MinDiskUsedPercent" />

• <add key="LogArchiver.MaxDiskUsedMB" value="MaxDiskUsedMB" />

• <add key="LogArchiver.DaysToKeep" value="DaystoKeep" />

Related Topics

• Log File Management
Engagement Cloud Service

The Engagement Cloud Service is Simphony’s interactive user interface for the Oracle MICROS Tablet E-Series and Workstation 6. The Engagement Cloud Service is a web-based interface featuring an ultra-modern look and feel with interactive live tiles. The Engagement Cloud Service is visually stimulating and provides advanced capabilities that redefine the hospitality and retail experience.

- Understanding the Engagement Cloud Service
- System Requirements and Supported Devices
- Firewall and Communication
- Security Precautions
- Setting File Management Permissions
- Registering and Logging In
- Retrieving Your Engagement Organization ID
- Language Translation Tasks
- Adding a New Language to Hub and Welcome Pages
- Adding a Language to the EMCWeb File
- Adding a Language File to the Engagement Configuration Application Server
- Setting Multiple Languages
- Understanding Engagement Manager Procedures
- Adding Engagement Manager Procedure Tiles to the Hub Page
- Editing the Check Header and Trailer
- Editing Bulk Menu Item Prices
- Adding an Employee From a Template
- Adding a New Menu Item Using an Existing Menu Item as a Template
- Adding Images to Menu Items
- Adding or Changing an Employee’s Profile Image
- Creating Pages for Engagement Users
- Modifying Pages for Engagement Users
- Publishing, Unpublishing, and Republishing Pages
- Assigning Logos and Colors to Pages
- Understanding Tagging
- Adding Tags and Creating Relationships between Pages, Employees, and Tablets
- Deleting Tags
- Understanding Widgets
Understanding the Engagement Cloud Service

The Engagement experience lets you:

- Create customized pages online
- Assign and tag pages to properties, employees or workstations, or both
- Run Point-of-Sale (POS) operations and execute Manager Procedures

There are two types of pages:

- Welcome Pages – Initial page that appears on the MICROS Tablet E-Series device. You can assign different Welcome pages to workstations.
- Hub Pages – Pages that appear on the tablet after workstation operators sign in and click the Hub button. You can assign different Hub pages to each employee.

Pages can contain widgets that allow you to enhance workstation functionality. For example, you can have daily specials, image slideshows, a Twitter feed, and Oracle Hospitality Reporting and Analytics reports appear on the tablet’s touchscreen.

System Requirements and Supported Devices

Engagement version 2.0 requires a system running Oracle Hospitality Simphony version 2.8 (or later) and Oracle Hospitality Enterprise Back Office version 8.5.0 (or later).

The Engagement service is supported on workstations running the Microsoft Windows 8.1 operating system.

You can use Engagement on the following devices:

- Oracle MICROS Tablet E-Series 8-inch and 11-inch models
- Oracle MICROS Workstation 6

Firewall and Communication

Ensure that a firewall is in place that restricts inbound and outbound traffic per PCI_DSS_V3 requirement 1.3–Prohibit direct public access between the Internet and any system component in the cardholder data environment. The following diagram illustrates the firewall communication for Engagement Enterprise with the Simphony Enterprise.
The Engagement Enterprise sends requests to the Simphony Enterprise through the Simphony2 site to register and perform synchronization. The Simphony Enterprise allows inbound requests from the uniform resource locator (URL) https://www.cloudmicros.com/ on port 443. The following diagram illustrates the communication between the Engagement Enterprise and the Simphony Enterprise.

Workstations make outbound requests for pages, authentication, and content to the URL https://www.cloudmicros.com/ on port 443. The following diagram illustrates the communication between the Engagement Enterprise and the Simphony property.
In addition to the Engagement Enterprise, firewall rules need to ensure that any URL used within Engagement is allowed through an outbound request. This includes the URL Widget, PDF Widget, IP Camera, and all other external content being used within Engagement.

### Security Precautions

The Engagement feature allows you to configure live tiles and content that appear on a Point-Of-Sale (POS) device. Ensure that any external data sources or uniform resource locators (URLs) provided through Engagement are secure and derive from a trusted source.

The URL widget, which shows web content from the configured location, has some security precautions built into it. By default the URL widget locks the workstation operator into the domain of the link provided. That is, all links on a page that are outside of the domain are disabled to prevent workstation operators from navigating to these links. For example, if you configure a URL widget for http://www.oracle.com, all links outside of *.oracle.com are automatically disabled for the workstation operator.

Consider the following best practices when configuring the URL widget and POS device on which it runs.
Internet Security Settings

The browser security settings within the Engagement feature are defined by the settings of Microsoft Internet Explorer. When you change Internet Explorer options, (for example, Do not allow cookies) you also change the settings for the Engagement browser.

Do not move security levels below Medium-high with Enable Protected Mode on for Internet and Medium-low with Enable Protected Mode off for Local intranet. These are the minimum Engagement security settings. You may increase the security levels if desired.

Trusted Source

Only enter URLs for the widget from a secure and trusted source. Creating links to unverified sources and untrusted websites increases the security risk for your POS device.

Setting File Management Permissions

In some installations, the internal Microsoft Windows user that runs the Engagement web services on a Simphony application server does not have sufficient permission to create and manage files (such as logs) within the folder where the software is installed. A batch file is available to run after installation, which enables the appropriate permissions. Contact Oracle Support for the EngagementFolderPerm.bat batch file.

As an alternative to running the script through the batch file, you can manually set the permissions by following these steps:

1. Use Windows Explorer to browse to the web root folder of the EGateway application (for example, [Drive Letter]\MICROS\Simphony2).
2. Locate the Engagement sub folder within the EGateway web root folder (for example, [Drive Letter]\MICROS\Simphony2\Engagement).
3. Right-click the Engagement folder, click Properties, and then click the Security tab.
4. Click Edit.
5. Click Add.
6. In the Select Users or Groups dialog, enter IIS APPPOOL\WCCPool and click OK.
7. In the Permissions for Engagement dialog, select WCCPool, allow the following permissions for the user, and click OK.
   • Modify
   • Read & execute
   • List folder contents
   • Read
   • Write
8. Open a Command prompt window and enter iisreset. IIS should successfully reset within a few minutes.
Registering and Logging In

2. If you are a new user, click Register. If you are an existing user, continue to the next step.
3. Enter the same connection settings (Simphony Server’s Internet Protocol (IP) address) and login credentials you use to access the Simphony Enterprise Management Console (EMC).
4. Select the default organization language and click Next.
5. Enter the same connection settings and login credentials you use to log in to Oracle Hospitality Reporting and Analytics.
6. Enter the email address where you want to receive registration confirmation information.

Retrieving Your Engagement Organization ID

Perform the following steps from the Login screen if you forget your Engagement Organization ID.

1. Click Forgot my ID.
2. Enter your site’s gateway uniform resource locator (URL) (for example, http://<ServerName>:8080 or http://<Server IPAddress>:8080).
3. Enter your Simphony Enterprise Management Console (EMC) user name and password.
4. Click Recover Org Id. The Engagement Organization ID appears.
5. Click Back to Login to enter your Login credentials.

Language Translation Tasks

Configuring language translation for Engagement consists of completing the following tasks:

- Adding a language to Hub and Welcome pages
- Adding a language to the EMCWeb file
- Adding a language file to the Engagement Configuration application server
- Enabling multi-languages

Related Topics

- Adding a New Language to Hub and Welcome Pages
- Adding a Language to the EMCWeb File
- Adding a Language File to the Engagement Configuration Application Server
- Setting Multiple Languages
Adding a New Language to Hub and Welcome Pages

1. Browse to the Engagement Language File directory on the Simphony application server.
   The default installation path is [Drive Letter]\Micros\Simphony\WebServer\Engagement\LanguageFile\Resources.xml.

2. Copy the Resources.xml file.

3. Rename the file to Resource.CULTURE-CODE.xml, where CULTURE-CODE is the code of the new language you are adding (for example, Resources.fr-FR.xml for French or Resources.es-ES.xml for Spanish).

4. Change the values of the <string> elements of each language entry to the target language.
   Do not change the values of other elements or attributes.
   You can move the number parameters ({0} or {1}) in the language string (left or right of the string text), but do not delete them.

5. Save the changes.

Related Topics
• Language Translation Tasks
• Setting Multiple Languages

Adding a Language to the EMCWeb File

1. Browse to the Engagement Language File directory on the Simphony application server.
   The default installation path is [Drive Letter]\Micros\Simphony2\EGatewayService\CAL\Win32\Package\ServiceHost2.0\WebServer45\Engagement\LanguageFiles.

2. Copy the EMCWebLanguageStringsEN-US.xml file.

3. Rename the file to EMCWebLanguageStrings.CULTURE-CODE.xml, where CULTURE-CODE is the code of the new language you are adding. The file name must include the correct CULTURE-CODE naming convention (for example, EMCWebLanguageStrings.fr-FR.xml for French or EMCWebLanguageStrings.es-ES.xml for Spanish).

4. Change the values of the Text language attribute for each language entry to the target language.
   Do not change the values of the key or screen attributes.
   You can move the number parameters ({0} or {1}) in the language string (left or right of the string text), but do not delete them.

5. Save the changes.

Related Topics
• Language Translation Tasks
Adding a Language File to the Engagement Configuration Application Server

1. Browse to the Engagement Language File folder on the Engagement Configuration (Config) application server. The default installation path is [Drive Letter]:\Web Root\Languages.
2. Copy the en-US.xml file.
3. Rename the file to CULTURE-CODE.xml, where CULTURE-CODE is the code of the new language you are adding (for example, fr-FR.xml for French or es-ES.xml for Spanish).
4. Change the values of the Text language attribute for each language entry to the target language. Do not change the value of the record key attribute.
   You can move the number parameters ({0} or {1}) in the language string (left or right of the string text), but do not delete them.
5. Change the values of the name and code attributes on the second line to the Culture code of the target language (<Language version="32" name="English (US)" code="en-US">).
6. Save the changes.

Related Topics
• Language Translation Tasks

Setting Multiple Languages

1. In the EMC, select the Enterprise level, click Setup and Languages.
2. Double-click a language record.
3. In the Language Culture field, enter the abbreviated language code. For example, the code for English - United States is en-US.
   See http://msdn.microsoft.com/en-us/library/ee825488(v=cs.20) for a list of language codes.
4. Repeat Steps 2 and 3 for each language record.
5. Click Save.

Related Topics
• Language Translation Tasks

Understanding Engagement Manager Procedures

The Web EMC or Web Configuration Console (WCC) widget enables you to assign one of the following manager procedures to a tile:
## Adding Engagement Manager Procedure Tiles to the Hub Page

1. Log in to the Engagement dashboard, go to the Hub Pages section, and then add a new WCC widget.
2. In the EMC - Properties dialog box, select **Copy Employee** as the **Command Type**.
3. (Optional) Enter the **Primary Text** and **Secondary Text** that should appear on the widget.
4. (Optional) Select the widget **Size**, and add a **Tile Image** for the widget.
5. Click **Save**.
6. Repeat Steps 1 through 5 to add tiles to the Hub page for the Edit Header/Trailer, Bulk Edit MI Prices, and Copy Menu Item manager procedures.

### Related Topics
- Understanding Engagement Manager Procedures
Editing the Check Header and Trailer

1. Log in to the workstation and click the touchscreen button configured for the Hub function key.
2. Click the tile configured for the Edit Header/Trailer manager procedure.
3. Select a property or revenue center.
4. If you want to edit the header and trailer for guest checks, select Guest Check.
5. If you want to edit the check header for a customer receipt, select Customer Receipt.
6. Enter the details that should print on the header in the Header text fields, and enter the details that should print on the trailer in the Trailer text fields.
7. If you want to insert a logo for the header:
   a. Select a Header text field, and then click Insert Image.
   b. Select a logo from the preview.
8. Click Save.

Related Topics
• Understanding Engagement Manager Procedures

Editing Bulk Menu Item Prices

1. Log in to the workstation and click the touchscreen button configured for the Hub function key.
2. Click the tile configured for the Bulk Edit MI Prices manager procedure.
3. If you want to edit the price of a single menu item:
   a. Enter the menu item’s name in the search field, and click Search.
   b. Click the Price field of the menu item, enter the new menu item price, and then click Enter.
4. If you want to edit the prices of several menu items:
   a. Click Filter Menu Item and select one or more of the following filter criteria:
      • Major Group
      • RVC
      • Family Group
      • SLU
      • Menu Item Class
   b. Click the Price field of the first menu item on the search results, enter the new menu item price, and then click Enter. The focus moves to the price of the next menu item.
5. Click Save, and then click OK to confirm the changes.
Related Topics

- Understanding Engagement Manager Procedures

Adding an Employee From a Template

1. Log in to the workstation and click the touchscreen button configured for the **Hub** function key.
2. Click the tile configured for the **Copy Employee** manager procedure.
3. Click **Filter Employees**, select the revenue center, employee role, and employee class that you want to assign to the new employee.
4. Select an employee from the search results and click **Copy Employee**.
5. Configure the following information for the new employee:

**Table 27-2 Configuration Fields for Adding New Employees From a Template**

<table>
<thead>
<tr>
<th>Field or Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>Enter the employee’s first name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Enter the employee’s last name.</td>
</tr>
<tr>
<td>DOB</td>
<td>Select the employee’s date of birth.</td>
</tr>
<tr>
<td>Hire Date</td>
<td>Enter the date the employee was hired.</td>
</tr>
<tr>
<td>(Optional) MagCard ID</td>
<td>Enter the number of the magnetic card assigned to the employee or swipe the card to enter the card number into the application.</td>
</tr>
<tr>
<td>(Optional) Finger Print</td>
<td>If a fingerprint scanner is connected, you can scan the employee’s fingerprints into the application.</td>
</tr>
<tr>
<td>RVCs</td>
<td>Select the employee’s revenue center. You cannot change the primary revenue center of the employee.</td>
</tr>
<tr>
<td>Enable Reporting</td>
<td>If you want to grant the employee access to Simphony’s reporting portal (Oracle Hospitality Reporting and Analytics), select this option.</td>
</tr>
<tr>
<td>Is Salaried</td>
<td>If the employee is paid a flat amount, select this option.</td>
</tr>
<tr>
<td>Pay Rate</td>
<td>Enter the employee’s pay rate.</td>
</tr>
<tr>
<td>Logon Name</td>
<td>Enter the username to use to log in to the workstation. If you select <strong>Enable Reporting</strong>, the employee can use the same username to log in to Reporting and Analytics.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password to use to log in to the workstation. If you select <strong>Enable Reporting</strong>, the employee can use the same username to log in to Reporting and Analytics.</td>
</tr>
</tbody>
</table>
Table 27-2 (Cont.) Configuration Fields for Adding New Employees From a Template

<table>
<thead>
<tr>
<th>Field or Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm Password</td>
<td>Re-enter the password.</td>
</tr>
</tbody>
</table>

6. If you want to add an image to the employee’s profile:
   a. Click **Change Picture**, and then click **Browse Image**.
   b. Select the employee’s image and click **Open**.

7. Click **Add Employee**, and then click **Yes** to confirm the insertion.

Related Topics

• Understanding Engagement Manager Procedures

Adding a New Menu Item Using an Existing Menu Item as a Template

1. Log in to the workstation and click the touchscreen button configured for the **Hub** function key.
2. Click the tile configured for the **Copy Menu Item** manager function.
3. Select a menu item that belongs to the same menu item class and print class that you want to assign to the new menu item, and click **Copy Image**.
4. Configure the following details for the new menu item:

Table 27-3 Configuration Fields for Adding New Menu Items From a Template

<table>
<thead>
<tr>
<th>Field or Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Item Master Name</td>
<td>Enter the new menu item name.</td>
</tr>
<tr>
<td>Definition</td>
<td>Select the appropriate menu item definition.</td>
</tr>
<tr>
<td></td>
<td>If the menu item that you are using as the template has several definitions,</td>
</tr>
<tr>
<td></td>
<td>all definitions appear in the list.</td>
</tr>
<tr>
<td>Menu Item Definition Name</td>
<td>Enter the name for the new menu item definition.</td>
</tr>
<tr>
<td>Price</td>
<td>Enter the menu item price.</td>
</tr>
</tbody>
</table>

5. If you want to change the image for the menu item:
   a. Click **Change Picture**, and then click **Browse Image**.
   b. Select the new image and click **Open**.

6. Click **Add Menu**, and then click **OK** to confirm the insertion.

Related Topics

• Understanding Engagement Manager Procedures
Adding Images to Menu Items

1. Log in to the workstation and click the touchscreen button configured for the Hub function key.
2. Click the tile configured for the Copy Menu Item manager function.
3. Select the menu item that you want to use as the template for the new menu item, and then click Upload Image.
4. Select the menu item image, and click Open.

Related Topics
• Understanding Engagement Manager Procedures

Adding or Changing an Employee's Profile Image

1. Copy images to the Point-of-Sale (POS) device using a flash drive or download the images through the Internet.
2. Log in to the workstation and click the touchscreen button configured for the Hub function key.
3. Click the tile configured for the Copy Employee manager procedure.
4. Select an employee and click Preview.
5. Click Change Picture, and then click Browse Image.
6. Browse to and select the employee's image, and then click Open.

   Image files cannot exceed 50 KB in size. The following image file type formats are supported:
   • .bmp
   • .jpeg
   • .png
   • .gif
7. Close the Employee Summary dialog box.

Related Topics
• Understanding Engagement Manager Procedures

Creating Pages for Engagement Users

1. From the dashboard, go to the Pages section and click View All.
2. To add a new page from either the Welcome Pages or Hub Pages section, click + Create New Page in the appropriate section.
3. Type the name of the page in the text box and click OK.

Modifying Pages for Engagement Users

You can modify pages using the controls that appear when you select a page.
1. Select a page and click Edit to make changes to the page.
2. Select a page and click Clone to duplicate a page.
3. Select a page and click Default to set the page as the default.
   Default pages have a star shaped icon. Workstation operators see the default page upon signing in to the workstation if no tags are assigned. You can assign default Welcome pages to workstations and assign default Hub pages to employees.
4. Select a page and click Tag to assign or add a tag to a page.

**Publishing, Unpublishing, and Republishing Pages**

Publish pages to allow workstation operators to view and access non-default pages. Published pages appear in color, while non-published pages are gray.

1. Click Publish to save and load the page on the Point-of-Sale (POS) clients.
   You can only publish one page if no pages are tagged. When you publish an untagged page, the application unpublishes the previous default page and the newly published page becomes the default page.
2. Click Unpublish to deactivate currently published pages.
3. Click Republish to publish pages that were previously published. Clicking Republish automatically loads the page for the POS clients.

**Assigning Logos and Colors to Pages**

You can define a logo and color palette on Welcome pages. You can add only a logo to Hub pages because the color palette can be inherited from the Enterprise, property, or revenue center level based on the Theme Assignment module configuration.

Copy logo images to the Point-of-Sale (POS) device using a flash drive or download the images through the Internet.

1. Open the page and click anywhere within the grid.
2. Select the color from the Palette drop-down list.
3. If you want to add a company logo to the page, click Open.
4. Browse to the logo image file and select it. The directory path appears in the Logo field.
   Image files cannot exceed 1 MB in size. The following image file type formats are supported:
   • .bmp
   • .jpeg
   • .png
   • .gif
5. Click Save.
Understanding Tagging

You can assign pages to employees and workstations. This is known as tagging. Tagging organizes pages by identifying which property, employee, and tablet are assigned to specific pages. For example, if My Bar assigns a BAR tag to all of the pages, you can search for all pages tagged as BAR.

You can assign multiple tags to a single page, but you can only assign one tag to a workstation and one tag to an employee. You cannot tag pages that are set as the default page. The application assigns new employees to the default Hub page, and a new Point-of-Sale (POS) client shows the default Welcome page without tagging.

The color of the tag indicates the tag state. The following table describes the tag colors and states.

<table>
<thead>
<tr>
<th>Tag Color</th>
<th>Tag State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amber</td>
<td>Tag created and assigned</td>
</tr>
<tr>
<td>Brown</td>
<td>Tag created, but not assigned</td>
</tr>
<tr>
<td>Red</td>
<td>Tag deleted</td>
</tr>
</tbody>
</table>

Depending on the workstation an employee signs into, the application checks the employee tag number and workstation tag number, and shows the appropriate Hub page that meets the tagging criteria.

For example, in the following figure, if the employee signs into Workstation 1, Hub Page 1 appears. This is because the Employee has tag 2, Workstation 1 has tag 1, and the Hub Page 1 has tag numbers 1 and 2. The application shows the page that most closely matches the tagging criteria.

If the employee signs into Workstation 2, Hub Page 2 appears. This is because the Employee has tag 2, Workstation 2 has tag 3, and Hub Page 2 has tags 2 and 3.
Figure 27-4  Application Logic for Showing Hub Page Based on Tag Assignment

Related Topics
  • Adding Tags and Creating Relationships between Pages, Employees, and Tablets
  • Deleting Tags
Adding Tags and Creating Relationships between Pages, Employees, and Tablets

1. From the dashboard, click one or more pages, and click Tags.
2. Click Add, enter a name for the tag, and then click Done.
3. Select an employee and a workstation, and click Tags.
4. Select the tag you created in Step 2, and click Done.

Related Topics
• Understanding Tagging

Deleting Tags

1. Click Tags and then click Delete Tags.
2. Click the tag you want to delete, click Delete, and confirm the deletion.

Related Topics
• Understanding Tagging

Understanding Widgets

Widgets are tiles that you create to show on Simphony Engagement Cloud Service client screens. Widgets allow workstation operators to perform optional tasks and procedures based on the assigned privilege level.

Related Topics
• Adding and Moving Widgets
• Creating Tiles (Adding Widgets to a Page)
• Adding Command Buttons
• List of Widgets

The IP Camera Widget

The Engagement Internet Protocol (IP) Camera widget is used to display a camera feed on the user interface (UI) screen as a widget. It allows users to view live video from an IP camera configured using the Engagement Widget designer. The IP Camera widget uses the Motion-JPEG (MJPEG) video compression format. MJPEG is a video format in which each frame of video is sent as a separate and compressed JPEG image. The viewer displays the JPEG images as quickly as they are received and that creates the video.

The IP Camera widget is implemented using an image control to render the camera feeds received as images on the UI screen. A separate media player is not used. The IP Camera widget uses an open source library named MJPEG Decoder available in CodePlex.
The widget initializes the MJPEG decoder by passing an IP camera feed URL, which is configured using the Engagement widget designer. The widget receives the appropriate events whenever a new image is available and draws it on the container image control. The widget works with all resolutions supported by the IP Camera. The image is resized to fit within the widget’s dimensions, while it preserves its native aspect ratio in the detail view, regardless of the resolution of the images received. The widget does not save or store images.

The MJPEG Decoder library initiates an asynchronous request to the MJPEG URL provided by the viewer. It then streams the multi-part response data received into separate images as they are received. The library passes each JPEG image to the viewer using an event whenever they are available.

The IP Camera widget supports all network and IP cameras capable of sending a direct MJPEG stream. This does not include cameras that are embedded within a web page. The camera must provide a direct stream of only the MJPEG for the IP Camera widget to successfully display the feed.

The IP Camera widget does not require additional security measures when displaying the IP Camera feed. Administrators should implement security restrictions on the network to explicitly allow workstations to connect to the camera feed. Additionally, the IP camera feed should be configured in a secure manner to ensure that the username and password are included in the URL, if possible.

Related Topics

- Adding and Moving Widgets
- Creating Tiles (Adding Widgets to a Page)
- Adding Command Buttons
- List of Widgets

Adding and Moving Widgets

1. Click the widget you wish to add from the Widget list.
2. To move the widget to a new grid location:
   a. Click the widget. A move icon appears.
   b. Click the move icon and then click the new grid location.

   Widgets move based on clicking the left corner (upper left corner on large widgets) and automatically resize when moved to a smaller section of the grid.

Related Topics

- Understanding Widgets
- The IP Camera Widget
- List of Widgets

Creating Tiles (Adding Widgets to a Page)

1. From the dashboard, click a page and then add a widget.
2. (Optional) Enter the **Primary Text**, **Secondary Text**, or both that should appear on the widget.

   The secondary text appears beneath the primary text in a smaller font.

3. Select the size for the tile:
   - **Small**: One tile (small square)
   - **Wide**: Two tiles (rectangle)
   - **Large**: Four tiles (square)
   - **Extra Large**: Nine tiles (large square)

4. (Optional) If you want to add a background image to the tile:
   a. Click **Open**.
   b. Click **Upload images(s)** and browse to the location of the image file, or type the image uniform resource locator (URL) and click **OK**.
   c. If images were previously uploaded, click **View Album Contents** and select the image.
   d. Click **Select** to save an existing image or **Crop** to modify the image, and then click **Done**.

5. If you want to add a URL widget:
   a. Type the URL for the website of choice.
   b. If you want to show the keyboard icon on the tile's top toolbar, select **Show Keyboard**. This allows workstation operators to click the keyboard icon to have the tablet keyboard appear on the tile.

6. If you want to add an Image widget, click **Open** to add an image that appears when the workstation operator selects the tile (not the same as Tile Image).
   If you do not add an image here, the assigned tile image appears by default.

7. If you want to add an IP Camera Feed widget, type the web address (URL) of the IP camera's video stream in the **Video URL** field.
   Include the end query that defines the user and password of the camera (for example, http://CAMERAIPADDRESS/videostream.cgi?user=USERNAME&pwd=PASSWORD&resolution=32&rate=0).

8. If you want to add a PDF Viewer widget, enter the directory path to access the PDF document in the **URL** field.

9. If you want to add a Twitter widget, add a hashtag or account in the **Query text** field (for example, #oracle or @oracle).

10. If you want to add an InMotion Chart widget, select the **Report** that you want to show and the data that you want to appear by default from the **Chart** drop-down list.

11. If you want to add an Image Slideshow widget:
    a. Click **Slideshow Item**, and then click **Open** to add an image that appears during the slideshow.
    b. Enter the primary and secondary text that appears on the image during the slideshow.
    c. If you want to add images to the slideshow, click **Add More**.
d. If you want to remove an image from the slideshow, click Delete Item.

12. If you want to add a Today’s Special widget:
   a. Type the name of the tile in the **Header Text** field, and select a **Template**.
   - Template1 shows each menu item individually during image rotation.
   - Template2 shows each menu item and a preview pane of other menu items during image rotation.
   b. Click **Menu Item** to add an image, enter the menu item name in the **Title** field, and then enter a **Description** of the menu item.
   - The Oracle MICROS Tablet E-Series 8-inch supports up to 823 characters, including spaces.
   - Oracle MICROS Tablet E-Series 11-inch supports up to 627 characters, including spaces.
   c. Enter a **Price**, and additional text or pricing information in the **Extra** field.
   d. If you want to assign a time range to show specials for differing meal periods:
      i. Click **Add Group**, expand the **Group** panel, and click **Recurrence**.
      ii. Enter a time range in 24-hour format during which the group of menu items appear, and select either **Daily** or the days of the week that the group of menu items appear.
   e. Add as many menu items and groups as needed, and then click **OK**.

13. If you want to add a Command widget, assign one of the available commands to the tile.
   The Command widget does not support adding a tile image.

14. If you want to add a Weather widget:
   a. If you want to use the default service provider, select **wunderground** from the **Provider** drop-down list for weather updates.
   b. If you want to use a different service provider, enter the **API URL**, and then enter the **API Key** to authorize running the weather application programming interface (API).
   c. Enter a city name or zip code in the **Location/Zip Code** field for specific forecasts, and select the desired temperature scale from the **Scale** drop-down list.

15. If you want to add an EMC widget, select the EMC task from the **Command** drop-down list.

16. Click **Save**.

17. Click **Publish** for new pages or **Republish** for existing pages.

**Related Topics**
- Understanding Widgets
- The IP Camera Widget
- List of Widgets
Adding Command Buttons

You can add command buttons that provide additional ways to perform common Point-of-Sale (POS) functions such as clocking in or out, editing menu items, or updating the workstation database. These buttons remain hidden and appear only when a workstation operator swipes the upper or lower area of the tablet touchscreen.

1. Click either the upper or lower directional arrow, depending on where you want to add the buttons.

   The upper or lower command bars work independently of each other.

2. Click the plus sign (+) in the upper corner.

3. Enter Primary Text, select the Command to assign the button, and click Save.

Related Topics
• Understanding Widgets
• The IP Camera Widget
• List of Widgets

Understanding Widget Timing Values

You can assign timing values to three widgets. Timing values affect the duration of time that widgets appear on an idle Engagement workstation screen. You can assign custom timing values to the following widgets:

• URL Launcher
• Image Slideshow
• Today’s Special

Engagement widget timing settings are overridden by Log Off User When Idle settings that are configured in the Simphony application, with the exception of the Web Configuration Console (WCC) widget. The WCC widget ignores the Simphony idle client timeout settings. The default timing value setting for the Engagement widgets is twenty seconds.

Related Topics
• Configuring Widget Timing Values

Configuring Widget Timing Values

1. Log in to the workstation and select a page from the dashboard.

2. Select the widget and click Edit.

3. Enter a value in the Allowed Idle Time field.

4. Click Save.

Related Topics
• Understanding Widget Timing Values
List of Widgets

You can add the following widgets to a Welcome page. Welcome pages do not support Hub page widgets.

Table 27-5  Welcome and Home Page Widgets

<table>
<thead>
<tr>
<th>Widgets for Welcome and Home Pages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL Launcher</td>
<td>Allows you assign an image and a web address or uniform resource locator (URL) to a tile. Clicking this tile takes you to the website.</td>
</tr>
<tr>
<td><img src="image" alt="URL Launcher" /></td>
<td></td>
</tr>
<tr>
<td>Image</td>
<td>Allows you to assign an image or picture to a tile. When you click this tile, the image appears larger and shows more detail.</td>
</tr>
<tr>
<td><img src="image" alt="Image" /></td>
<td></td>
</tr>
<tr>
<td>IP Camera Feed</td>
<td>Allows you to directly assign an IP camera feed to a tile. When you click this tile, the camera feed screen increases in size. You do not need to assign an image to the tile. You can connect a maximum of three cameras. See Creating Tiles (Adding Widgets to a Page) for more information about the IP Camera Feed widget.</td>
</tr>
<tr>
<td><img src="image" alt="IP Camera Feed" /></td>
<td></td>
</tr>
<tr>
<td>PDF Viewer</td>
<td>Allows you to assign a portable document format (PDF) to a tile. When you click this tile, the PDF document opens. You must install a PDF reader application on the device to use this widget.</td>
</tr>
<tr>
<td><img src="image" alt="PDF Viewer" /></td>
<td></td>
</tr>
<tr>
<td>Twitter</td>
<td>Allows you to assign a Twitter feed to a tile. When you click this tile, the Twitter feed view increases in size.</td>
</tr>
<tr>
<td><img src="image" alt="Twitter" /></td>
<td></td>
</tr>
<tr>
<td>Image Slideshow</td>
<td>Allows you to assign multiple images that rotate for viewing at five-second intervals.</td>
</tr>
<tr>
<td><img src="image" alt="Image Slideshow" /></td>
<td></td>
</tr>
</tbody>
</table>
### Table 27-5  (Cont.) Welcome and Home Page Widgets

<table>
<thead>
<tr>
<th>Widgets for Welcome and Home Pages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Today’s Special</td>
<td>Allows you to assign one or more menu items, graphics, descriptions, and prices to a tile. When more than one menu item is configured, the items rotate for viewing at five-second intervals. You can assign a time range to this widget so that different specials cycle based on the times they are being served.</td>
</tr>
<tr>
<td>Command Widget</td>
<td>Allows you to assign procedures, functions, and Ops commands to a tile. The available commands are:</td>
</tr>
<tr>
<td></td>
<td>• Clock In</td>
</tr>
<tr>
<td></td>
<td>• Clock Out</td>
</tr>
<tr>
<td></td>
<td>• Update Database</td>
</tr>
<tr>
<td></td>
<td>• Close Application</td>
</tr>
<tr>
<td></td>
<td>• Employee Training</td>
</tr>
<tr>
<td></td>
<td>• Redirect Order Device</td>
</tr>
<tr>
<td></td>
<td>• Edit Menu Item</td>
</tr>
<tr>
<td></td>
<td>• Menu Item Availability</td>
</tr>
<tr>
<td></td>
<td>• Minimize Application</td>
</tr>
<tr>
<td></td>
<td>• Sign In RVC Prompt</td>
</tr>
<tr>
<td>Weather</td>
<td>Allows you to assign a weather forecast provider and location to a tile. In order to use this widget, you must purchase an application program interface (API) key.</td>
</tr>
</tbody>
</table>

### Table 27-6  Hub Page Widgets

<table>
<thead>
<tr>
<th>Widgets for Hub Pages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>inMotion Charts</td>
<td>Allows you to assign Oracle Hospitality Enterprise Back Office reports to a tile. When you select this tile, the assigned report generates first, but all other reports are also accessible. Select each report to view more information. The available reports are:</td>
</tr>
<tr>
<td></td>
<td>• Sales</td>
</tr>
<tr>
<td></td>
<td>• Labor Cost</td>
</tr>
<tr>
<td></td>
<td>• Discount</td>
</tr>
<tr>
<td></td>
<td>• Sales Per Labor Hour</td>
</tr>
<tr>
<td></td>
<td>• Check Count</td>
</tr>
<tr>
<td></td>
<td>• Guest Count</td>
</tr>
<tr>
<td></td>
<td>• Average Ticket Time</td>
</tr>
</tbody>
</table>
Table 27-6  (Cont.) Hub Page Widgets

<table>
<thead>
<tr>
<th>Widgets for Hub Pages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>inMotion Stores</td>
<td>Allows you to view cumulative Sales Report information from all available outlets, or you can select an individual store from a list that appears when selecting this tile.</td>
</tr>
<tr>
<td>Labor Cost</td>
<td>Allows you to view potential employee overtime labor costs. When you select this tile, alerts inform the supervisor about employees approaching overtime for a particular pay cycle.</td>
</tr>
</tbody>
</table>
| WCC (Web Configuration Console) | Allows you to assign one of the following available manager procedures to a tile:  
  - Edit Header/Trailer  
  - Bulk Edit MI Prices  
  - Copy Menu Item |

Related Topics
- Understanding Widgets
- The IP Camera Widget
- Adding and Moving Widgets
- Creating Tiles (Adding Widgets to a Page)
- Adding Command Buttons

Viewing the Maximum Data Limit for Hosted Engagement Server

You can view the maximum allowable amount and remaining space for uploading widget images to your hosted Engagement server. When adding images for widgets, the data limit (2GB total) appears on the image upload screen, along with the remaining amount of available space for adding more image content.

Related Topics
- Adding and Moving Widgets